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Foreword	…
General	or	vocational	education?	This	 is	a	“tough	choice”	 for	many	students.	 In	 the	human	capital	 framework,	general	education	creates

‘general	human	capital’	and	vocational	and	technical	education	‘specific	human	capital’	(Becker,	1964).	The	former	is	portable	across	one’s	life	and
from	job	to	job,	while	the	lafer	is	not	and	hence	many	advocate	general	education,	as	more	suitable	to	the	flexible	labour	force	that	can	change	task
and	even	the	type	of	work;	but	the	lafer	has	an	advantage,	imbibing	specific	job-relevant	skills,	that	can	make	the	worker	more	readily	suitable	for	a
given	job	and	would	make	him	/	her	thus	more	productive.	Hence	both	are	important.	Vocational	education	courses	offered	in	schools	at	Grades	11
and	12	are	aimed	at	developing	skills	to	prepare	the	workforce	that	can	contribute	to	the	economy.	They	prepare	students	for	wage	employment	or
self	employment.CBSEis	offering	Skill	Competency	Based	Vocational	Courses	in	Schools	at	Senior	Secondary	Level	to	create	skilled	manpower	for
the	industry.	Overwhelmingly,	students	who	get	through	the	vocational	stream	want	to	proceed	to	further	education	to	improve	their	job	prospects.
The	 few	 rigorous	 evaluation	 of	 the	 impact	 of	 the	 programme,	 that	 have	 been	 undertaken,	 point	 to	 low	 levels	 of	 gainful	 employment	 of	 these
students.	For	making	the	existing	vocational	education	system	relevant	to	market	needs,	a	major	restructuring	of	the	system	and	how	it	is	managed
is	needed.	It	is	also	important	to	ensure	private	sector	participation	to	create	labour	market	for	the	trainees.	However,	it	is	also	important	to	provide
quality	education	and	training	to	students	at	both	pre-vocational	as	well	as	vocational	level	based	on	the	demands	of	the	industry	/	employers.	This
demands	excellent	competency	levels	of	their	trainers	–	the	vocational	stream	teachers.	In	the	year	2007-08,	SCERT	took	up	the	task	of	training
vocational	stream	teachers/	trainers	of	office	management	and	stenography	with	focus	on	imparting	the	knowledge	and	skills	required	to	meet	the
demands	of	the	fast	growing	industry,	public	sector	and	even	the	government,	which	is	competing	with	the	industry	to	recruit	the	best	talent.

There	 is	a	need	to	develop	appropriate	and	relevant	skills	 in	the	students	to	enable	them	to	use	state	of	 the	art	 technology	and	compete
globally	as	workforce.	This	will	equip	them	to	contribute	to	the	economic	development	of	the	country.	Skill	development	should	be	aligned	to	the
needs	 of	 the	 industry.	 There	 is	 a	 need	 to	 continually	 upgrade	 the	 skills	 of	 the	workforce	 to	 enable	 them	 to	 keep	 pace	with	 rapid	 technological
advancements.	 There	 is	 a	 need	 for	 the	 industry	 to	 partner	 educational	 institutions	 in	 designing	 competency	 based,	 industry	 relevant	 curricula,
organizing	on	the	job	training	for	students	so	that	they	can	get	practical	experience	in	the	actual	environment.

To	meet	the	demands	of	the	industry,	the	Information	Technology	vocational	stream
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curriculum	has	been	revised	by	Central	Board	of	 secondary	Education	 from	 the	academic	session	2013-14.	The	course	intends	 to	 develop	 skills
related	to	web	applications	and	advanced	web	designing.	Knowledge	of	network	safety	and	security,	digital	designing,	multimedia	authoring,	web
content	creation,	 interactive	web	page	creating	and	troubleshooting	will	be	taught.	The	curriculum	is	designed	to	develop	 appropriate	 technical
knowledge	as	well	as	the	professional	skills	of	the	students,	so	that	they	are	equipped	to	take	gainful	employment	in	the	said	vocation.

This	manual	is	based	on	the	curriculum	of	vocational	course	:	Information	Technology(IT	Application)	[NSQF	IT	Level	4]	for	Class	XII	.	It
is	 developed	 to	 impart	 knowledge	 and	 skills	 in	 the	 areas	 of	 database	 concepts,	 operating	 web	 based	 applications,	 fundamentals
ofjavaprogramming,movieeditingtools,customizingandembedding	multimediacomponents	in	web	pages,	web	scripting	-	Java	script,	etc.	 in	the
vocational	course	on	Information	Technology.	While	it	is	primarily	aimed	at	vocational	teachers	teaching	this	subject	at	ClassXII , it	shall	also	benefit
students	of	this	stream	apart	from	other	teachers,	students,	educators	and	others	who	wish	to	upgrade	their	knowledge	and	skills	in	these	areas.
The	Manual	specifies	the	steps	for	each	activity.	 It	 is	 illustrative,	simple	and	easy	to	follow.	It	 is	wrifen	 in	a	self	 learning	format.	The	material	 is
followed	by	questions	and	activities.	Manual	on	Information	Technology	(IT	Application)	Vol-II	Class	–	XII	2015-2016	has	been	wrifen	by	a	team	of
experts	headed	by	Shri	Naresh	Kapoor.Weappreciate	and	acknowledge	 the	contribution	of	Shri	Naresh	Kapoor	and	 the	 team	of	 contributors	 for
bringing	out	this	manual.

The	untiring	efforts	of	 the	faculty	of	Work	Experience	&	Vocational	Education	(Area	:ICT)	Shri	Naresh	Kapoor,	 in	 the	preparation	of	 the
manual	and	that	of	the	officers	and	staff	of	Publication	Department	as	well	as	other	concerned	officers	and	staff	are	appreciated	and	acknowledged.
We	acknowledge	all	the	web	sites	and	the	material	which	were	consulted	and	used	for	their	high	academic	value	and	relevance.	This	material	 is
solely	for	educational	purposes	to	be	used	by	teachers	and	students	and	not	for	any	commercial	use.

This	manual	 shares	 with	 the	 teachers	 the	 knowledge	 and	 skills	 required	 to	 be	 imparted	 in	 the	 area	 of	 vocational	 course	 :	 Information
Technology[NSQFITLevel	 4]	 for	 ClassXII .This	 manual	 covers	 the	 syllabus	 laid	 down	 by	 Central	 Board	 of	 Secondary	 Education.	 Latest
developments	in	the	area	ofITand	material	on	further	education	/	career	opportunities	available	after	studying	this	subject	and	developing	the	skills
as	well	as	the	scope	of	the	subject	industry	have	also	been	incorporated.

It	 is	 hoped	 that	 the	 manual	 helps	 bring	 about	 qualitative	 improvements	 in	 transaction	 in	 the	 area	 of	 vocational	 course	 :	 Information
Technology	and	meets	the	needs	of	the	teachers.

Director,	SCERT
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For	Teachers…………
Nowadays	 the	 termICTs(Informationand	 Communication	 Technologies)	 is	 used	 in	 place	 of	 computer	 becauseICThas	 a	 wider	 scope	 and

application	 than	 just	 computer.	 ICTsstand	 for	 information	 and	 communication	 technologies	 and	 are	 defined	 as	 a	 “diverse	 set	 of
technological	tools	and	resources	used	to	communicate,	and	to	create,	disseminate,	store,	and	manage	information.”The	“information
and	 communication	 technologies”(ICTs)includes	 technologies	 such	 as	 radio,	 television,	 video,	DVD,	 telephone	 (both	 fixed	 line	 and
mobile	 phones),	 satellite	 systems,	 and	 computer	 and	 network	 hardware	 and	 sohware,	 aswellastheequipmentandservices
associatedwith	 thesetechnologies,suchasvideoconferencing,	 e-mail	 and	blogs.	 ICT	 has	 enormous	 potential	 to	 make	 teaching	 learning
more	 interesting,	 interactive,	 illustrative,	 and	 participatory.ICTfacilitates	 development	 of	 user	 friendly	 learning	 material	 accessible	 to	 all
irrespective	 of	 age,	 grade,	 geographical	 distance,	 cultural	 diversity,	etc.	 It	 can	 be	 used	 to	 give	 such	 experiences	 to	 learners	 that	will	 help	 him
learn.ICTcan	be	used	to	develop	higher	order	thinking	skills.	It	can	be	used	to	provide	an	opportunity	to	learners	to	construct	their	knowledge.	ICT
can	be	used	to	connect	to,	share,	interact	with	a	large	number	of	people	simultaneously.	ICT	opens	a	window	to	the	universe.	The	profile	of	learners
can	 be	 developed	 and	 their	 needs	 can	 be	 assessed	 using	 ICT.This	 will	 help	 the	 teacher	 to	 identify	 appropriate	 pedagogy	 and	 plan	 his
teaching.ICTprovides	tools	to	the	teachers	to	write,	edit,	format,	make	a	table,	plot	data	on	a	graph,	prepare	presentation,	prepare	database,	make
and	edit	audios,	videos,	draw	and	edit	a	picture,	perform	computations	on	data	and	store	the	result	for	future	reference	or	use,	etc.ICTprovides
access	to	 immense	storehouse	of	knowledge	which	is	constantly	being	updated	and	is	ever	expanding.	The	information	and	material	provided	by
people	,	issues	raised	by	them,	their	views	and	suggestions,	etc.	relating	to	a	theme	can	collected	and	collated	timely	and	used	to	enhance	learning
material	using	ICT.	ICT	has	immense	potential	which	needs	to	be	exploited	by	the	teacher.

It	is	said	that	schools	must	promote	“learning	to	learn,”	:	i.e.,	the	acquisition	of	knowledge	andskills	that	make	possible	continuous	learning
over	the	lifetime.	“The	illiterate	of	the	21st	century,”	according	to	futurist	Alvin	Toffler,”	will	not	be	those	who	cannot	read	and	write,	but	those	who
cannot	learn,	unlearn,	and	relearn.”

ICT	can	be	very	effectively	used	to	facilitate	the	acquisition	of	knowledge	and	skills	that	7



enable	continuous	 learning	The	 teacher	can	use	LCD	Projector,	 interactive	whiteboards	as	presentation	 tools	 in	 the	classroom	to	organise	class
room	discussions	and	individual/small	group	work	.	This	will	reinforce	knowledge,	enhance	understanding	of	abstract	concepts.

Teacherscan	share	digital	 resources	and	educational	 tools	with	 students	 to	 support	 learning.	Using	simulation	 the	abstract	 concepts	and
processes	 can	 be	 concretised	 and	 explained	 to	 the	 students.Teacherscan	 make	 up	 to	 date	 knowledge	 accessible	 to	 students.Teachers	 design
activities	for	students	using	ICT	that	will	challenge	their	understanding	and	thinking.

The	development	ofICT/	computer	technology	skills	has	an	enabling	role	in	the	teaching	and	learning	process.	In	order	to	be	able	to	tap	the
potential	of	computer	and	utilise	it	effectively	in	education,	the	teachers	must	have	adequateICTskills	and	must	know	to	useICTsto	perform	various
tasks	efficiently.	Hence	continued	professional	development	and	capacity	building	of	teachers	in	ICTs	assumes	great	importance.

To	facilitate	the	use	ofICTby	teachers,	it	is	imperative	that	the	teachers	be	continually	trained	in	ICT	to	enrich	and	update	their	ICT	skills.
Software	are	being	updated	and	newer	tools	are	being	evolved	which	further	necessitate	continuous	professional	development	of	teachers	in	ICT.
Training	 must	 be	 contextualised	 to	 the	 National	 Curriculum	 Framework	 forTeacherEducation(NCFTE,2009),	 National	 Curriculum
Framework(NCF2005),	subject	curriculum,	training	needs	of	the	teachers	and	the	environment.

It	 is	 very	 important	 here	 to	 mention	 National	 Curriculum	 Framework	 forTeacherEducation.	 ‘This	 National	 Curriculum	 Framework
forTeacherEducation	 elaborates	 the	 context,concerns	 and	 vision	 underscoring	 that	 teacher	 education	 and	 school	 education	 have	 a	 symbiotic
relationship	and	developments	in	both	these	sectors	mutually	reinforce	the	concerns	necessary	for	qualitative	improvements	of	the	entire	spectrum
of	education	 including	teacher	education	as	well.	 The	 new	 concerns	 of	 school	 curriculum	 and	 the	 expected	 transactional	modalities	 have	 been
emphasized	 in	designing	 this	Framework	 for	all	 stages	of	school	education.	 Issues	related	 to	 inclusive	education,	perspectives	 for	equitable	and
sustainable	development,	gender	perspectives,	 role	of	community	knowledge	 in	education	andICTin	schoolingas	well	 as	elearning	become	 the
centre-stage	in	theFramework…..ICT	can	be	imaginatively	drawn	upon	for	professional	development	and	academicsupport	of	the	pre-service	and	 in-
service	teachers’	(NCFTE,	2009)	NCFTE	further	highlights	the	use	of	ICT	including	TV,	radio,	telephony	and	internet	as	adistance	media	providing
access	to	ideas	or	for	the	wider	dissemination	of	information.
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The	National	Focus	Group	on	Educational	 Technology	 has	 suggested	 ‘Recognise	 the	 potential	 ofICT	 and	 the	 Internet,	 promote	 universal
access,	 facilitate	 participatory	 forums,	 and	 developcommunitiesandinterest	 groups’…‘Worktowards	 transformingallschools	 intoICT-rich
environments’….	‘Create	opportunities	for	administrators	and	educational	 leaders	 in	the	school	system	to	become	ET	savvy	and	to	be	able	to	use
ICTs	competently’	…’	Encourage	ICT	literacy	for	official	and	personal	use	to	build	comfort	and	 later	creativity	 in	educational	work’….	(The	Position
Paper	National	Focus	Group	on	Educational	Technology,	NCERT,	2006)	National	 Skills	 Qualification	 Framework	 (NSQF)	 has	 been	 brought	 out	 by
Govt.	 of	 India.	 Itorganizes	qualifications	according	 to	 a	 series	 of	 levels	 of	 knowledge,	 skills	 and	 aptitude.	 These	 levels	 are	 defined	 in	 terms	 of
learning	outcomes	which	the	learner	must	possess	regardless	of	whether	they	were	acquired	through	formal,	non-formal	or	 informal	 learning.	In
that	sense,	the	NSQF	is	a	quality	assurance	framework.	It	 is,	therefore,	a	nationally	 integrated	education	and	competency	based	skill	 framework
that	will	provide	for	multiple	pathways,	horizontal	as	well	as	vertical,	both	within	vocational	education	and	vocational	training	and	among	vocational
education,	vocational	training,	general	education	and	technical	education,	thus	linking	one	level	of	learning	to	another	higher	 level.	This	will	enable
a	person	to	acquire	desired	competency	levels,	transit	to	the	job	market	and,	at	an	opportune	time,	return	for	acquiring	additional	skills	to	further
upgrade	their	competencies.	The	teachers	may	browse	the	web	for	details	on	NSQF.

This	 manual	 is	 based	 on	 the	 curriculum	 of	 vocational	 stream	 :	 ‘Information	 Technology’(IT	 Application)	 for
ClassXII[NSQFITLevel	4].The	purpose	of	this	manual	is	to	provideInformationTechnology	skills	to	empower	the	teacher	and	the	student	to	use
them	 for	 education	 and	 for	 life.	 The	 scope	 of	 this	 manual	 is	 database	 concepts,	 operating	 web	 based	 applications,	 fundamentals	 of	 java
programming,	movie	editing	tools,	customizing	and	embedding	multimedia	components	in	web	pages,	web	scripting	-	Java	script,	etc.	The	aim	of
this	manual	 is	 to	equip	 the	 teachers	with	up	 to	date	knowledge	and	skills	 in	 the	area	of	 Information	Technology	so	 that	 they	can	 transact	 them
effectively	 using	 appropriate	 pedagogy.	 The	 objective	 of	 this	 manual	 is	 also	 to	 adequately	 prepare	 the	 students	 for	 self	 employment	 or	 wage
employment	in	the	area	of	Information	Technology.The	NationalCurriculum	Framework	forTeacherEducation	 (NCFTE,	2009),	National	Curriculum
Framework	 (NCF	 2005),	 National	 Policy	 on	 Information	 and	 CommunicationTechnology(ICT)	 in	 School	 Education,	 2010	 (Revised	 Draß	 24-02-
2011.)have	also	been	referred	and	kept	in	mind	while	preparing	this	manual.	Besides	fulfilling	the	above	objectives	it	is	also	hoped	that	the	manual
shall	enable	the	teachers	and	other	learners	to	use	computers	effectively	for	teaching	learning,	administrative	work	and	other	day	to	day	activities.
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This	 manual	 not	 only	 explains	 the	 various	 theoretical	 concepts	 but	 also	 elaborates	 the	 procedure	 for	 carrying	 out	 tasks	 using	 various
software	on	computer	visually.	The	manual	may	be	used	to	apprise	the	learners	with	the	interface,	the	features,	tools,	applications,	etc.	The	manual
may	be	used	to	develop	the	skills	to	enable	the	learner	to	perform	tasks	and	carry	out	jobs	in	real	world.	The	manual	includes	a	number	of	activities.
The	learner	may	execute	 the	 various	 commands	and	 try	 to	use	 the	 various	 features	 and	 tools	 covered	 in	 the	manual.	The	 learner	may	 carryout
various	activities	given	in	the	manual.	The	manual	also	includes	questions	to	assess	the	content	knowledge	and	skills	of	the	learner.	The	manual	is
wrifen	not	only	for	vocational	teachers	but	also	other	teachers,	educational	administrators,	other	staff,	students	and	other	people	who	wish	to	learn
computer,	 update	 their	 knowledge	 and	 skills	 and	 use	 it	 to	 carry	 out	 various	 tasks	 that	 will	 facilitate	 their	 work.	 They	 may	 upgrade	 their
ITknowledgeandskillsintheareas	coveredbysurfingthewebandreferring	othersupplementary	material.

NARESH	KAPOOR	COORDINATOR	SENIOR	LECTURER
SCERT9810724310

nareshkapoor2004@yahoo.com,	nareshkapoor456@gmail.com
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Curriculum:
Information	Technology

–VocationalStream	(Central	Board	of	Secondary
Education)
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IT	Application	(XIth	&	XIIth	New)
Introduction	to	Computer	Applications

I.	 Preamble
Computer	 is	 now	 affecting	 energy	 sphere	 of	 human	 activity.	 It	 is	 instrumental	 in	 bringing	 revolutionary	 changes	 in	 industry,	 scientific

research	and	education.	This	is	not	only	the	demand	of	time	but	also	the	demand	of	almost	each	and	every	subject	to	have	an	associated	computer
learning	to	equip	a	student	with	start-of-art	technology	to	prove	himself/herself	a	befer	candidate	than	those	without	computer	knowledge.

Since	the	CBSE	has	been	foremost	in	giving	best	to	its	clientele,	a	single	paper	as	per	requirement	of	industry	has	been	designed	in	such	a
way	that	it	can	be	taken	as	an	independent	subject	along	with	any	combination	of	vocational	packages.

This	paper	has	been	designed	keeping	in	view	the	need	and	demand	of	computer	industry.
II.	 Objectives

The	course	is	designed	to	fulfill	the	following	objectives:—
(i) Familiarisation	with	computer-dominated	technological	world.
(ii) To	impart	adequate	know	how	to	the	students	to	be	able	to	take	up	entry	level	jobs	in	the	area	of	Data	Processing.
(iii) Exposure	of	utility	and	applications	of	computers.
(iv) To	get	acquaintance	with	the	basics	of	Computer	Science	and	lay	foundation	for	higher	education/careers	in	computers	in	conformance
with	industry	requirements.

(v) Application	of	computers	in	the	specific	areas	such	as	accounting	&	auditing,	stores	accounting,	office	management	&	secretarial	practice,
textile	designing	etc.

(vi) Algorithmic	approach	to	problem	solving.
(vii)To	use	computer	effectively	and	efficiently	by	acquiring	working	knowledge	of	PC	softwares.
(viii)Familiarisation	with	Data	Processing	environment	and	Data	Processing	terminology.

III.	 Career	Opportunities
1.	 Field	Service	Technician
2.	 IT	Support	Specialist

13



3.	 Executive	(Web	Development)
4.	 Data	Processing	Assistant/Documentation	Assistant
5.	 Programming	Assistant

The	rapid	changes	in	the	area	of	Information	Technology	have	significantly	affected	the	fields	of	business,	finance,	trade,	governance	and
communications	 which	 have	 not	 only	 resulted	 in	 global	 competitiveness	 invarious	 fields	 but	 simultaneously	 have	 pushed	 the	 global	 technical
advancements.	The	feasibility	of	easy	access	to	information,	data	processing	and	modes	ofcommunication	has	made	visible	changes	in	the	modes	of
administration	at	 all	 levels.	Due	 to	 the	 increasing	demands	 for	 a	deeper	understanding	of	 information	 technology,	 computer	 aided	 learning	has
necessitated	curricular	reforms	incorporating	basic	competency	and	skills	in	the	fieldsof	information	technology.

The	course	 intends	to	develop	skills	related	to	web	applications	and	advanced	web	designing.	Knowledge	of	network	safety	and	security,
digital	designing,	multimedia	anchoring,	web	content	creation,	interactive	web	page	creating	and	troubleshooting	will	be	imparted.	The	curriculum
is	designed	to	develop	appropriate	technical	knowledge	as	well	as	the	professional	skills	of	the	students,	so	that	they	are	equipped	to	take	gainful
employment	in	the	said	vocation.
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INFORMATION	TECHNOLOGY	(CLASS-XI)
[NSQF	IT	LEVEL	3]	NSQFIT	LEVEL	3	(CLASS-XI)	IT	TOOLS	(795)

(Paper-I)	Total	Marks:	100	(Knowledge	-	50:	Practical	-
50)

Unit
Code

Unit	Title Total
Hours

ITDC-
301

Computer	Organization	&	OS:	User	perspective
Understanding	of	Hardware
Basics	of	Operating	System

15

ITDC-
302

Networking	and	internet
Network	Safety	concerns
Network	Security	tools	and	services
Cyber	Security
Safe	practices	on	Social	networking

10

ITDC-
303

Office	automation	tools:
Spreadsheet
Word	processing
Presentation

40

ITDC-
304

Multi	Media	Design:	(Open	Source	Design	Tools)
Interface	and	Drawing	Tools	in	GIMP
Applying	Filters
Creating	and	handling	multiple	layers
Using	Stamping	and	Smudging	tools
Importing	pictures

35

ITDC-
305

Troubleshooting:	Hardware,	Sohware	and
Networking

Commonly	encountered	problems
(Monitor:	No	display,	KB/Mouse	not
responding,	monitor	giving	beeps,
printer	not	responding,	check	for	virus,
Delete	temporary	files	if	system	is	slow,
adjust	mouse	speed)

10

ITDC-
306

Work	Integrated	Learning	IT	-	ISM
Identification	of	Work	Areas
Work	Experience

14

124
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NSQF	IT	LEVEL	3	(CLASS-XI):	WEB	APPLICATIONS-I	(796)
(Paper-II)	Total	Marks:	100

(Knowledge—50:	Practical—50)

Unit
Code

Unit	Title Total
Hours

ITDC-
310

Multimedia	Authoring-Animation	Tools
Animation	Concepts
Frames	and	Layers
Motion	and	Shape,	Tweening
ImportingAV	Files
Publishing

30

ITDC-
311

Digital	Content	Creation-Adding	Styles	to	Web
Pages	(CSS)

Review	of	HTML
Adding	Style	Sheets
External	style	sheets
CSS	Properties	-	border,	box,	font,
margin,	padding	CSS	classes

30

ITDC-
312

Web	Scripting-JavaScript
Creating	interactiveWebPages	with	scripts
Variablesand	Operators
Decision	making	using	if	and	switch
Iterations	-	loops
Window	Object
Location	Object
History	Object
Popup	Boxes	-	alert,	confirm

50

ITDC-
313

Work	Integrated	Learning	IT	-	WA-I
Identification	of	Work	Areas
Work	Experience

14

124
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NSQFIT	LEVEL	4	(CLASS-XII):
DATA	MANAGEMENT	APPLICATIONS	(CODE:	795)

Paper-I	Total	Marks:-100	(Knowledge—50:	Practical—
50)

Unit
Code

Unit	Title Total
Hours

ITDC-
401

Database	Concepts	-	RDBMS	Tool
Basics	of	RDBMS
SQL	-	Creating	and	Opening	Database
Creating	and	populating	tables
Modifying	the	content	and	structure	of	table
Ordering	and	Grouping
Operating	with	multiple	tables

50

ITDC-
402

Operating	Web	Based	Applications
Online	Reservation	Systems
E-Governance
Online	Shopping	and	Bill	payments
Online	Tutorials	and	Tests
Project	Management	-WebBased	Application
development
Project	essentials	and	tips
Case	Study	-	Online	Game
Case	Study	-	Online	Quiz
Case	Study	-	Online	Bill	Calculator

30

ITDC-
403

Fundamentals	of	Java	programming,	Introduction	to
Java,	Object	Oriented	Programming,	Java	Language
Elements,	Operators,	Control	Flow,	Array,	Class	Design,
Exception	Handling,	Assertions,	Threads,	Wrapper			
Classes,	String	Manipulation

30

ITDC-
404

Work	Integrated	Learning	IT	-	DMA
Identification	of	Work	Areas
Work	Experience

14

124
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NSQFIT	LEVEL	4	(CLASS-XII):	WEB	APPLICATIONS	II	(CODE:	796)
Paper-II	Total	Marks:-100(Knowledge-50:	Practical-50)

Unit
Code

Unit	Title Total
Hours

ITDC-
410

Movie	Editing	Tools
Familiarization	of	interface	components
Importing	pictures
ImportingAudioand	Video	Files
Splifing	and	Joining	Movie	Clips
Adding	Titles	and	publishing

40

ITDC-
411

Customizing	and	Embedding	Multimedia
components	in	Web	Pages

Compatible	Multimedia	file	formats	forWeb
Pages
EmbeddingAudio	file
Embedding	Video	file
Embedding	Flash	file

40

ITDC-
412

Web	Scripting	-	Java	Script
Java	Script	review
Functions	-	user	defined
String	Object
Math	Object
Array	Object
Events
Case	Studies

30

ITDC-
413

Work	Integrated	Learning	IT	-	WA-II
Identification	of	Work	Areas
Work	Experience

14

124
Note:	Practical	will	be	based	on	a	foresaid	theory	paper.
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PRACTICAL	ASSESSMENT

NSQFIT	LEVEL	3	(CLASS-XI):	IT	TOOLS	(CODE:	795)

Paper-I	-	Practical—50)

Details Marks
Distribution

Programs/	Practical	Questions
-Spreadsheets,	Word,
Presentation	(	15	Marks)

-Multimedia
Design	(10
Marks)

-Troubleshooting
(	5	Marks)

	
30	Marks

Project/	Practical	File 10	Marks

Viva	Voce 10	Marks

Total 50	Marks

NSQFIT	LEVEL	3	(CLASS-XI):	WEB	APPLICATIONS	(CODE:	796)

Paper-II	(	Practical-50)

Details Marks
Distribution

Programs/	Practical	Questions
-Animation	Tools	(
15	Marks)

-HTML	(10
Marks)

-WebScripting	-	Java
Script	(	5	Marks)

	
30	Marks

Project/	Practical	File 10	Marks

Viva	Voce 10	Marks

Total 50	Marks
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NSQFIT	LEVEL	4	(CLASS-XII):
DATA	MANAGEMENT	APPLICATIONS	(CODE:	795)

Paper-I	-	Practical—50)

Details Marks
Distribution

Programs/	Practical	Questions
-SQL	Queries	(
15	Marks)

-JAVAPrograms
(10	Marks)

-OperatingWebBased
Applications	(	5	Marks)

	
30	Marks

Project/	Practical	File 10	Marks

Viva	Voce 10	Marks

Total 50	Marks
NSQFIT	LEVEL	4	(CLASS-XII):	WEB	APPLICATIONS	II	(CODE:	796)

Paper-II	(	Practical-50)

Details Marks
Distribution

Programs/	Practical	Questions
-Movie
Editing
Tools	(	15
Marks)

-Customizing	and	Embedding
Multimedia	components
inWebPages	(10	Marks)

-WebScripting
-	Java	Script	(
5	Marks)

	
30	Marks

Project/	Practical	File 10	Marks

Viva	Voce 10	Marks

Total 50	Marks
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SUGGESTED	LIST	OF	BOOKS
1.	 Information	Technology	(IT)	Student	Handbook	for	level	I,	Published	by	CBSE
2.	 Database	Systems:	Design,	Implementation	And	Management	by	Peter	Rob,	Carlos	Coronel
3.	 Introduction	to	Information	Technology	by	EfraimTurban(Author),	R.	Kelly	Rainer	(Author),	Richard	E.	Pofer(Author)
4.	 Introduction	to	Information	Technology	by	ITL	Education	Solutions	Limited
5.	 JavaScript,	A	Beginner’s	Guide	by	McGraw-Hill	Osborne	Media,	2009
6.	 HTML	and	CSS:	Design	and	Build	Websites	by	Wiley	(ISBN-10:	1118008189,	ISBN-13:	978-1118008188),	2011
7.	 The	Book	of	GIMP:	A	Complete	Guide	to	Nearly	Everything	by	No	Starch	Press	(ISBN-10:	1593273835,	ISBN-13:	978-1593273835),
2013

8.	 GIMP	for	absolute	beginners	by	Apress	Publishers	(ISBN-10:	1430231688,	ISBN-13:	978-1430231684),	2013
9.	 Microsoft	Windows	Movie	Maker	For	Dummies	by	Keith	Underdahl
10.	 Gefing	StartED	with	Windows	Live	Movie	Maker	by	James	Floyd	Kelly
11.	 Microsoft	Windows	Movie	Maker	2	by	Jan	Ozer
12.	 Microsoft	Windows	Movie	Maker	Handbook	(Book	&	CD-ROM)	by	Bill	Birney
13.	 Filmmaking	For	Dummies	by	Bryan	Michael	Stoller

COURSE	COMMITTEE	MEMBERS
1.	 Dr.	Biswajit	Saha,	Associate	Professor	and	Programme	Officer,	(Voc.	Education),	CBSE.
2.	 Ms.SwatiGupta,	Assistant	ProfessorandAssistant	Programme	Officer,(Voc.Education),	CBSE.
3.	 Dr.	Om	Vikas,	Senior	Director,	DOE	Electronic	Niketan.
4.	 Professor	Ranjit	Biswas,	Head	of	the	Departments,	Jamia	Hamdard	University
5.	 Dr.	P.	Venkata	Suresh,	Associate	Professor,	IGNOU
6.	 Dr.	Sudhansh	Sharma,	Assistant	Professor,	IGNOU
7.	 Dr.	Naveen	Kumar,	Associate	Professor,	Delhi	University
8.	 Mr.	Manoj	Kumar,	Head	of	the	Departments,	Ambedkar	institute	of	Technology
9.	 Mr.	Yogesh	Kumar,	IT	Department	Head,	Mira	Model	School
10.	 Mr.	G.	Natesh	Sharma,	Business	Development,	Aptech	Ltd.
11.	 Mr.	Chandrakant	S	Harne,	Technical	Head,	HCL	infosystems	Ltd.
12.	 Mr.	Sabornib	Bahfacharya,	Manager,	Aptech	Ltd.

Note:	Practical	will	be	based	on	a	foresaid	theory	paper.
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CBSE/PO/2013
	

To
The	Heads	of	InstitutionsAffiliated	to	CBSE

17th	January,	2013	Circular	No.	Acad-07/2013



Sub:	Implementation	of	Skill	Competency	Based	Vocational	Courses	in	Schools	at	Senior	Secondary	Level	for	Academic	Session	2013-
14

Dear	Principal
As	you	might	be	aware	 that	 the	Board	 is	offering	40	Vocational	Courses	 in	different	 sectors	at	Senior	Secondary	Level	and	4	vocational

courses	at	secondary	level;	many	of	these	courses	are	offered	in	collaboration	with	the	professional	organisations	to	create	skilled	manpower	for	the
industry,	 in	 order	 to	 upgrade	 the	 skills	 and	 proficiency	 of	 the	 younger	 generation	 and	 also	 to	 provide	 knowledge	 and	 awareness	 about	 various
career	options.	A	student	can	choose	to	avail	competency	based	skill	 learning	along	with	general	education	 in	order	to	enhance	the	skills	 in	the
chosen	 field.	 Also,	 these	 courses	 allow	 them	 to	 explore	 new	 avenues/	 options	 available	 along	 with	 imparting	 the	 skills	 required	 to	 pursue	 a
particular	course.

The	vocational	 education	envisions	 imparting	 the	procedural	 knowledge	and	 skills	 to	 the	 students	 that	will	 enable	 students	 to	excel	 and
emerge	successful	in	real	life	situation	of	both	work	and	life.	It	works	towards	imparting	an	education	that	is	holistic,	meaningful	and	skill	oriented
which	instils	among	the	youth	a	sense	of	usefulness	and	responsibility.	Board	aims	to	prepare	our	future	generation	to	become	global	citizens	and	to
make	India	a	global	leader.	India	has	only	5	per	cent	skilled	workers	in	its	total	workforce.	It	is	projected	that	the	labour	force	will	grow	by	close	to
2	percent	or	some	7	million	or	more	a	year	over	the	next	few	years.	The	clear	objective	with	this	initiative	is	to	teach	real	life	applications	at	an
early	stage	so	that	the	required	talent	can	be	developed	for	a	befer	future.	This	will	go	a	long	way	in	building	22



up	the	skilled	personnel	that	is	required	for	India.	Keeping	this	in	view,	the	curriculum	designed	for	classes	XI	and	XII
•Is	Industry
oriented

•Focuses	from	academics	to
employability

•Will	provide	excellent	opportunities	for	higher	education	in	the	specific
area	through	degree	and	diploma	course

•Will	provide	employment
potential	in	all	sectors

The	Board	is	pufing	continual	efforts	for	improvising	the	existing	courses	and	devising	new	courses	that	are	relevant	to	the	current	economy.
To	achieve	the	purpose	of	quality	education	the	Board	has	collaborated	with	various	organizations	like	ROLTA	India	Ltd,	NIFT,	WWI,	CII,	NHMIT,
Med	varsity	Online	Education,	Intel	etc.

Also,	BoardhaspartneredwithCentral	InstituteofTechnology,Australiaforintroducing	new	vocational	courses	of	CIT	in	the	affiliated	schools.
It	is	also	to	mention	here	that	teachers	will	be	trained	on	by	CBSE	and	its	industry	partners,	throughout	the	year	to	enhance	the	training	skills	of
the	teachers	to	ensure	effective	curriculum	transaction.

Therefore,	you	are	requested	kindly	to	choose	and	offer	one	or	more	of	these	competency	based	courses	(list	enclosed)	in	your	esteem	school
on	priority	basis	from	the	academic	session	2013-14.	Filled	in	proforma	along	with	requisite	fee	in	favour	of	secretary,	CBSE,	Delhi	may	be	sent	to
the	office	of	the	undersigned	within	March	15,	2013,	With	Regards

Yours	Sincerely
	

Dr.	Biswajit	SahaAssociate	Professor
&Programme	Officer	(Vocational)

Enclosures:
a.	 List	ofVocational	Courses
b.	 Teacher’s	Qualification
c.	 Scheme	of	Studies
d.	 Proforma	for	Affiliation
e.	 Affiliation	fee	details
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Scheme	of	StudiesVocational	Courses	CBSE
Circular	Jan	13

	

S.
No.

Name	of	the	subject Period/week Marks	Distribution Marks

Theory Practical
1. Language	I	(English	) 7 100

-
100

2. Two	Subjects	from	Academic	stream	(Science
Commerce	Humanities	)

7	+7 100
or	as	per	subject
concerned
70	30

100	each

3. Two	papers	from	any	of	34vocational	courses 8+8 60
50
30

40
50
70

100	each

4. One	Optional	Additionalsubject	from
academicstream(Science/Commerce/Humanities)
or	vocational	stream

7 100
or

70	:	30
Or

60	:	40

100

5. Work	integrated	learning On	the	job
exposure	for
60	hrs.	(level
1&2)=10
days	120	hrs.
(Level
3&	4)=	20	days
Min	6	hrs.	per
day

6. Personality	Development	and	Soft	Skills 2

7. Total 46 500+100(optional
additional)
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Chapter	One
ITDC-401

Database	Concepts	-	RDBMS	Tool
•Basics	of	RDBMS
•SQL-Creating	and	Opening	Database
•Creating	and	populating	tables
•Modifying	the	content	and	structure	of	table
•Ordering	and	Grouping
•Operating	with	multiple	tables

Outline	of	the	Chapter
•Introduction •Database	Management	System	(DBMS)
•Basic	Elements	of	Database •The	Advantages	of	a	DBMS
•The	Disadvantages	of	a	DBMS
•Types	of	DBMS

Hierarchical	Database	Management	System(HDBMS)
Network	Database	Management	System(NDBMS)
Relational	Database	Management	System(RDBMS)
Object-Oriented	Database	Management	System(OODBMS)

•Manipulation	And	Query	Languages•Structured	Query	Language	(SQL)
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INTRODUCTION

In	 the	present	 age,	 databases	play	 a	 critical	 role	 in	 almost	 all	 areas	where	 computers	 are	 used	 including	business,	 engineering,	medicine,	 law,
education,	library	science	etc.	For	example,	ifwe	go	to	the	bank	to	deposit	or	withdraw	money;	if	we	make	a	hotel	or	train	reservation;	if	weaccess	a
computerized	library	catalog,	chances	are	that	our	activities	will	involve	someone	accessing	a	database.

A	database	is	a	collection	of	related	data	i.e.	known	facts	that	can	be	recorded	and	have	implicit	meaning.	The	data	related	to	some	organization
may	be	under	consideration.	For	example,	a	school	has	recorded	the	students’	name,	address	and	phone	numbers	in	an	indexed	address	book	or
have	stored	it	on	CD/DVDusing	a	personal	computer	and	software	such	as	Microsoft	Access	or	DBASE.

It	can	also	be	defined	as	a	collection	of	 logically	related	data.	A	 telephone	directory	consisting	names,	addresses	and	telephone	numbers	 is	one
example.	A	database	may	be	computerized	as	well	as	manually	generated.	For	example,	the	database	for	library	card	catalog	may	be	manipulated
manually	as	well	as	it	may	be	computerized.	At	the	same	time,	a	database	may	consist	several	related	but	separate	databases.	For	example,	a	library
database	might	include	database	of	book	details,	database	of	books	on	order,	database	of	books	checked	out	etc.
Basics	of	RDBMS
DATABASE	MANAGEMENT	SYSTEM	(DBMS)
DBMS	 is	 a	 software	 system	 that	 facilitates	 the	 processes	 of	 defining,	 constructing	 and	 manipulating	 database.	 Defining	 a	 database	 involves
specifying	the	data	types,	structures,	and	constraints	for	the	data	to	be	stored	in	the	database.	Constructing	the	database	is	the	process	of	storing
the	 data	 on	 a	 storage	medium	 such	 as	 CD,	 DVD	 or	 computer	 Hard	 disk.	Manipulating	 a	 database	 includes	 functions	 such	 as	 retrieving	 data,
updating	database	and	generating	reports	etc.

Let	us	discuss	one	example,	a	SCHOOL	database	for	maintain	information	related	to	students,	courses,	teachers,	examinations	and	results	etc.

To	define	this	database,	one	will	specify	the	structure	of	the	records	of	each	file	by	specifying	the	different	types	of	data	elements	to	be	stored	in
each	record.
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BASIC	ELEMENTS	OF	DATABASE
A	computer	cannot	process	data	unless	it	is	organized	in	special	ways;	into	characters,	fields,	records,	files	and	databases.

Character
A	character	is	the	most	basic	element	of	data	that	can	be	observed	and	manipulated.	Behind	it	are	the	invisible	data	elementswecall	bits	and	bytes,
referring	 to	 physical	 storage	 elements	 used	 by	 the	 computer	 hardware.	 A	 character	 is	 a	 single	 symbol	 such	 as	 a	 digit,	 lefer	 of	 other	 special
character.

Field
A	field	contains	an	item	of	data	such	as	a	character,	or	group	of	characters	that	are	related.	For	instance,	a	grouping	of	related	text	characters	such
as	 “Mohd	 Rashid”	 makes	 up	 a	 name	 in	 the	 name	 field.	 Let’s	 look	 at	 another	 example.	 Suppose	 ‘The	 Times	 of	 India’	 action	 group	 advocating
education	in	New	Delhi	and	compiling	the	names	and	addresses	of	potential	volunteers	for	the	cause.	For	each	person,	they	must	identify	the	name,
address,	 city,	 state,	pin	code	and	 telephone	number.	A	 field	would	be	established	 for	each	 type	of	 information	 in	 the	 list.	The	name	 field	would
contain	all	of	the	lefers	of	the	first	and	last	name.	The	pin	code	field
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would	hold	all	of	the	digits	of	a	person’s	pin	code,	and	so	on.	In	summary,	a	field	may	contain	an	afribute	(e.g.,	employee	salary)	or	the	name	of	an
entity	(e.g.,	person,	place,	or	event).

It	is	the	smallest	unit	of	the	data	that	has	meaning	to	its	users	and	is	also	called	data	item	or	data	element.	Name,	Address	and	Telephone	number
are	examples	of	fields.	These	are	represented	in	the	database	by	a	value.

	
Field

Record
A	record	is	composed	of	a	group	of	related	fields.	As	another	way	of	saying	it,	a	record	contains	a	collection	of	afributes	related	to	an	entity	such	as
a	person	or	product.	Looking	at	the	list	of	potential	gun	control	supporters,	the	name,	address,	pin	code	and	telephone	number	of	a	single	individual
would	constitute	a	record.
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Record

Database	File
As	we	move	up	the	ladder,	a	database	file	is	defined	as	a	collection	of	related	records.	A	database	file	is	sometimes	called	a	table.	A	file	may	be
composed	of	a	complete	list	of	individuals	on	a	mailing	list,	including	their	addresses	and	telephone	numbers.	Files	are	frequently	categorized	by
the	 purpose	 or	 application	 for	 which	 they	 are	 intended.	 Some	 common	 examples	 include	mailing	 lists,	 quality	 control	 files,	 inventory	 files,	 or
document	files.	Files	may	also	be	classified	by	the	degree	of	permanence	they	have.	Transition	files	are	only	temporary,	while	master	files	are	much
more	long-lived.
THE	ADVANTAGES	OF	A	DBMS
The	main	advantages	of	using	a	Database	Management	System	are	such	as:
Information	Availability	Enhancement
The	meaning	of	Information	Availability	Enhancement	is	that	the	same	information	can	be	made	available	to	different	users.
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Redundancy	Decrement
The	data	redundancy,	that	is	the	repetition	of	data,	may	be	minimized	by	usingDBMS.Therefore	the	cost	of	storing	data	on	hard	drives	or	other
storage	devices	can	be	significantly	reduced.

Accuracy
Asweknow	 that	manual	 database	 requires	 changes	 in	 several	 different	 places	 to	 change	or	 update	 a	 record	while	 updates	 and	 changes	 to	 data
inDBMS,only	have	to	be	made	in	one	place.	Therefore,	the	chances	of	making	mistakes	are	lessor	in	DBMS	and	the	data	integrity	is	fostered.

Program	and	File	Consistency
File	formats	and	system	programs	are	standardized	in	DBMS.	The	maintenance	of	data	files	are	easier	because	of	same	rules	and	guidelines	across
all	types	of	data.	Even	in	the	case	of	multiple	programmers,	the	level	of	consistency	of	file	and	programs	are	maintained.

User-friendly
Access	and	manipulating	data	is	much	easier	for	the	users	with	a	DBMS	as	compared	to	manual	Database	management.

Security
DBMS	protects	and	makes	secured	the	data	through	the	use	of	passwords	and	restricts	the	data	access	to	only	those	who	should	access	it.	It	means
it	can	minimize	the	risks	for	the	organizations.
THE	DISADVANTAGES	OF	A	DBMS
There	are	basically	two	major	downsides	to	using	DBMSs
Cost:	Implementation	of	a	DBMS	may	be	expensive	and	time-consuming,	especially	in	large	organizations.	And	the	Training	of	the	DBMS	personal
can	be	quite	costly.

Security:	Though	aDBMSis	having	safeguards	of	password	and	controlled	access	to	users,	there	is	a	possibility	that	some	unauthorized	users	may
access	the	database.	Once	an	unauthorized	user	gets	into	the	database,	they	have	access	to	all	the	files	that	will	pose	a	threat	to	individual	privacy.
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TYPES	OF	DBMS
There	are	four	structural	types	of	database	management	systems:	hierarchical,	network,	relational,	and	object-oriented.
Hierarchical	Database	Management	System

Hierarchical	Databases	(DBMS),	is	one	of	the	oldest	methods	of	organizing	and	storing	data.	Some	organizations	are	still	using	it.	It
is	organised	like	the	branches	of	a	tree	shown	in	the	figure	above.	Related	fields	and	records	are	grouped	together	to	make	higher-
level	records	and	lower-level	records	just	like	the	parent	and	child	in	a	family	tree	respectively.	Here,	it	must	be	remembered	that	a
child	record	has	only	one	parent	record	to	which	it	is	linked	while	a	parent	record	may	have	more	than	one	child	record	linked	to	it.	If
one	searches	a	 record,	he/she	 starts	at	 the	 top	and	moves	down	 through	 the	 tree	 from	parent	 to	child	until	 the	appropriate	child
record	is	found.

The	advantage	of	hierarchical	databases	 is	 that	 they	can	be	accessed	and	updated	 rapidly	because	 the	 tree-like	 structure	and	 the
relationships	between	records	are	defined	in	advance.

This	type	of	database	structure	is	having	a	disadvantage	that	is,	each	child	in	the	tree	may	have	only	one	parent,	and	relationships	or
linkages	between	children	are	not	permifed.	Adding	a	new	field	or	record	in	Hierarchical	databases	requires	that	the	entire	database
must	be	redefined.
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Network	Database	Management	System

Similar	to	hierarchical	databases,	Network	databases	also	have	a	hierarchical	structure.	A	network	database	looks	more	like	a	cobweb
or	 interconnected	 network	 of	 records.	 In	 network	 databases,	 similar	 to	 hierarchical	 databases,	 children	 are	 called	members	 and
parents	are	called	owners.	But	the	important	difference	is	that	each	child	or	member	can	have	more	than	one	parent	(or	owner).

Since	more	 connections	 can	 be	made	 between	 different	 types	 of	 data,	 network	 databases	 are	 considered	more	 flexible.	 Similar	 to
hierarchical	databases,	network	databases	must	be	defined	in	advance.	There	is	also	a	limit	to	the	number	of	connections	that	can	be
made	between	records.
Relational	Database	Management	System	(RDBMS)
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In	 relational	 databases,the	 relationship	 between	 data	 files	 is	 relational,	 not	 hierarchical.	 Relational	 databases	 connect	 data	 in
different	files	by	using	common	data	elements	or	a	key	field.Tablesare	used	to	store	data	in	relational	databases.	EachTablehas	a	key
field	that	uniquely	identifies	each	row.	In	relational	databases,	tables	or	files	are	known	as	relations,	a	row	or	record	called	tuples,
and	columns	are	referred	to	as	afributes	or	fields.

A	key	field(s)	that	uniquely	identifies(s)	each	row	can	be	used	to	connect	one	table	of	data	to	another.	For	example,	a	table	‘customer’
might	have	a	row	consisting	of	a	customer	account	number	as	the	key	field	along	with	address	and	telephone	number.	The	customer
account	number	in	this	table	could	be	linked	to	another	table	of	data	that	also	includes	customer	account	number	(a	key	field),	but	in
this	case,	contains	information	about	product	returns,	including	an	item	number	(another	key	field).	This	key	field	can	be	linked	to
another	table	that	contains	item	numbers	and	other	product	information	such	as	production	location,	color,	quality	control	person,
and	other	data.

The	 advantages	 of	 the	 relational	 database	 are	 that	 it	 can	 be	 used	with	 lifle	 or	 no	 training	 and	 database	 entries	 can	 be	modified
without	redefining	the	entire	structure.	The	downside	of	using	a	relational	database	is	that	searching	for	data	can	take	more	time
than	if	other	methods	are	used.
Object-oriented	Databases	(OODBMS)
Object-oriented	 database	 is	 capable	 to	 handle	 many	 new	 data	 types,	 including	 graphics,	 photographs,	 audio,	 and	 video,	 while
Hierarchical	 and	network	databases	 are	all	 designed	 to	handle	 structured	data;	 that	 is,	 data	 that	 fits	nicely	 into	 fields,	 rows,	 and
columns.	An	object-oriented	database	can	also	be	used	to	store	data	from	a	variety	of	media	sources,	such	as	photographs	and	text,
and	produce	work,	as	output,	in	a	multimedia	format.

Object-oriented	databases	use	small,	reusable	chunks	of	software	called	objects	that	are	stored	in	the	object-oriented	database.	Each
object	consists	of	two	elements:	1)	a	piece	of	data	(e.g.,	sound,	video,	text,	or	graphics),	and	2)	the	instructions,	or	software	programs
called	methods,	 for	 what	 to	 do	 with	 the	 data.	 For	 example,	 test	 scores	 would	 be	 within	 the	 object	 as	 would	 the	 instructions	 for
calculating	average	test	score.

The	 object-oriented	 databases	 have	 the	 ability	 to	 mix	 and	 match	 reusable	 objects	 that	 further	 provides	 incredible	 multimedia
capability.	Healthcare	organizations,	for	example,	can	store,	track,	and	recall	CAT	scans,	X-rays,	electrocardiograms	and	many	other
forms	of	crucial	data.
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The	development	of	these	databases	is	more	costly.
MANIPULATION	AND	QUERY	LANGUAGES
The	data	can	be	manipulated	in	two	ways	by	using	database	software.	One	approach	is	that	a	special	language	called	a	query	language
is	used	 to	 interact	directly	with	 theDBMS.In	 the	second	approach,	a	user	 interacts	with	 the	application	program.	The	application
program	sends	instructions	to	the	DBMS,	which	then	carries	out	the	actions	specified	by	the	program.

Query	Language
To	perform	information-processing	tasks	using	data,	Query	language	allows	the	user	to	interact	directly	with	the	database	software.
This	 language	 relies	 on	 basic	 words	 such	 as	 SELECT,	 DELETE,	 or	MODIFY.	 To	 retrieve	 data	 from	 a	 database	 or	 update	 data	 in	 a
database,	the	user	enters	these	commands	that	instruct	the	DBMS.
SQL-Creating	and	Opening	Database	Structured	Query	Language
(SQL)
It	 is	 one	 of	 the	 widely	 used	 query	 language	 to	 perform	 operations	 using	 relational	 databases.
Originally,SQLwascalledSEQUEL(StructuredEnglishQUEryLanguage)	andwasdesigned	 and	 implemented	 atIBMin	 1974.SQLis	 now
the	standard	language	for	commercial	relational	DBMSs.	As	we	know	that	relational	databases	are	composed	of	tables	with	rows	and
columns,SQLcan	be	used	to	retrieve	information	from	related	tables	in	a	database	or	to	select	and	retrieve	information	from	specific
rows	and	columns	in	one	or	more	tables.

A	typical	SQL	query	contains	three	key	elements:SELECT	(the	column	names
to	be	displayed)	FROM	(indicates	the	table	name	from	which	column	names
will	be	derived)WHERE	(describes	the	condition	for	the	query)
An	Example	of	SQL
Assume		a		principal		of		an		institution		wishes		to		query		a		relational		database		containing	34



information	about	students.	If	he	wants	to	know	the	name	and	address	of	all	students	who	got	aggregate	marks	percentage	more	than
75,	the	following	query	might	be	used:	SELECT	Name,	AddressFROMStudent
WHERE	Aggmarks>	75
Once	this	command	has	been	executed,	the	computer	will	display	a	list	of	students	that	meets	the	predefined	criteria.	In	this	case,	all
of	the	data	are	extracted	from	a	single	table.	Similar	queries	can	be	made	to	extract	data	from	multiple	tables.	Such	a	strategy	might
be	used	to	analyze	customer	 information	 involving	billing	data	and	order	data,	using	two	separate	 tables.	 In	 this	case,	 the	FROM
command	would	list	the	names	of	the	two	tables	involved.

SQL	can	be	divided	into	two	parts:	The	Data	Manipulation	Language(DML)	and	The	Data	Definition	Language(DDL).

The	DDL	part	of	SQL	includes	the	creation	and	modification	of	database.	It	also	creates	table,	modifies	and	deletes	a	table.	The	most
important	DDL	statements	in	SQL	are:	CREATE	DATABASE	–	creates	a	new	database	ALTER	DATABASE	–	modifies	a	database
CREATE	TABLE	–	creates	a	new	table	ALTER	TABLE	–	modifies	a
table
DROP	TABLE	–	deletes	a	table
Creating	a	Database
In	SQL,	there	is	a	specific	command	CREATE	DATABASE	to	create	a	database.	The	syntax	of	the	command	is	as	follows:	CREATE
DATABASE	database_name
Example:	suppose	we	want	to	create	a	database	called	“school_database”.CREATEDATABASE
school_database
Creating	and	populatingTablesOpening	a	Database
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Creating	a	Table
The	CREATE	TABLE	 command	 is	 used	 to	 specify	 a	new	 table	 by	 giving	 it	 a	 name	and	 specifying	 its	 afributes.	 The	 afributes	 are
specified	first,	and	each	afribute	is	given	a	name,	a	data	type	to	specify	its	domain	of	values.

Syntax
CREATE	TABLE	table_name	(
column_name1	 data_type,	 column_name2	 data_type,
column_name3	data_type,
….
)
The	data	type	specifies	what	type	of	data	the	column	can	hold.	Example	1
Now	we	want	to	create	a	table	called	“Persons”	that	contains	five	columns:	P_Id,	LastName,	FirstName,	Address,	and	City.

We	use	the	following	CREATE	TABLE	statement:
CREATE	TABLE	Persons	(
P_Id	int,
LastName	varchar(255),	FirstName	varchar(255),
Address	varchar(255),	City	varchar(255)
)
The	P_Id	column	is	of	type	int	and	will	hold	a	number.	The	LastName,	FirstName,	Address,	and	City	columns	are	of	type	varchar	with	a
maximum	length	of	255	characters.

The	empty	“Persons”	table	will	now	look	like	this:
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P_Id LastName FirstName Address City

The	empty	table	can	be	filled	with	data	with	the	INSERT	INTO	statement.
The	CREATE	TABLE	command	may	also	specify	its	afributes	with	some	constraints.	The	afributes	are	specified	first,	and	each	afribute
is	given	a	name,	a	data	type	to	specify	its	domain	of	values	and	constraints.

Syntax:	CREATE	TABLE	table_name	(Afribute_name1	data_type	constraint_if_any
Afribute_name2	data_type	constraint_if_any,	…..
Afribute_namen	data_type	constraint_if_any)

	
Example:
CREATE	TABLE	EMPLOYEE
(	FNAME	VARCHAR(15)	NOT	NULL,	LNAME	VARCHAR(15)	NOT	NULL,
SSN	CHAR(9)	NOT	NULL,

BDATE	DATE	SEX	CHAR
SALARY	DECIMAL(10,2)
)
Modifying	the	content	and	structure	of	table	Altering	Table

The	 possible	 alter	 table	 actions	 include	 adding	 or	 dropping	 an	 afribute(column),	 changing	 a	 column	 definition,	 and	 adding	 or
dropping	 table	 constraints.	 For	 example,	 to	 add	 an	 afribute	 for	 keeping	 track	 of	 jobs	 of	 employees	 to	 theEMPLOYEEtable	 in
theSCHOOL	database,	following	command	will	be	used:	ALTER	TABLE	SCHOOL.EMPLOYEE	ADD	JOB	VARCHAR(10);
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DATA	MANIPULATION	LANGUAGE
SQL	provides	basic	Data	Manipulation	statements:	select,	update,	delete	and	insert.
Select	Statement
The	basic	form	of	the	SELECT	statement	is	formed	of	the	three	clauses	SELECT,	FROM,	and	WHERE.

Syntax:	The	SELECT-FROM-WHERE	statement	has	the	following	syntax:
SELECT	afribute	list	FROM	table	list
WHERE	condition;
Example:	The	table	EMPLOYEE	is	given	below

S_Id LastName FirstName Address City

1 Yadav Ramesh Kishan	garh New	Delhi

2 John Adam Bandra Mumbai

3 Kuller Daljeet Kriti	Nagar New	Delhi

4 Rizvi Akram Khan	Road Kolkata

5 Rizvi Akram Laban Shillong

Retrieve	the	address	and	city	of	the	employee(s)	whose	name	is	“Akram	Rizvi”,	the	SQL	command	is—
SELECT	ADDRESS,CITY	FROM	EMPLOYEE
WHERE	FNAME=”Akram”	AND	LNAME=”Rizvi”;
The	result-set	will	look	like	this:
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Address City

Khan	Road Kolkata

Laban Shillong

Here	the	result	may	have	duplicate	records,	if	exists.	To	eliminate	duplicate	records,	the	DISTINCT	option	is	used	with	SELECT
command.

SELECT	DISTINCT	ADDRESS,	CITY	FROM	EMPLOYEE
WHERE	FNAME=”Akram”	AND	LNAME=”Rizvi”;
The	result-set	will	look	like	this:

Address

Khan	Road

Laban

A	missingWHEREclause	indicates	no	conditions	on	records	(also	called	tuples)	selection.	Hence,	all	records	of	the	specified	table	in
the	FROM	clause	will	be	shown	in	the	result	of	the	query.

Example:	Retrieve	the	addresses	and	city	of	all	employees	in	the	EMPLOYEE	table
SELECT	ADDRESS,CITY	FROM	EMPLOYEE;

The	result-set	will	look	like	this:

Address City

Kishan	garh New	Delhi

Bandra Mumbai

Kriti	Nagar New	Delhi

Khan	Road Kolkata

Laban Shillong
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To	retrieve	all	the	afribute	values	of	the	selected	table,	we	do	not	have	the	list	of	afribute	names.	We	just	specify	an	asterisk(*),	which
stands	for	all	the	afributes.

Example:	Retrieve	all	the	afribute	values	of	the	table	EMPLOYEE.
SELECT	*
FROM	EMPLOYEE;
The	result-set	will	look	like	this:

S_Id LastName FirstName Address City

1 Yadav Ramesh Kishan	garh New	Delhi

2 John Adam Bandra Mumbai

3 Kuller Daljeet Kriti	Nagar New	Delhi

4 Rizvi Akram Khan	Road Kolkata

5 Rizvi Akram Laban Shillongi

The	INSERT	Command
In	its	simplest	form,	INSERT	is	used	to	add	a	single	tuple(record)	in	a	table.	We	must	specify	the	table	name	and	a	list	of	values	for
the	record	in	the	same	order	in	which	the	corresponding	afributes	were	specified	in	the	CREATE	TABLE	command.

Example:	To	add	a	new	tuple	to	the	EMPLOYEE	table	INSERT	INTO	EMPLOYEE
VALUES	(‘Mohd’,	‘Ali’,	‘000100240’,	‘1977-3-12’,	‘M’,	‘45000’);
If	a	table(relation)	has	many	afributes,	but	only	a	few	of	those	afributes	are	assigned	values	in	the	new	tuple,	a	second	form	of
INSERT	statement	is	used.

INSERT	INTO	EMPLOYEE	(FNAME,	LNAME,SALARY)
VALUES	(‘Shradha’,	‘Vasisht’,	‘50000’);	The	DELETE	Command
The	DELETE	command	removes	the	tuples	from	a	relation.	It	includes	a	WHERE	clause	to	select	the	tuples	to	be	deleted.	A	missing
WHERE	clause	specifies	that	all	tuples	in	the	table	40



are	to	be	deleted;	however	the	table	remains	in	the	database	as	an	empty	table.
DELETE	FROM	EMPLOYEE	WHERE	LNAME=”Ali”;

DELETE	FROM	EMPLOYEE;
The	UPDATE	Command
The	UPDATE	command	is	used	to	modify	afribute	values	of	one	or	more	selected	tuples.	TheWHERE	clause	selects	the	tuples	to	be
modified.

Example:	To	change	the	salary	of	an	employee	whose	first	name	is	‘Mohd’	as	‘70000’
UPDATE	EMPLOYEE	SET	SALARY=‘70000’	WHERE
FNAME=‘Ali’;
Ordering	and	Grouping
TheORDERBYkeyword	is	used	to	sort	the	result-set	by	a	specified	column.	TheORDERBY	keyword	sorts	 the	records	 in	ascending
order	by	default.	If	you	want	to	sort	the	records	in	a	descending	order,	you	can	use	the	DESC	keyword.

Syntax
SELECT	Column_name(s)	FROM	table_name
ORDER	BY	column_name(s)	ASC/DESC
Example
The	“Student”	table:

S_Id LastName FirstName Address City

1 Yadav Ramesh Kishan	garh New	Delhi

2 John Adam Bandra Mumbai

3 Kuller Daljeet Kriti	Nagar New	Delhi

4 Rizvi Akram Khan	Road Kolkata
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Now	we	want	to	select	all	the	persons	from	the	table	above,	however,	we	want	to	sort	the	persons	by	their	last	name.

We	use	the	following	SELECT	statement:
SELECT	*	FROM	Persons	ORDER	BY	LastName
The	result-set	will	look	like	this:

P_Id LastName FirstName Address City

2 John Adam Bandra Mumbai

3 Kuller Daljeet Kriti	Nagar New	Delhi

4 Rizvi Akram Khan	Road Kolkata

1 Yadav Ramesh Kishan	garh New	Delhi

Grouping
The	GROUP	BY	statement	is	used	in	conjunction	with	the	aggregate	functions	to	group	the	result-set	by	one	or	more	columns.

SQL	GROUP	BY	Syntax
SELECT	column_name,	aggregate_function(column_name)	FROM	table_name
WHERE	column_name	operator	value	GROUP	BY	column_name

SQL	GROUP	BY	Example
We	have	the	following	“ORDERS”	table	consisting	the	details	of	the	orders	given	by	the	teachers	to	purchase	books
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O_Id OrderDate OrderPrice Teacher

1 2008/11/12 1000 Hari

2 2008/10/23 1600 Neelam

3 2008/09/02 700 Hari

4 2008/09/03 300 Hari

5 2008/08/30 2000 Naved

6 2008/10/04 100 Neelam

Now	we	want	to	find	the	total	sum	(total	order)	of	each	teacher.
We	will	have	to	use	the	GROUP	BY	statement	to	group	the	customers.We	use	the	following	SQL
statement:	SELECT	Teacher,	SUM(OrderPrice)	FROM	ORDERS	GROUP	BY	Teacher
The	result-set	will	look	like	this:

Teacher SUM(OrderPrice)

Hari 2000

Neelam 1700

Naved 2000

Let’s	see	what	happens	if	we	omit	the	GROUP	BY	statement:
SELECTTeacher,SUM(OrderPrice)FROM	ORDERS
The	result-set	will	look	like	this:
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Customer SUM(OrderPrice)

Hari 5700

Neelam 5700

Hari 5700

Hari 5700



Naved 5700

Neelam 5700

The	result-set	above	is	not	what	we	wanted.
Explanation	 of	 why	 the	 aboveSELECTstatement	 cannot	 be	 used:	 TheSELECTstatement	 above	 has	 two	 columns
specified(TeacherandSUM(OrderPrice).The“SUM(OrderPrice)”returns	 a	 single	 value	 (that	 is	 the	 total	 sum	 of	 the	 “OrderPrice”
column),	while	“Teacher”	returns	6	values	(one	value	for	each	row	in	the	“Orders”	table).	This	will	therefore	not	give	us	the	correct
result.	However,	you	have	seen	that	theGROUPBYstatement	solves	this	problem.
Operating	with	MultipleTablesSELECT	Statement
The	SELECT	command	can	also	be	used	to	get	data	from	more	than	one	table.
We	have	tables	namely	“EMPLOYEE”	and	“ORDERS”	consist	the	details	of	the	teachers	and	orders	given	by	the	teachers	to	purchase
books.

EMPLOYEE	TABLE

E_Id LastName City

E1 Yadav New	Delhi

E2 John Mumbai

E3 Kuller New	Delhi
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ORDERS	TABLE

O_Id OrderDate OE_Id

O1 2008/09/13 E1

O2 2008/08/30 E3

O3 2008/10/04 E1
SELECT	*	FROM	EMPLOYEE,	ORDERS;
The	result-set	will	look	like	this:

E_Id LastName City O_Id OrderDate OE_Id

E1 Yadav New	Delhi O1 2008/09/13 E1

E1 Yadav New	Delhi O2 2008/08/30 E3

E1 Yadav New	Delhi O3 2008/10/04 E1

E2 John Mumbai O1 2008/09/13 E1

E2 John Mumbai O2 2008/08/30 E3

E2 John Mumbai O3 2008/10/04 E1

E3 Kuller New	Delhi O1 2008/09/13 E1

E3 Kuller New	Delhi O2 2008/08/30 E3

E3 Kuller New	Delhi O3 2008/10/04 E1

	

SELECT	*

From	ORDERS,	EMPLOYEE	WHERE	OE_Id=E_Id
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The	result-set	will	look	like	this:

E_Id LastName City O_Id OrderDate OE_Id

E1 Yadav New	Delhi O1 2008/09/13 E1

E1 Yadav New	Delhi O3 2008/10/04 E1

E3 Kuller New	Delhi O2 2008/08/30 E3

SELECT	LastName,	City,	OrderDate	From	ORDERS,	EMPLOYEE
WHERE	OE_Id=E_Id

	
The	result-set	will	look	like	this:

LastName City OrderDate

Yadav New	Delhi 2008/09/13

Yadav New	Delhi 2008/10/04

Kuller New	Delhi 2008/08/30
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Knowledge	Check	Points
.1.DBMSstands	for

a)Data	Base	Manipulation
Scheme

b)Data	Base	Marginal
System

c)Data	Base	Management
System

d)Directory	Base	Management
System

.2.In	a	Database,	each	row	is	called
a)Recordb)Informationc)Horizontal	datad)None	of	these

.3.SQLstands	for
a)Sequential	Query	Languageb)Structured	Query	Languagec)Standard	Query	Languaged)Structure	Question	Literature

.4.Which	of	the	following(s)	is/are	the	element(s)	of	a	database
a)Relationsb)Datac)Constraintsd)All	of	these

.5.What	is	database	or	database	management	systems(DBMS)?

.6.What’s	the	difference	between	file	and	database?

.7.What	isSQL	?

.8.What’s	difference	betweenDBMSandRDBMS	?

.9.What	areDMLandDDLstatements?	Give	two	examples	for	each.	Q.10.How	doweselect	distinct	values	from	a	table?
Q.11.Can	you	explain	Insert,	Update	and	Delete	query?	Q.12.What	is	order	by	clause?
Q.13.What	is	”	Group	by	”	clause?
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Skill	Check	Points

Q.1.	Write	the	SQL	statements(commands)	to	create	the	table	and	to	insert	the	data	into	the	table	given	below:	COURSE

CourseName CourseNo CreditHours Department

Teacher	Education ED1210 6 EDU

Elementary	Education ED1211 4 EDU

Computer	Network CS3101 4 CS

Introduction	to
DBMS

CS3102 4 CS

Q2.	In	the	table	given	in	Q14,	insert	a	new	course	<‘Education	Technology’,	‘ED	1213’,	‘4’,	‘EDU’>	in	the	table	COURSE.
.3.What	is	the	result	of	the	followingSQL	statements:

(i)SELECTCourseNameFROMCOURSE
WHERE	Department=”EDU”;
(ii) SELECTCourseNoFROM	COURSE;
(iii)SELECTCourseName,	SUM(Credit)FROMCOURSE
GROUP	BY	Department
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Chapter	Two
	

ITDC-402
Operating	Web	Based	Applications

	
•Online	Reservation	Systems
•E-Governance
•Online	Shopping	and	Bill	Payments
•OnlineTutorialsand	Tests
•Project	Management	-WebBased	Application	Development
•Project	essentials	and	tips
•Case	Study	–	Online	Quiz
•Case	Study	–	Online	Game
•Case	Study	–	Online	Bill	Calculator
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Introduction
Webservices	 are	 open	 standard	 (XML,SOAP,HTTPetc.)	 basedWebapplications	 that	 interact	 with	 other	 web	 applications	 for	 the
purpose	of	exchanging	data.	Web	services	may	be	defined	as	follows:-

•A	web	service	 is	any	piece	of	software	that	makes	 itself	available	over	the	 internet	andusesastandardizedX	M	Lmessaging
system.X	M	 Lisusedtoencodeallcommunications	 to	 a	 web	 service.	 For	 example,	 a	 client	 invokes	 a	 web	 service	 by	 sending
anXMLmessage,	thenwaits	for	acorrespondingXMLresponse.	Becauseall	communication	 is	 inXML,web	services	are	not	 tied
to	 any	 one	 operating	 system	 or	 programming	 language—Java	 can	 talk	 with	 Perl;	 Windows	 applications	 can	 talk	 with	 Unix
applications.
•Web	 Services	 are	 self-contained,	 modular,	 distributed,	 dynamic	 applications	 that	 can	 be	 described,	 published,	 located,	 or
invoked	over	the	network	to	create	products,	processes,	and	supply	chains.	These	applications	can	be	local,	distributed,	or	Web-
based.Webservices	are	built	on	top	of	open	standards	such	as	TCP/IP,	HTTP,	Java,	HTML,and	XML.
•Webservices	areXML-basedinformation	exchange	systems	that	use	the	Internet	for	direct	application-to-application	interaction.
These	systems	can	include	programs,	objects,	messages,	or	documents.
•A	 web	 service	 is	 a	 collection	 of	 open	 protocols	 and	 standards	 used	 for	 exchanging	 data	 between	 applications	 or	 systems.
Software	 applications	 wrifen	 in	 various	 programming	 languages	 and	 running	 on	 various	 platforms	 can	 use	 web	 services	 to
exchange	 data	 over	 computer	 networks	 like	 the	 Internet	 in	 a	 manner	 similar	 to	 inter-process	 communication	 on	 a	 single
computer.	This	interoperability	(e.g.,	between	Java	and	Python,	or	Windows	and	Linux	applications)	is	due	to	the	use	of	open
standards.

To	summarize,	a	complete	web	service	is,	therefore,	any	service	that:
•Is	 available	 over	 the
Internet	 or	 private
(intranet)	networks

•Uses	 a	 standardized
XML	 messaging
system

•Is	not	tied	to	any	one	operating
system	 or	 programming
language

•Is	 self-describing	 via
a	 common	 XML
grammar

•Is	discoverable	via	a
simple	 find
mechanism
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ONLINE	SHOPPING
Online	shopping	made	things	much	easier	in	terms	of	time.	Go	to	the	internet	page,	choose	the	product	you	want	and	buy	it.	Whatever
you	buy	it	will	be	in	front	of	your	door	after	sometime.	If	you	are	not	able	to	go	out	any	more	for	any	reason,	go	for	online	shopping
and	you	can	buy	food	as	well	as	things	you	need	in	the	household.Youcan	get	everything	you	need	on	the	internet	shop.	Another	good
opportunity	in	online	shopping	is	that	you	can	compare	prices	easily.

The	weakness	of	online	shopping	is	that	you	have	to	be	really	careful	in	choosing	the	site	you	want	to	buy	the	things	you	need.	Some
sites	are	fake	in	the	sense	that	they	ask	you	for	money	and	won’t	give	you	anything.	Another	big	problem	is	the	quality	of	the	things
you	get.	Online	shopping	is	always	quite	tricky,	you	have	to	look	at	the	prices	and	compare	them	to	the	other	sites	to	be	sure	you	are
not	paying	much	for	the	goods	you	want.

Internet	shopping	is	faster,	convenient,	and	generates	befer	deals.	Internet	shopping	has	even	helped	certain	companies	in	achieving
competitive	 advantages	because	 it	 enables	 them	 to	get	 rid	 of	 intermediaries	 and	 sell	 directly	 to	 the	 customers.	 There	 is	 a	higher
probability	of	finding	befer	prices	on	the	internet	than	in	shopping	malls.	Many	internet	companies	operate	as	online	retailers	only
which	means	they	don’t	have	to	pay	any	intermediaries	such	as	distributors	and	they	don’t	have	to	hire	sales	people.	Thus,	they	can
pass	some	of	the	savings	to	the	customers	by	offering	reduced	prices.	Internet	also	enables	the	customers	to	do	price	comparisons	in
an	instant,	thus,	they	can	buy	from	the	online	retailer	that	offers	the	best	prices.	Internet	companies	are	aware	of	this	thus,	they	price
their	inventory	competitively.

Internet	also	enables	shopping	on	the	international	websites	that	stock	local	products.	Foreign	products	may	not	be	available	in	most
shopping	malls	because	 the	 level	of	demand	doesn’t	 justify	 the	 stocking	of	 such	products.	 Internet	 is	not	 limited	by	 international
boundaries	and	makes	it	possible	to	buy	products	from	other	countries	without	actually	having	to	go	there.

There	are	number	of	websites	which	provide	the	facility	of	online	shopping.	Some	of	them	arewww.snapdeal.com,	 www.flipcart.com,
www.amazon.com,	www.ebay.com,	etc.
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Example:For	online	shopping,	one	can	logon	towww.flipkart.com.The	home	page	of	the	website	is	as	below:
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If	you	want	to	purchase	some	books	on	flipkart,	go	to	the	option	All	Categories	Books
Click	on	one	of	the	category/subject

	
For	example,	if	you	click	on	the	category	“Academic	and	Professional”	under	the	head	of	“Education”,	you	will	get	a	list	of	books	under
this	category.
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To	purchase	a	book,	click	on	option	“Buy	Now”.
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ONLINE	RESERVATION
Online	reservation	system	has	a	number	of	benefits	that	makes	the	use	of	online	reservation	preferable	for	arranging	a	trip.	Online
reservation	 system	 provides	 the	 customer	 all	 required	 information	 and	 the	 customers	 get	 reservation	 wherein	 it	 saves	 time	 and
energy.	So	customers	are	able	to	book	or	reserve	all	that	they	deserve	and	be	able	to	plan	their	reservation	quickly	without	leaving
their	home.	The	 system	keeps	 the	best	 alternative	 solution	 to	once	 stagnant	method	 for	manual	 operation.	This	process	mutually
enhances	the	technical	capability	of	the	resort	in	the	pursuit	of	the	business	world.

For	example	one	is	booking	the	railway	ticket	online.	The	following	steps	will	be-Go	to	website	www.irctc.co.in.	The
homepage	will	be	displayed	such	as:
If	you	have	an	account,	enter	your	userid	in	the	column	“username”	and	enter	password.	Click	login.	The	new	window	will	be	displayed
as	below:
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Now	you	can	enter	the	code	of	both	the	stations	(departure	and	destination)	in	the	from	and	To	columns	respectively.
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The	next	webpage	will	show	the	list	of	the	trains
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ONLINE	RESERVATION	of	BUS
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ONLINE	MOVIE	TICKETS
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E	Governance
The	National	e-Governance	Plan	(NeGP)	has	been	formulated	by	the	Department	of	Electronics	and	Information	Technology	(DEITY)
and	 Department	 of	 Administrative	 Reforms	 and	 Public	 Grievances	 (DARPG).	 The	 NeGP	 approved	 by	 the	 Union	 Government,
comprising	of	27	Mission	Mode	Projects	(MMPs)	and	10	components	on	May	18,	2006.

TheNeGPaimed	 at	 improving	 delivery	 of	 Government	 services	 to	 citizens	 and	 businesses.	 The	 vision	 of	 the	 NeGP:“Make	 all
Government	services	accessible	to	the	common	man	in	his	 locality,	 through	common	service	delivery	outlets	and	ensure	efficiency,
transparency	&	reliability	of	such	services	at	affordable	costs	to	realise	the	basic	needs	of	the	common	man.”

About	NeGP
Central	Government	as	well	as	various	State	Governments	has	been	taken	a	large	number	of	initiatives	for	e-Governance.	Sustained
efforts	have	been	made	at	multiple	levels	to	improve	the	delivery	of	public	services	and	simplify	the	process	of	accessing	them.

e-GovernanceinIndiahassteadilyevolved	 fromcomputerizationofGovernmentDepartments	 to	 initiatives	 that	 encapsulate	 the	 finer
points	of	Governance,	such	as	citizen	centricity,	service	orientation	and	transparency.	The	progressive	e-Governance	strategy	is	being
shaped	in	the	country.	It	is	noticed	to	speed	up	e-Governance	implementation	across	the	65



various	arms	of	Government	at	National,	State,	 and	Local	 levels,	 a	programme	approach	needs	to	be	 adopted,	 guided	 by	 common
vision	 and	 strategy.	 This	 approach	 has	 the	 potential	 of	 enabling	 huge	 savings	 in	 costs	 through	 sharing	 of	 core	 and	 support
infrastructure,	enabling	interoperability	through	standards,	and	of	presenting	a	seamless	view	of	Government	to	citizens.

The	National	e-Governance	Plan	(NeGP),takes	a	holistic	view	of	e-Governance	initiatives	across	the	country,	integrating	them	into	a
collective	vision,	a	shared	cause.	Around	this	idea,	a	massive	countrywide	infrastructure	reaching	down	to	the	remotest	of	villages	is
evolving,	and	large-scale	digitization	of	records	is	taking	place	to	enable	easy,	reliable	access	over	the	internet.	The	ultimate	objective
is	to	bring	public	services	closer	home	to	citizens,	as	articulated	in	the	Vision	Statement	of	NeGP.



“Make	all	Government	services	accessible	 to	 the	common	man	 in	his	 locality,	 throughcommon	service	delivery	 outlets,	 and	 ensure
efficiency,	transparency,	and	reliability	of	such	services	at	affordable	costs	to	realise	the	basic	needs	of	the	common	man”

The	 Government	 approved	 the	 National	 e-Governance	 Plan	 (NeGP),	 comprising	 of	 27	 Mission	 Mode	 Projects	 (MMPs)	 and	 8
components,	 on	 May	 18,	 2006.	 The	 Government	 has	 accorded	 approval	 to	 the	 vision,	 approach,	 strategy,	 key	 components,
implementation	methodology,	 and	management	 structure	 for	NeGP.	 The	 existing	 or	 ongoing	 projects	 in	 the	MMP	 category,	 being
implemented	by	various	Central	Ministries,	States,	and	State	Departments	would	be	suitably	augmented	and	enhanced	to	align	with
the	objectives	of	NeGP.

Online	Passport
Online	Passport	is	a	Mission	Mode	Project	of	Government	of	India.	The	process	of	gefing	passport	online	is	as	follows	:
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ONLINE	BILL	PAYMENT
Online	bill	payment	is	a	system	of	paying	bills	using	the	Internet.	For	example	if	you	want	to	 pay	 the	 electricity	 bill	 online	 in	New
Delhi,	you	have	to	go	to	the	website	 www.bsesdelhi.com.As	 you	will	 enter	 this	 URL	 in	 the	 address	 bar	 and	 enter,	 you	will	 get	 the
homepage	of	BSESwebsite.
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Click	on	the	option	“Payment	option”.You	will	get	the	webpage	as	below:
Click	on	Pay	Now

	
Enter	CA	No.
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And	click	Go
The	next	page…

	
The	webpage	shows	the	details	of	the	bill.	To	pay	the	amount	of	the	bill,	select	the	mode	of	payment.	Click	on	“Pay	Now”.
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ONLINE	TUTORIALS	AND	TESTS
Online	tutoringis	an	online,	virtual	environment	or	networked	environment	in	which	teachers	and	learners	are	separated	by	time	and
space.	Online	 tutoring,	 as	 a	 reflection	 of	 the	 diversity	 of	 the	wider	 Internet,	 is	 practiced	 using	many	 different	 approaches	 and	 is
addressed	 to	 distinct	 sets	 of	 users.	 The	 distinctions	 are	 in	 online	 content	 and	 interface,	 as	well	 as	 in	 tutoring	 and	 tutor-training
methodologies.	 Definitions	 associated	 with	 online	 tutoring	 vary	 widely,	 reflecting	 the	 ongoing	 evolution	 of	 the	 technology,	 the
refinement	 and	 variation	 in	 online	 learning	 methodology,	 and	 the	 interactions	 of	 the	 organizations	 that	 deliver	 online	 tutoring
services	 with	 the	 institutions,	 individuals,	 and	 learners	 that	 employ	 the	 services.	 This	 form	 of	 Internet	 service	 is	 a	 classical
micropublishing	situation.

Online	environments	applied	in	education	usually	involve	the	use	of	learning	management	systems	or	Virtual	Learning	Environments
such	as	Moodle,	Sakai,WebCT,Blackboard.	Online	tutoring	may	be	offered	either	directly	through	the	virtual	learning	environment	of
a	tutoring	service	or	via	a	link	in	a	learning	management	system.

Moodle
Moodle	(abbreviation	for	Modular	Object-Oriented	Dynamic	Learning	Environment)	is	a	free	source	elearning	software	platform,	also
known	 as	 a	 Learning	 Management	 System,	 orVirtualLearning
Environment(VLE).MoodlewasoriginallydevelopedbyMartinDougiamas	 to	 help	 educators	 create	 online	 courses	 with	 a	 focus	 on
interaction	and	collaborative	construction	of	content,	and	is	in	continual	evolution.

You	will	find	access	to	Moodle	from	the	address:	hfp://www.moodle.aau.dk/	and	then	choose	the	school/study	you	want	to	enter.	It	may
also	be	possible	to	find	a	link	to	Moodle	from	the	homepage	of	your	study.

Login
From	the	front	page	of	Moodle	you	have	the	possibility	to	log	on	viayour	AAU	e-mail	address,	and	the	password	belonging	to	this.
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In	order	to	get	access	to	your	page	in	Moodle	(MyMoodle)	where	you	find	an	outline	of	your	rooms	in	Moodle,	it	is	important	that	you
log	on	to	Moodle	via	your	AAU	mail	address	and	the	matching	passwords.

Furthermore	 you	 must	 be	 logged	 into	 Moodle	 to	 receive	 information	 sent	 from	 secretaries	 and	 teachers,	 as	 this	 is	 being
communicated	via	 fora	 in	Moodle,	and	to	have	access	 to	material	being	available	 from	teachers	 in	 the	so-called	course	rooms	and
project	rooms.

Rooms	in	Moodle
Moodle	uses	3	kinds	of	rooms:	Semester	room,	Course	room	and	Project	room.	In	connection	with	the	different	rooms	3	lefers	are
mentioned	in	brackets	after	the	study	program,	as	shown	below:
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Exercise
.1.MOODLEstands	for

a)Multi	Object-Oriented
Dynamic	Learning
Environment

b)Modular	Object-Oriented
Dynamic	Learning
Environment

c)Modular	Object-Oriented
Direct	Learning
Environment

d)Multi	Object-Oriented
Direct	Learning
Environment

.2.What	do	you	mean	by	web	services?	How	are	these	web	services	helpful	for	human	being	in	their	daily	life?	Explain	with
examples.

.3.NeGPstands	for
a)National	e-Governance	Planb)New	Governance	Planc)National	Electronic	Governance	Pland)New	e-Governance	Plan

.4.What	do	you	mean	by	Online	Reservation?	Explain	with	suitable	examples.

.5.What	are	the	advantages	of	e-Governance?	Illustrate	with	suitable	examples.
.6.Using	the	online	reservation	service,	follow	the	steps	to	book	a	train	ticket	except	the	bill	payment	steps.
.7.Using	the	online	shopping	service,	follow	the	steps	to	purchase	an	item	except	the	bill	payment	steps.

Q8.			Discuss	how	MOODLE	can	be	used	used	for	learning	mathematics	at	elementary	level?
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PROJECT	MANAGEMENT

-	WEB	BASED	APPLICATION	DEVELOPMENT
What	is	Project?

1.	 A	Project	 is	 a	 set	 of	 things	 that	 an	 organization	 decides	 to	 do	 to	 achieve	 its	 vision	 and	goals	 as	well	 as	 to	 enhance
revenues	and	profits.

2.	 Each	project	has	a	definite	beginning	and	definite	ending	time.
3.	 Each	project	has	to	be	executed	under	certain	constraints.	These	constraints	may	change	with	time	and	that	is	a	part	of

project	dynamics.	Example	of	 such	constraints	could	be:availability	of	manpower,	capital	budget,	duration	of	project,
target	date	of	project	etc.

Sohware	Development	life	cycle
A	typical	Software	Development	life	cycle	consists	of	the	following	stages:

1.	 Stage	 1:Planningand	 Requirement	 Analysis	 :Requirement	 analysis	 is	 the	 most	 important	 and	 fundamental	 stage	 in
SDLC.	It	is	performed	by	the	senior	members	of	the	team	with	inputs	from	the	customer,	the	sales	department,	market
surveys	and	domain	experts	 in	 the	 industry.	This	 information	 is	 then	used	 to	plan	 the	basic	project	approach	and	 to
conduct	product	feasibility	study	in	the	economical,	operational,	and	technical	areas.

2.	 Stage	2:	Defining	Requirements	:	Once	the	requirement	analysis	is	done	the	next	step	is	to	clearly	define	and	document
the	product	requirements	and	get	them	approved	from	the	customer	or	the	market	analysts.	This	is	done	through	‘SRS’
–	 Software	 Requirement	 Specification	 document	 which	 consists	 of	 all	 the	 product	 requirements	 to	 be	 designed	 and
developed	during	the	project	life	cycle.

3.	 Stage	3:	Designing	the	product	architecture	:	SRS	 is	 the	 reference	 for	 product	 architects	 to	 come	 out	with	 the	 best
architecture	 for	 the	 product	 to	 be	 developed.	 Based	 on	 the	 requirements	 specified	 in	 SRS,	 usually	 more	 than	 one
design	approach	for	 the	product	architecture	 is	proposed	and	documented	 in	aDDS-	Design	Document	Specification.
ThisDDSis	 reviewed	by	all	 the	 important	 stakeholders	and	based	on	 various	parameters	as	 risk	assessment,	product
robustness,	design	modularity	,	budget	and	time	constraints	,	the	best	design	approach	is	selected	for	the	product.

4.	 Stage	4:Buildingor	Developing	the	Product	:In	this	stage	ofSDLCthe	actual	development	starts	and	the	product	is	built.
The	programming	code	is	generated	as	perDDS	during	this	stage.	If	the	design	is	performed	in	a	detailed	and	organized
manner,
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code	generation	can	be	accomplished	without	much	hassle.	Developers	have	to	follow	the	coding	guidelines	defined	by	their
organization	and	programming	tools	like	compilers,	interpreters,	debuggers	etc	are	used	to	generate	the	code.	Different	high
level	programming	languages	such	as	C,	C++,	Pascal,	Java,	and	PHP	are	used	for	coding.	The	programming	language	is	chosen
with	respect	to	the	type	of	software	being	developed.

5.	 Stage	5:Testingthe	Product	:This	stage	is	usually	a	subset	of	all	the	stages	as	in	the	modernSDLCmodels,	 the	 testing
activities	 are	mostly	 involved	 in	 all	 the	 stages	 ofSDLC.	 However	 this	 stage	 refers	 to	 the	 testing	 only	 stage	 of	 the
product	 where	 products	 defects	 are	 reported,	 tracked,	 fixed	 and	 retested,	 until	 the	 product	 reaches	 the	 quality
standards	defined	in	the	SRS.

6.	 Stage	6:Deploymentin	the	Market	and	Maintenance	:Once	the	product	is	tested	and	ready	to	be	deployed	it	is	released
formally	in	the	appropriate	market.	Sometime	product	deployment	happens	in	stages	as	per	the	organizations’	business
strategy.	The	product	may	first	be	released	in	a	limited	segment	and	tested	in	the	real	business	environment	(UAT-	User
acceptance	testing).

7.	 Then	based	 on	 the	 feedback,	 the	product	may	be	 released	 as	 it	 is	 or	with	 suggested	 enhancements	 in	 the	 targeting
market	segment.	After	the	product	is	released	in	the	market,	its	maintenance	is	done	for	the	existing	customer	base.

Project	Essentials	&	tips:
The	essentials	of	writing	high	quality	JavaScript	need	habits	and	best	practices.	These	habits	and	best	practices	can	help	you	write
befer,	more	understandable,	and	maintainable	code	-	code	to	be	proud	of	(and	be	able	to	figure	out)	when	revisiting	it	months	and
years	down	the	road.	They	are:

1.	 Writing	Maintainable	Code
Maintainable	code	means	code	that:

•Is	readable•Is	consistent•Is	predictable•Looks	as	if	itwaswrifen	by	the	same	person•Is	documented
2.	 Minimizing	Globals

JavaScript	uses	functions	to	manage	scope.	A	variable	declared	inside	of	a	function	is	local	to
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that	function	and	not	available	outside	the	function.	On	the	other	hand,	global	variables	are	those	declared	outside	of	any	function	or
simply	used	without	being	declared.
The	problem	with	global	variables	is	that	they	are	shared	among	all	the	code	in	your	JavaScript	application	or	web	page.	They	live	in
the	 same	global	 namespace	 and	 there	 is	 always	 a	 chance	 of	 naming	 collisions	 -	when	 two	 separate	 parts	 of	 an	 application	define
global	variables	with	the	same	name	but	with	different	purposes.

3.	 Single	var	Paflern
Using	a	single	var	statement	at	the	top	of	your	functions	is	a	useful	pafern	to	adopt.	It	has	the	following	benefits:

•Provides	 a	 single	 place	 to	 look	 for	 all
the	 local	 variables	 needed	 by	 the
function

•Prevents	 logical	 errors	 when	 a
variable	 is	 used	 before	 it’s
defined

•Helps	 you	 remember	 to	 declare
variables	 and	 therefore	 minimize
globals

•Is	less	code	(to	type	and
to	 transfer	 over	 the
wire)

JavaScript	enables	you	to	have	multiple	var	statements	anywhere	in	a	function,	and	they	all	act	as	if	the	variables	were	declared	at	the
top	of	the	function.	This	behavior	is	known	as	hoisting.	This	can	lead	to	logical	errors	when	you	use	a	variable	and	then	you	declare	it
further	in	the	function.

4.	 for	Loops
In	for	loops	you	iterate	over	or	array-like	objects	such	as	arguments	andHTMLCollectionobjects.	The	usual	for	loop	pafern	looks	like
the	following:	//	sub-optimal	loop

for	(var	i	=	0;	i	<	myarray.length;	i++)	{
//	do	something	with	myarray[i]

}

A	 problem	 with	 this	 pafern	 is	 that	 the	 length	 of	 the	 array	 is	 accessed	 on	 every	 loop	 iteration.Thiscanslow	 down	 your
code,especiallywhen	myarrayisnotanarraybutanHTMLCollection	object.	The	 trouble	with	collections	 is	 that	 they	are	 live	queries
against	the	underlying	document	(theHTMLpage).	This	means	that	every	time	you	access	any	collection’s	length,	you’re	querying	the
liveDOM,andDOMoperations	are	expensive	in	general.
That’s	 why	 a	 befer	 pafern	 for	 for-loops	 is	 to	 cache	 the	 length	 of	 the	 array	 (or	 collection)	 you’re	 iterating	 over,	 as	 shown	 in	 the
following	example:	for	(var	i	=	0,	max	=	myarray.length;	i	<	max;	i++)	{
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//	do	something	with	myarray[i]

}

This	way	you	retrieve	the	value	of	length	only	once	and	use	it	during	the	whole	loop.	Caching	the	length	when	iterating	over
HTMLCollection	is	faster	across	all	browsers.

5.	 switch	Paflern
You	can	improve	the	readability	and	robustness	of	your	switch	statements	by	following	this	pafern:

var	inspect_me	=	0,	result	=	”;
switch	(inspect_me)	{	case	0:

result	=	“zero”;	break;
case	1:

result	=	“one”;	break;
default:

result	=	“unknown”;

}

The	style	conventions	followed	in	this	simple	example	are:
•Aligning	each	case	with	switch	(an	exception	to	the	curly	braces	indentation	rule).
•Indenting	the	code	within	each	case.
•Ending	each	case	with	a	clear	break	statement.
•Avoiding	 fall-throughs	 (when	you	omit	 the	break	 intentionally).	 If	 you’re	absolutely	convinced	 that	a	 fall-through	 is	 the	best
approach,	make	sure	you	document	such	cases,	because	they	might	look	like	errors	to	the	readers	of	your	code.
•Ending	the	switch	with	a	default	to	make	sure	there’s	always	a	sane	result	even	if	none	of	the	cases	matched.

6.	 AvoidingImplied	Typecasting
JavaScript	implicitly	typecasts	variables	when	you	compare	them.	That’s	why	comparisons	such	as	false	==	0	or	“”==0	return	true.	To
avoid	confusion	caused	by	the	implied	typecasting,	always	use	the	===	and	!==	operators	that	check	both	the	values	and	the	type	of
the	expressions	you	compare:	76



var	zero	=	0;
if	(zero	===	false)	{

//	not	executing	because	zero	is	0,	not	false

}

//	antipafern
if	(zero	==	false)	{

//	this	block	is	executed…

}

7.	 Number	Conversions	with	parseInt()
Using	parseInt()	you	can	get	a	numeric	value	from	a	string.	The	function	accepts	a	second	radix	parameter,	which	is	often	omifed	but
shouldn’t	 be.	 The	problems	 occur	when	 the	 string	 to	 parse	 starts	with	 0:	 for	 example,	 a	 part	 of	 a	 date	 entered	 into	 a	 form	 field.
Strings	 that	 start	with	 0	 are	 treated	 as	 octal	 numbers	 (	 base	 8	 )	 in	ECMAScript	 3;	 however,	 this	has	 changed	 in	ES	5.	To	 avoid
inconsistency	and	unexpected	results,	always	specify	the	radix	parameter:	var	month	=	“06”,

year	=	“09”;
month	=	parseInt(month,	10);	year	=	parseInt(year,
10);

In	this	example,	if	you	omit	the	radix	parameter	like	parseInt(year),	the	returned	value	will	be	0,	because	“09”	assumes	octal	number
(as	if	you	did	parseInt(year,	8))	and	09	is	not	a	valid	digit	in	base	8.

8.	 Indentation
Code	without	indentation	is	impossible	to	read.	The	only	thing	worse	is	code	with	inconsistent	indentation,	because	it	looks	like	it’s
following	a	convention,	but	it	may	have	confusing	surprises	along	the	way.	It’s	important	to	standardize	the	use	of	indentation.	Some
developers	prefer	 indentation	with	 tabs,	because	anyone	can	 tweak	 their	 editor	 to	display	 the	 tabs	with	 the	 individually	preferred
number	of	spaces.	Some	prefer	spaces	-	usually	four.	It	doesn’t	mafer	as	long	as	everyone	in	the	team	follows	the	same	convention.
And	what	should	you	indent?	The	rule	is	simple	-	anything	within	curly	braces.	This	means	the	bodies	of	functions,	loops	(do,	while,
for,	 for-in),	 ifs,	 switches,	 and	 objects	 properties	 in	 the	 object	 literal	 notation.	 The	 following	 code	 shows	 some	 examples	 of	 using
indentation:	function	outer(a,	b)	{
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var	c	=	1,
d	=	2,
inner;	if	(a	>	b)	{
inner	=	function	()	{	return	{

r:	c	-	d

};

}	else	{

};
	

inner	=	function	()	{	return	{
r:	c	+	d

};

};

}

return	inner;

}

9.	 Curly	Braces
Curly	braces	should	always	be	used,	even	in	cases	when	they	are	optional.	Technically,	if	you	have	only	one	statement	in	an	if	or	a	for,
curly	 braces	 are	 not	 required,	 but	 you	 should	 always	 use	 them	 anyway.	 It	makes	 the	 code	more	 consistent	 and	 easier	 to	 update.
Imagine	you	have	a	for	loop	with	one	statement	only.	You	could	omit	the	braces	and	there	will	be	no	syntax	error:	//	bad	practice

for	(var	i	=	0;	i	<	10;	i	+=	1)	alert(i);
But	what	if,	later	on,	you	add	another	line	in	the	body	of	the	loop?

//	bad	practice
for	(var	i	=	0;	i	<	10;	i	+=	1)	alert(i);

alert(i	+	”	is	”	+	(i	%	2	?	“odd”	:	“even”));
The	second	alert	is	outside	the	loop	although	the	indentation	may	trick	you.	The	best	thing	to	do	in	the	long	run	is	to	always	use	the
braces,	even	for	one-line	blocks:	//	befer
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for	(var	i	=	0;	i	<	10;	i	+=	1)	{	alert(i);

}

Similarly	for	if	conditions:
//		bad	if	(true)

alert(1);
else

alert(2);
//		befer	if	(true)	{

alert(1);
}	else	{

alert(2);

}

10.	 Opening	Brace	Location
Developers	also	tend	to	have	preferences	about	where	the	opening	curly	brace	should	be	-	on	the	same	line	or	on	the	following	line?

if	(true)	{
alert(“It’s	TRUE!”);

}

if	(true)

{

OR:



alert(“It’s	TRUE!”);

}

In	this	specific	example,	it’s	a	mafer	of	preference,	but	there	are	cases	in	which	the	program	might	behave	differently	depending	on
where	the	brace	is.	This	is	because	of	the	semicolon	insertion	mechanism	-	JavaScript	is	not	picky	when	you	choose	not	to	end	your
lines	properly	with	a	semicolon	and	adds	it	for	you.	This	behavior	can	cause	troubles	when	a	function	returns	an	object	literal	and	the
opening	brace	is	on	the	next	line:	//	warning:	unexpected	return	value	function	func()	{

return
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//	unreachable	code	follows

{

name	:	“Batman”

}

}

If	 you	 expect	 this	 function	 to	 return	 an	 object	 with	 a	 name	 property,	 you’ll	 be	 surprised.	 Because	 of	 the	 implied	 semicolons,	 the
function	returns	underfined.	The	preceding	code	is	equivalent	to	this	one:	//	warning:	unexpected	return	value	function	func()	{

return	undefined;
//	unreachable	code	follows

{

name	:	“Batman”

}

}

In	conclusion,	always	use	curly	braces	and	always	put	the	opening	one	on	the	same	line	as	the	previous	statement:	function	func()	{
return	{

name	:	“Batman”

};

}

11.	 White	Space
The	use	of	white	space	can	also	contribute	to	improved	readability	and	consistency	of	the	code.	In	wrifen	English	sentences	you	use
intervals	after	commas	and	periods.	In	JavaScript	you	follow	the	same	logic	and	add	intervals	after	list-like	expressions	(equivalent	to
commas)	 and	 end-of-statements	 (equivalent	 to	 completing	 a	 “thought”).	 Good	 places	 to	 use	 a	 white	 space	 include:	 After	 the
semicolons	that	separate	the	parts	of	a	for	loop:	for	example,	for(var	i	=	0;	i	<	10;	i	+=	1)	{…}
Initializing	multiple	variables	(i	and	max)	in	a	for	loop:	for(var	i	=	0,	max	=	10;	i	<	max;	i	+=	1)

{…}
After	the	commas	that	delimit	array	items:var	a	=	[1,	2,	3];	80



After	 commas	 in	 object	 properties	 and	 after	 colons	 that	 divide	 property	 names	 and	 their	 values:var	 o	 =	 {a:	 1,	 b:	 2};	 Delimiting
function	arguments:myFunc(a,	b,	c);	Before	the	curly	braces	in	function	declarations:function	myFunc()	{}
After	 function	 in	anonymous	 function	expressions:var	myFunc	=	 function	 ()	 {};	Another	good	use	for	 white	 space	 is	 to	 separate	 all
operators	and	their	operands	with	spaces,	which	basically	means	use	a	space	before	and	after	+,	-,	*,	=,	<,	>,	<=,	>=,	===,	!==,	&&,	||,
+=,	and	so	on:	//	generous	and	consistent	spacing

//	makes	the	code	easier	to	read
//	allowing	it	to	“breathe”var	d	=	0,

a	=	b	+	1;
if	(a	&&	b	&&	c)	{	d	=	a	%	c;

a	+=	d;

}

//	antipafern
//	missing	or	inconsistent	spaces
//	make	the	code	confusingvar	d	=	0,

a	=	b	+	1;
if	(a	&&	b	&&	c)	{	d	=	a	%	c;

a	+=	d;

}

And	a	final	note	about	white	space	-	curly	braces	spacing.	It’s	good	to	use	a	space:
•Before	opening	curly	braces	({)	in	functions,	if-else	cases,	loops,	and	object	literals
•Between	the	closing	curly	brace	(})	and	else	or	while

A	case	against	liberal	use	of	white	space	might	be	that	it	could	increase	the	file	size,	but	minification	takes	care	of	this	issue.
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12.	 Coding	and	Naming	Conventions
It’s	important	to	establish	and	follow	coding	conventions	-	they	make	your	code	consistent,predictable,	and	much	easier	to	read	and
understand.	A	new	developer	joining	the	team	can	read	through	the	conventions	and	be	productive	much	sooner,	understanding	the
code	wrifen	by	any	other	team	member.
Another	way	to	make	your	code	more	predictable	and	maintainable	is	to	adopt	naming	conventions.	That	means	choosing	names	for
your	variables	and	functions	in	a	consistent	manner.

13.	 Capitalizing	Constructors
JavaScript	doesn’t	have	classes	but	has	constructor	functions	invoked	with	new	:var	adam	=	new	Person();	Because

constructors	are	still	just	functions,	it	helps	if	you	can	tell,	just	by	looking	at	a	function	name,	whether
itwassupposed	to	behave	as	a	constructor	or	as	a	normal	function.	Naming	constructors	with	a	capital	first
lefer	provides	that	hint.	Using	lowercase	for	functions	and	methods	indicates	that	they	are	not	supposed	to	be
called	with	new:	function	MyConstructor()	{…}	function	myFunction()	{…}

14.	 Separating	Words
When	you	have	multiple	words	in	a	variable	or	a	function	name,	it’s	a	good	idea	to	follow	a	convention	as	to	how	the	words	will	be
separated.	 A	 common	 convention	 is	 to	 use	 the	 so-called	 camel	 case.	 Following	 the	 camel	 case	 convention,	 you	 type	 the	 words	 in
lowercase,	only	capitalizing	the	first	lefer	in	each	word.
For	your	constructors,	you	can	useupper	camel	case,	as	 in	MyConstructor(),	and	for	function	and	method	names,	you	can	uselower
camel	case,	as	in	myFunction(),	calculateArea()	and	getFirstName().
And	what	about	variables	that	are	not	functions?	Developers	commonly	use	lower	camel	case	for	variable	names,	but	another	good
idea	is	to	use	all	lowercase	words	delimited	by	an	underscore:	for	example,	first_name,	favorite_bands,	and	old_company_name.	This
notation	helps	you	visually	distinguish	between	functions	and	all	other	identifiers	-	primitives	and	objects.

15.	 Other	Naming	Paflerns
Sometimes	developers	use	a	naming	convention	to	make	up	or	substitute	language	features.
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For	example,	there	is	no	way	to	define	constants	 in	 JavaScript	 (although	 there	 are	 some	 built-in	 such	 asNumber.MAX_VALUE),so
developers	have	adopted	 the	convention	of	using	all-caps	for	naming	variables	that	shouldn’t	 change	 values	 during	 the	 life	 of	 the
program,	like:	//	precious	constants,	please	don’t	touch	var	PI	=	3.14,

MAX_WIDTH	=	800;
There’s	another	convention	that	competes	for	the	use	of	all	caps:	using	capital	lefers	for	names	of	global	variables.	Naming	globals
with	all	caps	can	reinforce	the	practice	of	minimizing	their	number	and	can	make	them	easily	distinguishable.

16.	 Writing	Comments
Youhave	to	comment	your	code,	even	if	 it’s	unlikely	that	someone	other	than	you	will	ever	touch	 it.	Often	when	you’re	deep	into	a
problem	 you	 think	 it’s	 obvious	 what	 the	 code	 does,	 but	 when	 you	 come	 back	 to	 the	 code	 after	 a	 week,	 you	 have	 a	 hard	 time
remembering	how	it	worked	exactly.
Youshouldn’t	go	overboard	commenting	the	obvious:	every	single	variable	or	every	single	line.	But	you	usually	need	to	document	all
functions,	their	arguments	and	return	values,	and	also	any	interesting	or	unusual	algorithm	or	technique.
Think	 of	 the	 comments	 as	 hints	 to	 the	 future	 readers	 of	 the	 code;	 the	 readers	 need	 to	 understand	what	 your	 code	 does	 without
reading	much	more	than	just	the	comments	and	the	function	and	property	names.	When	you	have,	for	example,	five	or	six	lines	of
code	performing	a	specific	task,	the	reader	can	skip	the	code	details	if	you	provide	a	one-line	description	describing	the	purpose	of
the	code	and	why	it’s	there.
There’s	no	hard	and	 fast	 rule	or	 ratio	of	 comments-to-code;	 some	pieces	of	 code	 (think	 regular	 expressions)	may	actually	 require
more	comments	than	code.
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Case	Study	1	-	Online	Quiz
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quiz.html
<HTML>
<HEAD>
<style	type=“text/css”>
.bgclr

{

background-color:	white;	color:	black;
font-weight:	bold;

}

</style>
<script	type=“text/javascript”	src=“quiz.js”	></script>
</HEAD>
<BODY>
<h3>Online	Quiz</h3>
<FORM	name=“quiz”>

1.	 What	does	HTML	stand	for?
<ul	style=“margin-top:	1pt”>
<li><input	type=“radio”	name=“q1”	value=“Hyper	Text	Machine	Language”>	Hyper	Text	Machine	Language	</li>	<li><input
type=“radio”	name=“q1”	value=“Hyper	Text	Markup	Language”>	Hyper	Text	Markup	Language	</li>	<li><input	type=“radio”
name=“q1”	value=“High	Text	Markup	Language”>	High	Text	Markup	Language	</li>	</ul>

2.	 What	does	WWW	stand	for?
<ul	style=“margin-top:	1pt”>
<li><input	type=“radio”	name=“q2”	value=“World	Wide	Wing”>	World	Wide	Wing	</li>	85



<li><input	type=“radio”	name=“q2”	value=“Whole	World	Web”>	Whole	World	Web	</li>	<li><input	type=“radio”	name=“q2”
value=“World	Wide	Web”>	World	Wide	Web	</li>
</ul>

3.	 What	does	HTTP	stand	for?
<ul	style=“margin-top:	1pt”>
<li><input	type=“radio”	name=“q3”	value=“Hyper	Text	Transmission	Protocol”>	Hyper	Text	Transmission	Protocol	</li>	<li><input
type=“radio”	name=“q3”	value=“HyperTextTransfer	Protocol”>	HyperText	Transfer	Protocol	</li>	<li><input	type=“radio”	name=“q3”
value=“High	Text	Transfer	Protocol”>	High	Text	Transfer	Protocol	</li>	</ul>

4.	 What	does	FTP	stand	for?
<ul	style=“margin-top:	1pt”>
<li><input	type=“radio”	name=“q4”	value=“File	Transmission	Protocol”>	File	Transmission	Protocol	</li>	<li><input	type=“radio”
name=“q4”	value=“File	Testing	Protocol”>	File	Testing	Protocol	</li>	<li><input	type=“radio”	name=“q4”	value=“File	Transfer
Protocol”>	File	Transfer	Protocol	</li>	</ul>
<input	type=“bufon”	value=“Get	score”	onClick=“getScore(this.form)”>
<input	type=“reset”	value=“Clear	all”>
<p>	Score	=	<strong><input	class=“bgclr”	type=“text”	size=“5”	name=“percentage”
disabled></strong><br><br>	Correct	answers:<br>
<TEXTAREA	class=“bgclr”	name=“solutions”	wrap=“virtual”	rows=“4”	cols=“50”	disabled>
</TEXTAREA>
</FORM>
</BODY>
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</HTML>
quiz.js
//	Insert	number	of	questionsvar	numQues	=	4;
//	Insert	number	of	choices	in	each	questionvar	numChoi	=	3;
//	Insert	number	of	questions	displayed	in	answer	areavar	answers	=	new	Array(4);	//	Insert
answers	to	questions
answers[0]	=	“Hyper	Text	Markup	Language”;	answers[1]	=	“World	WideWeb”;
answers[2]	=	“HyperTextTransfer	Protocol”;	answers[3]	=	“File	Transfer
Protocol”;	function	getScore(form)	{	var	score	=	0;

var	currElt;
var	currSelection;
for	(i=0;	i<numQues;	i++)	{	currElt		=		i*numChoi;	for	(j=0;

j<numChoi;	j++)	{
currSelection	=	form.elements[currElt	+	j];	if	(currSelection.checked)	{

if	(currSelection.value	==	answers[i])	{	score++;
break;

}

}

}
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}

score	=	Math.round(score/numQues*100);	form.percentage.value	=	score
+	“%”;
varcorrectAnswers	=	””;	for	(i=1;	i<=numQues;	i++)
{

correctAnswers	+=	i	+	“.	”	+	answers[i-1]	+	“\r\n”;

}

form.solutions.value	=	correctAnswers;

}

Case	Study	2	-	Online	Game

1.	 This	is	the	two	players	Tic-Tac-Toe	logic	game	allows	one	player	to	play	against	another.
2.	 Player	1	is	X	and	the	Player	2	is	O.
3.	 Select	the	square	you	want	to	put	your	marker	into	by	clicking	the	box.
4.	 You	cannot	occupy	a	square	that	is	already	occupied.
5.	 The	first	player	to	get	three	squares	in	a	row	wins.	View	the	source	code.
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tictactoe.html
<!DOCTYPE	html>
<html>
<head>
<title>Tic-Tac-Toe</title>
<link	rel=“stylesheet”	type=“text/css”	href=“tictactoe.css”	/>
<script	type=“text/javascript”	src=“tictactoe.js”>	</script>
</head>
<body>
<center>
<h1><b><p	id=“turnlabel”>Player	1	</p></b></h1>
<table>
<tr>

	

</tr>
<tr>

	

</tr>
<tr>

	

</tr>

<td><bufon	id=“cell”	name=“c00”	onclick=“move(this,0,0);”>	</bufon></td>	<td><bufon	id=“cell”	name=“c01”
onclick=“move(this,0,1);”>	</bufon></td>
<td><bufon	id=“cell”	name=“c02”	onclick=“move(this,0,2);”>	</bufon></td>

	
<td><bufon	id=“cell”	name=“c10”	onclick=“move(this,1,0);”>	</bufon></td>
<td><bufon	id=“cell”	name=“c11”	onclick=“move(this,1,1);”>	</bufon></td>
<td><bufon	id=“cell”	name=“c12”	onclick=“move(this,1,2);”>	</bufon></td>

	
<td><bufon	id=“cell”	name=“c20”	onclick=“move(this,2,0);”>	</bufon></td>
<td><bufon	id=“cell”	name=“c21”	onclick=“move(this,2,1);”>	</bufon></td>
<td><bufon	id=“cell”	name=“c22”	onclick=“move(this,2,2);”>	</bufon></td>



</table>
<b><p>Player	1	-	X	</p><p>Player	2	-	O	</p>	</b>
</center>
</body>
</html>
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tictactoe.js
var	currLefer	=	“X”;	var	moves	=	0;
var	board	=	[[‘	‘,’	‘,’	‘],[‘	‘,’	‘,’	‘],[‘	‘,’	‘,’	‘]];
function	move(obj,i,j)

{

if	(board[i][j]	==	‘	‘)

{

var	lbl	=	document.getElementById(“turnlabel”);	moves	=	moves	+	1;
obj.innerHTML	=	currLefer;	board[i][j]	=	currLefer;
if	(currLefer	==	“X”)

{

}

else

{

}

currLefer	=	“O”;	lbl.innerHTML	=	“Player	2”;
currLefer	=	“X”;	lbl.innerHTML	=	“Player	1”;

	
var	result	=	gameOver();	if	(result	==	“tie”)

{

alert(“Nobody	wins!”);	initBoard();

}

else	if	(result	!=	””)

{

alert(result.substring(0,1)	+	”	wins!”);
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initBoard();

}

}

else

{

//do	nothing

}

}

function	initBoard()

{

var	lbl	=	document.getElementById(“turnlabel”);	lbl.innerHTML	=	“Player	1”;
currLefer	=	“X”;	moves	=	0;
for	(var	i	=	0;	i	<	3;	i++)

{

for	(var	j	=	0;	j	<	3;	j++)

{

board[i][j]	=	‘	‘;
var	cells=document.getElementsByName(“c”+i+j);	cells[0].innerHTML	=	”	“;

}

}

}

function	gameOver()

{

//is	there	is	a	row	or	column	of	all	Xs	or	Osvar	str;
str	=	board[0][0]	+	board[0][1]	+	board[0][2];	if	(str	==	“XXX”	||	str	==
“OOO”)	{

return	str;

}
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str	=	board[1][0]	+	board[1][1]	+	board[1][2];	if	(str	==	“XXX”	||	str	==	“OOO”)	{
return	str;

}

str	=	board[2][0]	+	board[2][1]	+	board[2][2];	if	(str	==	“XXX”	||	str	==	“OOO”)	{
return	str;

}

str	=	board[0][0]	+	board[1][0]	+	board[2][0];if	(str	==	“XXX”	||	str	==	“OOO”)	{
return	str;

}

str	=	board[0][1]	+	board[1][1]	+	board[2][1];	if	(str	==	“XXX”	||	str	==	“OOO”)	{
return	str;

}

str	=	board[0][2]	+	board[1][2]	+	board[2][2];	if	(str	==	“XXX”	||	str	==	“OOO”)	{
return	str;

}

str	=	board[0][0]	+	board[1][1]	+	board[2][2];	if	(str	==	“XXX”	||	str	==	“OOO”)	{
return	str;
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}

str	=	board[2][0]	+	board[1][1]	+	board[0][2];	if	(str	==	“XXX”	||	str	==
“OOO”)	{

return	str;

}

//are	all	the	spaces	taken	if	(moves	==	9)

{

return	“tie”;

}

return	””;

}

Case	Study	3	–	Online	Bill	Calculator
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calculator.html
<!DOCTYPE	html>
<html>
<head>
<title>Simple	Calculator</title>
<script	type=“text/javascript”	src=“calculator.js”>	</script>
<link	rel=“stylesheet”	type=“text/css”	href=“calculator.css”	/>
</head>
<body>
<center>
<form	name=“form1”>
<table	border=“5”>
<tr>

<td	colspan=“4”><input	type=“text”	name=“display”	style=“text-align:right”	style=“font-weight:bold”></td>	</tr>
	



<tr>
	

</tr>
<tr>

<td><input	type=“bufon”	class=“btn”	name=“btnClear”	value=“C”	onclick=cleardata()></td>	<td><input	type=“bufon”
class=“btn”	name=“btnClear”	value=”&radic;”	onclick=sqroot()>	</td>	<td><input	type=“bufon”	class=“btn”
name=“btn0”	value=”+/-”	onclick=negation()></td>	<td><input	type=“bufon”	class=“btn”	name=“btnDiv”	value=”%”
onclick=mod()></td>

<td><input	type=“bufon”	class=“btn”	name=“btn1”	value=“1”	onclick=“form1.display.value	+=	‘1’”></td>
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</tr>
<tr>

	
</tr>
<tr>

	
</tr>
<tr>

<td><input	type=“bufon”	class=“btn”	name=“btn2”	value=“2”	onclick=“form1.display.value	+=	‘2’”></td>	<td><input
type=“bufon”	class=“btn”	name=“btn3”	value=“3”	onclick=“form1.display.value	+=	‘3’”></td>	<td><input	type=“bufon”
class=“btn”	name=“btnDiv”	value=””	onclick=div()><td>

<td><input	type=“bufon”	class=“btn”	name=“btn4”	value=“4”	onclick=“form1.display.value	+=	‘4’”></td>	<td><input
type=“bufon”	class=“btn”	name=“btn5”	value=“5”	onclick=“form1.display.value	+=	‘5’”></td>	<td><input	type=“bufon”
class=“btn”	name=“btn6”	value=“6”	onclick=“form1.display.value	+=	‘6’”></td>	<td><input	type=“bufon”	class=“btn”
name=“btnMul”	value=“x”	onclick=mul()></td>

<td><input	type=“bufon”	class=“btn”	name=“btn7”	value=“7”	onclick=“form1.display.value	+=	‘7’”></td>	<td><input
type=“bufon”	class=“btn”	name=“btn8”	value=“8”	onclick=“form1.display.value	+=	‘8’”></td>	<td><input	type=“bufon”
class=“btn”	name=“btn9”	value=“9”	onclick=“form1.display.value	+=	‘9’”></td>	<td><input	type=“bufon”	class=“btn”
name=“btnSub”	value=”-”	onclick=sub()></td>

<td><input	type=“bufon”	class=“btn”	name=“btnEqual”	value=”.”	onclick=decpoint()></td>	<td><input	type=“bufon”
class=“btn”	name=“btn0”	value=“0”	onclick=“form1.display.value	+=	‘0’”></td>	<td><input	type=“bufon”	class=“btn”
name=“btnEqual”	value=”=”
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</tr>

onclick=equals()></td>
<td><input	type=“bufon”	class=“btn”	name=“btnAdd”	value=”+”	onclick=add()	></td>
</table>
</form>
</center>
</body>
</html>

calculator.css



input	{

}

td	{

}

font-family:consola,monospace;	font-size:20px;
font-weight:bold;

	
margin-left:	auto;	margin-right:	auto;	text-align:	center;

	



.btn	{

}

height:40px;	width:40px

calculator.js
var	N1=0;

	
96



varN2=0;varop;var	Flag	=	0;	function
decpoint()

{

if	(Flag	==	0)

{

form1.display.value	=	form1.display.value	+	“.”;	Flag	=	1;

}

}

function	negation()

{

form1.display.value	=	form1.display.value	*	-1;

}

function	cleardata()

{

form1.display.value	=	””;	N1	=	0;
N2	=	0;
Flag	=	0;

}

function	sqroot()

{

form1.display.value	=	Math.sqrt(form1.display.value);

}

function	add()

{

if	(N1==0)
N1	=	Number(form1.display.value);	else
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N1	+=	Number(form1.display.value);	op	=	“+”;
form1.display.value	=	””;

}

function	sub()

{

if	(N1==0)
N1	=	Number(form1.display.value);	else
N1	-=	Number(form1.display.value);

op	=	“-“;
form1.display.value	=	””;

}

function	mul()

{

if	(N1==0)
N1	=	Number(form1.display.value);	else
N1	*=	Number(form1.display.value);

op	=	“*”;	form1.display.value	=	””;

}

function	div()

{

if	(N1==0)
N1	=	Number(form1.display.value);	else
N1	/=	Number(form1.display.value);

op	=	“/”;	form1.display.value	=	””;
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}

function	mod()

{

N1	=	Number(form1.display.value);	op	=	“%”;
form1.display.value	=	””;

}

function	equals()

{

N2	=	Number(form1.display.value);
if	(op	==	“+”	)

form1.display.value	=	N1	+	N2;	else	if	(	op	==	“-”	)
form1.display.value	=	N1	-	N2;	else	if	(op	==	“*”)
form1.display.value	=	N1	*	N2;	else	if	(op	==”/”)
form1.display.value	=	N1/N2;	else	if	(op==”%”	)
form1.display.value	=	N1%N2;

N1=0;	N2=0;

}

References:
1.	 hfp://code.tutsplus.com/tutorials/the-essentials-of-writing-high-quality-javascript—	net-15145
2.	 hfp://www.webestools.com/
3.	 hfps://docs.google.com/file/d/0BzsgtY7KuQUXdzgyLURVZ	3BuS3c/edit?pli=1
4.	 hfp://sumtotalz.com/TotalAppsWorks/Javascript/JS_BasicCalc.html
5.	 hfp://www.javascriptsource.com/miscellaneous/basic-javascript-quiz.html

	
99
	

100



Chapter	Three

ITDC-403
Fundamentals	of	Java	Programming

•Introduction	to	Java
•Object	Oriented	Programming
•Java	Language	Elements
•Operators
•Control	Flow
•Array
•Class	Design
•Exception	Handling
•Assertions
•Threads
•Wrapper	Classes
•String	Manipulation
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FUNDAMENTALS	OF	JAVA	PROGRAMMING

1.	 Introduction	to	Java
Java	is	a	high-level	programming	language	originally	developed	by	Sun	Microsystems	and	released	in	1995,	later	acquired	by	Oracle
Corporation.	It	was	conceived	by	James	Gosling	and	Patrick	Naughton.	It	is	a	simple	programming	language.	Writing,	compiling	and
debugging	a	program	is	easy	in	java.	It	helps	to	create	modular	programs	and	reusable	code.	Java	runs	on	a	variety	of	platforms,	such
as	Windows,	Mac	OS,	and	the	various	versions	of	UNIX.

1.1Main	Features	of	JAVA:
1)Javaisaplatform	 independent	 language:Aplatformisapre-existingenvironment	 in	which	a	program	runs,	obeying	 its

constraints,	and	making	use	of	its	facilities.	During	compilation,	the	compiler	converts	java	program	to	its	byte	code.
This	byte	code	can	run	on	any	platform	such	as	Windows,	Linux,	Mac/OS	etc.	Which	means	a	program	that	is	compiled
on	windows	can	run	on	Linux	and	vice-versa.	This	is	why	java	is	known	as	platform	independent	language.

2)Java	 is	 an	 Object	 Oriented	 language:Object	 oriented	 programming	 is	 awayof	 organizing	 programs	 as	 collection	 of
objects,	each	of	which	represents	an	instance	of	a	class.

3)Simple:Java	 is	 considered	 as	 one	 of	 simple	 language	 because	 it	 does	 not	 have	 complex	 features	 like	 Operator
overloading,	Multiple	inheritance,	pointers	and	Explicit	memory	allocation.

4)Robust	Language:Twomain	problems	 that	cause	program	failures	are	memory	management	mistakes	and	mishandled
runtime	errors.	Java	handles	both	of	them	efficiently.

a)Memory	 management	 mistakes	 can	 be	 overcome	 by	 garbage	 collection.	 Garbage	 collection	 is	 automatic	 de-
allocation	of	objects	which	are	no	longer	needed.

b)Mishandled	runtime	errors	are	resolved	by	Exception	Handling	procedures.
5)Secure:It	 provides	 a	 virtual	 firewall	 between	 the	 application	 and	 the	 computer.	 Java	 codes	 are	 confined	within	 Java

Runtime	Environment(JRE)thus	it	does	not	grant	unauthorized	access	on	the	system	resources.
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6)Java	 is	 distributed:Using	 java	 programming	 languagewecan	 create	 distributed	 applications.	 RMI	 (Remote	 Method
Invocation)	and	EJB	(Enterprise	Java	Beans)	are	used	for	creating	distributed	applications	in	java.	In	simple	words:	The
java	programs	can	be	distributed	on	more	than	one	systems	that	are	connected	to	each	other	using	internet	connection.
Objects	on	one	JVM	(java	virtual	machine)	can	execute	procedures	on	a	remote	JVM.

7)Multithreading:Java	supports	multithreading.	It	enables	a	program	to	perform	several	tasks	simultaneously.
8)Portable:	 As	 discussed	 above,	 java	 code	 that	 is	 written	 on	 one	machine	 can	 run	 on	 another	machine.	 The	 platform

independent	byte	code	can	be	carried	to	any	platform	for	execution	that	makes	java	code	portable.
1.2Java	Tools:

JDK	(Java	Development	Kit):JDK	contains	 JRE	along	with	various	development	 tools	 like	 Java	 libraries,	 Java	source	compilers,	 Java
debuggers,	bundling	and	deployment	tools	JRE	(Java	Runtime	Environment):	It	is	part	of	JDK	but	can	be	used	independently	to	run
any	byte	code	(compiled	java	program).	It	can	be	called	as	JVM	implementation.

JVM	(Java	Virtual	Machine):‘JVM’	is	software	that	can	be	ported	onto	various	hardware	platforms.	JVM	will	become	instance	of	JRE	at
run	time	of	java	program.	Byte	codes	are	the	machine	language	for	the	JVM.	Like	a	real	computing	machine,	JVM	has	an	instruction
set	 which	 manipulates	 various	 memory	 areas	 at	 run	 time.	 Thus	 for	 different	 hardware	 platforms	 one	 has	 corresponding
implementation	of	JVM	available	as	vendor	supplied	JREs.

Java	API	(Application	Programming	Interface):Set	of	classes’	written	using	 Java	programming	 language	which	runs	on	 JVM.	These
classes	will	help	programmers	by	providing	standard	methods	 like	reading	from	console,	writing	to	console,	saving	objects	 in	data
structure	etc.

1.3Popular	Java	Editors:
To	write	your	Java	programs,	you	will	need	a	text	editor.	There	are	even	more	sophisticated	IDEs	available	in	the	market.	But	for	now,
you	can	consider	one	of	the	following:

•Notepad:	On	Windows	machine	you	can	use	any	simple	text	editor
like	Notepad

•Netbeans:	Netbeans	is	a	Java	IDE	that	is	open-source	and	free
which	can	be
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downloaded	fromhttp://www.netbeans.org/index.html.
•Eclipse:Eclipseisalsoa	JavaIDEdevelopedbytheeclipse	open-sourcecommunity	and	can	be	downloaded	from
http://www.eclipse.org/.

1.4How	Java	Works:
Step	1:Create	a	source	document	using	any	editor	and	save	file	as	.java	(e.g.	abc.java)
Step	2:Compile	the	abc.java	file	using	“javac”	command.
Step	3:Byte	Code	(abc.class)	will	be	generated	on	disk.
Step	4:This	byte	code	can	run	on	any	platform	or	device	having	JVM	(java.exe	convert	byte	code	in	machine	language)

1.5First	Java	Program:

Let	us	look	at	a	simple	code	that	would	print	the	words	Hello	World.	public	class	MyFirstJavaProgram

{

/*	This	is	my	first	java	program.
*	This	will	print	‘Hello	World’	as	the	output

*/

public	static	void	main(String	[]args)	{	System.out.println(“Hello	World”);	//	prints	Hello	World
}

}

Let’s	look	at	how	to	save	the	file,	compile	and	run	the	program.	Please	follow	the	steps	given	below:
•Open	notepad	and	add	the	code	as	above.
•Save	the	file	as:	MyFirstJavaProgram.java.
•Open	a	command	prompt	window	and	go	to	the	directory	where	you	saved	the	class.	Assume	it’s	C:.
•Type	‘	javac	MyFirstJavaProgram.java	‘	and	press	enter	to	compile	your	code.	If	there	are	no	errors
in	your	code,	the	command	prompt	will	take	you	to	the	next	line

•Now,	type	‘java
MyFirstJavaProgram’	to	run	your
program.
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You	will	be	able	to	see	‘	Hello	World	‘	printed	on	the	window.	C	:	>	javac
MyFirstJavaProgram.java	C	:	>	java	MyFirstJavaProgram	Hello	World

1.6Java	Programming	Guidelines:
•Case	Sensitivity	-Java	is	case	sensitive,	which	means	identifier	Hello	and	hello	would	have	different	meaning	in	Java.
•Class	Names	-For	all	class	names	the	first	letter	should	be	in	Upper	Case.	If	several	words	are	used	to	form	a	name	of	the	class,
each	inner	word’s	first	letter	should	be	in	Upper	Case.

Example:	class	MyFirstJavaClass
•Method	Names	 -All	method	names	should	 start	with	a	Lower	Case	 letter.	 If	 several	words	are	used	 to	 form	 the	name	of	 the
method,	then	each	inner	word’s	first	letter	should	be	in	Upper	Case.

Example:	public	void	myMethodName()
•Program	File	Name	-Name	of	the	program	file	should	exactly	match	the	class	name.	When	saving	the	file,	you	should	save	it
using	the	class	name	(Remember	Java	is	case	sensitive)	and	append	‘.java’	to	the	end	of	the	name	(if	the	file	name	and	the	class
name	do	not	match	your	program	will	not	compile).

Example:	Assume	‘MyFirstJavaProgram’	is	the	class	name.	Then	the	file	should	be	saved	as	‘MyFirstJavaProgram.java’
•public	static	void	main(String	args[])	-	Java	program	processing	starts	from	the	main()	method	which	is	a	mandatory	part	of
every	Java	program.

2.	 Object	Oriented	Programming
A	 type	 of	 programming	 in	which	 programmers	 define	not	 only	 the	 data	 type	 of	 a	 data	 structure,	 but	 also	 the	 types	 of	 operations
(functions)	that	can	be	applied	to	the	data	structure.	In	this	way,	the	data	structure	becomes	an	object	that	includes	both	data	and
functions.	 In	 addition,	 programmers	 can	 create	 relationships	 between	 one	 object	 and	 another.	 For	 example,	 objects	 can	 inherit
characteristics	from	other	objects.
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One	of	the	principal	advantages	of	object-oriented	programming	 techniques	 over	 procedural	 programming	 techniques	 is	 that	 they
enable	programmers	to	create	modules	that	do	not	need	to	be	changed	when	a	new	type	of	object	is	added.	A	programmer	can	simply
create	a	new	object	that	inherits	many	of	its	features	from	existing	objects.	This	makes	object-oriented	programs	easier	to	modify.

.1What	is	Object?
Objects	 are	 key	 to	 understanding	 object-oriented	 technology.	 Look	 around	 right	 now	 and	 you’ll	 find	many	 examples	 of	 real-world
objects:	your	dog,	your	desk,	your	television	set,	your	bicycle.

Real-world	 objects	 share	 two	 characteristics:	 They	 all	 have	 state	 and	 behavior.	 Dogs	 have	 state	 (name,	 color,	 breed,	 hungry)	 and
behavior	(barking,	fetching,	wagging	tail).	Bicycles	also	have	state	(current	gear,	current	pedal	cadence,	current	speed)	and	behavior
(changing	gear,	changing	pedal	cadence,	applying	brakes).	Identifying	the	state	and	behavior	for	real-world	objects	is	a	great	way	to
begin	thinking	in	terms	of	object-oriented	programming.

Software	objects	are	conceptually	similar	to	real-world	objects:	they	too	consist	of	state	and	related	behavior.	An	object	stores	its	state
in	 fields	 (variables	 in	 some	 programming	 languages)	 and	 exposes	 its	 behavior	 through	methods	 (functions	 in	 some	 programming
languages).	Methods	operate	on	an	object’s	internal	state	and	serve	as	the	primary	mechanism	for	object-to-object	communication.
Hiding	internal	state	and	requiring	all	interaction	to	be	performed	through	an	object’s	methods	is	known	as	data	encapsulation	—	a
fundamental	principle	of	object-oriented	programming.

Object	is	a	bundle	of	related	variables	and	functions	(also	known	methods).	Objects	share	two	characteristics:
•State:	State	is	a	well	defined	condition	of	an	item.	A	state	captures	the	relevant
aspects	of	an	object

•Behavior:	Behavior	is	the	observable	effects	of	an
operation	or	event,

Examples:
1)Object:	House
State:	Current	Location,	Color,	Area	of	House	etc	Behavior:	Close/Open	main	door.
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2)Object:				Car	State:	Color,	Make
Behavior:	Climb	Uphill,	Accelerate,	SlowDown	etc

Everything	a	software	object	knows	(State)	and	can	do	(Behavior)	is	represented	by	variables	and	methods	(functions)	in	the	object
respectively.

Bundling	code	into	individual	software	objects	provides	a	number	of	benefits,	including:
•Modularity:	The	source	code	for	an	object	can	be	written	and	maintained	independently	of	the	source	code	for	other	objects.
Once	created,	an	object	can	be	easily	passed	around	inside	the	system.
•Information-hiding:By	interacting	only	with	an	object’s	methods,	the	details	of	its	internal	implementation	remain	hidden	from
the	outside	world.
•Code	 re-use:	 If	 an	 object	 already	 exists	 (perhaps	 written	 by	 another	 software	 developer),	 you	 can	 use	 that	 object	 in	 your
program.	This	allows	specialists	to	implement/test/debug	complex,	task-specific	objects,	which	you	can	then	trust	to	run	in	your
own	code.
•Pluggability	 and	 debugging	 ease:	 If	 a	 particular	 object	 turns	 out	 to	 be	 problematic,	 you	 can	 simply	 remove	 it	 from	 your
application	and	plug	in	a	different	object	as	its	replacement.	This	is	analogous	to	fixing	mechanical	problems	in	the	real	world.
If	a	bolt	breaks,	you	replace	it,	not	the	entire	machine.

.2What	is	Class?
In	the	real	world,	you’ll	often	find	many	individual	objects	all	of	the	same	kind.	There	may	be	thousands	of	other	bicycles	in	existence,
all	of	the	same	make	and	model.	Each	bicyclewasbuilt	from	the	same	set	of	blueprints	and	therefore	contains	the	same	components.
In	object-oriented	terms,	we	say	that	your	bicycle	is	an	instance	of	the	class	of	objects	known	as	bicycles.	A	class	is	the	blueprint	from
which	individual	objects	are	created.

The	following	Bicycle	class	is	one	possible	implementation	of	a	bicycle:	class	Bicycle	{
int	cadence	=	0;	int	speed	=	0;	int
gear	=	1;
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void	changeCadence(int	newValue)	{	cadence	=	newValue;

}

void	changeGear(int	newValue)	{	gear	=	newValue;

}

void	speedUp(int	increment)	{	speed	=	speed	+	increment;

}

void	applyBrakes(int	decrement)	{	speed	=	speed	-	decrement;

}

void	printStates()	{	System.out.println(“cadence:”	+
cadence	+	”	speed:”	+	speed	+	”	gear:”	+	gear);

}

}

The	syntax	of	the	Java	programming	language	will	look	new	to	you,	but	the	design	of	this	class	is	based	on	the	previous	discussion	of
bicycle	 objects.	 The	 fields	 cadence,	 speed,	 and	 gear	 represent	 the	 object’s	 state,	 and	 the	 methods	 (changeCadence,	 changeGear,
speedUp	etc.)	define	its	interaction	with	the	outside	world.

You	may	have	noticed	that	the	Bicycle	class	does	not	contain	a	main	method.	That’s	because	it’s	not	a	complete	application;	it’s	just
the	blueprint	for	bicycles	that	might	be	used	in	an	application.	The	responsibility	of	creating	and	using	new	Bicycle	objects	belongs	to
some	other	class	in	your	application.

Here’s	a	BicycleDemo	class	that	creates	two	separate	Bicycle	objects	and	invokes	their	methods:

class	BicycleDemo	{
public	static	void	main(String[]	args)	{
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//	Create	two	different
//	Bicycle	objects
Bicycle	bike1	=	new	Bicycle();	Bicycle	bike2	=	new
Bicycle();

//	Invoke	methods	on
//	those	objects	bike1.changeCadence(50);
bike1.speedUp(10);	bike1.changeGear(2);
bike1.printStates();	bike2.changeCadence(50);
bike2.speedUp(10);	bike2.changeGear(2);
bike2.changeCadence(40);	bike2.speedUp(10);
bike2.changeGear(3);	bike2.printStates();	}

}

The	output	of	this	test	prints	the	ending	pedal	cadence,	speed,	and	gear	for	the	two	bicycles:	cadence:50	speed:10	gear:2

cadence:40	speed:20	gear:3
.3Message	passing

A	single	object	by	 itself	may	not	be	very	useful.	An	application	contains	many	objects.	One	object	 interacts	with	another	object	by
invoking	 methods	 (or	 functions)	 on	 that	 object.	 Through	 the	 interaction	 of	 objects,	 programmers	 achieve	 a	 higher	 order	 of
functionality	which	has	complex	behavior.	One	object	 invoking	methods	on	another	object	 is	known	as	Message	passing.	 It	 is	also
referred	to	as	Method	Invocation.
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.4Object	Oriented	Programming	features:

	
.4.1Abstraction

The	purpose	of	abstraction	is	to	hide	information	that	is	not	relevant	or	rather	show	only	relevant	information	and	to	simplify	it	by
comparing	it	to	something	similar	in	the	real	world.	Abstraction	means	“The	process	of	forming	of	general	and	relevant	concept	from
more	complex	scenarios”.

.4.2Encapsulation
Encapsulation	means	the	localization	of	the	information	or	knowledge	within	an	object.	Encapsulation	is	also	called	as	“Information
Hiding”.

•Objects	encapsulate	data	and	implementation	details.	To	the	outside	world,	an	object	is	a	black	box	that	exhibits	a	certain
behavior.
•The	behavior	of	this	object	is	what	which	is	useful	for	the	external	world	or	other	objects.
•An	object	exposes	its	behavior	by	means	of	methods	or	functions.
•The	set	of	functions	an	object	exposes	to	other	objects	or	external	world	acts	as	the
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interface	of	the	object.
..3Inheritance

The	 process	 by	 which	 one	 class	 acquires	 the	 properties	 and	 functionalities	 of	 another	 class.	 Inheritance	 provides	 the	 idea	 of
reusability	of	code	and	each	sub	class	defines	only	those	features	that	are	unique	to	it.

•Inheritance	 is	 a	mechanism	 of	 defining	 a	 new	 class
based	on	an	existing	class.
•Inheritance	enables	reuse	of	code.	Inheritance	also
provides	scope	for	refinement	of	the	existing	class.
Inheritance	helps	in	specialization

•The	existing	(or	original)	class	is	called	the	base	class	or	super	class	or
parent	class.	The	new	class	which	inherits	from	the	base	class	is	called
the	derived	class	or	sub	class	or	child	class.

•Inheritance	implements	the	“Is-A”	or	“Kind	Of/	Has-A”
relationship.

The	biggest	advantage	of	Inheritance	is	that,	code	in	base	class	need	not	be	rewritten	in	the	derived	class.	The	member	variables	and
methods	of	the	base	class	can	be	used	in	the	derived	class	as	well.

Types	of	Inheritance:
1)Multilevel	Inheritance:	Multilevel	 inheritance	refers	to	a	mechanism	in	OO	technology	where	one	can	inherit	 from	a	derived	class,
thereby	making	this	derived	class	the	base	class	for	the	new	class.

2)Multiple	 Inheritance:	 “Multiple	 Inheritance”	 refers	 to	 the	 concept	 of	 one	 class	 inheriting	 from	 more	 than	 one	 base	 class.	 The
inheritancewelearnt	earlier	had	the	concept	of	one	base	class	or	parent.	The	problem	with	“multiple	inheritance”	is	that	the	derived
class	will	have	to	manage	the	dependency	on	two	base	classes.

Note:Multilevel	inheritance	is	allowed	in	Java	but	not	multiple	inheritance.
..4Polymorphism

Polymorphism	is	a	feature	that	allows	one	interface	to	be	used	for	a	general	class	of	actions.	It’s	an	operation	may	exhibit	different
behavior	in	different	instances.	The	behavior	depends	on	the	types	of	data	used	in	the	operation.	It	plays	an	important	role	in	allowing
objects	having	different	internal	structures	to	share	the	same	external	interface.	Polymorphism	is	extensively	used	in	implementing
inheritance.
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Types	of	Polymorphism:
1)Static	Polymorphism:

•Function	Overloading	–	within	same	class	more	than	one	method	having	same	name	but	differing	in	signature.
•Resolved	during	compilation	time.
•Return	type	is	not	part	of	method	signature.

2)Dynamic	Polymorphism:
•Function	Overriding	–	keeping	the	signature	and	return	type	same,	method	in	the	Base	class	is	redefined	in	the
derived	class.
•Resolved	during	run	time.
•Which	method	to	be	invoked	is	decided	by	the	object	that	the	reference	points	to	and	not	by	the	type	of	the
reference.

3.	 Java	Language	Elements
When	we	consider	a	Java	program	it	can	be	defined	as	a	collection	of	objects	that	communicate	via	invoking	each	other’s	methods.	Let
us	now	briefly	look	into	what	do	class,	object,	methods	and	instance	variables	mean.

1)Object	-Objects	have	states	and	behaviors.	Example:	A	dog	has	states	-	color,	name,	breed	as	well	as	behaviors	-wagging,
barking,	eating.	An	object	is	an	instance	of	a	class.

2)Class	-	A	class	can	be	defined	as	a	template/	blue	print	that	describes	the	behaviors/states	that	object	of	its	type	support.
3)Methods	-	A	method	is	basically	a	behavior.	A	class	can	contain	many	methods.	It	is	in	methods	where	the	logics	are	written,
data	is	manipulated	and	all	the	actions	are	executed.

4)Instance	Variables	-	Each	object	has	its	unique	set	of	instance	variables.	An	object’s	state	is	created	by	the	values	assigned	to
these	instance	variables.

3.1	Java	Keywords:
The	following	list	shows	the	reserved	words	in	Java.	These	reserved	words	may	not	be	used	as	constant	or	variable	or	any	other
identifier	names.
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abstract assert boolean break

byte case catch char

class const continue default

do double else enum

extends final finally float

for goto if implements

import instanceof int interface

long native new package

private protected public return

short static strictfp super

switch synchronized this throw

throws transient try void

volatile while
3.2	Java	Identifiers:
All	Java	components	require	names.	Names	used	for	classes,	variables	and	methods	are	called	identifiers.	In	Java,	there	are	several
points	to	remember	about	identifiers.	They	are	as	follows:

1)All	identifiers	should	begin	with	a	letter	(A	to	Z	or	a	to	z),	currency	character	($)	or	an	underscore	(_).
2)After	the	first	character	identifiers	can	have	any	combination	of	characters.
3)A	key	word	cannot	be	used	as	an	identifier.
4)Most	importantly	identifiers	are	case	sensitive.
Examples:

age,	$salary,	value,	1_value (legal
identifiers)

	
3.3

123abc,	-salary
Java	Datatypes:

(illegal
identifiers)

There	are	two	data	types	available	in	Java:
1)Primitive	Data	Types2)Reference/Object	Data	Types
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..1Primitive	Data	Types:
There	are	eight	primitive	data	types	supported	by	Java.	Primitive	data	types	are	predefined	by	the	language	and	named	by	a	keyword.
Let	us	now	look	into	detail	about	the	eight	primitive	data	types.

Data	type Size Range Example

byte 8-bit -128	to	127
(-28to	28-1)

byte	a	=
100	byte	b
=	-50

short 16-bit -32,768	to	32,767
(-216to	216-1)

short	s	=
10000	short	r
=	-20000



int 32-bit -2,147,483,648	to
2,147,483,647
(-231to	231-1)

int	a	=
100000	int	b
=	-200000

long 64-bit -9,223,372,036,854,775,808
to
9,223,372,036,854,775,807
(-264to	264-1)

long	a	=
100000L	int	b	=
-200000L

float 32-bit 3.4e-038	to	3.4e+038 float	f1	=
234.5f

double 64-bit 1.7e-308	to	1.7e+308 double	d1	=
123.4

char 16-bit 0	to	65,535 Char	ch	=	‘A’
boolean 1-bit True/False boolean	one	=

true
..2Reference	Data	Types:

Reference	 variables	 are	 created	 using	 defined	 constructors	 of	 the	 classes.	 They	 are	 used	 to	 access	 objects.	 These	 variables	 are
declared	to	be	of	a	specific	type	that	cannot	be	changed.	For	example,	Employee,	Puppy	etc.

•Class	objects,	and	various	type	of	array	variables	come	under	reference	data	type.
•Default	value	of	any	reference	variable	is	null.
•A	reference	variable	can	be	used	to	refer	to	any	object	of	the	declared	type	or	any	compatible	type.
•Example:	Animal	animal	=	new	Animal(“giraffe”);
.3Java	Literals:

A	literal	is	a	source	code	representation	of	a	fixed	value.	They	are	represented	directly	in	the	code	without	any	computation.	Literals
can	be	assigned	to	any	primitive	type	variable.	For	example:
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byte	a	=	68;	char	a	=	‘A’

byte,	int,	long,	and	short	can	be	expressed	in	decimal(base	10),	hexadecimal(base	16)	or	octal(base	8)	number	systems	as	well.

Prefix	0	is	used	to	indicate	octal	and	prefix	0x	indicates	hexadecimal	when	using	these	number	systems	for	literals.	For	example:	int
decimal	=	100;	int	octal	=	0144;	int	hexa	=	0x64;

String	literals	in	Java	are	specified	like	they	are	in	most	other	languages	by	enclosing	a	sequence	of	characters	between	a	pair	of
double	quotes.	Examples	of	string	literals	are:	“Hello	World”	“two\nlines”

“"This	is	in	quotes"”

String	and	char	types	of	literals	can	contain	any	Unicode	characters.	For	example:	char	a	=	‘\u0001’;	String	a	=

“\u0001”;

Java	language	supports	few	special	escape	sequences	for	String	and	char	literals	as	well.	They	are:

Notation Character	represented
\n Newline	(0x0a)
\r Carriage	return	(0x0d)
\f Formfeed	(0x0c)

\b Backspace	(0x08)

\s Space	(0x20)
\t tab
" Double	quote
' Single	quote

\
backslash

\ddd Octal	character	(ddd)
\uxxxx Hexadecimal	UNICODE	character	(xxxx)
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.4Java	Variables:
Variablesare	nothing	but	reserved	memory	 locations	 to	store	values.	This	means	 that	when	you	create	a	variable	you	reserve	some
space	in	memory.	Based	on	the	data	type	of	a	variable,	the	operating	system	allocates	memory	and	decides	what	can	be	stored	in	the
reserved	memory.	Therefore,	by	assigning	different	data	types	to	variables,	you	can	store	integers,	decimals,	or	characters	in	these
variables.

A	 variable	 provides	 us	 with	 named	 storage	 that	 our	 programs	 can	 manipulate.	 Each	 variable	 in	 Java	 has	 a	 specific	 type,	 which
determines	the	size	and	layout	of	the	variable’s	memory;	the	range	of	values	that	can	be	stored	within	that	memory;	and	the	set	of
operations	that	can	be	applied	to	the	variable.

You	must	declare	all	variables	before	they	can	be	used.	The	basic	form	of	a	variable	declaration	is	shown	here:	data	type	variable	[	=
value][,	variable	[=	value]	…]	;
Here	data	type	is	one	of	Java’s	datatypes	and	variable	is	the	name	of	the	variable.	To	declare	more	than	one	variable	of	the	specified
type,	you	can	use	a	comma-separated	list.

Following	are	valid	examples	of	variable	declaration	and	initialization	in	Java:
int	a,	b,	c;	//	Declares	three	ints,	a,	b,	and	c.int	a	=	10,	b	=	10;	//	Example	of
initialization	byte	B	=	22;	//	initializes	a	byte	type	variable	B.double	pi	=	3.14159;	//
declares	and	assigns	a	value	of	PI.
char	a	=	‘a’;	//	the	char	variable	a	iis	initialized	with	value	‘a’There	are	three	kinds	of	variables	in	Java:

1)Local	variables2)Instance	variables3)Class/static	variables
3.5.1	Local	variables:
Local	variables	are	declared	in	methods,	constructors,	or	blocks.	Local	variables	are	created	when	the	method,	constructor	or	block	is
entered	and	the	variable	will	be	destroyed	once	it	exits	the	method,	constructor	or	block.	Access	modifiers	cannot	be	used	for	local
variables.	Local	variables	are	visible	only	within	the	declared	method,	constructor	or	block.	Local	116



variables	are	implemented	at	stack	level	internally.	There	is	no	default	value	for	local	variables	so	local	variables	should	be	declared
and	an	initial	value	should	be	assigned	before	the	first	use.

Example:
Here,	age	is	a	local	variable.	This	is	defined	inside	pupAge()	method	and	its	scope	is	limited	to	this	method	only.

public	class	Test{
public	void	pupAge(){	int	age	=	0;

age	=	age	+	7;
System.out.println(“Puppy	age	is	:	”	+	age);

}

public	static	void	main(String	args[]){	Test	test	=	new	Test();
test.pupAge();

}

}

This	would	produce	the	following	result:	Puppy	age	is:	7
Example:
Following	example	uses	age	without	initializing	it,	so	it	would	give	an	error	at	the	time	of	compilation.

public	class	Test{
public	void	pupAge(){	int	age;

age	=	age	+	7;
System.out.println(“Puppy	age	is	:	”	+	age);

}

public	static	void	main(String	args[]){	Test	test	=	new	Test();
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test.pupAge();

}

}

This	would	produce	the	following	error	while	compiling	it:
Test.java:4:variable	number	might	not	have	been	initialized	age	=	age	+	7;

^	1	error

3.5.2	Instance	variables:
Instance	variables	are	declared	in	a	class,	but	outside	a	method,	constructor	or	any	block.	When	a	space	is	allocated	for	an	object	in
the	heap,	a	slot	for	each	instance	variable	value	is	created.	Instance	variables	are	created	when	an	object	is	created	with	the	use	of
the	keyword	‘new’	and	destroyed	when	the	object	is	destroyed.	Instance	variables	hold	values	that	must	be	referenced	by	more	than
one	method,	constructor	or	block,	or	essential	parts	of	an	object’s	state	that	must	be	present	throughout	the	class.	Instance	variables
can	be	declared	in	class	level	before	or	after	use.	Access	modifiers	can	be	given	for	instance	variables.

The	instance	variables	are	visible	for	all	methods,	constructors	and	block	in	the	class.	Normally,	 it	 is	recommended	to	make	these
variables	private	(access	level).	However	visibility	for	subclasses	can	be	given	for	these	variables	with	the	use	of	access	modifiers.

Instance	variables	have	default	values.	For	numbers	the	default	value	is	0,	for	Booleans	it	is	false	and	for	object	references	it	is	null.
Values	can	be	assigned	during	the	declaration	or	within	the	constructor.

Instance	variables	can	be	accessed	directly	by	calling	the	variable	name	inside	the	class.	However	within	static	methods	and	different
class	(when	instance	variables	are	given	accessibility)	should	be	called	using	the	fully	qualified	name.

ObjectReference.VariableName
Example:
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import	java.io.*;
public	class	Employee{

//	this	instance	variable	is	visible	for	any	child	class.	public	String	name;

//	salary	variable	is	visible	in	Employee	class	only.	private	double	salary;

//	The	name	variable	is	assigned	in	the	constructor.	public	Employee	(String	empName){
name	=	empName;

}

//	The	salary	variable	is	assigned	a	value.	public	void	setSalary(double	empSal){
salary	=	empSal;

}

//	This	method	prints	the	employee	details.	public	void	printEmp(){
System.out.println(“name	:	”	+	name	);	System.out.println(“salary	:”	+	salary);

}

public	static	void	main(String	args[]){
Employee	empOne	=	new	Employee(“Ajay”);	empOne.setSalary(5000);
empOne.printEmp();

}

}

This	would	produce	the	following	result:	name		:	Ajay

salary	:5000.0
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.5Comments	in	Java:
Java	supports	single-line	and	multiline	comments	very	similar	to	c	and	c++.	All	characters	available	inside	any	comment	are	ignored
by	Java	compiler.

public	class	MyFirstJavaProgram{
/*	This	is	my	first	java	program.
*This	will	print	‘Hello	World’	as	the	output*This	is	an	example	of	multiline	comments.

*/

public	static	void	main(String	[]args){
//	This	is	an	example	of	single	line	comment
/*	This	is	also	an	example	of	single	line	comment.	*/	System.out.println(“Hello
World”);

}

}

.6Using	Blank	Lines:
A	line	containing	only	whitespace,	possibly	with	a	comment,	is	known	as	a	blank	line,	and	Java	totally	ignores	it.

4.	 Java	Operators
Java	provides	a	rich	set	of	operators	to	manipulate	variables.	We	can	divide	all	the	Java	operators	into	the	following	groups:

•Arithmetic	Operators•Relational	Operators•Bitwise	Operators•Logical	Operators•Assignment	Operators•Conditional	Operators
4.1The	Arithmetic	Operators:

Arithmetic	operators	are	used	in	mathematical	expressions	in	the	same	way	that	they	are	used	in	algebra.	The	following	table	lists	the
arithmetic	operators:
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Assume	integer	variable	A	holds	10	and	variable	B	holds	20,	then:

Operator Description Example

+
Addition	-	Adds	values	on	either	side	of	the	operator A	+	B	will	give

30

-
Subtraction	-	Subtracts	right	hand
operand	from	left	hand	operand

A	-	B	will	give
-10

*
Multiplication	-	Multiplies	values	on	either
side	of	the	operator

A	*	B	will	give
200

/
Division	-	Divides	left	hand	operand	by	right	hand
operand

B	/	A	will	give	2

%
Modulus	-	Divides	left	hand	operand	by	right
hand	operand	and	returns	remainder

B	%	A	will	give
0

++
Increment	-	Increases	the	value	of	operand	by	1 B++	gives	21

—
Decrement	-	Decreases	the	value	of	operand	by	1 B—	gives	19

4.2	The	Relational	Operators:
There	are	following	relational	operators	supported	by	Java	language	Assume	variable	A	holds	10	and	variable
B	holds	20,	then:

Operator Description Example

==
Checks	if	the	values	of	two	operands	are	equal
or	not,	if	yes	then	condition	becomes	true.

(A	==	B)	is
not	true.

!=
Checks	if	the	values	of	two	operands	are	equal
or	not,	if	values	are	not	equal	then	condition
becomes	true.

(A	!=	B)	is
true.

> Checks	if	the	value	of	left	operand	is	greater	than
the	value	of	right	operand,	if	yes	then	condition
becomes	true.

(A	>	B)	is
not	true.

< Checks	if	the	value	of	left	operand	is	less	than	the
value	of	right	operand,	if	yes	then	condition
becomes	true.

(A	<	B)	is	true.

>= Checks	if	the	value	of	left	operand	is	greater	than	or
equal	to	the	value	of	right	operand,	if	yes	then
condition	becomes	true

(A	>=	B)	is	not
.	true.

<= Checks	if	the	value	of	left	operand	is	less	than	or
equal	to	the	value	of	right	operand,	if	yes	then
condition	becomes	true.

(A	<=	B)	is
true.
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4.3	The	Bitwise	Operators:
Java	defines	several	bitwise	operators,	which	can	be	applied	to	the	integer	types,	long,	int,	short,	char,	and	byte.	Bitwise	operator
works	on	bits	and	performs	bit-by-bit	operation.

Assume	if	a	=	60;	and	b	=	13;	now	in	binary	format	they	will	be	as	follows:	a	=	0011	1100
b	=	0000	1101
–––––—	a&b	=	0000	1100
a|b	=	0011	1101
a^b	=	0011	0001
~a		=	1100	0011
The	following	table	lists	the	bitwise	operators:
Assume	integer	variable	A	holds	60	and	variable	B	holds	13	then:

	

Operator Description Example
& Binary	AND	Operator	copies	a	bit	to	the	result	if

it	exists	in	both	operands.
(A	&	B)	will	give
12	which	is	0000
1100

|
Binary	OR	Operator	copies	a	bit	if	it	exists
in	either	operand.

(A	|	B)	will	give	61
which	is	0011
1101

^
Binary	XOR	Operator	copies	the	bit	if	it	is
set	in	one	operand	but	not	both.

(A	^	B)	will	give
49	which	is	0011
0001

~
Binary	Ones	Complement	Operator	is	unary	and
has	the	effect	of	‘flipping’	bits.

(~A	)	will	give	-61
which	is	1100
0011	in	2’s
complement	form
due	to	a	signed
binary	number.

<< Binary	Left	Shift	Operator.	The	left	operands
value	is	moved	left	by	the	number	of	bits
specified	by	the	right	operand.

A	<<	2	will	give
240
which	is	1111
0000
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>> Binary	Right	Shift	Operator.	The	left	operands
value	is	moved	right	by	the	number	of	bits
specified	by	the	right	operand.

A	>>	2	will	give
15
which	is	1111

>>> Shift	right	zero	fill	operator.	The	left	operands
value	is	moved	right	by	the	number	of	bits
specified	by	the	right	operand	and	shifted	values
are	filled	up	with	zeros.

A	>>	2	will	give
15
which	is	0000
1111

	
.4The	Logical	Operators:

The	following	table	lists	the	logical	operators:
Assume	Boolean	variables	A	holds	true	and	variable	B	holds	false,	then

Operator Description Example
&& Called	Logical	AND	operator.	If	both	the

operands	are	non-zero,	then	the	condition
becomes	true.

(A	&&	B)	is	false.

||
Called	Logical	OR	Operator.	If	any	of	the	two
operands	are	non-zero,	then	the	condition
becomes	true.

(A	||	B)	is	true.

! Called	Logical	NOT	Operator.	Use	to	reverses	the
logical	state	of	its	operand.	If	a	condition	is	true
then	Logical	NOT	operator	will	make	false.

!(A	&&	B)	is	true.

.5The	Assignment	Operators:
There	are	following	assignment	operators	supported	by	Java	language:

Operator Description Example

=
Simple	assignment	operator,	Assigns	values	from
right	side	operands	to	left	side	operand

C	=	A	+	B	will
assign	value	of	A	+
B	into	C



+=
Add	AND	assignment	operator,	It	adds	right
operand	to	the	left	operand	and	assign	the	result
to	left	operand

C	+=	A	is
equivalent	to	C	=
C	+	A

-=
Subtract	AND	assignment	operator,	It
subtracts	right	operand	from	the	left	operand
and	assign	the	result	to	left	operand

C	-=	A	is
equivalent	to	C	=
C	-	A

*=
Multiply	AND	assignment	operator,	It	multiplies
right	operand	with	the	left	operand	and	assign
the	result	to	left	operand

C	=	A	is
equivalent	to	C	=
C	A
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/=
Divide	AND	assignment	operator,	It	divides	left
operand	with	the	right	operand	and	assign	the
result	to	left	operand

C	/=	A	is
equivalent	to	C	=
C	/	A

%=
Modulus	AND	assignment	operator,	It	takes
modulus	using	two	operands	and	assign	the
result	to	left	operand

C	%=	A	is
equivalent	to	C	=
C	%	A

<<= Left	shift	AND	assignment	operator C	<<=	2	is
same	as	C	=	C
<<	2

>>= Right	shift	AND	assignment	operator C	>>=	2	is
same	as	C	=	C
>>	2

&= Bitwise	AND	assignment	operator C	&=	2	is
same	as	C	=	C
&	2

^=
bitwise	exclusive	OR	and	assignment	operator C	^=	2	is

same	asC	=	C
^	2

|=
bitwise	inclusive	OR	and	assignment	operator C	|=	2	is	same

as	C	=	C	|	2

Conditional	operator	is	also	known	as	the	ternary	operator.	This	operator	consists	of	three	operands	and	is	used	to	evaluate	Boolean
expressions.	The	goal	of	the	operator	is	to	decide	which	value	should	be	assigned	to	the	variable.	The	operator	is	written	as:	variable
x	=	(expression)	?	value	if	true	:	value	if	false	Following	is	the	example:
public	class	Test	{

public	static	void	main(String	args[]){	int	a	,	b;
a	=	10;
b	=	(a	==	1)	?	20:	30;
System.out.println(	“Value	of	b	is	:	”	+		b	);
b	=	(a	==	10)	?	20:	30;
System.out.println(	“Value	of	b	is	:	”	+	b	);

}

}
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This	would	produce	the	following	result:
Value	of	b	is	:	30	Value	of	b	is	:	20

4.7				Precedence	of	Java	Operators:
Operator	 precedence	 determines	 the	 grouping	 of	 terms	 in	 an	 expression.	 This	 affects	 how	 an	 expression	 is	 evaluated.	 Certain
operators	have	higher	precedence	 than	others;	 for	 example,	 the	multiplication	operator	has	higher	precedence	 than	 the	addition
operator:	For	example,	x	=	7	+	3	2;	here	x	 is	assigned	13,	not	20	because	operator	has	higher	precedence	than	+,	so	 it	 first	gets
multiplied	with	3*2	and	then	adds	into	7.

Here,	operators	with	the	highest	precedence	appear	at	the	top	of	the	table,	those	with	the	lowest	appear	at	the	bottom.	Within	an
expression,	higher	precedence	operators	will	be	evaluated	first.

	

Category Operator Associativity

Postfix ()	[]	.	(dot	operator) Left	to	right

Unary
++	-	-	!	~

Right	to	left

Multiplicative
*	/	%

Left	to	right

Additive
+	-

Left	to	right

Shift >>	>>>	<< Left	to	right

Relational >	>=	<	<= Left	to	right

Equality
==	!=

Left	to	right

Bitwise	AND & Left	to	right

Bitwise	XOR
^

Left	to	right

Bitwise	OR
|

Left	to	right

Logical	AND && Left	to	right

Logical	OR
||

Left	to	right

Conditional
?:

Right	to	left

Assignment =	+=	-=	*=	/=	%=	>>=	<<=	&=	^=	|= Right	to	left

Comma , Left	to	right
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This	would	produce	the	following	result:
5.	 Control	Flow

In	java,	control	flow	is	managed	by	following	two	types	of	statements:
1)Decision	Making	Statements2)Loop	Control	Statements

5.1Decision	Making	Statements
There	are	two	types	of	decision	making	statements	in	Java.	They	are:

1)if	statements2)switch	statements
5.1.1	The	if	Statement:
An	if	statement	consists	of	a	Boolean	expression	followed	by	one	or	more	statements.
Syntax:
if(Boolean_expression)

{

//Statements	will	execute	if	the	Boolean	expression	is	true

}

If	the	Boolean	expression	evaluates	to	true	then	the	block	of	code	inside	the	if	statement	will	be	executed.	If	not	the	first	set	of	code
after	the	end	of	the	if	statement	(after	the	closing	curly	brace)	will	be	executed.

Example:
public	class	Test	{

public	static	void	main(String	args[]){	int	x	=	10,	y=20;

if(	x	<	y	){
System.out.print(“x	is	less	than	y”);

}

}

}
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This	would	produce	the	following	result:	x	is	less	than	y
..2The	if…else	Statement:

An	if	statement	can	be	followed	by	an	optional	else	statement,	which	executes	when	the	Boolean	expression	is	false.

Syntax:
if(Boolean_expression){

//Executes	when	the	Boolean	expression	is	true
}else{

//Executes	when	the	Boolean	expression	is	false

}

Example:
public	class	Test	{

public	static	void	main(String	args[]){	int	x	=	20,	y	=	10;

if(	x	<	y	){
System.out.print(“x	is	less	than	y”);

}else{
System.out.print(“x	is	not	less	than	y”);

}

}

}

This	would	produce	the	following	result:	x	is	not	less	than	y
Example	Program:
//	Java	Program	to	check	Even	or	Odd	number	import	java.util.Scanner;
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class	CheckEvenOdd

{

public	static	void	main(String	args[])

{

int	num;
System.out.println(“Enter	an	Integer	number:”);
//The	input	provided	by	user	is	stored	in	num	Scanner	input	=	new
Scanner(System.in);	num	=	input.nextInt();	/*	If	number	is	divisible	by	2
then	it’s	an	even	number
else	odd	number/	if	(	num	%	2	==	0	)

System.out.println(“Entered	number	is	even”);



else

}

}

System.out.println(“Entered	number	is	odd”);
Output	1:
Enter	an	Integer	number:	78
Entered	number	is	even
Output	2:
Enter	an	Integer	number:	77
Entered	number	is	odd

..3The	if…else	if…else	Statement:
An	if	statement	can	be	followed	by	an	optional	else	if…else	statement,	which	is	very	useful	to	test	various	conditions	using	single	if…
else	if	statement.	When	using	if,	else	if,	else	statements	there	are	few	points	to	keep	in	mind.	An	if	can	have	zero	or	one	else’s	and	it
must	come	after	any	else	if’s.	An	if	can	have	zero	to	many	else	if’s	and	they	must	come	before	the	else.	Once	an	else	if	succeeds,	none
of	the	remaining	else	if’s	or	else’s	will	be	tested.
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Syntax:
if(Boolean_expression	1){

//Executes	when	the	Boolean	expression	1	is	true
}else	if(Boolean_expression	2){

//Executes	when	the	Boolean	expression	2	is	true
}else	if(Boolean_expression	3){

//Executes	when	the	Boolean	expression	3	is	true
}else	{

//Executes	when	the	none	of	the	above	condition	is	true.

}

Example:
public	class	Test	{

public	static	void	main(String	args[]){	int	x	=	30;
if(	x	==	10	){

System.out.print(“Value	of	X	is	10”);
}else	if(	x	==	20	){

System.out.print(“Value	of	X	is	20”);
}else	if(	x	==	30	){

System.out.print(“Value	of	X	is	30”);
}else{

System.out.print(“This	is	else	statement”);

}

}

}

This	would	produce	the	following	result:Value	of	X	is	30
Example	Program:
//	Java	Program	to	find	largest	of	three	numbers	using	if	…	else	if	import	java.util.Scanner;
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class	LargestOfThreeNumbers

{

public	static	void	main(String	args[])

{

int	x,	y,	z;
System.out.println(“Enter	three	integers	“);	Scanner	in	=	new
Scanner(System.in);

x			=			in.nextInt();	y			=			in.nextInt();	z	=	
in.nextInt();

if	(	x	>	y	&&	x	>	z	)
System.out.println(“First	number	is	largest.”);	else	if	(	y	>	x	&&	y	>	z	)
System.out.println(“Second	number	is	largest.”);	else	if	(	z	>	x	&&	z	>	y	)
System.out.println(“Third	number	is	largest.”);



else

}

}

System.out.println(“Entered	numbers	are	not	distinct.”);
Output:
Enter	three	integers	10	30	20
Second	number	is	largest.
5.1.4	Nested	if…else	Statement:
It	is	always	legal	to	nest	if-else	statements	which	means	you	can	use	one	if	or	else	if	statement	inside	another	if	or	else	if	statement.

Syntax:
if(Boolean_expression	1){

//Executes	when	the	Boolean	expression	1	is	true	if(Boolean_expression	2){
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//Executes	when	the	Boolean	expression	2	is	true

}

}

You	can	nest	else	if…else	in	the	similar	way	as	we	have	nested	if	statement.
Example:
public	class	Test	{

public	static	void	main(String	args[]){	int	x	=	10;
int	y	=	20;

if(	x	==	10	){
if(	y	==	20	){

System.out.print(“X	=	10	and	Y	=	20”);

}

}

}

}

This	would	produce	the	following	result:	X	=	10	and	Y	=	20
//	Java	Program	to	find	largest	of	three	numbers	using	nested	if	import	java.util.Scanner;

class	LargestOfThreeNumbers

{

public	static	void	main(String	args[])

{

int	x,	y,	z;
System.out.println(“Enter	three	integers	“);	Scanner	in	=	new
Scanner(System.in);

x	 =	 in.nextInt();	 y	 =	 in.nextInt();	 z	 =
in.nextInt();
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if	(	x	>	y	)

{

If(	x	>	z	)
System.out.println(“First	number	is	largest.”);

}

else

{

else

System.out.println(“Third	number	is	largest.”);



If(	y	>	z	)
System.out.println(“Second	number	is	largest.”);



else

}

}

}

System.out.println(“Third	number	is	largest.”);
Output:
Enter	three	integers	10	30	20
Second	number	is	largest.
5.1.5	The	switch	Statement:
A	switch	statement	allows	a	variable	to	be	tested	for	equality	against	a	list	of	values.	Each	value	is	called	a	case,	and	the	variable	being
switched	on	is	checked	for	each	case.

Syntax:
switch(expression){	case	value	:

//Statements	break;	//optional
case	value	:

//Statements	break;	//optional
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//You	can	have	any	number	of	case	statements.	default	:	//Optional
//Statements

}

The	following	rules	apply	to	a	switch	statement:
1)The	variable	used	in	a	switch	statement	can	only	be	a	byte,	short,	int,	or	char.
2)You	can	have	any	number	of	case	statements	within	a	switch.	Each	case	is	followed	by	the	value	to	be	compared	to	and	a	colon.
3)The	value	for	a	case	must	be	the	same	data	type	as	the	variable	in	the	switch	and	it	must	be	a	constant	or	a	literal.
4)When	the	variable	being	switched	on	is	equal	to	a	case,	the	statements	following	that	case	will	execute	until	a	break	statement
is	reached.

5)When	a	break	statement	is	reached,	the	switch	terminates,	and	the	flow	of	control	jumps	to	the	next	line	following	the	switch
statement.

6)Not	every	case	needs	to	contain	a	break.	If	no	break	appears,	the	flow	of	control	will	fall	through	to	subsequent	cases	until	a
break	is	reached.

7)A	switch	statement	can	have	an	optional	default	case,	which	must	appear	at	 the	end	of	 the	switch.	The	default	case	can	be
used	for	performing	a	task	when	none	of	the	cases	is	true.	No	break	is	needed	in	the	default	case.

Example:
public	class	Test	{

public	static	void	main(String	args[]){
//char	grade	=	args[0].charAt(0);	char	grade	=	‘C’;

switch(grade)

{

case	‘A’	:
System.out.println(“Excellent!”);	break;

133



case	‘B’	:
case	‘C’	:

System.out.println(“Well	done”);break;
case	‘D’	:

System.out.println(“You	passed”);	case	‘F’	:
System.out.println(“Better	try	again”);	break;

default	:
System.out.println(“Invalid	grade”);

}

System.out.println(“Your	grade	is	”	+	grade);

}

}

Compile	and	run	above	program	using	various	command	line	arguments.	This	would	produce	the	following	result:	WelldoneYour	grade
is	a	C
Program	Example:
//	Java	Program	to	print	the	day	import	java.util.Scanner;

class	CheckDay

{

public	static	void	main(String	args[])

{

int	n;
System.out.println(“Enter	the	number:”);
//The	input	provided	by	user	is	stored	in	n	Scanner	input	=	new
Scanner(System.in);	n	=	input.nextInt();
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switch(n)

{

case	1	:	System.out.println(“MONDAY”);break;
case	2	:	System.out.println(“TUESDAY”);break;
case	3	:	System.out.println(“WEDNESDAY”);break;
case	4	:	System.out.println(“THURSDAY”);break;
case	5	:	System.out.println(“FRIDAY”);break;
case	6	:	System.out.println(“SATURDAY”);break;
case	7	:	System.out.println(“SUNDAY”);break;



default:

}

}

}

System.out.println(“WRONG	ENTRY”);
Output	1:
Enter	the	number:	3
WEDNESDAY
Output	2:
Enter	the	number:	8
WRONG	ENTRY

6.	 Array
Java	provides	a	data	structure,	the	array,	which	stores	a	fixed-size	sequential	collection	of	elements	of	the	same	type.	An	array	is	used
to	store	a	collection	of	data,	but	it	is	often	more
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useful	to	think	of	an	array	as	a	collection	of	variables	of	the	same	type.
Instead	 of	 declaring	 individual	 variables,	 such	 as	 number0,	 number1,	 …,	 and	 number99,	 you	 declare	 one	 array	 variable	 such	 as
numbers	and	use	numbers[0],	numbers[1],	and	…,	numbers[99]	to	represent	individual	variables.

.1Declaring	Array	Variables:
To	use	an	array	in	a	program,	you	must	declare	a	variable	to	reference	the	array,	and	you	must	specify	the	type	of	array	the	variable
can	reference.	Here	is	the	syntax	for	declaring	an	array	variable:	dataType[]	arrayRefVar;	//	preferred	way.	or
dataType	arrayRefVar[];	//	works	but	not	preferred	way.
Example:
The	following	code	snippets	are	examples	of	this	syntax:	double[]	myList;	//	preferred
way.
or
double	myList[];						//		works	but	not	preferred	way.

.2Creating	Arrays:
You	can	create	an	array	by	using	the	new	operator	with	the	following	syntax:	arrayRefVar	=	new
dataType[arraySize];	The	above	statement	does	two	things:

1)It	creates	an	array	using	new	dataType[arraySize];
2)It	assigns	the	reference	of	the	newly	created	array	to	the	variable	arrayRefVar.

Declaring	an	array	variable,	creating	an	array,	and	assigning	the	reference	of	the	array	to	the	variable	can	be	combined	in	one
statement,	as	shown	below:	dataType[]	arrayRefVar	=	new	dataType[arraySize];
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Alternatively	you	can	create	arrays	as	follows:	dataType[]	arrayRefVar	=	{value0,
value1,	…,	valuek};	The	array	elements	are	accessed	through	the	index.	Array
indices	are	0-based;	that	is,	they	start	from	0	to	arrayRefVar.length-1.

Example:
Following	statement	declares	an	array	variable,	myList,	creates	an	array	of	10	elements	of	double	type	and	assigns	its	reference	to
myList:	double[]	myList	=	new	double[10];
Example	Program:
This	program	uses	linear	search	algorithm	to	find	out	a	number	among	all	other	numbers	entered	by	user.

/*	Program:	Linear	Search	Example
*Written	by:	Chaitanya	from
beginnersbook.com

*Input:	Number	of	elements,	element’s
values,	value	to	be	searched

*Output:Position	of	the	number	input	by	user	among	other
numbers*/	import	java.util.Scanner;

class	LinearSearchExample

{

public	static	void	main(String	args[])

{

int	counter,	num,	item,	array[];
//To	capture	user	input
Scanner	input	=	new	Scanner(System.in);	System.out.println(“Enter	number	of
elements:”);	num	=	input.nextInt();	//Creating	array	to	store	the	all	the	numbers
array	=	new	int[num];	System.out.println(“Enter	”	+	num	+	”	integers”);	//Loop		
to		store		each		numbers		in		array	for	(counter	=	0;	counter	<	num;	counter++)	
array[counter]	=	input.nextInt();
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System.out.println(“Enter	the	search	value:”);	item	=	input.nextInt();

for	(counter	=	0;	counter	<	num;	counter++)

{

if	(array[counter]	==	item)

{

System.out.println(item+”	is	present	at	location	”	+(counter+1));
/*Item	is	found	so	to	stop	the	search	and	to	come	out	of	the

loop	use	break	statement./	break;

}

}

if	(counter	==	num)
System.out.println(item	+	”	doesn’t	exist	in	array.”);

}

}

Output	1:
Enter	number	of	elements:	6
Enter	6	integers
22
33
45
1
3
99
Enter	the	search	value:	45
45	is	present	at	location	3
Output	2:
Enter	number	of	elements:	4
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Enter	4	integers
11
22
4
5
Enter	the	search	value:	99
99	doesn’t	exist	in	array.

7.	 Class	Design
Java	is	an	Object-Oriented	Language.	In	object-oriented	programming	technique,	we	design	a	program	using	objects	and	classes.	In
this	chapter,	we	will	look	into	the	concepts	Classes	and	Objects.

•Object	-Objects	have	states	and	behaviors.	Example:	A	dog	has	states	-	color,	name,	breed	as	well	as	behaviors	-wagging,
barking,	eating.	An	object	is	an	instance	of	a	class.
•Class	-	A	class	can	be	defined	as	a	template/blue	print	that	describes	the	behaviors/states	that	object	of	its	type	support.
7.1Objects	in	Java:

Let	us	now	look	deep	into	what	are	objects.	Ifweconsider	the	real-worldwecan	find	many	objects	around	us,	Cars,	Dogs,	Humans,	etc.
All	these	objects	have	a	state	and	behavior.	If	weconsider	a	dog,	then	its	state	is	-	name,	breed,	color,	and	the	behavior	is	-	barking,
wagging,	running	If	you	compare	the	software	object	with	a	real	world	object,	they	have	very	similar	characteristics.	Software	objects
also	 have	 a	 state	 and	 behavior.	 A	 software	 object’s	 state	 is	 stored	 in	 fields	 and	 behavior	 is	 shown	 via	 methods.	 So	 in	 software
development,	methods	operate	on	the	internal	state	of	an	object	and	the	object-to-object	communication	is	done	via	methods.

7.2Classes	in	Java:
A	class	is	a	blue	print	from	which	individual	objects	are	created.	A	sample	of	a	class	is	given	below:	public	class	Dog{
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String	breed;	int				age;	String	color;

void	barking(){

}

void	hungry(){

}

void	sleeping(){

}

}

A	class	can	contain	any	of	the	following	variable	types.
•Local	variables:	Variables	defined	inside	methods,	constructors	or	blocks	are	called	local	variables.	The	variable	will	be	declared
and	initialized	within	the	method	and	the	variable	will	be	destroyed	when	the	method	has	completed.
•Instance	variables:Instance	variables	are	variables	within	a	class	but	outside	any	method.	These	variables	are	instantiated	when
the	class	is	loaded.	Instance	variables	can	be	accessed	from	inside	any	method,	constructor	or	blocks	of	that	particular	class.
•Class	variables:Class	variables	are	variables	declared	with	in	a	class,	outside	any	method,	with	the	static	keyword.

A	class	can	have	any	number	of	methods	to	access	the	value	of	various	kinds	of	methods.	In	the	above	example,	barking(),	hungry()
and	sleeping()	are	methods.

7.3Constructors:
When	discussing	about	classes,	one	of	the	most	important	sub	topic	would	be	constructors.	Every	class	has	a	constructor.	Ifwedo	not
explicitly	 write	 a	 constructor	 for	 a	 class	 the	 Java	 compiler	 builds	 a	 default	 constructor	 for	 that	 class.	 Each	 time	 a	 new	 object	 is
created,	at	least	one	constructor	will	be	invoked.	The	main	rule	of	constructors	is	that	they	should	have	the	same	name	as	the	class.	A
class	can	have	more	than	one	constructor.	Example	of	a	constructor	is	given	below:	public	class	Puppy{	public	Puppy(){
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public	Puppy(String	name){
//	This	constructor	has	one	parameter,	name.

}

}

Java	also	supports	Singleton	Classes	where	you	would	be	able	to	create	only	one	instance	of	a	class.

7.4				Creating	an	Object:
As	mentioned	previously,	a	class	provides	the	blueprints	for	objects.	So	basically	an	object	is	created	from	a	class.	In	Java,	the	new	key
word	is	used	to	create	new	objects.	There	are	three	steps	when	creating	an	object	from	a	class:

1)Declaration:	A	variable	declaration	with	a	variable	name	with	an	object	type.
2)Instantiation:	The	‘new’	key	word	is	used	to	create	the	object.
3)Initialization:The	‘new’	keyword	is	followed	by	a	call	to	a	constructor.	This	call	initializes	the	new	object.

Example	of	creating	an	object	is	given	below:	public	class	Puppy{
public	Puppy(String	name){

//	This	constructor	has	one	parameter,	name.	System.out.println(“Passed	Name	is	:”	+	name	);

}

public	static	void	main(String	[]args){
//	Following	statement	would	create	an	object	myPuppy	Puppy	myPuppy	=	new	Puppy(
“tommy”	);

}

}

If	we	compile	and	run	the	above	program,	then	it	would	produce	the	following	result:	Passed	Name	is	:tommy
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7.5	Accessing	InstanceVariablesand	Methods:
Instance	variables	and	methods	are	accessed	via	created	objects.	To	access	an	instance	variable	the	fully	qualified	path	should	be	as
follows:	/*	First	create	an	object	*/	ObjectReference	=	new	Constructor();

/*	Now	call	a	variable	as	follows	*/	ObjectReference.variableName;

/*	Now	you	can	call	a	class	method	as	follows	*/
ObjectReference.MethodName();



Example:
This	example	explains	how	to	access	instance	variables	and	methods	of	a	class:	public	class	Puppy{

int	puppyAge;
public	Puppy(String	name){

//	This	constructor	has	one	parameter,	name.	System.out.println(“Passed	Name	is	:”	+	name	);

}

public	void	setAge(	int	age	){	puppyAge	=	age;

}

public	int	getAge(	){
System.out.println(“Puppy’s	age	is	:”	+	puppyAge	);	return	puppyAge;

}

public	static	void	main(String	[]args){
/*	Object	creation	*/
Puppy	myPuppy	=	new	Puppy(	“tommy”	);
/*	Call	class	method	to	set	puppy’s	age	*/	myPuppy.setAge(	2	);

/*	Call	another	class	method	to	get	puppy’s	age	*/
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myPuppy.getAge(	);
/*	You	can	access	instance	variable	as	follows	as	well	*/	System.out.println(“Variable	Value	:”	+	myPuppy.puppyAge	);	}

}

If	we	compile	and	run	the	above	program,	then	it	would	produce	the	following	result:
Passed	Name	is	:tommy	Puppy’s	age	is	:2	Variable
Value	:2

.6Source	file	declaration	rules:
As	the	last	part	of	this	section	let’s	now	look	into	the	source	file	declaration	rules.	These	rules	are	essential	when	declaring	classes,
import	statements	and	package	statements	in	a	source	file.

There	can	be	only	one	public	class	per	source	file.
1)A	source	file	can	have	multiple	non	public	classes.
2)The	public	class	name	should	be	the	name	of	the	source	file	as	well	which	should	be	appended	by	.java	at	the	end.	For	example:
The	class	name	is	public	class	Employee{}	Then	the	source	file	should	be	as	Employee.java.

3)If	the	class	is	defined	inside	a	package,	then	the	package	statement	should	be	the	first	statement	in	the	source	file.
4)If	import	statements	are	present	then	they	must	be	written	between	the	package	statement	and	the	class	declaration.	If	there
are	no	package	statements	then	the	import	statement	should	be	the	first	line	in	the	source	file.

5)Import	and	package	statements	will	 imply	to	all	the	classes	present	 in	the	source	file.	It	 is	not	possible	to	declare	different
import	and/or	package	statements	to	different	classes	in	the	source	file.

.7Java	Package:
In	 simple,	 it	 is	 a	 way	 of	 categorizing	 the	 classes	 and	 interfaces.	 When	 developing	 applications	 in	 Java,	 hundreds	 of	 classes	 and
interfaces	will	be	written,	therefore	categorizing	these	classes	is	a	must	as	well	as	makes	life	much	easier.

	
143



Import	statements:
In	 Java	 if	 a	 fully	qualified	name,	which	 includes	 the	package	and	 the	class	name,	 is	given	 then	 the	compiler	can	easily	 locate	 the
source	code	or	classes.	Import	statement	is	a	way	of	giving	the	proper	location	for	the	compiler	to	find	that	particular	class.

For	example,	the	following	line	would	ask	compiler	to	load	all	the	classes	available	in	directory	java_installation/java/io	:	import
java.io.*;

8.	 Exception	Handling
An	exception	is	a	problem	that	arises	during	the	execution	of	a	program.	An	exception	can	occur	for	many	different	reasons,	including
the	following:

1)A	user	has	entered	invalid	data.
2)A	file	that	needs	to	be	opened	cannot	be	found.
3)A	network	connection	has	been	lost	in	the	middle	of	communications	or	the	JVM	has	run	out	of	memory.

Some	of	these	exceptions	are	caused	by	user	error,	others	by	programmer	error,	and	others	by	physical	resources	that	have	failed	in
some	manner.

To	understand	how	exception	handling	works	in	Java,	you	need	to	understand	the	three	categories	of	exceptions:
•Checked	exceptions:	A	 checked	exception	 is	 an	 exception	 that	 is	 typically	 a	user	 error	 or	 a	problem	 that	 cannot	be	 foreseen	by	 the
programmer.	For	example,	if	a	file	is	to	be	opened,	but	the	file	cannot	be	found,	an	exception	occurs.	These	exceptions	cannot	simply	be
ignored	at	the	time	of	compilation.
•Runtime	exceptions:A	 runtime	 exception	 is	 an	 exception	 that	 occurs	 that	 probably	 could	 have	 been	 avoided	 by	 the	 programmer.	 As
opposed	to	checked	exceptions,	runtime	exceptions	are	ignored	at	the	time	of	compilation.
•Errors:	These	are	not	exceptions	at	all,	but	problems	that	arise	beyond	the	control	of	the	user	or	the	programmer.	Errors	are	typically
ignored	in	your	code	because	you	can	rarely	do	anything	about	an	error.	For	example,	 if	a	stack	overflow	occurs,	an	error	will	arise.
They	are	also	ignored	at	the	time	of	compilation.
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8.1				Exception	Hierarchy:
All	exception	classes	are	subtypes	of	 the	 java.lang.Exception	class.	The	exception	class	 is	a	subclass	of	 the	Throwable	class.	Other
than	the	exception	class	there	is	another	subclass	called	Error	which	is	derived	from	the	Throwable	class.

Errors	are	not	normally	trapped	form	the	Java	programs.	These	conditions	normally	happen	in	case	of	severe	failures,	which	are	not
handled	by	the	java	programs.	Errors	are	generated	to	indicate	errors	generated	by	the	runtime	environment.	Example	:	JVM	is	out	of
Memory.	Normally	programs	cannot	recover	from	errors.

The	Exception	class	has	two	main	subclasses:	IOException	class	and	RuntimeException	Class.
	

Throwable
	

Error

Exception
	

IOExceoption

Runtime	Exception
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.2Exceptions	Methods:

Following	is	the	list	of	important	medthods	available	in	the	Throwable	class.

SN Methods	with	Description

1 public	String	getMessage()
Returns	a	detailed	message	about	the	exception	that	has	occurred.	This
message	is	initialized	in	the	Throwable	constructor.

2 public	Throwable	getCause()
Returns	the	cause	of	the	exception	as	represented	by	a	Throwable	object.

3 public	String	toString()
Returns	the	name	of	the	class	concatenated	with	the	result	of
getMessage()

4 public	void	printStackTrace()
Prints	the	result	of	toString()	along	with	the	stack	trace	to	System.err,	the
error	output	stream.

5 public	StackTraceElement	[]	getStackTrace()
Returns	an	array	containing	each	element	on	the	stack	trace.	The	element
at	index	0	represents	the	top	of	the	call	stack,	and	the	last	element	in	the
array	represents	the	method	at	the	bottom	of	the	call	stack.

6 public	Throwable	fillInStackTrace()
Fills	the	stack	trace	of	this	Throwable	object	with	the	current	stack	trace,
adding	to	any	previous	information	in	the	stack	trace.
.3Catching	Exceptions:

A	method	catches	an	exception	using	a	combination	of	the	try	and	catch	keywords.	A	try/catch	block	is	placed	around	the	code	that
might	generate	an	exception.	Code	within	a	try/catch	block	is	referred	to	as	protected	code,	and	the	syntax	for	using	try/catch	looks
like	the	following:	try

//Protected	code
}catch(ExceptionName	e1)

{

//Catch	block
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}

A	catch	statement	involves	declaring	the	type	of	exception	you	are	trying	to	catch.	If	an	exception	occurs	in	protected	code,	the	catch
block	 (or	blocks)	 that	 follows	 the	 try	 is	checked.	 If	 the	 type	of	exception	 that	occurred	 is	 listed	 in	a	catch	block,	 the	exception	 is
passed	to	the	catch	block	much	as	an	argument	is	passed	into	a	method	parameter.

Example:
The	following	is	an	array	is	declared	with	2	elements.	Then	the	code	tries	to	access	the	3rd	element	of	the	array	which	throws	an
exception.

//	File	Name	:	ExcepTest.java	import	java.io.*;
public	class	ExcepTest{

public	static	void	main(String	args[]){	try{
int	a[]	=	new	int[2];
System.out.println(“Access	element	three	:”	+	a[3]);

}catch(ArrayIndexOutOfBoundsException	e){	System.out.println(“Exception	
thrown		:”	+	e);	}



System.out.println(“Out	of	the	block”);

}

}

This	would	produce	the	following	result:
Exception	thrown	:java.lang.ArrayIndexOutOfBoundsException:	3	Out	of	the	block

.4Multiple	catch	Blocks:
A	try	block	can	be	followed	by	multiple	catch	blocks.	The	syntax	for	multiple	catch	blocks	looks	like	the	following:	try

{

//Protected	code
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}catch(ExceptionType1	e1)

{

//Catch	block
}catch(ExceptionType2	e2)

{

//Catch	block
}catch(ExceptionType3	e3)

{

//Catch	block

}

The	previous	 statements	demonstrate	 three	catch	blocks,	but	 you	can	have	any	number	of	 them	after	a	 single	 try.	 If	 an	exception
occurs	 in	 the	 protected	 code,	 the	 exception	 is	 thrown	 tothefirst	 catch	 blockinthelist.Ifthe	 data	 typeoftheexception	 thrown
matchesExceptionType1,	it	gets	caught	there.	If	not,	the	exception	passes	down	to	the	second	catch	statement.	This	continues	until
the	exception	either	 is	caught	or	 falls	 through	all	catches,	 in	which	case	 the	current	method	stops	execution	and	 the	exception	 is
thrown	down	to	the	previous	method	on	the	call	stack.

Example:
Here	is	code	segment	showing	how	to	use	multiple	try/catch	statements.

	



try

{

file	=	new	FileInputStream(fileName);	x	=	(byte)	file.read();



}catch(IOException	i)

{

i.printStackTrace();	return	-1;
}catch(FileNotFoundException	f)	//Not	valid!

{

f.printStackTrace();	return	-1;

}
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.5The	throws/throw	Keywords:

If	a	method	does	not	handle	a	checked	exception,	the	method	must	declare	it	using	the	throws	keyword.	The	throws	keyword	appears
at	the	end	of	a	method’s	signature.	You	can	throw	an	exception,	either	a	newly	instantiated	one	or	an	exception	that	you	just	caught,
by	using	 the	 throw	keyword.	Try	 to	understand	 the	different	 in	 throws	and	 throw	keywords.	The	 following	method	declares	 that	 it
throws	a	RemoteException:	import		java.io.*;	public	class	className

{

public	void	deposit(double	amount)	throws	RemoteException

{

//	Method	implementation	throw	new	RemoteException();

}

//Remainder	of	class	definition

}

A	method	 can	 declare	 that	 it	 throws	more	 than	 one	 exception,	 in	 which	 case	 the	 exceptions	 are	 declared	 in	 a	 list	 separated	 by
commas.	For	example,	 the	 following	method	declares	 that	 it	 throws	a	RemoteException	and	an	InsufficientFundsException:	 import		
java.io.*;	public	class	className

{

public	void	withdraw(double	amount)	throws	RemoteException,	InsufficientFundsException

{

//	Method	implementation

}

//Remainder	of	class	definition

}

.6The	finally	Keyword:
The	finally	keyword	is	used	to	create	a	block	of	code	that	follows	a	try	block.	A	finally	block	of	code	always	executes,	whether	or	not	an
exception	has	occurred.	Using	a	finally	block	allows
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you	to	 run	 any	 cleanup-type	 statements	 that	 you	want	 to	 execute,	 no	matter	 what	 happens	 in	 the	 protected	 code.	 A	 finally	 block
appears	at	the	end	of	the	catch	blocks	and	has	the	following	syntax:	try

{

//Protected	code
}catch(ExceptionType1	e1)

{

//Catch	block
}catch(ExceptionType2	e2)

{

//Catch	block
}catch(ExceptionType3	e3)

{

//Catch	block
}finally

{

//The	finally	block	always	executes.

}

Example:
public	class	ExcepTest{

public	static	void	main(String	args[]){	int	a[]	=	new	int[2];
try{

System.out.println(“Access	element	three	:”	+	a[3]);
}catch(ArrayIndexOutOfBoundsException	e){	System.out.println(“Exception	

thrown		:”	+	e);	}
finally{

a[0]	=	6;
System.out.println(“First	element	value:	”	+a[0]);	System.out.println(“The	finally
statement	is	executed”);	}
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}

}

This	would	produce	the	following	result:
Exception	thrown	:java.lang.ArrayIndexOutOfBoundsException:	3	First	element	value:	6
The	finally	statement	is	executed

Note:
1)A	catch	clause	cannot	exist	without	a	try	statement.
2)It	is	not	compulsory	to	have	finally	clauses	whenever	a	try/catch	block	is	present.
3)The	try	block	cannot	be	present	without	either	catch	clause	or	finally	clause.
4)Any	code	cannot	be	present	in	between	the	try,	catch,	finally	blocks.
.7Declaring	you	own	Exception:

You	can	create	your	own	exceptions	in	Java.	Keep	the	following	points	in	mind	when	writing	your	own	exception	classes:
All	exceptions	must	be	a	child	of	Throwable.
If	you	want	to	write	a	checked	exception	that	is	automatically	enforced	by	the	Handle	or	Declare	Rule,	you	need	to	extend	the
Exception	class.

If	you	want	to	write	a	runtime	exception,	you	need	to	extend	the	RuntimeException	class.

We	can	define	our	own	Exception	class	as	below:
class	MyException	extends	Exception{

}

You	just	need	to	extend	the	Exception	class	to	create	your	own	Exception	class.	These	are	considered	to	be	checked	exceptions.	The
following	 InsufficientFundsException	 class	 is	 a	 user-defined	 exception	 that	 extends	 the	 Exception	 class,	 making	 it	 a	 checked
exception.	An	exception	class	is	like	any	other	class,	containing	useful	fields	and	methods.
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Example:
//	File	Name	InsufficientFundsException.java	import	java.io.*;

public	class	InsufficientFundsException	extends	Exception

{

private	double	amount;
public	InsufficientFundsException(double	amount)

{

this.amount	=	amount;

}

public	double	getAmount()

{

return	amount;

}

}

To	demonstrate	using	our	user-defined	exception,	the	following	CheckingAccount	class	contains	a	withdraw()	method	that	throws	an
InsufficientFundsException.

//	File	Name	CheckingAccount.java	import	java.io.*;

public	class	CheckingAccount

{

private	double	balance;	private	int	number;
public	CheckingAccount(int	number)

{

this.number	=	number;

}

public	void	deposit(double	amount)

{

balance	+=	amount;

}

public	void	withdraw(double	amount)	throws
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InsufficientFundsException

{

if(amount	<=	balance)

{

}

else

{

}

}

balance	-=	amount;
	

double	needs	=	amount	-	balance;
throw	new	InsufficientFundsException(needs);



public	double	getBalance()

{

return	balance;

}

public	int	getNumber()

{

return	number;

}

}

The	following	BankDemo	program	demonstrates	invoking	the	deposit()	and	withdraw()	methods	of	CheckingAccount.

//	File	Name	BankDemo.java	public	class	BankDemo

{

public	static	void	main(String	[]	args)

{

CheckingAccount	c	=	new	CheckingAccount(101);	System.out.println(“Depositing
$500…”);	c.deposit(500.00);	try

{

System.out.println(“\nWithdrawing	$100…”);
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c.withdraw(100.00);	System.out.println(“\nWithdrawing	$600…”);
c.withdraw(600.00);	}catch(InsufficientFundsException	e)

{

System.out.println(“Sorry,	but	you	are	short	$”
+	e.getAmount());	e.printStackTrace();

}

}

}

Compile	all	the	above	three	files	and	run	BankDemo,	this	would	produce	the	following	result:	Depositing	$500…
Withdrawing	$100…
Withdrawing	$600…
Sorry,	but	you	are	short	$200.0
InsufficientFundsException

at	CheckingAccount.withdraw(CheckingAccount.java:25)	at
BankDemo.main(BankDemo.java:13)
.8Common	Exceptions:

In	Java,	it	is	possible	to	define	two	categories	of	Exceptions	and	Errors.
1)JVM	Exceptions:These	are	exceptions/errors	that	are	exclusively
or	logically	thrown	by	the	JVM.	Examples	:	NullPointerException,
ArrayIndexOutOfBoundsException,	ClassCastException,

2)Programmatic	exceptions:These	exceptions	are	thrown
explicitly	by	the	application	or	the	API	programmers
Examples:	IllegalArgumentException,
IllegalStateException.

9.	 Assertions
Assertion	is	a	statement	in	java.	It	can	be	used	to	test	your	assumptions	about	the	program.	While	executing	assertion,	it	is	believed	to
be	true.	If	it	fails,	JVM	will	throw	an	error	named	AssertionError.	It	is	mainly	used	for	testing	purpose.
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.1Advantage	of	Assertion:
It	provides	an	effective	way	to	detect	and	correct	programming	errors.
Syntax:
There	are	two	ways	to	use	assertion.	First	way	is:	assert	expression;
and	second	way	is:
assert	expression1	:	expression2;	Simple	Example	of	Assertion	in
java:	import	java.util.Scanner;
class	AssertionExample{
public	static	void	main(	String	args[]	){

Scanner	scanner	=	new	Scanner(	System.in	);	System.out.print(“Enter	your
age	“);

int	value	=	scanner.nextInt();	assert	value>=18:”	Not	valid”;
System.out.println(“value	is	“+value);

}

}

If	you	use	assertion,	It	will	not	run	simply	because	assertion	is	disabled	by	default.	To	enable	the	assertion,	-ea	or	-enableassertions
switch	of	java	must	be	used.

Compile	it	by:	javac	AssertionExample.java	Run	it	by:	java	-ea
AssertionExample	Output:
Enter	ur	age	11
Exception	in	thread	“main”	java.lang.AssertionError:	Not	valid

.2Where	not	to	use	Assertion:
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There	are	some	situations	where	assertion	should	be	avoid	to	use.	They	are:
1)According	 to	 Sun	 Specification,	 assertion	 should	 not	 be	 used	 to	 check	 arguments	 in	 thepublic	 methods	 becauseitshould
resultinappropriate	runtime	exception	e.g.IllegalArgumentException,	NullPointerException	etc.

2)Do	not	use	assertion,	if	you	don’t	want	any	error	in	any	situation.
10.	 Threads

Java	 is	 a	multithreaded	 programming	 language	which	means	we	 can	 develop	multithreaded	 program	 using	 Java.	 A	multithreaded
program	contains	 two	or	more	parts	 that	 can	 run	 concurrently	 and	 each	part	 can	handle	different	 task	 at	 the	 same	 time	making
optimal	use	of	the	available	resources	specially	when	your	computer	has	multiple	CPUs.

By	definition	multitasking	is	when	multiple	processes	share	common	processing	resources	such	as	a	CPU.	Multithreading	extends	the
idea	of	multitasking	into	applications	where	you	can	subdivide	specific	operations	within	a	single	application	into	individual	threads.
Each	of	the	threads	can	run	in	parallel.	The	OS	divides	processing	time	not	only	among	different	applications,	but	also	among	each
thread	within	an	application.

Multithreading	enables	you	to	write	in	a	way	where	multiple	activities	can	proceed	concurrently	in	the	same	program.
10.1Life	Cycle	of	a	Thread:

A	thre	started,
ad	goes	through	various	stages	in	its	life	cycle.	For	example,	a	thread	is	born,
nd	then	dies.	Following	diagram	shows	complete	life	cycle	of	a	thread.
runs,	a
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Above-mentioned	stages	are	explained	here:
New:	A	new	thread	begins	its	life	cycle	in	the	new	state.	It	remains	in	this	state	until	the	program	starts	the	thread.	It	is	also
referred	to	as	a	born	thread.

Runnable:	 After	 a	 newly	 born	 thread	 is	 started,	 the	 thread	 becomes	 runnable.	 A	 thread	 in	 this	 state	 is	 considered	 to	 be
executing	its	task.

Waiting:	Sometimes,	a	 thread	 transitions	 to	 the	waiting	state	while	 the	 thread	waits	 for	another	 thread	 to	perform	a	 task.A
thread	transitions	back	to	the	runnable	state	only	when	another	thread	signals	the	waiting	thread	to	continue	executing.

Timed	waiting:A	 runnable	 thread	 can	 enter	 the	 timed	waiting	 state	 for	 a	 specified	 interval	 of	 time.	 A	 thread	 in	 this	 state
transitions	back	to	the	runnable	state	when	that	time	interval	expires	or	when	the	event	it	is	waiting	for	occurs.

Terminated:	A	runnable	thread	enters	the	terminated	state	when	it	completes	its	task	or	otherwise	terminates.
10.2Thread	Priorities:

Every	Java	thread	has	a	priority	that	helps	the	operating	system	determine	the	order	in	which	threads	are	scheduled.

Java	thread	priorities	are	in	the	range	between	MIN_PRIORITY	(a	constant	of	1)	and	MAX_PRIORITY	(a	constant	of	10).	By	default,
every	thread	is	given	priority	NORM_PRIORITY	(a	constant	of	5).

Threads	with	higher	priority	are	more	important	to	a	program	and	should	be	allocated	processor	time	before	lower-priority	threads.
However,	thread	priorities	cannot	guarantee	the	order	in	which	threads	execute	and	very	much	platform	dependentant.

10.3Create	Thread	by	Implementing	Runnable	Interface:
If	your	class	is	intended	to	be	executed	as	a	thread	then	you	can	achieve	this	by	implementing	Runnable	interface.	You	will	need	to
follow	three	basic	steps:

Step	1:
As	a	first	step	you	need	to	implement	a	run()	method	provided	by	Runnable	interface.	This	method	provides	entry	point	for	the	thread
and	you	will	put	you	complete	business	logic	inside	this	method.	Following	is	simple	syntax	of	run()	method:	157



public	void	run(	)
Step	2:
At	second	step	you	will	instantiate	a	Thread	object	using	the	following	constructor:	Thread(Runnable	threadObj,	String
threadName);	Where,	threadObj	is	an	instance	of	a	class	that	implements	the	Runnable	interface	and	threadName	is
the	name	given	to	the	new	thread.

Step	3:
Once	Thread	object	is	created,	you	can	start	it	by	calling	start(	)	method,	which	executes	a	call	to	run(	)	method.	Following	is	simple
syntax	of	start()	method:	void	start(	);
Example:
Here	is	an	example	that	creates	a	new	thread	and	starts	it	running:	class	RunnableDemo
implements	Runnable	{

private	Thread	t;
private	String	threadName;
RunnableDemo(	String	name){	threadName	=	name;

System.out.println(“Creating	”	+		threadName	);

}

public	void	run()	{
System.out.println(“Running	”	+	threadName	);	try	{

for(int	i	=	4;	i	>	0;	i—)	{
System.out.println(“Thread:	”	+	threadName	+	“,	”	+	i);
//	Let	the	thread	sleep	for	a	while.	Thread.sleep(50);

}

}	catch	(InterruptedException	e)	{
System.out.println(“Thread	”	+		threadName	+	”	interrupted.”);	158

}

System.out.println(“Thread	”	+		threadName	+	”	exiting.”);

}

public	void	start	()

{

System.out.println(“Starting	”	+	threadName	);	if	(t	==	null)

{

t	=	new	Thread	(this,	threadName);	t.start	();

}

}

}

public	class	TestThread	{
public	static	void	main(String	args[])	{

RunnableDemo	R1	=	new	RunnableDemo(	“Thread1”);	R1.start();
RunnableDemo	R2	=	new	RunnableDemo(	“Thread2”);	R2.start();

}

}

This	would	produce	the	following	result:
Creating	Thread1	Starting	Thread1	Creating
Thread2	Starting	Thread2	Running	Thread1
Thread:	Thread1,	4	Running	Thread2	Thread:
Thread2,	4
Thread:	Thread1,	3
Thread:	Thread2,	3
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Thread:	Thread1,	2
Thread:	Thread2,	2
Thread:	Thread1,	1
Thread:	Thread2,	1	Thread	Thread1	exiting.	Thread
Thread2	exiting.

10.4		Create	Thread	by	Extending	Thread	Class:
The	second	way	to	create	a	thread	is	to	create	a	new	class	that	extends	Thread	class	using	the	following	two	simple	steps.	This
approach	provides	more	flexibility	in	handling	multiple	threads	created	using	available	methods	in	Thread	class.

Step	1:
You	will	need	to	override	run(	)	method	available	in	Thread	class.	This	method	provides	entry	point	for	the	thread	and	you	will	put	you
complete	business	logic	inside	this	method.	Following	is	simple	syntax	of	run()	method:	public	void	run(	)
Step	2:
Once	Thread	object	is	created,	you	can	start	it	by	calling	start(	)	method,	which	executes	a	call	to	run(	)	method.	Following	is	simple
syntax	of	start()	method:	void	start(	);
Example:
Here	is	the	preceding	program	rewritten	to	extend	Thread:	class	ThreadDemo	extends	Thread
{

private	Thread	t;
private	String	threadName;
ThreadDemo(	String	name){	threadName	=	name;

System.out.println(“Creating	”	+		threadName	);

}

public	void	run()	{
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System.out.println(“Running	”	+	threadName	);	try	{
for(int	i	=	4;	i	>	0;	i—)	{

System.out.println(“Thread:	”	+	threadName	+	“,	”	+	i);
//	Let	the	thread	sleep	for	a	while.	Thread.sleep(50);

}

}	catch	(InterruptedException	e)	{
System.out.println(“Thread	”	+		threadName	+	”	interrupted.”);	}
System.out.println(“Thread	”	+		threadName	+	”	exiting.”);

}

public	void	start	()

{

System.out.println(“Starting	”	+	threadName	);	if	(t	==	null)

{

t	=	new	Thread	(this,	threadName);	t.start	();

}

}

}

public	class	TestThread	{
public	static	void	main(String	args[])	{

ThreadDemo	T1	=	new	ThreadDemo(	“Thread1”);	T1.start();

ThreadDemo	T2	=	new	ThreadDemo(	“Thread2”);	T2.start();

}

}
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This	would	produce	the	following	result:
Creating	Thread1	Starting	Thread1
Creating	Thread2	Starting	Thread2
Running	Thread1	Thread:	Thread1,	4
Running	Thread2	Thread:	Thread2,	4
Thread:	Thread1,	3
Thread:	Thread2,	3
Thread:	Thread1,	2
Thread:	Thread2,	2
Thread:	Thread1,	1
Thread:	Thread2,	1	Thread	Thread1	exiting.
Thread	Thread2	exiting.

10.5		Thread	Methods:
Following	is	the	list	of	important	methods	available	in	the	Thread	class.

SN Methods	with	Description

1 public	void	start()
Starts	the	thread	in	a	separate	path	of	execution,	then	invokes	the	run()
method	on	this	Thread	object.

2 public	void	run()
If	this	Thread	object	was	instantiated	using	a	separate	Runnable	target,
the	run()	method	is	invoked	on	that	Runnable	object.

3 public	final	void	setName(String	name)
Changes	the	name	of	the	Thread	object.	There	is	also	a	getName()	method
for	retrieving	the	name.
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4 public	final	void	setPriority(int	priority)
Sets	the	priority	of	this	Thread	object.	The	possible	values	are	between	1
and	10.

5 public	final	void	setDaemon(boolean	on)
A	parameter	of	true	denotes	this	Thread	as	a	daemon	thread.

6 public	final	void	join(long	millisec)
The	current	thread	invokes	this	method	on	a	second	thread,	causing	the
current	thread	to	block	until	the	second	thread	terminates	or	the	specified
number	of	milliseconds	passes.

7 public	void	interrupt()
Interrupts	this	thread,	causing	it	to	continue	execution	if	it	was	blocked	for
any	reason.

8 public	final	boolean	isAlive()
Returns	true	if	the	thread	is	alive,	which	is	any	time	after	the	thread	has
been	started	but	before	it	runs	to	completion.

The	previous	methods	are	invoked	on	a	particular	Thread	object.	The	following	methods	in	the	Thread	class	are	static.	Invoking	one
of	the	static	methods	performs	the	operation	on	the	currently	running	thread.

SN Methods	with	Description

1 public	static	void	yield()
Causes	the	currently	running	thread	to	yield	to	any	other	threads	of	the
same	priority	that	are	waiting	to	be	scheduled.

2 public	static	void	sleep(long	millisec)
Causes	the	currently	running	thread	to	block	for	at	least	the	specified
number	of	milliseconds.

3 public	static	boolean	holdsLock(Object	x)
Returns	true	if	the	current	thread	holds	the	lock	on	the	given	Object.



4 public	static	Thread	currentThread()
Returns	a	reference	to	the	currently	running	thread,	which	is	the	thread
that	invokes	this	method.

5 public	static	void	dumpStack()
Prints	the	stack	trace	for	the	currently	running	thread,	which	is
useful	when	debugging	a	multithreaded	application.
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Example:
The	following	ThreadClassDemo	program	demonstrates	some	of	these	methods	of	the	Thread	class.	Consider	a	class	DisplayMessage
which	implements	Runnable:	//	File	Name	:	DisplayMessage.java
//	Create	a	thread	to	implement	Runnable
public	class	DisplayMessage	implements	Runnable

{

private	String	message;
public	DisplayMessage(String	message)

{

this.message	=	message;

}

public	void	run()

{

while(true)

{

System.out.println(message);

}

}

}

Following	is	another	class	which	extends	Thread	class:
//	File	Name	:	GuessANumber.java
//	Create	a	thread	to	extentd	Thread
public	class	GuessANumber	extends	Thread

{

private	int	number;
public	GuessANumber(int	number)

{

this.number	=	number;

}

public	void	run()

{
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int	counter	=	0;	int	guess	=	0;	do

{

guess	=	(int)	(Math.random()	*	100	+	1);
System.out.println(this.getName()

+	”	guesses	”	+	guess);	counter++;
}while(guess			!=			number);	System.out.println(“**	Correct!	”	+	this.getName()	+	”	in	”
+	counter	+	”	guesses.**”);

}

}

Following	is	the	main	program	which	makes	use	of	above	defined	classes:
//	File	Name	:	ThreadClassDemo.java	public	class	ThreadClassDemo

{

public	static	void	main(String	[]	args)

{

Runnable	hello	=	new	DisplayMessage(“Hello”);	Thread	thread1	=	new	Thread(hello);
thread1.setDaemon(true);	thread1.setName(“hello”);	System.out.println(“Starting
hello	thread…”);	thread1.start();	Runnable	bye	=	new	DisplayMessage(“Goodbye”);
Thread	thread2	=	new	Thread(bye);	thread2.setPriority(Thread.MIN_PRIORITY);
thread2.setDaemon(true);	System.out.println(“Starting	goodbye	thread…”);
thread2.start();	System.out.println(“Starting	thread3…”);
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Thread	thread3	=	new	GuessANumber(27);	thread3.start();
try

{

thread3.join();
}catch(InterruptedException	e)

{

System.out.println(“Thread	interrupted.”);

}

System.out.println(“Starting	thread4…”);	Thread	thread4	=	new
GuessANumber(75);
thread4.start();	System.out.println(“main()	is	ending…”);

}

}

This	would	produce	the	following	result.	You	can	try	this	example	again	and	again	and	you	would	get	different	result	every	time.

Starting	hello	thread…	Starting	goodbye	thread…	Hello
Hello	Hello	Hello	Hello	Hello	Goodbye
Goodbye	Goodbye	Goodbye	Goodbye
…….
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11.				Wrapper	Classes
Each	of	Java’s	eight	primitive	data	types	has	a	class	dedicated	to	it.	These	are	known	as	wrapper	classes,	because	they	“wrap”	the
primitive	data	type	into	an	object	of	that	class.	The	wrapper	classes	are	part	of	the	java.lang	package,	which	is	imported	by	default
into	all	Java	programs.

The	wrapper	classes	in	java	servers	two	primary	purposes.
1)To	provide	mechanism	to	‘wrap’	primitive	values	in	an	object	so	that	primitives	can	do	activities	reserved	for	the	objects	like
being	added	to	ArrayList,	Hashset,	HashMap	etc.	collection.

2)To	 provide	 an	 assortment	 of	 utility	 functions	 for	 primitives	 like	 converting	 primitive	 types	 to	 and	 from	 string	 objects,
converting	to	various	bases	like	binary,	octal	or	hexadecimal,	or	comparing	various	objects.

The	following	two	statements	illustrate	the	difference	between	a	primitive	data	type	and	an	object	of	a	wrapper	class:	int	x	=	25;
Integer	y	=	new	Integer(33);
The	 first	 statement	 declares	 an	 int	 variable	 named	 x	 and	 initializes	 it	 with	 the	 value	 25.	 The	 second	 statement	 instantiates	 an
Integer	object.	The	object	is	initialized	with	the	value	33	and	a	reference	to	the	object	is	assigned	to	the	object	variable	y.

Below	table	lists	wrapper	classes	in	Java	API	with	constructor	details.

Primitive Wrapper	Class Constructor	Argument
boolean Boolean boolean	or	String
byte Byte byte	or	String

char Character char
int Integer int	or	String
float Float float,	double	or	String
double Double double	or	String
long Long long	or	String
short Short short	or	String
Below	is	wrapper	class	hierarchy	as	per	Java	API
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As	 explain	 in	 above	 table	 all	 wrapper	 classes	 (except	 Character)	 take	 String	 as	 argument	 constructor.	 Please	 notewemight	 get
NumberFormatException	ifwetry	to	assign	invalid	argument	in	constructor.	For	example	to	create	Integer	object	we	can	have	following
syntax.

Integer	intObj	=	new	Integer	(25);	Integer	intObj2	=	new
Integer	(“25”);
Here	 in	 we	 can	 provide	 any	 number	 as	 string	 argument	 but	 not	 the	 words	 etc.	 Below	 statement	 will	 throw	 run	 time	 exception
(NumberFormatException)	Integer	intObj3	=	new	Integer	(“Two”);
The	following	discussion	focuses	on	the	Integer	wrapperclass,	but	applies	in	a	general	sense	to	all	eight	wrapper	classes.	The	most
common	methods	of	 the	 Integer	wrapper	class	are	 summarized	 in	below	 table.	Similar	methods	 for	 the	other	wrapper	classes	are
found	in	the	Java	API	documentation.
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Method Purpose
parseInt(s) returns	a	signed	decimal	integer	value	equivalent	to	string	s

toString(i) returns	a	new	String	object	representing	the	integer	i

byteValue() returns	the	value	of	this	Integer	as	a	byte
doubleValue() returns	the	value	of	this	Integer	as	an	double
floatValue() returns	the	value	of	this	Integer	as	a	float
intValue() returns	the	value	of	this	Integer	as	an	int
shortValue() returns	the	value	of	this	Integer	as	a	short
longValue() returns	the	value	of	this	Integer	as	a	long
int	compareTo(int
i)

Compares	 the	 numerical	 value	 of	 the	 invoking	 object	 with
that	 of	 i.	 Returns	 0	 if	 the	 values	 are	 equal.	 Returns	 a
negative	 value	 if	 the	 invoking	 object	 has	 a	 lower	 value.
Returns	a	positive	value	if	the	invoking	object	has	a	greater
value.

static	int
compare
(intnum1,	int
num2)

Compares	 the	 values	 of	 num1	 and	 num2.	 Returns	 0	 if	 the
values	 are	 equal.	 Returns	 a	 negative	 value	 if	 num1	 is	 less
than	num2.	Returns	a	positive	value	if	num1	is	greater	than
num2.

boolean
equals
(Object
intObj)

Returns	true	if	the	invoking	Integer	object	is	eq

Let’s	see	java	program	which	explain	few	wrapper	classes	methods.	package	WrapperIntro;
public	class	WrapperDemo	{

public	static	void	main	(String	args[]){	Integer	intObj1	=	new	Integer
(25);	Integer	intObj2	=	new	Integer	(“25”);	Integer	intObj3=
new	Integer	(35);	//compareTo	demo
System.out.println(“Comparing	using	compareTo	Obj1	and	Obj2:	”	+	intObj1.compareTo(intObj2));
System.out.println(“Comparing	using	compareTo	Obj1	and	Obj3:	”	+	intObj1.compareTo(intObj3));
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//Equals	demo
System.out.println(“Comparing	using	equals	Obj1	and	Obj2:	”	+	intObj1.equals(intObj2));
System.out.println(“Comparing	using	equals	Obj1	and	Obj3:	”	+	intObj1.equals(intObj3));

Float	f1	=	new	Float(“2.25f”);	Float	f2	=	new
Float(“20.43f”);	Float	f3	=	new	Float(2.25f);

System.out.println(“Comparing	using	compare	f1	and	f2:	“
+Float.compare(f1,f2));
System.out.println(“Comparing	using	compare	f1	and	f3:	“
+Float.compare(f1,f3));
//Addition	of	Integer	with	Float	Float	f	=	intObj1.floatValue()	+
f1;
System.out.println(“Addition	of	intObj1	and	f1:	“+	intObj1	+”+”	+f1+”=”	+f	);

}

}

Output:
Comparing	using	compareTo	Obj1	and	Obj2:	0	Comparing	using	compareTo
Obj1	and	Obj3:	-1	Comparing	using	equals	Obj1	and	Obj2:	true	Comparing
using	equals	Obj1	and	Obj3:	false	Comparing	using	compare	f1	and	f2:	-1
Comparing	using	compare	f1	and	f3:	0	Addition	of	intObj1	and	f1:
25+2.25=27.25

12.	String	Manipulation
Strings,	which	are	widely	used	 in	Java	programming,	are	a	sequence	of	characters.	 In	 the	Java	programming	 language,	strings	are
objects.	The	Java	platform	provides	the	String	class	to	create	and	manipulate	strings.
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.1Creating	Strings:
The	most	direct	way	to	create	a	string	is	to	write:	String	greeting	=	“Hello
world!”;	Whenever	it	encounters	a	string	literal	in	your	code,	the	compiler
creates	a	String	object	with	its	value	in	this	case,	“Hello	world!’.

As	with	 any	 other	 object,	 you	 can	 create	 String	 objects	 by	 using	 the	new	keyword	 and	 a	 constructor.	 The	String	 class	 has	 eleven
constructors	that	allow	you	to	provide	the	initial	value	of	the	string	using	different	sources,	such	as	an	array	of	characters.

public	class	StringDemo{
public		static		void		main(String		args[]){	char[]	helloArray	=	{	‘h’,	‘e’,	‘l’,	

‘l’,	‘o’,	‘.’};	String	helloString	=	new	String(helloArray);
System.out.println(	helloString	);

}

}

This	would	produce	the	following	result:	hello.
Note:	The	String	class	is	immutable,	so	that	once	it	is	created	a	String	object	cannot	be	changed.	If	there	is	a	necessity	to	make	a	lot
of	modifications	to	Strings	of	characters,	then	you	should	use	String	Buffer	&	String	Builder	Classes.

.2String	Length:
Methods	used	 to	obtain	 information	about	an	object	 are	known	as	accessor	methods.	One	accessor	method	 that	 you	can	use	with
strings	is	the	length()	method,	which	returns	the	number	of	characters	contained	in	the	string	object.

After	the	following	two	lines	of	code	have	been	executed,	len	equals	17:	public	class	StringDemo	{
public	static	void	main(String	args[])	{

String	palindrome	=	“Dot	saw	I	was	Tod”;
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int	len	=	palindrome.length();	System.out.println(	“String	Length	is	:	”	+	len
);	}

}

This	would	produce	the	following	result:	String	Length	is	:	17
.3Concatenating	Strings:

The	String	class	includes	a	method	for	concatenating	two	strings:	string1.concat(string2);
This	returns	a	new	string	that	is	string1	with	string2	added	to	it	at	the	end.	You	can	also	use	the	concat()	method	with	string	literals,
as	in:	“My	name	is	“.concat(“Zara”);
Strings	are	more	commonly	concatenated	with	the	+	operator,	as	in:	“Hello,”	+	”	world”	+	“!”
which	results	in:	“Hello,	world!”
Let	us	look	at	the	following	example:
public	class	StringDemo	{

public	static	void	main(String	args[])	{	String	string1	=	“saw	I	was
“;
System.out.println(“Dot	”	+	string1	+	“Tod”);

}

}

This	would	produce	the	following	result:	Dot	saw	I	was	Tod
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.4Creating	Format	Strings:

Youhave	 printf()	 and	 format()	methods	 to	 print	 output	with	 formatted	numbers.	 The	String	 class	 has	 an	 equivalent	 class	method,
format(),	that	returns	a	String	object	rather	than	a	PrintStream	object.

Using	String’s	 static	 format()	method	 allows	 you	 to	 create	 a	 formatted	 string	 that	 you	 can	 reuse,	 as	 opposed	 to	 a	 one-time	 print
statement.	For	example,	 instead	of:	System.out.printf(“The	value	of	the	float	variable	 is	”	+	“%f,	while	the	value	of	the	 integer	”	+
“variable	is	%d,	and	the	string	”	+

“is	%s”,	floatVar,	intVar,	stringVar);
you	can	write:
String	fs;
fs	=	String.format(“The	value	of	the	float	variable	is	”	+	“%f,	while	the	value	of	the	integer	”

+	“variable	is	%d,	and	the	string	”	+
“is	%s”,	floatVar,	intVar,	stringVar);	System.out.println(fs);

.5String	Methods:
Here	is	the	list	of	methods	supported	by	String	class:
SN	Methods	with	Description

1char	charAt(int	index)
Returns	the	character	at	the	specified	index.
2int	compareTo(Object	o)
Compares	this	String	to	another	Object.
3int	compareTo(String	anotherString)	Compares	two	strings	lexicographically.
4int	compareToIgnoreCase(String	str)
Compares	two	strings	lexicographically,	ignoring	case	differences.
5String	concat(String	str)
Concatenates	the	specified	string	to	the	end	of	this	string.
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6boolean	contentEquals(StringBuffer	sb)
Returns	true	if	and	only	if	this	String	represents	the	same	sequence	of	characters	as	the	specified	StringBuffer.
7static	String	copyValueOf(char[]	data)
Returns	a	String	that	represents	the	character	sequence	in	the	array	specified.
8static	String	copyValueOf(char[]	data,	int	offset,	int	count)
Returns	a	String	that	represents	the	character	sequence	in	the	array	specified.
9boolean	endsWith(String	suffix)
Tests	if	this	string	ends	with	the	specified	suffix.
10boolean		equals(Object		anObject)	Compares	this	string	to	the	specified	object.
11boolean	equalsIgnoreCase(String	anotherString)
Compares	this	String	to	another	String,	ignoring	case	considerations.
12byte	getBytes()
Encodes	this	String	into	a	sequence	of	bytes	using	the	platform’s	default	charset,	storing	the	result	into	a	new	byte	array.
13byte[]	getBytes(String	charsetName
Encodes	this	String	into	a	sequence	of	bytes	using	the	named	charset,	storing	the	result	into	a	new	byte	array.
14void	getChars(int	srcBegin,	int	srcEnd,	char[]	dst,	int	dstBegin)		Copies	characters	from	this	string	into	the	destination	
character	array.

15int	hashCode()
Returns	a	hash	code	for	this	string.
16int	indexOf(int	ch)
Returns	the	index	within	this	string	of	the	first	occurrence	of	the	specified	character.
17int	indexOf(int	ch,	int	fromIndex)
Returns	the	index	within	this	string	of	the	first	occurrence	of	the	specified	character,	starting	the	search	at	the	specified	index.
18int	indexOf(String	str)
Returns	the	index	within	this	string	of	the	first	occurrence	of	the	specified	substring.
19int	indexOf(String	str,	int	fromIndex)
Returns	the	index	within	this	string	of	the	first	occurrence	of	the	specified	substring,	starting	at	the	specified	index
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20String	intern()
Returns	a	canonical	representation	for	the	string	object.
21int	lastIndexOf(int	ch)
Returns	the	index	within	this	string	of	the	last	occurrence	of	the	specified	character.
22int	lastIndexOf(int	ch,	int	fromIndex)
Returns	the	index	within	this	string	of	the	last	occurrence	of	the	specified	character,	searching	backward	starting	at	the
specified	index.
23int	lastIndexOf(String	str)
Returns	the	index	within	this	string	of	the	rightmost	occurrence	of	the	specified	substring.
24int	lastIndexOf(String	str,	int	fromIndex)
Returns	the	index	within	this	string	of	the	last	occurrence	of	the	specified	substring,	searching	backward	starting	at	the
specified	index.



25int	length()
Returns	the	length	of	this	string.
26boolean	matches(String	regex)
Tells	whether	or	not	this	string	matches	the	given	regular	expression.
27boolean	regionMatches(boolean	ignoreCase,	int	toffset,	String	other,	int	ooffset,	int	len)
Tests	if	two	string	regions	are	equal.
28boolean	regionMatches(int	toffset,	String	other,	int	ooffset,	int	len)Testsif	two	string
regions	are	equal

29String	replace(char	oldChar,	char
newChar)

Returns	a	new	string	resulting	from	replacing	all	occurrences	of	oldChar	in	this	string	with	newChar.
30String	replaceAll(String	regex,	String	replacement
Replaces	each	substring	of	this	string	that	matches	the	given	regular	expression	with	the	given	replacement.
31String	replaceFirst(String	regex,	String	replacement)
Replaces	the	first	substring	of	this	string	that	matches	the	given	regular	expression	with	the	given	replacement.
32String[]	split(String	regex)
Splits	this	string	around	matches	of	the	given	regular	expression.

	
175

33String[]	split(String	regex,	int	limit)
Splits	this	string	around	matches	of	the	given	regular	expression.
34boolean	startsWith(String	prefix)
Tests	if	this	string	starts	with	the	specified	prefix.
35boolean	startsWith(String	prefix,	int	toffset)
Tests	if	this	string	starts	with	the	specified	prefix	beginninga	specifiedindex.
36CharSequence	subSequence(int	beginIndex,	int	endIndex)
Returns	a	new	character	sequence	that	is	a	subsequence	of	this	sequence.
37String	substring(int	beginIndex)
Returns	a	new	string	that	is	a	substring	of	this	string.
38String	substring(int	beginIndex,	int	endIndex)	Returns	a	new	string	that	is	a	substring	of	this	string.
39char[]	toCharArray()
Converts	this	string	to	a	new	character	array.
40String	toLowerCase()
Converts	all	of	the	characters	in	this	String	to	lower	case	using	the	rules	of	the	default	locale.
41String	toLowerCase(Locale	locale)
Converts	all	of	the	characters	in	this	String	to	lower	case	using	the	rules	of	the	given	Locale.
42String	toString()
This	object	(which	is	already	a	string!)	is	itself	returned.
43String	toUpperCase()
Converts	all	of	the	characters	in	this	String	to	upper	case	using	the	rules	of	the	default	locale.
44String	toUpperCase(Locale	locale)
Converts	all	of	the	characters	in	this	String	to	upper	case	using	the	rules	of	the	given	Locale.
45String	trim()
Returns	a	copy	of	the	string,	with	leading	and	trailing	whitespace	omitted.
46static	String	valueOf(primitive	data	type	x)
Returns	the	string	representation	of	the	passed	data	type	argument.
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Chapter	Four

ITDC-404
Work	Integrated	Learning	IT	–	DMA

•Identification	ofWork	Areas
•WorkExperience
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Scope	of	Programming	in	Java,	web-based	applications	and	database	management
Scope	of	Java	programming	is	huge	in	the	world	today	as	a	number	of	web	based	applications	are	developed	in	Java.	Java	is	a	platform
independent	language	and	is	used	world	over	for	development	of	majority	of	web	sites	and	web	based	applications.	It	offers	a	number
of	 job	opportunities	 such	as	 those	of	 Java	developer,	 entry	 level	 Java	programmer,	 programmer,	 software	 engineer,	 analyst.	 Salary
offered	is	also	very	good.	There	is	huge	scope	for	data	base	managers	too.

Skills	required	by	Developer,	Programmer,	database	manager
Some	of	the	most	important	skills	required	to	become	a	software	developer,	web	based	application	developer,	Java	programmer,	data
base	manager	are	as	follows	:-

i) Problem	Solving	Skill	:Programming	is	done	and	software	is	developed	to	solve	well	defined	problems.	Prospective	candidates
are	asked	to	solve	problems	in	interviews.	Exams	for	jobs	and	interviews	test	a	developer’s	and	data	base	manager’s	ability	to
solve	problems.	Hence,	problem	solving	skill	is	needed	by	developers,	programmers,	etc.

ii)Professional	Development	:	With	a	 lot	of	changes	taking	place	so	rapidly	 in	 the	 field	of	software	development	and	database
management,	a	person	is	constantly	required	to	update	himself	with	newer	technologies	and	develop	himself	professionally.
One	should	have	the	ability	to	acquire	the	knowledge	and	skills	quickly.

iii)Dealing	with	people	/	Interpersonal	Skills	:Here	the	person	is	required	to	deal	with	people	–	clients,	users,	fellow	programmers
and	 developers,	 organisations,	 etc.	 to	 identify	 the	 needs,	 conditions,	 to	 explain	 to	 others	 the	 process,	 to	 integrate	 various
modules	and	components,	hence	interpersonal	skills	are	required	to	succeed	as	a	developer,	database	manager.

iv)Practical	Skills	:One	should	have	competence	in	using	different	technologies	and	should	have	the	ability	to	apply	them.
v)Communication	Skill	 :As	 the	developer,	programmer	 is	 required	 to	 interact	with	clients,	users,	 staff	at	different	 levels,	etc.
he/she	should	be	an	effective	communicator.

There	are	job	opportunities	in	the	private	sector	as	well	as	the	public	sector.	There	are	number	of	multinational	corporations	as	well
as	 software	companies	 in	 India	 such	as	 INFOSYS,	 IBM,	HCL,	HP,	SATYAM,	DELL,	DOCOMO,	LG,	FACEBOOK,	BHEL,ONGC,	POWER
GRID,

180



GOOGLE,	TCS,MICROSOFT,	ACCENTURE,
COGNIZANT	in	which	there	are	abundant	opportunities	for	persons	skilled	in	java	programming,	web	based	application	development
and	data	base	managers	Besides,	there	are	many	PSUs(Public	Sector	Undertakings)	in	India	such	as	BHEL,	BEL,	ECIL,	EIL,	NTPC,
HPCL,	GAIL,	SAI,	AAI,	HAL,	GENCO,	TRANSCO,	BSNL,	MTNL,	etc.many	of	which	conduct	exams	for	recruitment	in	these	areas.
Selection	in	these	companies	is	through:

1.	 Written	test
2.	 Technical	interview3,	Presentation

4.	HR	interview,	etc.
Candidates	are	selected	from	campuses	of	colleges	and	universities	as	well	as	directly	from	the	market	through	the	above	selection
process.	 Information	about	 the	 recruitment	 can	be	obtained	over	 the	 Internet.	Candidates	 can	also	get	 the	 information	about	 the
recruitment	in	their	email	account	by	registering	with	the	sites.

Procedure	for	application	for	jobs	online
Steps	to	apply	for	Jobs	online	are	given	below	:-

•Step-I	:We	have	to	go	to	Job	websites(List	of	some	of	the	websites	is	mentioned	below).
•Step-II	:	We	should	register	with	the	website	and	submit	resume	.
•Step-III:	We	are	required	to	mention	area	in	which	we	want	to	work	and	also	our	qualification.
•Step-IV	:	We	are	required	to	give	our	E-Mail	Id	where	we	can	get	information	about	jobs.
•Step-V:	It	is	suggested	thatwecheck	our	e-mail	every	day.There	will	be	a	lot	of	information	about	jobs	commensurate	with	our
qualification	and	our	Interests.
•Step-VI	:	We	are	required	to	apply	for	job	and	attend	written	exams,group	discussion	and	interviews	etc.
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List	of	Web	sites	/	portals	for	jobs:http://www.naukri.com/
http://www.shine.com/	http://www.timesjobs.com/
http://www.fresherworld.com/	http://www.monsterindia.com
http://governmentjobsalerts.com/etc	Students	should	acquire
competency	in	these	areas	and	get	some	work	experience.
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Chapter	Five
ITDC-410

Movie	Editing	Tools
(with	Windows	Movie	Maker)

	
•Familiarisation	of	interface	components
•Importing	pictures
•Importing	Audio	andVideo	Files
•Splifling	and	Joining	Movie	Clips
•AddingTitlesand	publishing
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Windows	Movie	Maker
Verdict:	Windows	Movie	Maker	is	an	easy-to-use	application	for	making	quick,	professional-looking	edits	to	your	video	clips.	Get	it
now	and	start	making	the	most	of	your	videos	and	photos.

•	Windows	Movie	Maker
•	License:	Freeware
•	Language:	English
•	Author:	Microsoft
•	System:Win	XP
•	File	size:1.2MB
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Windows	Movie	Makeris	a	free	video	creating/editing	software	application,	designed	for	Windows	Me,	XP	and	Vista.	Also	works	with
latest	Windows7	&	 Windows	 8.	 Windows	 Movie	 Maker	 contains	 features	 such	 as	 effects,	 transitions,	 titles/credits,	 audio	 track,
timeline	 narration,	 and	 Auto	Movie.	 New	 effects	 and	 transitions	 can	 be	made	 and	 existing	 ones	 can	 be	 modified	 usingXMLcode.
Windows	Movie	Maker	is	also	a	basic	audio	track	editing	program.	Windows	Movie	Maker	can	apply	basic	effects	to	audio	tracks	such
as	fade	in	or	fade	out.	The	audio	tracks	can	then	be	exported	in	the	form	of	a	sound	file	instead	of	a	video	file.

	
How	to	Make	a	Video	in	Windows	Movie	Maker
How	can	you	turn	your	video	 folder	 into	a	movie	 that	everyone	wants	 to	watch?	The	key	 to	any	good	movie	 is	 the	editing	process.
Windows	Movie	Maker	 can	 transform	 your	 collection	 of	 clips	 into	 a	 single	masterpiece,	 complete	with	 credits,	 a	 soundtrack,	 and
snazzy	transitions.	Follow	this	tutorial	steps	to	make	a	video	as	it’s	meant	to	be	seen.

Gefling	Started
Download	Windows	Essentials:	This	is	a	free	software	package	from	Microsoft	that	contains	Windows	Movie	Maker	as	well	as	a	few
other	Windows	utilities.	You	can	find	the	installation	program	from	the	Microsoft	website.

•Windows	Movie	Maker	is	included	in	Windows	Vista	andXP,but	needs	to	be	downloaded	for	Windows	7	and	8.
Windows	Movie	Maker	Free	Download
With	Windows	Movie	Maker,	you	can	quickly	turn	your	photos	and	videos	into	polished
movies.	Add	special	effects,	transitions,	sound,	and	captions	to	help	tell	your	story.	Share
the	movie	with	friends	and	family.

Compatible	with	Windows	XP,	Windows	7,	Windows	8,	Windows	Vista.
Link1:hflp://www.windows-movie-maker.org/
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Windows-Movie-Maker.org	is	a	website	to	download	Windows	Movie	Maker	for	XP,	Vista,	Windows	7,	Windows	8.	Test	Compatible	for
Windows	XP,	Vista,	7,	8.	Software	has	been	scanned	by	popular	anti-virus	software	avast!	and	AVG.	Note:	We	are	not	affiliated	with
Microsoft.	The	windows	movie	maker	software	is	also	available	on	microsoft	official	site.

How	to	download	and	install	Windows	Movie	Maker?
Steps	:

1.	 Open	your	browser,	navigate	to	“hfp://www.windows-movie-maker.org/”	and	click	the	download	bufon	to	download	setup
file.

	

2.	 Double	click	the	downloaded	setup	file:	windows-movie-maker.exe	.	The	click“Yes”	to	allow	the	setup	package	to	run.
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3.	 Click	“Next”	bufon	to	continue	with	Windows	Movie	Maker	install	progress.	Select	“I	accept	the	agreement”	to	continue.
Of	course,	please	read	Windows	Movie	Maker	License	Agreement	carefully	before	“Accept”	it.

	

4.	 In	 the	 next	 steps,	 you	 can	 select	 the	 destination	 folder	 where	Windows	Movie	 Maker	 will	 be	 installed,	 rename	 the
Quickstart	group	name	if	you	like,	etc.	It	is	recommended	to	leave	all	these	sefings	as	default,	just	click	“Next”	bufon	to
get	the	software	installed.
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5.	 This	is	the	last	step.	 The	 option	 “Launch	Windows	Movie	Maker”	 is	 checked	 as	 default.	 This	means	Windows	Movie
Maker	will	be	launched	automatically	after	the	install	process	is	finished.	You	can	uncheck	this	option	if	you	want	run
the	software	later.

6.	 Finish	the	download	and	install	process.	Then	you	can	make	videos	with	Windows	Movie	Maker	as	you	wish.	Enjoy	the
software	now!

What’s	the	difference	between	“Windows	Movie	Maker”	and	“Windows	Live	Movie	Maker”?

Whenyousearch“windowsmovie	 maker”onpopularsearchenginessuchasgoogle/yahoo/bing,	 you	 may	 get	 “windows	 live	 movie
maker”	 or	 even	 the	 “windows	 live”	 setup	 package.	 What’s	 wrong?	Where	 is	 my	 familiar	 windows	movie	 maker?	 I	 still	 need	 this
software	to	make	videos	from	my	images	and	videos	collection.

As	you	may	already	know,	“Windows	Live	Movie	Maker”	is	the	later	version	of	“Windows	Movie	Maker”.	But	the	thing	is	not	so	simple.
Firstly,	the	later	version	does	not	support	previous	Windows	Edition	including	the	popularly	used	Windows	XP.	Secondly,	later	version
may	not	as	easy	&	powerful	as	the	previous	versions.

Here	is	a	table	of	Windows	Movie	Maker	versions	and	a	brief	description.
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Version Supported	OS Brief

Windows	Movie
Maker	2.1,	2.6

Windows	XP	and
later

The	only	version	that
works	on	Windows	XP.

Windows	Movie
Maker	6.0

Windows	Vista	and
later

Latest	version	of
Windows	Movie	Maker.
Later	version	changes
name.

Windows	Live	Movie
Maker	2009,	2011

Windows	Vista	and
later

Here	Windows	Movie
Maker	is	part	of	the
Windows	Live	Sohware
package.

Windows	Live	Movie
Maker	2012

Windows	7,	8 Latest	Version	of
Windows	Movie	Maker.
Only	supports	Windows	7
and	later.

OK.	the	table	above	is	clear	enough.	However,	it	may	be	a	little	complicated	for	many	users.	So	there	is	a	simple	solution.	Just	click
and	download	the	below	mentioned	Windows	Movie	Maker	installer.	The	installer	will	select	the	best	edition	based	on	your	Windows
version	and	hardware	configurations.

Link2:hfp://www.windows-movie-maker.org/download/windows-movie-maker-free.exe

Introduction

Familiarization	of	interface	components

W	i	n	d	o	w	s	M	o	v	i	e		M	a	k	e	r		i	s		a	n		e	m	b	e	d	d	e	d		p	r	o	g	r	a	m		i	n		W	i	n	d	o	w	 s	 (Start	 >	 All	 Programs	 >	 Windows	 Movie
Maker).	 You	 can	 use	Windows	Movie	Maker	 to	 create	 movies	 by	 importing	 pictures,	 videos	 and	 audios.	 You	 can	 also	 add	 video
transitions	or	effects	to	your	movie	to	make	it	nicer.

Open	Windows	Movie	Maker.	You	can	find	it	in	your	Start	Menu	under	all	programs,	or	you	can	search	for	“movie	maker”	and	select
it	from	the	results.

Aher	completing	this,	you	will	see	menu	as	follows:
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Basic Intermediate Advanced
•Tools •Effect •Adjust	volume
•Import	media •Transition •Timeline

•Credit/title •Storyboard
•Add	music •Publish	project

Familiarize	yourself	with	the	interface.	Windows	Movie	Maker	 is	 organized	 in	 a	 similar	wayto	Microsoft	 Office.	 You	 can	 navigate
through	the	various	options	by	selecting	the	tabs	at	the	top	of	the	window.

•Home	–	This	is	the	main	tab	for	Movie	Maker.	You	can	use	this	tab	to	add	videos,	images,	and	audio	to	your	project.	You	can	also
select	premade	 themes	 for	 the	movie,	 rotate	 the	 image,	and	upload	 the	project	 to	websites	 such	as	Facebook,	YouTube,	 and
Vimeo.
•Animations	–	This	tab	allows	you	to	add	transitions	between	clips.
•Visual	Effects	–	This	tab	will	allow	you	to	change	the	color	and	tone	of	the	image.	You	can	turn	it	black	and	white	or	turn	the
color	saturation	way	up.
•Project	–	You	can	make	overall	changes	to	your	entire	project	by	adjusting	the	audio	mix	and	change	the	aspect	ratio	of	the
video.
•View	–	This	tab	lets	you	zoom	in	and	out	on	the	timeline,	change	the	thumbnail	sizes,	and	view	the	waveforms	for	your	film’s
audio.
•Edit	–	This	menu	appears	after	you	add	your	first	video	clip.	You	can	use	this	tab	to	trim	the	clip,	set	a	new	start	point	or	end
point,	fade	in	and	out,	and	stabilize	the	video.
•Options	–	This	tab	shows	up	after	you	add	a	music	file	to	your	project.	You	can	set	start	and	end	times	for	the	music,	fade	it	in
and	out,	and	split	the	file.
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Overview	of	the	Windows	Movie	Maker	Screen
Before	we	can	start	making	a	movie,	let’s	look	at	the	parts	of	the	Windows	Movie	Maker	window.

1.	MovieTask	View
:	Links	to	the	various	tasks	to	create	your	movie.

	
This	MOVIE	TASKS
PANE	has	all	of	the	important	tasks	at	a
glance.	There	are	even	help	topics!
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2.	 CollectionsView:A	list	of	all	imported	components	for	your	movie	-	photos,	videos	or	sounds.

3.	 The	Preview	Screen.
4.	 The	Timeline	or	Storyboard

:	All	parts	of	your	movie,	whether	photos,	videos	or	sounds	are	dragged	to	this	area.
Timeline	View	of	Windows	Movie	Maker

Note	-Clicking	the	Show	Storyboard	link	returns	you	to	the	Storyboard	view.	This	link	will	then	read	Show	Timeline.	Clicking	on	the
link	Show	Timeline	returns	this	area	to	the	Timeline	view.	You	will	use	both	views	during	the	creation	of	your	movie.

Step	:	Open	Movie	Maker	and	name	your	project
File>	Save	project	as	(F12)

Importing	pictures
Step	:	Import	pictures,	sounds,	videos	into	Movie	Maker

A)Tools>		New	Collection	Folder
B)File>	Import	into	Collections	(ctrl+I)
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Steps	to	Import	Pictures
1.	 Click	on	theCapture	Videolink	to	open	the	list	of	options.	In	this	examplewewill	be	using	still	pictures	and	music	to

create	our	movie.

2.	 Click	on	Import	pictures	and	locate	the	folder	containing	your	pictures.
3.	 Select	the	picture	files	you	wish	to	import.

Tip	-	To	select	several	picture	files	which	are	listed	consecutively,	click	the	first	filename	in	the	list,	and	then	while	holding	the	Shift
key,	click	on	the	last	filename	in	the	list.	This	will	select	all	the	files	at	once	to	import.

Similarly,	to	select	several	files	that	are	not	in	consecutive	order,	hold	the	Ctrl	key	rather	than	the	Shift	key	and	then	click	on	the
different	filenames	you	wish	to	import.

•Find	the	MOVIE	MAKER	icon	on	the	desktop	and	doubleclick	it	to	open	the	program.
•Find	each	of	the	following	areas	or	items	on	the	MOVIE	MAKER	screen.	1	–	Open	Project	bufon

2	–	Import	Pictures	tool	3	–	Edit	Movie	options
4	–	Show	Timeline/Show	Storyboard	bufon5	–	Save	Project	bufon

	
•	Click	the	IMPORT	PICTURES	link.
•	Use	the	menu	to	locate	your

MY	MOVIE	folder	and	doubleclick	the	pictures	your	want	to
import.

•	Quick	Tip:	Hold	down	the	SHIFT	key	and	click	on	several	pictures	in	a	row.	ClickIMPORT	to	put	them	in	your	movie.

•	TIME	TO	SAVE	:	Click	the	disk	icon	or	go	to	File—>Save	and	find	your	My	Movie	folder	to	save	your	movie	project.
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There	are	several	ways	to	import	files	into	Windows	Movie	Maker.
1.	 You	can	just	drag	and	drop	the	files	into	Contents	Panel

2.	 Click	File	>	Import	into	Collection	(indicated	in	the	red	frame	in	the	image	below)
3.	 Click	on	the	“Import	into	Collection”	(indicated	in	the	red	frame	in	the	image	below)

4.	 Go	to	Task	Panel>	Import	video,	pictures,	audio	or	music	(indicated	in	the	red	frame	in	the	image	below)

Drag	and	drop	the	files	that	you	imported	from	Contents	Panel	to	Storyboard/Timeline.	Step	:	Place	pictures,	video,	and	sound	into	your	project

Drag	each	element	from	the	collection	folder	to	the	timeline.	You	can	change	the	duration	of	each	element	(how	long	it	appears	on
the	screen)	by	pulling	on	the	ends	of	it’s	frame	on	the	timeline,	stretching	it	longer	to	make	it	stay	on	the	screen	longer	or	pushing
it	back	to	compact	it	into	a	shorter	timeframe.
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Add	transitions
Transitions	do	cool	things	as	your	movie	switches	from	one	scene	to	the	next.
Note:	 In	most	movies	and	TV	shows,	 there	are	no	 transitions;	scenes	simply	advance	 from	one	to	 the	next	Therefore,	 for	 the	most
professional	appearance,	don’t	use	any	transitions.	Home	movies	are	supposed	to	be	fun,	though,	so	use	all	the	crazy	transitions	you
want.	However,	remember	your	audience:	you	might	want	to	use	just	a	few	so	you	don’t	overwhelm	your	viewers.

Steps	to	add	transitions	in	movies
1.	 Tools	>	Video	Transitions	>	Select	the	transition	that	you	want	to	add.
2.	 In	theMovieTaskspane,	underEdit	Movie,clickViewvideo	transitions.Click	transitions	that	you	want	to	add	and	drag	and	drop	it

between	two	clips	on	the	storyboard.
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Preview	transitions	by	doubleclicking	them	and	watching	the	Preview	Monitor.	Once	you’ve	found	a	transition	you	like,	drag	it	from
the	Video	Transitions	pane,	under	Edit	Movie	pane	to	the	box	between	two	of	your	clips.

	
In	the	Preview	Monitor,	click	the	Video	Transitions	pane,	under	Play	bufon	to	watch	your	transition	in	action.	If	you	don’t	like	it,	just
return	to	the	previous	step	to	replace	it	with	a	different	transition.

	
To	remove	a	transition:	On	the	storyboard,	right	click	the	transition	cell	that	contains	the	transition	and	click	“delete”.If	you	decide
not	to	use	any	transition,	right-click	it	on	the	storyboard,	and	click	Delete.
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Transitions	cause	your	video	clips	to	overlap	by	about	one	second,	which	means	you	won’t	see	all	of	the	first	or	last	second	of	your
clip.	So,	when	you’re	filming,	it’s	good	to	start	the	camera	a	few	seconds	before	the	action	starts,	and	to	keep	filming	for	a	couple	of
seconds	afterward	so	that	you	have	time	to	transition	between	scenes.

This	also	helps	you	get	a	steadier	shot.	If	you	don’t	need	the	extra	time	in	a	clip,	you	can	trim	it	from	your	clip	in	Movie	Maker.
Movie	Tips:

•

•

Don’t	add	both	types	of	effects!	Choose	the	one	that	best	fits	your	picture	and/or	movie.
Use	only	two	or	three	effects.	Too	many	effects	will	distract	from	your	movie	and	viewers	will	focus	on	them	rather	than	the	information

you	are	presenting.

	
Add	effects	:	There	are	26	effects	and	20	transitions	that	come	with	Movie	Maker.	You	can	add	more-some	are	free,	others	you	can	buy.
You	can	preview	what	each	effect	or	transition	does	simply	by	clicking	on	it	and	looking	at	the	preview	window.	A	lot	of	learning	Movie
Maker	is	simply	figuring	out	which	of	these	effects	and	transitions	to	use	most	effectively.

Tip	:	You	cannot	combine	transitions,	but	you	can	combine	an	effect	WITH	a	transition,	and	you	can	add	more	than	one	effect	(such
as	 “fade	 in	 from	 black”	 AND	 “Ease	 in.”)	Warning-the	more	 of	 these	 you	 use,	 the	more	 likely	 you	 are	 to	 have	 difficulty	 with	 the
program	(they	use	a	lot	of	processing	power	and	memory).

How	to	add	a	special	effect
You	can	use	special	effects	to	change	how	your	clips	play	in	several	different	ways:
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•	Speed	up	a	clip	using	Speed	Up,	Double,	or	slow	down	a	clip	using	Slow	Down,	Half.
•	Zoom	in	using	Ease	In,	or	zoom	out	using	Ease	Out.
•	Make	a	clip	appear	older	by	using	Sepia	Tone,	Film	Age,	or	Grayscale.
•	Rotate	a	clip	using	one	of	theRotateeffects	(perfect	if	someone	accidentally	holds	thecamera	sideways).

•	Fade	in	using	one	of	the	Fade	In	effects,	or	fade	out	using	one	of	the	Fade	Out	effects.
•	Fix	exposure	problems	using	Brightness,	Decrease	or	Brightness,	Increase.
In	order	to	add	video	effects	to	your	movie,

	
1.	 Tools	>	Video	Effects	>	Select	the	transition	that	you	want	to	add.

	
2.	 Click	video	effects	that	you	want	to	add	and	drag	and	drop	it	on	the	image.

To	remove	an	effect:	On	the	storyboard,	right	click	the	effect	cell	that	contains	the	effect,	and	click	“delete”.
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Preview	effectsby	doubleclicking	them	and	watching	the	Preview	Monitor.	Once	you’ve	found	an	effect	you	like,	drag	it	from	the	Video
Effects	pane	to	one	of	your	clips.	This	adds	the	effect	to	the	clip,	which	you	can	see	by	looking	at	the	star	in	the	lower-left	corner	of
the	clip.

	

In	the	Preview	Monitor,	click	the	Play	bufon	to	watch	your	effect	in	action.
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You	can	add	more	than	one	effect	to	a	clip.	For	example,	if	you	want	to	both	brighten	a	clip	and	add	a	zoom	effect,	you	can	addEase
InandBrightness,	Increase.Youcan	also	add	a	single	effect	multiple	times	to	increase	the	effect.

For	example,	add	multiple	Brightness,	Increase	effects	to	brighten	a	scene	even	more,	or	add	two	Speed	Up	Double	effects	to
quadruple	the	speed	of	a	clip.

If	you	don’t	like	the	effect,	right-click	the	star	icon	in	the	lower-left	corner	of	the	clip,	and	click	Delete	Effects.

Adding	Titles	and	publishing	Add	titles	and	credits

1)				Add	titles	and	credits
•				Add	a	title:	Tools	>	Titles	and	Credits.
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Select	the	link	that	corresponds	to	where	you	want	to	add	the	title	and	credit.
	

Type	the	text	for	your	title	and	then	click	“Done,	add	title	to	Movie”	bufon.
	

2)To	edit	an	existing	title
•	On	the	storyboard/timeline,	right	click	on	the	title	that	you	want	to	edit,	and	click	“Edit	Title”.	Make	the	changes	you	want	to	make,

and	then	click	“Done”.
3)To	remove	a	title

•	On	the	storyboard/timeline,	right	click	on	the	title	that	you	want	to	remove	from	yourmovie	and	click	on	“delete”.
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Let’s	create	a	title	slide.	Click	in	the	first	box	at	the	boflom	of	the	window.

•Click	the	link	for	MAKE	TITLES	OR	CREDITS.
	

•Cilck	the	link	for	ADD	TITLE	AT	THE	BEGINNING	OF	THE	MOVIE.
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•	Enter	the	text	you	want	for	your	movie	title	in	the	top	box.
•	Enter	any	other	text	you	want	on	the	first	page	in	the	second	box.
•	Click	CHANGE	THE	TITLE	ANIMATION	to	change	how	it	appears	on	the	slide.
•	ClickCHANGETHETEXT	FONTANDCOLORto		change		the		text	style	and	background	color.
•	Click	DONE,	ADDTITLETOMOVIEwhen	you	are	finished.
NOTE:You	can	also	use	a	picture	on	the	first	slide	instead	of	a	plain	background.
Movie	Tip:Choose	colors	for	your	text	and	background	so	that	the	text	is	easy	to	see.
*	Now	It	is	TIME	TO	SAVE!
Importing	Audio	and	Video	Files
Importing	an	Audio	File	into	Your	Movie

What	is	an	Audio	File?
Any	music,	sound	or	narration	file	is	known	as	an	audio	file.
Steps	to	Import	an	Audio	File

1.	 Under	the	Capture	Video	link,	choose	Import	audio	or	music.
2.	 Locate	the	folder	containing	your	audio	file.
3.	 Select	the	audio	file	you	wish	to	import.

Once	the	audio	file	is	imported,	you	will	notice	the	different	type	of	icon	in	the	Collections	window.
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Audio	Clips	Can	Only	Be	Added	in	the	Timeline
Drag	the	audio	icon	to	the	Storyboard.
*Note	the	message	box	indicating	that	audio	clips	can	only	be	added	in	the	Timeline
view.
Click	OK	in	this	message	box.
Add	an	audio	file
Go	to	Task	Panel>	Audio	or	Music.

	
•	Navigate	to	the	location	that	contains	the	digital	media	files	you	want	to	import,	andthen	click	“Import”.
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•	The	area	where	you	create	and	edit	your	project	is	displayed	in	two	views,	the	storyboard	and	the	timeline.

Adjust	volume	of	the	audio
•	A	quick	way	to	adjust	the	volume	of	an	audio	clip	is	to	right-click	the	clip,	and	then	click	“Volume”.	Adjust	the	volume	with	the

slider.

Splifling	and	Joining	Movie	Clips	Editing
To	edit	clips:
If	you	are	inSTORYBOARDview	click	here	to	change	toTIMELINEview
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Trimming	a	clip	–
1.	 Drag	the	media	clips	to	the	timeline	to	begin	making	a	movie
2.	 Once	you’re	clips	are	on	the	timeline,	click	on	the	clip	you’d	like	to	trim
3.	 In	the	PREVIEW	window,	drag	the	scroll	bar	to	the	point	where	you	want	to	trim	the	clip
4.	 On	the	CLIP	menu	click	SET	START	TRIM	POINT
5.	 Now	continue	to	drag	the	scroll	bar	until	you	reach	the	desired	end	point	of	your	clip
6.	 On	the	CLIP	menu	click	SET	END	TRIM	POINT	–	you	will	now	have	your	trimmed	clip

Splifling	a	clip	—Youcan	split	a	video	clip	into	two	clips.	This	is	useful	if	you	want	to	insert	either	a	picture	or	a	video	transition	in	the
middle	of	a	clip.

1.	 Click	on	the	clip	you	would	like	to	split
2.	 In	the	PREVIEW	window,	drag	the	scroll	bar	to	the	point	where	you	want	to	trim	the	clip
3.	 On	the	CLIP	menu	click	SPLIT	–	your	original	clip	is	now	two	separate	clips

You	can	enhance	your	movies	by	adding	different	elements	to	your	movie,	such	as	the	following:

•	 Video	 transitions	 -	 A	 video	 transition	 controls	 how	 your	movie	 plays	 from	 one	 video	 clip	 or	 picture	 to	 the	 next.	 You	 can	 add	 a
transition	 between	 two	 pictures,	 video	 clips,	 or	 titles,	 in	 any	 combination,	 on	 the	 storyboard/timeline.	 The	 transition	 plays
before	the	one	clip	ends	and	while	the	other	clip	starts	to	play.

•	Video	effects	-	A	video	effect	determines	how	a	video	clip,	picture,	or	title	displays	in	your	project	and	final	movie.	Video	effects	let
you	 add	 special	 effects	 to	 your	movie.	 A	 video	 effect	 is	 applied	 for	 the	 entire	 duration	 that	 the	 video	 clip,	 picture,	 or	 title
displays	in	your	movie.

•	Titles	and	credits	-	Titles	and	credits	let	you	enhance	your	movie	by	adding	text-based	information	to	your	movie.	You	can	change
the	appearance	of	 the	 title	or	credit,	 in	addition	 to	changing	 the	 title	animation,	which	determines	how	your	 title	or	credit
displays	in	your	movie.
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Delete	the	audio	file
Right	click	on	the	audio	file	on	the	Timeline	view,	and	click	on“delete”.

Audio	Files	Have	Their	Own	Timeline	in	Windows	Movie	Maker	Audio	Files	on	the	Timeline

Audio	files	have	their	own	location	in	the	Timeline	to	keep	them	separate	from	pictures	or	video	clips.	This	makes	it	easier	to
manipulate	either	type	of	file.
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Align	the	Audio	With	the	First	Picture

Drag	the	audio	file	to	the	left	to	align	with	the	start	point	of	the	first	picture.	This	will	start	the	music	when	the	first	picture	appears.

Timeline	View	of	Audio	Clip



The	Timeline	indicates	how	much	time	each	item	takes	up	over	the	course	of	the	whole	movie.	Notice	that	this	audio	file	takes	up	a
much	bigger	 space	on	 the	Timeline	 than	 the	pictures.	Scroll	 across	 the	Timeline	window	 to	 see	 the	 end	of	 the	audio	 clip.	 In	 this
example,	the	music	ends	at	approximately	4:23	minutes,	which	is	much	longer	than	we	need.
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Shorten	an	Audio	Clip

Hover	the	mouse	over	the	end	of	the	music	clip	until	it	becomes	a	two-headed	arrow.	Drag	the	end	of	the	music	clip	to	the	left	to	line
up	with	the	last	picture.

Note	-	In	this	instance,	I	will	have	to	drag	the	end	of	the	music	clip	several	times	to	reach	the	beginning	of	the	movie	due	to	its	size.	It
is	easier	to	do	this	if	you	zoom	in	on	the	timeline	so	that	there	is	not	so	much	dragging.	The	Zoom	tools	are	located	at	the	bofom	left
side	of	the	screen,	to	the	left	of	the	Storyboard	/	Timeline.
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Music	and	Pictures	Are	Lined	Up

Now	the	music	clip	is	lined	up	with	the	pictures	from	start	to	finish.
Save	the	movie	project.
Note	-Youmay	choose	to	start	the	music	at	any	time	in	your	movie.	The	music	clip	does	not	have	to	be	placed	at	the	beginning.

Publish	a	movie	to	your	computer
1.	 Click	on	“Save	to	my	computer”	under	“3.	Finish	Movie”	on	Task	Panel.

	

2.	 In	the	File	name	box,	type	a	name	for	your	movie.
In	the	Publish	to	box,	choose	where	you	want	to	save	your	movie	once	it’s	published,	and	then	click	on	“Next”.
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3.	Click	on	“Next”	when	you	see	this	image.
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4.	 Click	on	“Finish”	when	you	see	this	image.
	

Click	FINISH	to	complete	the	process.	It	may	take	a	long	time!	Be	patient!
Step	:	Export	your	finished	movie.
“Ctrl	+	P”	will	open	up	a	wizard	that	will	guide	you	through	a	process	that	will	allow	you	to	save	your	movie	to	one	of	5	formats:	for
playback	on	your	computer	(big	file,	high	quality	can	be	burned	to	a	DVD),	for	email	(lowest	quality,	highly	compressed),	for	posting
on	 the	web	 (as	 forYouTube),to	be	burned	on	a	videoCD,or	 to	 a	digital	 camcorder	 (highest	quality).	The	process	 is	 prefy	much	 self
explanatory,	but	if	you	want	to	eventually	burn	your	movie	to	aDVD,	choose	the	movie	sefing	“DV-AVI	(NTSC)”	when	you	save	your
film.	 To	 export	 your	 film	 to	 powerpoint,	 save	 it	 as	 a	 windows	media	 file	 (.avi	 extension)	 using	 the	 “playback	 on	 your	 computer”
option.”
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Save	Your	Windows	Movie	Maker	Project

Before	you	proceed	any	further,	you	should	save	your	project.	It	is	a	good	idea	to	do	this	frequently	throughout	the	movie	making
process.

From	the	main	menu,	choose	File	>	Save	Project.
Windows	Movie	Maker	 saves	 the	 project	 in	 the	 file	 format.MSWMMwhich	 allows	 for	 editing	 at	 a	 later	 time.	When	 your	movie	 is
complete,	you	have	additional	options	for	saving	the	file,	so	that	it	may	be	played	in	a	webpage	or	emailed,	for	example.	These	other
options	do	not	allow	editing,	so	it	is	important	to	save	your	working	file	in	the	Movie	Maker	project	format.

There	are	a	few	options	for	sharing	your	completed	movie.	My	Computer	–
Suggested	Selection
This	option	is	best	for	movies	you	will	use	in	other	applications	such	as
PowerPoint.

1.	 Click	onSAVE	TO	MYCOMPUTERfrom	the	TASKPANE
2.	 Enter	a	name	for	your	saved	movie
3.	 SelectBESTQUALITYFORPLAYBACKON	MY	COMPUTER
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Here	are	the	definitions	for	each	in	a	nutshell:

•Titles	are	standalone	clips	meant	to	precede	your	movie.
•Credits	are	standalone	clips	meant	to	follow	your	movie.
•Captions	are	text	areas	that	are	superimposed	on	top	of	clips	or	photos.

That’s	it.		Really!	:-)
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Knowledge	Check	Points

Window	Moviemaker
.1)What	type	of	file	should	you	save	your	audio	as	to	be	able	to	import	it	correctly	into	movie	maker?

A.	 .jpg
B.	 .mov
C.	 .wav	(Answer)
D.	 .aud

.2)Youcan	add	narration	to	your	timeline	by	speaking	into	a	microphone	afached	to	the	computer.
A.	 True	(Answer)
B.	 False

.3)To	delete	any	part	of	the	timeline,	select	the	item	and	press	“delete”
A.	 True	(Answer)
B.	 False

.4)Single	still	images	from	a	video	clip	are	called:
A.	 trim	points
B.	 frames	(Answer)
C.	 source	file

.5)A	file	on	your	computer	that	containes	an	image,	a	clip,	a	soundtrack,	or	all	the	footage	from	your	digital	camera	or	phone:
A.	 storyboard
B.	 source	file	(Answer)
C.	 project

.6)The	purpose	of	the	“collections”	section	is:
A.	 to	display	any	pictures	or	music	clips	that	have	already	been	imported	(Answer)
B.	 to	help	you	import	pictures	into	MovieMaker
C.	 to	assist	you	in	adding	effects	and	transitions	to	your	movie

.7)How	do	titles	and	credits	let	you	enhance	your	movie?
A.	 by	adding	text-based	information	to	your	movie	(Answer)
B.	 smaller	segments	of	larges	audio	and	video	files
C.	 collections	pane	of	Windows	Movie	Maker
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.8)A	collection	acts	as	a	for	.

A.	 container,	clips	(Answer)
B.	 organizer,	captured
C.	 split,	two	clips

.9)How	can	we	test	the	movie?
A.	 Select	the	first	slide	and	then	start	the	movie	from	Video	Preview	(Answer)
B.	 we	cannot
C.	 save	it

.10)Windows	Movie	Maker	will	allow	you	to	use,	pictures,ORpictures	and	video	clips,OR	just	video	clips	on	the	video	timeline.
A.	 True	(Answer)
B.	 False

.11)In	Windows	Movie	Maker,	if	I	delete	a	video	clip,	picture	or	audio	file	from	a	collection	folder,	it	is	also	deleted	from	the
hard	drive.

A.	 True
B.	 False	(Answer)

.12)Movements	as	one	picture	or	video	clip	changes	to	another.
A.	 effects
B.	 transitions	(Answer)
C.	 sequences
D.	 collections

.13)To	add	pictures	to	your	movie,	click	on…
A.	 capture	images
B.	 capture	video
C.	 import	pictures	(Answer)
D.	 import	video
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Some	more	Knowledge	Check	Points:-

1.	 Moving	Pictures	Expert	Group,	a	company	of	programmers	and	designers,	designed	a	series	of	widely	used	multimedia
file	formats	known	as:
A.	 Flash
B.	 MPEG
C.	 AVI
D.	 Macromedia

2.	 Windows	Media	Audio	(WMA)	stands	for:
A.	 Lossless	compression	to	significantly	reduce	file	size.
B.	 Microsoft	Windows	Media	native	audio	file	format
C.	 The	uncompressed	Wave	audio	file	format	used	with	Microsoft	Windows.

3.	 Tweening	is	the	process	of:-
A.	 Joining	pieces	of	animation	with	a	fade	or	slide.
B.	 Duplicating	frames	between	key	frames	to	animate	an	object.
C.	 Generating	frames	between	key	frames	to	animate	an	object.
D.	 Animating	an	object	to	make	it	spin.

4.	 An	animation	has	30	frames	per	second(fps).	If	the	animation	plays	for	30	seconds	how	many	frames	in	total	would	the
animation	contain?

A.	 1800	frames
B.	 900	frames	C.	1200

D.			1500
5.	 Youare	working	on	the	draft	of	a	logo.Youare	trying	to	decide	whether	to	flafen	the	image	or	leave	the	document	as	a

layered	 file	 until	 your	 client	 has	 approved	 the	 logo.	Which	 format	 should	 you	 use	 if	 you	 anticipate	making	 future
changes	to	the	logo	in	Photoshop?
A.	 Merge	the	layers	that	you	like	and	leave	the	remainder	in	layers
B.	 Leave	the	document	as	a	layered	file	for	any	future	edits	or	changes
C.	 Flafen	the	image	to	save	file	space
D.	 Merge	only	the	text	layers
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6.	 What	video	editing	technique	allows	one	to	make	a	gradual	change	from	one	video	clip	to	another	by	using	special
effects?
A.	 Transitions
B.	 Alpha	channel
C.	 Time	stamping
D.	 Scenes

7.	 Which	of	the	following	file	formats	delivers	vector-based	animation	on	the	web?
A.	 AVI
B.	 SWF
C.	 Animated	GIF
D.	 EPS

8.	 The	quality	of	a	vector	image	is	;-
A.	 Wholly	resolution	dependant
B.	 Reduced	if	the	image	is	resized
C.	 Totally	dependent	on	the	number	of	colours	used
D.	 Unaffected	if	the	image	is	rescaled	to	a	different	size.

9.	 What	is	the	most	effective	method	for	preserving	bitmap	image	quality?
A.	 Use	the	original	image	at	exactly	100%	size
B.	 Select	Allow	smoothing	from	Bitmap	Properties
C.	 Break	apart	image	and	resize	to	fit	exactly
D.	 Resize	proportionately	by	holding	shift	key

10.	 Which	of	the	following	is	true	of	a	bitmap	image?
A.	 It	is	made	up	of	pixels	on	a	grid
B.	 it	cannot	be	edited
C.	 Scaling	does	not	reduce	the	quality
D.	 It	is	mathematically	defined

11.	 MP	3	is	a	file	extension	and	file	format	that	is	used	for:
A.	 Audio	files.
B.	 Digital	files
C.	 High-definition	widescreen	film.
D.	 Web-based	multimedia.

	
218



12.	 Seema	edits	a	photo	in	Photoshop	and	saves	it	as	a	Jpeg	file	to	use	on	a	birthday	card.	When	he	resizes	the	image	to
make	it	larger,	it	looks	blurred.	This	is	most	likely	a	result	of;-
A.	 Dithering
B.	 Pixilation
C.	 Anti	aliasing
D.	 Distortion

13.	 You	are	required	to	create	a	music	mash	up	of	5	different	top	songs	for	2013.	What	type	of	file	should	you	save	your
audio	track,	in	order	to	import	it	correctly	into	a	program	like	Windows	Movie	Maker?
A.	 .aid
B.	 .wav
C.	 MP	3
D.	 Both	B	&	C

14.	 Youare	creating	a	graphic	for	a	web	page.Youneed	to	maintain	a	transparent	background	using	a	mafe	color.Youhave
turned	off	the	visibility	of	the	background	layer.
A.	 Choose	File	>	Save	As,	and	then	select	GIF
B.	 Choose	File	>	Save	As,	and	then	select	JPEG
C.	 Choose	File	>	Save	for	Web,	and	then	select	PNG
D.	 Choose	File	>	Save	for	Web,	and	then	select	GIF

15.	 To	generate	a	video	production	in	its	final	form,	including	transitions,	effects,	and	superimposed	tracks	is	called:
A.	 Compress.
B.	 Render
C.	 Store
D.	 Finalize.

16.	 The	process	of	playing	audio	and	video	in	real	time	over	the	internet	is	called;-
A.	 File	Sharing
B.	 Transferring
C.	 Streaming
D.	 Downloading
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17.	 A	junior	animator	has	been	asked	to	quickly	develop	a	short	30	second	animation	usingFLASHand	save	it	in	the	most
easily	viewed	web	format.	Which	file	format	do	you	recommend	is	the	most	appropriate	for	uploading	to	an	internet
site?
A.	 FLV
B.	 SWF
C.	 WMV
D.	 MPEG

18.	 What	should	you	take	 into	consideration	when	preparing	 images	 for	an	educational	audience	of	students,	ages	 five
through	to	11?
A.	 Entertaining	and	colorful	images
B.	 Whether	the	images	are	age	appropriate
C.	 Parental	concerns	and	requests
D.	 All	of	the	above

19.	 This	Flash	file	is	smaller	because	it	is	used	to	view	and	use	only.	It	cannot	be	modified.
A.	 FLV
B.	 SWF
C.	 HTML
D.	 PPT

20.	 A	design	in	Adobe	Photoshop	consists	of	multiple	…………………….of	graphics	andtext.
A.	 Layers
B.	 Text
C.	 Images
D.	 Graphics

21.	 Youhave	an	image	with	four	layers.	What	will	happen	if	you	select	all	the	four	layers	and	apply	a	style	from	the	Styles
palefe?
A.	 The	style	will	apply	on	all	the	four	selected	layers	simultaneously.
B.	 The	style	will	apply	only	on	the	bofom	most	layer.
C.	 The	style	will	not	affect	any	layer.
D.	 The	style	will	apply	only	on	the	topmost	layer

22.	 What	are	two	file	types	that	are	associated	with	Flash?
A.	 FLVand	SWF
B.	 PSDand	FLV
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C.	 PSDand	SWF
D.	 SWFand	DOC

23.	 The	process	of	building	a	movie	from	souce	files	so	that	its	can	be	viewed	on	another	system	such	as	a	PC	or	a	DVD
player.
A.	 Capture
B.	 Frames
C.	 Storyboard
D.	 Rendering(Ans)

24.	 To	record	audio,	video,	or	a	still	image	as	a	digital	file	on	your	computer.
A.	 Capture(Ans)
B.	 Clips
C.	 Trim	posts
D.	 Text	clip

25.	 Uses	a	time	scare	that	measures	the	length	of	clips	within	a	scene	and	works	in	real	time	while	the	scene	plays	back.
A.	 Project
B.	 Frames
C.	 Timeline(Ans)
D.	 Import

26.	 Single	still	images	from	a	video	clip.
A.	 Trim	points
B.	 Text	clip
C.	 Source	file
D.	 Firewire
E.	 Frames(Ans)

27.	 A	file	on	your	computer	that	containes	an	image,	a	clip,	a	soundtrack,	or	all	the	footage	from	your	digital	video
camera.
A.	 Storyboard
B.	 Project
C.	 Source	file(Ans)

D.	 import
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Window	Movie	Maker	Keyboard	shortcuts

Shortcut	keys	are	available	for	many	of	the	commands	in	Windows	Movie	Maker.	By	using	shortcut	keys,	we	can	quickly	accomplish
common	tasks.

The	following	table	provides	an	overview	of	the	tasks	we	can	complete	by	using	shortcut	keys.
Task	Shortcut	key
Create	a	new	project	CTRL+N
Open	an	existing	project	CTRL+O
Save	a	project	CTRL+S
Save	a	project	with	a	new	name	F12
Save	a	movie	CTRL+P
Capture	video	CTRL+R
Import	an	existing	digital	media	file	CTRL+I
Undo	the	last	action	CTRL+Z
Redo	the	last	undone	action	CTRL+Y
Cut	CTRL+X
Copy	CTRL+C
Paste	CTRL+V
Delete	DELETE
Select	all	clips	CTRL+A
Rename	a	collection	or	clip	F2
Clear	the	storyboard/timeline	CTRL+DELETE
Show	or	hide	the	storyboard/timeline	CTRL+T
Zoom	in	on	the	timeline	PAGE	DOWN
Zoom	out	on	the	timeline	PAGE	UPAdd	selected	clips	to	the	storyboard/timeline	CTRL+DPlay	video	in	full
screen	ALT+ENTER
Set	start	trim	point	CTRL+SHIFT+I
Set	end	trim	point	CTRL+SHIFT+O
Clear	trim	points	CTRL+SHIFT+DELETE
Split	a	clip	CTRL+L
Combine	contiguous	clips	CTRL+M
Nudges	clip	to	the	left	CTRL+SHIFT+B
Nudges	clip	to	the	right	CTRL+SHIFT+N
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Play	or	pause	clip	SPACEBAR
Stop	playback	on	the	storyboard/timeline	CTRL+K
Play	content	on	the	storyboard/timeline	CTRL+W
Rewind	content	on	the	storyboard/timeline	CTRL+Q
Back	CTRL+ALT+LEFT	ARROW
Forward	CTRL+ALT+RIGHT	ARROW
Previous	frame	ALT+LEFT	ARROW
Next	frame	ALT+RIGHT	ARROW
Display	Help	topics	F1
Select	previous	item	(on	a	timeline	track,	on	the
storyboard,	or	in	the	Contents	pane)	LEFTARROWSelect	next	item	(on	a	timeline	track,	on	the	storyboard,	or	in
the	Contents	pane)	RIGHT	ARROW
Select	item	above
(on	a	timeline	track	or	in	the	Contents	pane)	UP	ARROWSelect	item	below	(on	a	timeline	track	or	in	the
Contents	pane)	DOWN	ARROW
Go	to	the	first	item	(on	a	timeline	track,
on	the	storyboard,	or	in	the	Contents	pane)	HOMEGo	to	the	last	item	(on	a	timeline	track,	on	the
storyboard,	or	in	the	Contents	pane)	END
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Glossary

•	bandwidth	:	A	network’s	capacity	for	transferring	an	amount	of	data	in	a	given	time.
•	bit	rate	:	The	number	of	bits	transferred	per	second.
•	Capture	:	To	record	audio,	video,	or	still	images	as	digital	data	in	a	file.
•capture	device	:Hardware	that	transfers	audio	and	video	from	an	external	source,	such	as	a	VCR	or	camcorder,	to	a	computer.

•	Clip	:	Small	segment	of	a	larger	video	file.
•Codec	:An	abbreviation	for	compressor/decompressor.	Software	or	hardware	used	to	compress	and	decompress	digital	media.

•	Collection	:	A	container	for	organizing	clips.
•Compression	:A	process	for	removing	redundant	data	from	a	digital	media	file	or		stream	to	reduce	its	size	or	the	bandwidth	used.

•Content	:Audio,	video,	images,	text,	or	any	other	information	that	is	contained	in	a	digital	media	file	or	stream.

•Cross-fade	:A	method	of	smoothly	moving	from	one	video	clip	or	photo	to	another.		With	 a	 cross-fade	 transition,	 the	 frames	 in	 the
playing	clip	fade	out	as	the	frames	in	the	new	clip	fade	in.	In	the	film	industry,	the	same	process	is	called	a	dissolve.

•depth	of	field	:The	measurement	of	the	area	in	front	of	and	behind	the	subject	that	is	in	focus.

•	digital	video	(DV)	:	Video	images	and	sound	stored	in	a	digital	format.
•direct	memory	 access	 (DMA)	 :Memory	 access	 that	 does	 not	 involve	 the	 microprocessor	 and	 is	 frequently	 used	 for	 data	 transfer

directly	between	memory	and	a	peripheral	device,	such	as	a	disk	drive.

•	Download	:	To	transfer	a	file	over	a	network	in	response	to	a	request	from	the	device	that	receives	the	data.	Downloaded	content	is
kept	on	the	receiving	device	for	playback	on	demand.	In	contrast,	streamed	content	is	played	as	it	is	delivered.

•	Frame	:	One	of	many	sequential	images	that	make	up	video.
	

224



•frame	rate	 :The	number	 of	 video	 frames	displayed	per	 second.	Higher	 frame	 rates	 generally	 produce	 smoother	movement	 in	 the
picture.

•Header	:A	part	of	the	file	structure	that	contains	information	required	by	an	application	to	decompress	and	render	the	content.	The
header	in	a	protected	file	also	contains	information	required	to	get	a	license.

•Institute	of	Electrical	and	Electronics	Engineers	 (IEEE)	1394	 :A	high-speed	serial	bus	standard	 that	provides	enhanced	computer
connectivity	 for	 a	 wide	 range	 of	 devices,	 including	 consumer	 electronics	 audio/video	 (A/V)	 appliances,	 storage	 peripherals,
other	computers,	and	portable	devices.

•	microphone	noise	:Unwanted	sound	that	is	captured	when	objects	touch	a	microphone	inadvertently.

•moiré	paflern	:Video	artifacts	that	occur	when	recording	an	object	that	has	many	thin,	parallel	lines.

•project	file	:The	file	that	contains	information	about	the	files	that	have	been	imported	into	or	captured	in	the	current	project,	and
how	files	or	clips	have	been	arranged.

•	Record	:	See	definition	for:	capture

•Source	:Audio	and	video	content	that	can	be	captured	and	encoded	from	devices	installed	on	your	computer	or	from	a	file.

•	Split	:	To	divide	an	audio	or	video	clip	into	two	clips.

•	Storyboard	:	A	view	of	the	workspace	that	displays	the	sequence	of	your	clips.

•Timeline	:The	area	of	the	user	interface	that	shows	the	timing	and	arrangement	of	files	or	clips	that	make	up	a	project.

•Trim	:To	hide	parts	of	a	file	or	clip	without	deleting	them	from	the	original	source.	Files	and	clips	can	be	trimmed	by	adjusting	the
start	or	end	trim	points.

•trim	points	:The	points	where	playback	of	a	file	or	clip	begins	and	ends.	There	are	two	trim	points:	start	trim	point	and	end	trim
point.

•Windows	Media	 file	 :A	 file	 containing	 audio,	 video,	 or	 script	 data	 that	 is	 stored	 in	Windows	Media	 Format.	 Depending	 on	 their
content	and	purpose,	Windows	Media	files	use	a	variety	of	file	name	extensions,	such	as:	.wma,	.wme,	.wms,	.wmv,	.wmx,	.wmz,
or	.wvx.
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•Windows	Media	Technologies	:A	family	of	digital	media	software	developed	by	Microsoft,	such	as	Windows	Media	Services,	Windows
Media	Encoder,	and	Windows	Media	Player.

•Windows	Movie	Maker	:Software	for	capturing,	editing,	and	arranging	audio	and		video	source	material	to	create	movies.

•Workspace	:The	area	of	Windows	Movie	Maker	in	which	you	create	your	movies.	It	consists	of	two	views:	storyboard	and	timeline,
which	act	as	a	container	for	work	in	progress.
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Chapter	Six
ITDC-411

Customizing	and	EmbeddingMultimedia	Components
inWebPages

•Compatible	Multimedia	File	Formats	forWeb	Pages
•Embedding	Audio	File
•EmbeddingVideo	File
•Embedding	Flash	File

	
227



Introduction
Multimediameans	that	computer	information	can	be	represented	through	audio,	video,	and	animation	in	addition	to	traditional	media
(i.e.,	text,	graphics	drawings,	images).
Multimedia	 is	 the	 field	 concerned	 with	 the	 computer-controlled	 integration	 of	 text,	 graphics,	 drawings,	 still	 and	 moving	 images
(Video),	animation,	audio,	and	any	other	media	where	every	type	of	information	can	be	represented,	stored,	transmifed	and	processed
digitally.
A	Multimedia	 Application	 is	 an	 Application	 which	 uses	 a	 collection	 of	 multiple	 sources	 e.g.	 text,	 graphics,	 images,	 sound/audio,
animation	and/or	video.
Introduction	of	Dreamweaver
Dreamweaver	 has	 become	 one	 of	 the	 industry’s	 leadingWebsite	 Design	 editing	 andmanagementtool.
Thiscourseisdesignedforstudentswho	 wishtoevaluate	 theDreamweaverWebdesign	 tool	 or	 who	 would	 like	 to	 learn	 to	 use	 it.	 The
emphasis	is	on	learning	to	use	Dreamweaver	as	a	tool	to	create	aWebsite,	rather	than	on	learning	the	basic	concepts	ofWebdesign	and
we	move	very	quickly.	However,	all	questions	about	basic	Webdesign	concepts	will	be	answered.
Dreamweaver	is	a	web	development	application.	It	is	a	web	editor	and	allows	users	to	create	web	pages	with	different	features	without
the	need	 to	write	 the	HTML	 code	 by	 hand.	 The	 application	 enables	 you	 to	 preview	websites	 in	 a	 preview	panel	 and	 also	 provides
transfer	and	synchronization	features.	Dreamweaver	is	a	software	application	whose	main	function	is	to	design,	manage	and	publish
websites.	This	softwarewasoriginally	created	by	Macromedia	but	rights	to	produce	it	were	later	sold	to	Adobe	Systems.
Starting	Dreamweaver
1.			Start	Dreamweaver.	You	should	see	a	start		up	Screen.
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Define	a	local	site
When	you	Define	a	local	site,	you	tell	Dreamweaver	where	you	plan	to	store	all	the	files	for	a	particular	site.	To	work	effectively	in
Dreamweaver,	always	define	a	local	site	for	each	Web	site	you	create.
For	this	tutorial,	you’ll	specify	the	Compass	Site	folder	as	the	local	site	folder.

1.	 If	it	isn’t	already	open,	launch	Dreamweaver.	A	blank	document	opens.
2.	 Choose	Site	>	New	Site.
3.	 In	the	Site	Definition	dialog	box,	make	sure	Local	Info	is	selected	in	the	Category	list.
4.	 In	the	Site	Name	field,	type	my	tutorial.	The	site	name	lets	you	easily	identify	and	select	a	site	from	a	list	of	sites	you’ve

defined.
5.	 Click	the	folder	icon	to	the	right	of	the	Local	Root	Folder	field.
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6.	 In	Windows,	click	Open,	then	click	Select	when	Compass	Site	appears	in	the	Select	field.
7.	 On	the	Macintosh,	click	Choose	to	select	 the	Compass_Site	 folder.	The	Local	Root	Folder	 field	updates	 to	display	 the

path	to	the	local	site.
Note:	The	complete	path	to	the	Compass_Site	folder	may	vary,	depending	on	where	you	installed	Dreamweaver.

8.	 Click	OK	to	close	the	dialog	box.

Local	Info
Local	Info	is	where	we	put	in	the	information	about	the	files	that	are	on	your	local	computer	(which	is	where	all	your	files	are	or	will
be	for	now).

1.	 In	the	Advanced	Tab,	under	Category,	choose	Local	Info.
2.	 Next	 to	 Site	 Name,	 type:	 My	 First	 Dreamweaver	 Web	 site.Youwill	 use	 this	 name	 when	 you	 go	 into	 Dreamweaver	 to

retrieve	the	files	associated	with	this	site.	This	name	has	to	be	unique	within	Dreamweaver.
3.	 Next	to	Local	root	folder,	click	on	the	yellow	folder	icon	to	browse	for	where	you	want	to	store	your	web	site	on	your

local	computer.	You	may	wish	to	create	a	new	folder	to	store	your	files	in.	I	stored	my	Web	site	on	F:	(my	flash	drive)	in	a
folder	I	called	My	WebSite.	This	is	now	your	Root	Folder

4.	 Click	DONE.	You	should	see	a	Files	panel	on	the	right	side	of	your	screen.	The	Local	View	in	the	Files	Panel	will	display
all	the	files	for	your	Web	site	that	are	in	the	Root	Folder	on	your	computer.
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Later	we	will	add	information	about	connecting	to	the	server.	The	Remote	View	shows	which	files	have	been	uploaded	to	the
server.

5.	Once	we’ve	entered	all	this	information	about	local	and	remote	servers,	it	will	be	set	up	for	us	next	time	we	use	Dreamweaver	on
this	computer.	Unfortunately,	it	doesn’t	work	thatwayon	lab	computers.	If	you	move	to	another	computer,	you	will	have	to	set
up	your	Web	site	on	the	new	computer	as	well.

To	create	a	Web	page,	follow	these	guidelines:

1.	 Choose	a	page	to	be	the	homepage	of	your	Web	site.	This	will	be	the	first	page	that	users	encounter	when	they	visit	your
site.	Save	this	file	to	your	local	root	folder	as	home.html.	Naming	the	homepage	home.html	tells	theWebbrowser	that
this	is	the	first	page	it	should	open	when	someone	visits	your	site.

2.	 To	add	a	new	page	go	to	File	>	New	and	choose	a	basic	HTML	page.	Save	this	page	by	clicking	File	>	Save	As.	Name	the
first	page	index.html	(that	is	home	page)
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3.	 After	your	homepage	is	created,	you	can	use	this	page	as	a	template	layout	for	all	the	other	pages	in	your	site.	Simply
hit	Save	As	and	name	the	file	whatever	you	wish,	But	Remember	not	to	use	capital	lefers	or	spaces	when	naming	files;
this	will	make	it	easier	for	web	browsers	to	find	your	files.

4.	 To	save	the	pages	of	your	site	simply	click	File	>	Save	for	each	page.	Make	sure	your	homepage	is	named	index.html,
and	save	all	of	your	files	in	the	folder	you	chose	when	you	defined	your	site,	i.e.	in	your	local	root	folder.

5.	 After	your	homepage	is	created,	you	can	use	this	page	as	a	template	layout	for	all	the	other	pages	in	your	site.	Simply
hit	 Save	 As	 and	 name	 the	 file	 whatever	 you	 wish,	 but	 be	 sure	 to	 keep	 the	 name	 simple,	 for	 example	 CV.html,
resume.html,	pictures.	etc.	Remember	not	to	use	capital	lefers	or	paces	when	naming	files;	this	will	make	it	easier	for
web	browsers	to	find	your	files.

6.	 To	save	the	pages	of	your	site	simply	click	File	>	Save	for	each	page.	Make	sure	your	homepage	is	named	home.html,
and	save	all	of	your	files	in	the	folder	you	chose	when	you	defined	your	site,	i.e.	in	your	local	root	folder.

NOTE:	After	that	all	file	transfer	to	the	entire	site	once	you	have	finished	working	on	it.

WHAT’S	A	ROOT	FOLDER?
The	local	root	folder	is	where	you	will	keep	ALL	the	files	for	your	web	site.Youcan	create	subfolders	under	it,	but	consider	it	to	be	the
parent	of	all	parent	folders.	You’ll	keep	all	of	the	files	and	subfolders	for	yourWebsite	(including	html	pages,	images,	multimedia	files,
etc.)	either	in	the	root	folder	or	a	subfolder	under	the	root	folder..
Making	your	first	Web	Page:

10.	 Under	the	File	menu	at	the	top,	choose	New.
11.	 In	the	New	Document	dialog	box,	make	sure	you	have	Blank	Page	selected,	the	Page	Type	is	HTML,	and	the	Layout	is

<none>.
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12.	 Click	Create.	You	should	now	see	a	blank	Web	page	in	the	Document	Window.
13.	 Under	the	File	Menu,	choose	Save.
14.	 In	the	Save	As	box,	find	your	Web	site	folder	and	save	your	file	as	index.html
15.	 Click	Save.	In	the	Files	panel,	you	should	now	see	index.html.	Congratulations!	You’vecreated	your	first	Web	page	using

Dreamweaver.	Unfortunately,	it’s	prefy	boring	at	the	moment.
RULES	OF	THUMB	for	naming	web	files:

•Do	not	use	spaces	or	special	characters,	such	as	those	found	about	the
number	 keys	 onthekeyboard,inyour	 filenames.Youcan
usedashesandunderscores.	(e.g.,my_page.html)

•Always	 use	 a	 3-or	 4-character	 file	 extension	 for	 every
file	 you	use	on	 the	Web.	 In	 the	case	of	a	 regular	Web
page,	always	use	.htm	or	.html.

•Be	very	specific	about	capitalizing	because	most	Web	servers	are	case-
sensitive.

Give	your	Web	Page	a	Title
In	the	document	toolbar,	find	the	Title	box.

1.	 On	the	document	toolbar,	locate	the	Title	field.
2.	 Type	in	a	title	for	your	page.	Feel	free	to	be	creative	(but	not	indecent).	Hit	Enter
3.	 The	title	doesn’t	show	up	on	the	page,	but	will	appear	in	tabs	and	across	the	top	of	browsers.

Adding	Some	Content

1.	 In	the	Document	window,	type	in	a	good	title.	This	one	will	be	the	head	of	yourWebpage.	If	you	can’t	think	of	anything,
you	can	always	use,	“Aardvark	Adoption	Society	of	Delaware”.

2.	 Add	a	subtitle.	Again,	it	can	be	anything	you	want.	If	you’d	prefer,	it	could	be,	“We	speak	for	Aardvarks	who	can’t	speak
for	themselves.”

3.	 Now	that	you’ve	got	a	good	title,	add	some	content.	Logically,	it	should	go	with	the	title.	Type	one	or	two	lines	now	for
now.	We’ll	add	more	later.	(If	you	can’t	think	of	anything,	feel	free	to	throw	in	some	of	the	Aardvark	content).
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Now	let’s	format	the	content:
ØOn	the	Web	page,	highlight	the	title.
ØIn	the	Property	Inspector,	click	on	the	Format	drop	down	arrow,	and	choose	Heading	1.

Note:If	you	do	not	see	the	Property	Inspector,	choose	Window	>>	Properties.
4.	 On	the	web	page,	highlight	the	second	line	of	text.
5.	 From	the	Format	menu	on	the	Property	Inspector,	choose	Heading	2.

Note:	When	formafing	your	text,	keep	in	mind	that	text	sizes	in	HTML	are	relative	sizes.	This	means	that,	when	your	page	is	viewed	in
a	browser,	the	text	size	will	depend	on	the	default	text	size	sefings	on	each	user’s	computer.	Relative	sizes	give	users	the	ability	to
adjust	the	text	size	to	suit	their	individual	needs.	This	option	is	especially	important	for	people	with	visual	impairments,	but	it	means
that	the	appearance	of	your	pages	may	vary	from	computer	to	computer.
Playing	with	Font	Properties

1.	 Highlight	the	Subtitle.	Change	the	font	size	to	24.
2.	 Highlight	any	word	on	the	page	and	click	the	Bold	icon	(	)	on	the	Property	Inspector.	The	selected	word	appears	bold.
3.	 Highlight	the	title	click	the	gray	square	to	the	right	of	the	Size	popup	menu	in	the	Property	Inspector.	A	grid	of	colored

squares	appears,	and	the	cursor	changes	to	an	eye	dropper.
4.	 Click	the	eyedropper	on	the	desired	color.	The	field	to	the	right	of	the	color	swatch	reflects	the	code	Web	browsers	need

to	correctly	display	the	color	you’ve	chosen.
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Alignment
1.	 Highlight	the	title	and	subtitle	on	the	page.
2.	 Click	the	Align	Center	bufon	(	)	on	the	Property	Inspector.	The	titles	should	now	be	centered	on	your	page.

Creating	Lists
1.	 First	we	need	to	add	a	list.
2.	 Type	in	a	title	for	your	list	and	then	type	in	a	list	of	items.	Make	sure	there	are	at	least	3	items	in	your	list.	Make	sure

you	hit	return	after	each	item.	(Feel	free	to	use	a	list	from	the	aardvark	homework	if	you	can’t	think	of	your	own.)
3.	 Highlight	the	list	title	and	choose	Heading	3	from	the	Format	menu	on	the	Property	Inspector.
4.	 Highlight	the	list	items	and	click	the	Unordered	List	bufon	on	the	Property	Inspector.
5.	 The	items	appear	as	a	bulleted	list.
6.	 Now	type	in	another	List	title	and	another	list	of	items.
7.	 Highlight	the	title	and	select	Heading	3.
8.	 Highlight	the	rest	of	the	items	and	click	the	Ordered	List	bufon	on	the	Property	inspector	(next	to	the	ordered	list

bufon).	The	items	should	now	appear	in	a	numbered	list.
9.	 Save	your	work.	Get	into	the	habit	of	saving	your	work	regularly.
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Page	Properties
In	this	section	you	will	learn	how	to	set	your	page’s	background	color,	aswellas	the	default	text	and	link	colors.	These	sefings	differ
from	what	you’ve	done	so	far	on	the	Property	Inspector	because	they’ll	apply	to	all	the	text	and	links	on	the	page—not	just	a	selected
piece	of	text.

	
1.	 From	the	Modify	menu	at	the	top	of	the	workspace,	choose	Page	Properties.
2.	 To	change	the	text	color,	click	the	bofom	right	corner	of	the	text	color	box.
3.	 Using	the	eyedropper,	choose	a	color	by	clicking	on	any	of	the	color	swatches.
4.	 Similarly,	you	can	change	the	background	color	for	the	page	using	the	Background	color	sefing.
5.	 Youcan	also	change	the	color	of	links,	active	links,	and	visited	links.	An	active	link	is	a	link	just	when	the	user	clicks	it.

A	color	change	lets	the	user	know	that	s/he	clicked	on	a	link.	A	visited	link	is	one	that	the	user	has	already	clicked	on
and	visited.	A	color	change	lets	the	user	know	s/he’s	already	visited	that	link.

6.	 Select	“Links”	from	the	Category	menu	at	left,	then	make	your	selections	for	link,	visited	link,	and	active	link	colors	as
you	did	in	Step	3.

7.	 Click	the	Apply	bufon	to	see	how	your	color	choices	look	on	the	index	page.	ThePageProperties	dialog	box	will	remain	on
the	screen.

8.	 When	you’re	satisfied	with	the	colors	you’ve	picked,	click	OK.
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Note:Youcan	add	a	background	image	if	you	want.	Browse	to	find	an	image	by	the	background	image.	See	what	it	looks	like.	Now	you
know	that’s	an	option.	We’ll	talk	about	this	option	more	later.	For	now,	go	back	to	a	solid	color	background.
Note:If	you	changed	the	color	for	any	text	using	the	Property	Inspector,	those	changes	will	override	general	page	color	choices.
Web	Page	Preview
As	you	create	a	page	in	Dreamweaver,	the	page	may	not	look	exactly	like	it	would	in	a	browser.	To	preview	the	page	in	a	browser:

1.	 Choose	File	>>	Preview	in	Browser	>>	i-explorer	or	Netscape	or	press	the	F12	key.	A	web	browser,	such	as	Netscape	or
Internet	Explorer,	opens	and	loads	the	web	page.

2.	 Take	a	look	at	your	page	to	see	how	it	will	appear	on	the	Web.
3.	 When	finished,	close	the	browser	and	switch	back	to	Dreamweaver.

NOTE:Colored	or	underlined	text	can	be	mistaken	for	links.	Choose	your	color	scheme	so	that	the	links	stand	out	from	rest	of	the	text.
The	text	and	links	also	should	stand	out	from	the	background	for	readability.	When	selecting	colors,	keep	it	simple.	Too	many	colors
can	be	distracting	or	confusing.
Adding	Images
Note:	Any	editing	or	resizing	of	an	image	should	be	completed	before	it	is	added	to	a	web	page.

1.	 First	you	need	an	image.	Feel	free	to	find	one	on	your	own	that	suits	the	theme	of	your	web	page.	If	you	don’t	feel	like	it,
I’ve	included	an	image	on	myWebsite	that	you	can	download.

2.	 Next,	add	it	to	your	Web	page.
3.	 Place	your	cursor	below	the	sub	header	in	your	document	and	press	Enter	twice.
4.	 Choose	Insert	>>	Image.	The	Select	Image	Source	dialog	box	will	appear.
5.	 Using	the	dialog	box,	locate	and	select	an	image,	then	click	OK.
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You	will	first	encounter	a	prompt	to	add	accessibility	afributes:

•	Type	a	brief	description	of	the	image	in	the	Alternate	text	box,	then	click	OK.
	

•	Because	you’re	trying	to	use	a	file	that	lies	outside	your	root	folder	(mywebsite),	you’ll	receive	the	following	message:	•	Click	Yes.
The	Copy	File	As	dialog	box	will	appear.

•	Click	the	Save	bufon	to	place	a	copy	of	the	image	file	inside	your	my	website	folder.
•	The	image	will	appear	on	your	web	page.
•	Click	the	Refresh	bufon	on	the	Files	panel	(	)	and	the	image	file	will	appear	in	the	list	oflocal	files.
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Delete	an	Image
1.	 In	the	Document	window,	click	on	the	image	to	select	the	image.
2.	 Press	the	Delete	key.	The	image	disappears.
3.	 To	reverse	the	deletion,	use	the	Undo	command.	From	the	Edit	menu,	choose	Undo.	The	image	should	reappear	on	the

page.
Create	a	Second	Page
Next,	you	will	create	a	second	page	for	your	Web	site.

1.	 From	the	File	menu,	choose	New…The	New	page	dialog	box	appears.
2.	 Click	the	Create	bufon.	The	new	file	will	appear	in	the	document	window.
3.	 Save	your	new	page	in	the	mywebsite	folder	as	Page2.html
4.	 In	the	Title	field,	type	an	appropriate	title	for	this	page.We’lleventually	make	it	into	a	Calendar	of	Events	Page,	if	that

helps	you	decide	on	a	title.
5.	 Save	your	work.

Insert	Table
To	insert	a	table,	follow	these	steps:

1.	 In	the	main	menu,	click	Insert	>	Table	(alt+ctrl+T)
2.	 Insert	the	amount	of	Table	Rows	and	Columns
3.	 Set	Table	width	to	between	600	and	800	pixels,	or	our	page	ratio.
4.	 Set	Border	thickness.	To	have	a	visible	border	type	in	1	or	higher,	to	have	no	border	type	in	0.
5.	 Cell	padding	adds	room	inside	of	a	cell.	Enter	0	for	no	space	or	a	number	to	Increase	the	space.
6.	 Cell	spacing	adds	space	between	cells.	Enter	0	for	no	space	or	a	number	to	Increase	the	space.
7.	 Click	OK.
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>>	Properties	of	a	Table	Itself
If	you	click	on	one	of	the	table	borders,	you	can	view	your	table	properties	in	the	Table

	
By	the	above	Table	you	can	modify
•	name	your	table;
•	change	the	number	of	rows	and	columns	in	the	table;
•	change	the	width	and	height	of	the	table,
•	Change	the	Cell	Pad:	this	is	the	number	of	pixels	that	come	between	the	border	of	cellsand	the		content	of	cells.
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•Change	the	Cell	Space:	this	is	the	number	of	pixels	that	come	between	the	borders	of	each	cell.
•Change	the	alignment:	this	is	the	position	of	the	table	on	the	left	or	right	edge,	or	in	the	center	of	the	page.
•Change	the	border:	this	is	the	number	of	pixels	that	make	up	the	thickness	of	cell	borders.
•You	can	clear	and	convert	table	widths	and	heights.
•Change	the	background	color	of	the	whole	table.
•Insert	a	background	image	for	the	whole	table.
•Change	the	border	color.

Properties	of	Cells	Inside	Table
Once	the	properties	of	the	table	have	been	set,	you	can	also	adjust	the	properties	of	individual	cells	within	the	table	by	clicking	inside
the	cell
In	the	top	section	of	this	window	you	can	format	the	text	inside	the	table	cell.	In	the	bofom	section	of	this
window	you	can:

•Change	the	alignment	of	the	content	horizontally	and	vertically.
•Change	the	width	and	the	height	of	the	cell •Use	Wrap.
•Insert	Header •Insert	a	background	image	for	the	single	cell.
•Change	the	background	color	for	the	single	cell.
•Change	the	border	color	for	the	single	cell.

Inserting	Image
To	insert	an	image,	follow	these	steps:

1.	 Click	in	the	cell	where	you	want	the	image	to	appear.
2.	 Click	Insert	>	Image.
3.	 Locate	the	image	you	want	to	insert.

NOTE:	All	of	your	images	should	be	saved	in	the	“images”	folder	that	you	established
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when	you	started.
4.	 Click	Choose	to	insert	the	image.

Internal	Links
Internal	links	are	used	to	connect	users	to	other	pages	within	the	same	website.	Before	linking	to	other	pages,	you	must	make	sure
that	the	other	pages	are	saved	in	your	local	root	folder	and	contain	the	file	extension	.html.
To	create	an	internal	link,	follow	these	steps:

•Select	the	text	or	image	you	would	like	to	make	a	hyperlink.
•Click	on	the	small	folder	next	to	the	Link	field	in	the	Properties	Inspector.
•Click	OK.

Embedding	Flash	File	Insert	a	Flash	movie
Now	you’ll	add	a	different	type	of	asset.	You’ll	drag	a	Flash	movie	into	the	cell	below	the	navigation	bufons.

1Click	the	Flash	icon	in	the	Assets	panel	to	view	all	the	Flash	files	in	the	Compass	site.
2In	the	Names	list,	click	welcome.swf	to	select	the	Flash	movie	you’re	inserting	in	the	document.

In	the	Assets	panel’s	preview	area	you	see	a	placeholder	for	the	Flash	movie.

Play	bufon
	

4	In	the	Names	list,	drag	the	Welcome.swf	to	the	cell	below	the	Trip	Planner	navigationbufon.	A	Flash	move	placeholder	appears	in	the
selected	cell.

Insert	Flash	objects
Flash	objects	are	small	graphic	SWF	(Shockwave)	files	you	can	create	while	working	in	Dreamweaver.	You	can	create	Flash	Text	and
Flash	Bufon	objects.	Using	Flash	Text	allows	you	to	design	Web	pages	that	use	nonstandard	fonts	without	worrying	about	which	fonts
visitors	 to	 your	 site	 have	 available	 on	 their	 computers.	 Flash	 bufons	 are	 created	 from	 Flash	 templates	 that	 ship	 with
Dreamweaver.Youcan	easily	customize	a	template	bufon	and	add	it	to	your
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Web	pages.
The	Flash	Text	 object	 appears	 in	 the	document.	 You	must	 play	 the	Flash	object	 to	 see	 the	 text	with	 its	 rollover	 effect.	 1	 If	 it	 isn’t
already	expanded,	in	the	Property	inspector	click	the	expander	arrow	to	see	all.	2	In	the	Flash	Text	Property	inspector,	click	Play.	3	In
the	Document	window,	roll	the	pointer	over	the	FlashTextobject.	4	To	stop	playing	the	object,	click	Stop	in	the	Property	inspector.
Create	a	Flash	buflon	object
Now	you’ll	see	how	easy	it	is	to	add	a	Flash	bufon	to	a	document.	You’ll	create	a	Flash	bufon,	and	add	it	below	the	climber	image.

•In	the	Document	window,	place	the	insertion	point	where	you	want	the	object	to	appear,	below	the	image	of	the	rock	climber,
then	in	the	Objects	panel,	click	the	Insert	Flash	Bufon	icon.

The	Insert	Flash	Bufon	dialog	box	appears.
	

•In	the	Style	list,	select	Beveled	Rect-Bronze.
•For	Bufon	Text,	type	More	Details.
•For	Font,	select	Verdana,	or	choose	one	of	your	favorite	fonts.
•For	Size,	type	11.
•Click	Apply	to	see	the	Flash	bufon	in	the	document.
•In	Save	As,	type	myBufon.swf
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Click	OK	to	close	the	dialog	box.	The	Flash	Bufon	object	appears	in	the	document.

View	the	Flash	buflon	in	the	document
The	Flash	bufon	you	inserted	has	a	rollover	effect,	now	you’ll	play	the	bufon	to	see	how	it	looks.

1In	the	Flash	bufon	Property	inspector,	click	Play	to	play	the	bufon	in	the	document.
2In	the	Document	window,	roll	the	pointer	over	the	object	to	see	the	Flash	bufon’s	rollover	effect.
3To	stop	playing	the	object,	click	Stop	in	the	Property	inspector.You	can	add	music	or	video	into	your	web	page.

Embedding	Audio	File
How	to	Embed	MP3	Audio	Files	In	Web	Pages
<audio	controls>

<source	src=“horse.mp3”	type=“audio/mpeg”>
<source	src=“horse.ogg”	type=“audio/ogg”>

<embed	height=“50”	width=“100”	src=“horse.mp3”>
</audio>

Embedding	Video	File	Windows	Media
Here	is	an	example	of	embedding	a	Windows	Media	file.	On	your	page	you	would	replace	both	instances	of	filename.wmv	with	your
actual	file	path	and	name.
<object	id=“MediaPlayer”	width=“192”	height=“190”	classid=“CLSID:22D6F312-B0F6-11D0-94AB-0080C74C7E95”

standby=“Loading	Windows	Media	Player…”	TYPE=“application/x-oleobject”>
<param	name=“FileName”	VALUE=“filename.wmv”>
<param	name=“ShowControls”	VALUE=“true”>
<param	name=“ShowStatusBar”	value=“false”>
<param	name=“ShowDisplay”	VALUE=“false”>
<param	name=“autostart”	VALUE=“false”>

<embed	type=“application/x-mplayer2”	src=“filename.wmv”	name=“MediaPlayer”	width=“192”	height=“190”
ShowControls=“1”	ShowStatusBar=“0”	ShowDisplay=“0”
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autostart=“0”>	</embed>
</object>

Real	Media
The	following	example	presents	a	real	media	file	on	a	web	page.	Again,	you	would	replace	both	instances	of	filename.rmvb	with	your
actual	file	path	and	name.
<object	id=rvocx	classid=“clsid:cfcdaa03-8be4-11cf-b84b-0020abbccfa”	width=“180”	height=“159”>	<param	name=“src”

value=“filename.rm”>
<param	name=“autostart”	value=“false”>
<param	name=“controls”	value=“imagewindow”>
<param	name=“console”	value=“video”>
<embed	type=“audio/x-pn-realaudio-plugin”	src=“filename.rmvb”	width=“180”	height=“159”	autostart=“false”

controls=“all”	console=“video”>	</embed>
</object>

Note	on	Linking
If	you	create	a	link	directly	to	a	Real	Media	file	it	will	download	in	its	entirety	before	the	user	can	start	playing	it.	You	would	do	that
like	this:	<a	href=“filename.rm”>Download	Video</a>
If	you	wish	to	stream	the	file	such	that	the	user	can	start	watching	 it	as	soon	as	enough	of	 the	 file	 is	buffered,	you	must	create	a
metafile.	 This	 metafile	 is	 a	 simple	 text	 file	 containing	 the	 URL	 of	 the	 video	 file,	 but	 with	 a	 .ram	 extension:
hfp://it.rit.edu/~rpv/local/tutorials/embeding_video/filename.ram	You	would	then	link	to	this	metafile:	<a	href=“filename.ram”>Watch
Video</a>

Quicktime
Embedding	QuickTime	is	similar	to	the	above	two,	again	using	both	the	<object></object>	and	<embed></embed>	tags	for	maximum
browser	compatibility:
<object	classid=“clsid:02bf25d5-8c17-4b23-bc80-d3488abddc6b”

width=“320”height=“180”codebase=“hfp://www.apple.com/qtactivex/qtplugin.cab”>	245



<param	name=“src”	value=“filename.mov”>
<param	name=“autoplay”	value=“true”>
<param	name=“controller”	value=“false”>
<embed	src=“filename.mov”	width=“320”	height=“180”	autoplay=“true”

controller=“false”pluginspage=“hfp://www.apple.com/quicktime/download/”>
</embed>

</object>

MPEG-4
You	can	present	MPEG-4	video	to	your	users	via	the	QuickTime	plug-in	as	well:
<object	classid=“clsid:02bf25d5-8c17-4b23-bc80-d3488abddc6b”codebase=“hfp://www.apple.com/qtactivex/qtplugin.cab”	

width=“320”	height=“256”		>
<param	name=“src”	value=“filename.mp4”	>
<param	name=“autoplay”	value=“true”	>
<embed	src=“qtmimetype.pntg”	type=“image/x-
macpaint”pluginspage=“hfp://www.apple.com/quicktime/download”qtsrc=“filename.mp4”

width=“320”	height=“256”	autoplay=“true”>
</embed>

</object>

Flash
To	place	a	Flash	progressive	download	video	on	your	web	page	you	will	need	two	files:	An	FLV	video	file	and	an	SWF	Flash	application

with	which	to	play	the	video.
Embedding	the	video	on	the	page	is	accomplished	thusly:
<object	classid=“clsid:D27CDB6E-AE6D-11cf-96B8-444553540000”

codebase=“hfp://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#	version=6,0,29,0”	width=“400”
height=“400”	>	<param	name=“movie”	value=“flashplayer.swf”>
<param	name=“quality”	value=“high”	>
<param	name=“LOOP”	value=“false”>
<embed	 src=“flashplayer.swf”	 width=“400”	 height=“400”	 loop=“false”

quality=“high”pluginspage=“hfp://www.macromedia.com/go/getflashplayer”	 type=“application/x-shockwave-flash”></embed
>	</object	>

246



Uploading	Files	toWeb	Dreamweaver	allows	you	to	connect	to	your	main	server	space	and	retrieve	stored	folders	located

on	your	site.	This	feature	will	only	be	necessary	if	you	need	to	update	a	currently	uploaded	website	and	you	no	longer	have	the	local

root	folder	for	the	site.

To	download	a	file	from	the	server,	you	will	need	to	know	the	Remote	Info	(Figure	1).	The	Remote	Info	you	entered	when	you	uploaded
your	site	tells	Dreamweaver	where	to	find	your	currently	uploaded	files.

	
NOTE:	If	you	are	using	a	personal	BGSU	web	account,	you	can	find	the	remote	information	on	the	Gefling	Started	page	of	this	tutorial.
DOWNLOADING	YOUR	FILES
To	download	files,	complete	the	following	process:

1Click	theConnect	bufon.
2Change	the	toolbar	so	it	displaysRemoteViewand	the	files	associated	with	your	site	appear	on	the	screen.
3Select	the	folder	where	all	of	the	files	are	located,	and	click	on	the	Get	bufon.
4You	will	see	a	dialog	box	asking	“Are	you	sure	you	want	to	get	the	entire	site?”	Click	OK.
5Youshould	see	the	files	being	downloaded,	and	when	it	is	completed	your	uploadedWeb	site	should	appear	under	Local	View	in
the	toolbar.
6Goto	File	>	Save	to	save	your	project	before	you	make	changes	to	it.

NOTE:If	this	process	does	not	work,	go	back	and	check	yourRemote	InfounderSites	>
Manage	Site	>your	site	name.
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Hand	on	Activities
Important	:	Add	a	Navigation	Menu	Bar	to	Your	Website

1.	 Start	up	Dreamweaver.
2.	 Load	your	index.html	page	as	before.	That	is,	double	click	the	file	in	the	Files	pane	in	the	right	column.
3.	 Locate	your	existing	navigation	menu,	which	at	this	time	merely	consists	of	a	series	of	links	to	your	home	page,	About

Us	page,	Contact	Us	page	and	the	Site	Map.	Select	them	and	delete	them.	We	will	be	completely	replacing	them	in	this
chapter.

In	case	you’re	wondering	whywebothered	to	create	those	links	ifwewere	going	to	destroy	them	again	anyway,	hyperlinks	are	one
of	the	most	important	features	of	a	web	page.	As	a	webmaster,	you	will	be	continually	creating	hyperlinks	to	other	pages	on
your	site	as	well	as	links	to	other	sites	on	the	Internet.	Not	all	these	links	will	be	placed	in	your	navigation	menu.	It	was	thus
important	to	cover	that	aspect	of	web	design	in	the	tutorial.

4.	 Make	sure	that	the	blinking	text	cursor	is	currently	in	the	side	bar.	If	it	 is	not,	click	somewhere	in	the	side	bar.	Now
click	“Insert	|	Spry	|	Spry	Menu	Bar”	from	the	menu.	That	is,	click	the	“Insert”	menu,	then	the	“Spry”	item	on	the	menu
that	appears,	and	finally	on	“Spry	Menu	Bar”	on	the	submenu	that	appears.

5.	 A	dialog	box	will	appear	asking	you	whether	you	want	a	horizontal	menu	bar	or	a	vertical	one.	Sinceweare	placing	the
menu	bar	in	the	left	column,wewant	a	vertical	menu	bar.	Select	the	“Vertical”	option	and	click	OK.

6.	 A	 default	 menu	 bar	 will	 be	 inserted	 into	 your	 side	 bar.	 If	 you	 look	 at	 the	 Properties	 pane	 at	 the	 bofom	 of	 your
Dreamweaver	window,	you	will	see	that	the	text	and	links	for	menu	items	are	displayed	there.

7.	 Select	“Item	1”	by	clicking	on	it,	if	it	is	not	already	selected.	In	the	“Text”	box,	replace	the	words	“Item	1”	with	“Home”
(without	the	quotes).	Replace	the	default	“Link”	text	of	“#”	with	“index.html”	(without	the	quotes).

8.	 By	default	Dreamweaver	created	a	submenu	for	your	menu.Wedon’t	need	one,	sowewill	need	to	delete	it.	Select	“Item
1.1”.	Directly	above	“Item	1.1”	are	two	bufons	“+”	and	“-	“.	Click	the	“-”	item	to	delete	Item	1.1.	Do	the	same	for	“Item
1.2”	and	“Item	1.3”.

9.	 Now	do	the	same	with	the	other	items,	replacing	the	text	with	the	appropriate	words	for	your	site,	and	the	links	with	the
actual	page	names.	If	there	are	submenus,	delete	them	as	you	did	for	Item	1.	For	your	convenience,	the	replacement
text	 and	 links	 are	 reproduced	 below	 from	 chapter	 3.	 Note	 that	 Item	 3	 has	 a	 three-level	 menu	 system.	 Delete	 all
submenus	(item	3.1.1,	3.1.2,	3.1,	3.2,	3.3)	-	we	won’t	need	them.
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Text:	About	Us,	Link:	aboutus.html
Text:	Contact	Us,	Link:	feedback.html
Text:	Site	Map,	Link:	sitemap.html

10.	 Click	“File	|	Save”.	A	dialog	box	will	pop	up	telling	you	that	certain	files	have	been	added	to	your	site,	and	that	these
files	will	need	to	be	uploaded.	Click	“OK”.

11.	 Now	upload	the	page	to	your	website	using	“Site	|	Put”	and	check	the	results	in	your	browser.	Hover	your	mouse	over
your	menu	bufons,	and	you	will	see	that	they	change	colour.

Customising	the	Spry	Framework’s	Menu	Bar	Widget
While	adding	the	Spry	Framework’s	navigation	menu	bar	to	your	web	page	is	a	simple	procedure	under	Dreamweaver,	customising
(“customizing”	 in	US	English)	 it	 is,	 however,	 another	 cup	 of	 tea.	 There	 is	 no	 built-in	method	 to	 do	 so	 under	Dreamweaver’s	 user
interface.You	will	have	to	do	it	manually.
The	fastest	way	to	do	this	is	to	do	it	via	Dreamweaver’s	“Code”	view.
Dreamweaver	has	two	basic	ways	you	can	work	on	your	website.	So	far,	you	have	been	creating	your	site	using	the	“Design”	view.	The
“Design”	view	allows	you	to	work	on	your	web	page	using	the	What-You-See-Is-What-You-Get	(WYSIWYG)	editor	-	that	is,	as	you	create
your	web	page,	you	basically	see	the	page	as	a	visitor	would	when	they	visit	your	website.
The	“Design”	view	hides	the	real	code,	the	HTML	and	CSS	code,	that	Dreamweaver	generates	for	your	website.	This	code,	the	“raw”
code,	 if	 you	 will,	 is	 the	 actual	 content	 that	 is	 uploaded	 (published)	 to	 your	 website.	When	 your	 visitor	 loads	 your	 web	 page,	 the
browser	takes	the	“raw”	code	and	displays	it	according	to	the	instructions	given	in	the	“raw”	code.
To	customise	the	Spry	Framework’s	menu	bar	widget,	you	will	be	using	Dreamweaver’s	facility	for	viewing	this	“raw”	code	for	your
website.	Even	 if	 you	 find	 the	menu	bar	widget	 satisfactory	 at	 the	moment,	 you	 should	 still	 take	 the	 following	 steps	 to	 familiarize
yourself	with	Dreamweaver’s	“Code”	view.	You	will	be	using	the	Code	view	in	a	future	chapter	to	insert	your	feedback	form	code.
To	switch	to	the	“Code”	view,	click	“View	|	Code”	from	the	menu.	Instead	of	the	web	page	that	you	are	accustomed	to	viewing,	you	will
now	see	the	“raw”	HTML	code	for	that	page.	If	you	scroll	up	and	down	the	page,	you	should	be	able	to	see	your	content	amidst	other
characters.	These	other	characters,	things	like	“<p>”	and	the	like,	are	the	formafing	code	that	tells	the	browser	how	it	should	render
your	page.
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•Centering	the	Menu	Bar
Scroll	to	the	top	of	the	index.html	file	in	“Code”	view.	Locate	the	text	“</head>”	(without	the	quotes)	somewhere	near	the	top	of	the
file.	Place	your	cursor	just	before	“</head>”	on	the	same	line.	Hit	ENTER	(or	RETURN)	to	insert	a	blank	line.	When	you	do	this,	the
entire	line	with	“</head>”	should	move	downwards,	creating	a	new	blank	line.	Move	the	cursor	to	the	blank	line.
Now	 copy	 the	 text	 from	 the	 box	 below	 and	 paste	 it	 into	 the	 blank	 line	 you	 just	 created	 in	 Dreamweaver.	 To	 copy	 the	 text,	 click
somewhere	in	the	box	to	highlight	all	the	text	in	the	box.	(If	nothing	is	selected	when	you	do	that,	drag	your	mouse	cursor	over	the
text	to	highlight	it.)	Then	click	the	right	mouse	bufon	(or	if	you	use	Mac	OS	X,	hold	down	the	Control	key	on	the	keyboard	and	click
the	mouse),	and	select	Copy	from	the	menu	that	appears.	To	paste	 it	 into	Dreamweaver,	switch	to	the	Dreamweaver	window.	Make
sure	that	your	text	cursor	is	in	the	correct	location	(in	the	blank	line	above	the	word	“</head>”).	Select	“Edit	|	Paste”	from	the	menu.

	
To	check	that	your	insertion	works,	click	“View	|	Design”	from	the	menu.	You	should	see	that	the	menu	is	now	centred	in	the	Design
view.	You	can	again	click	“View	|	Code”	again	from	the	menu	if	you	want	to	return	to	the	“Code”	view.

•Changing	the	Colours	of	the	Menu	Bar
On	 the	 right	 side	 of	 the	 Dreamweaver	 window,	 in	 the	 Files	 pane,	 doubleclick	 the	 folder“SpryAssets”.Itshould	 expand,
showingyouother	 files.Doubleclickthe	 file“SpryMenuBarVertical.css”.	 If	 the	 Files	 pane	 is	 too	 narrow	 for	 you	 to	 see	 what	 file
you’re	clicking,	hover	your	mouse	over	each	file	in	turn	until	Dreamweaver	displays	a	tooltip	telling	you	the	full	name	of	the	file.
Another	file,	full	of	unfamiliar	code,	will	appear	in	the	Dreamweaver’s	centre	pane.	This	is	the	CSS	code	for	your	menu.	The	CSS	code
contains	the	formafing	code	for	your	menu.
Click	“Edit	|	Find	and	Replace”	from	the	menu.	Type	“ul.MenuBarVertical	a”	(without	the	quotes)	into	the	big	“Find”	box.	Click	the
“Find	Next”	bufon.	Dismiss	the	dialog	box	by	clicking	250



the	“Close”	bufon.	In	the	main	window,	you	should	see	the	highlighted	words	“ul.MenuBarVertical	a”.	Under	these	words	is	a	block	of
text	enclosed	between	“{”	and	“}”	(without	the	quotes).	You	should	be	able	to	find	“background-color”	followed	by	a	value	“#EEE”	in
this	block.	This	line	determines	the	color	of	the	menu	when	the	mouse	is	not	hovering	over	it.	“#EEE”	is	the	code	for	the	grayish	color
you	see	in	the	menu.
In	the	right	hand	column	of	the	Dreamweaver	window,	in	the	CSS	pane,	you	should	be	able	to	see	“Properties	for	ul.	Menu	Bar	Vertical
a”.	If	not,	move	your	mouse	over	the	line	separating	the	blue	“Applications”	and	the	section	above	and	drag	it	downwards	to	make
more	space.	Under	“Properties	for	ul.MenuBarVertical	a”,	 look	for	the	line	that	says	“background-color”	(or	parts	of	“background-
color”	if	your	window	is	too	narrow	to	display	the	full	text).	To	the	right,	you	should	see	a	square	box	followed	by	“#EEE”.	Click	the
square	box	to	display	the	colour	picker	window	and	choose	a	colour	of	your	choice.
To	 modify	 the	 colour	 of	 the	 menu	 bufon	 when	 a	 mouse	 moves	 over	 it,	 click	 “Edit	 |	 Find	 and	 Replace”	 again	 and	 search	 for
“ul.MenuBarVertical	 a:hover”.	Dismiss	 the	dialog	box	when	 you’ve	 located	 the	 text.	Once	again,	 you	 should	be	able	 to	 change	 the
“background-color”	property	from	the	CSS	pane	in	the	right	hand	column.
When	you’re	through	making	your	changes,	check	the	output	by	switching	back	to	the	index.html	window.	To	do	this,	select	“Window	|
index.html”	from	the	menu.	If	you	are	still	in	“Code”	view	when	you	switch	to	the	index.html	window,	switch	to	the	“Design”	view	by
selecting	“View	|	Design”.
When	you	are	satisfied	with	the	changes	you	have	made,	save	your	work	with	“File	|	Save	All”
from	 the	 menu.	 Note	 that	 you	 need	 to	 use	 “Save	 All”	 instead	 of	 “Save”	 because	 you	 have
modified	 two	 files,	 index.html	 and	 SpryMenuBarVertical.css.Clicking“Save”alone	 will
onlysavewhateverfile	you	happened	to	be	working	on	last.
Again,	use	“Site	|	Put”	to	publish	your	work	and	check	it	out	with	your	browser.
Atthis	point,	the	home	page	for	your	website	is	complete.	If	you	have	been	working	on	the	page
using	some	dummy	text	and	pictures,	such	as	the	one	I	supplied	in	chapter	1,	now	is	time	to
change	 them	 to	 your	 real	 content.Youhave	 learned	 everything	 you	 need	 to	 create	 a	working
main	page	 that	 looks	decent	and	works	correctly.Wewill	not	be	returning	to	 this	page	 in	 the
next	few	chapters.	Instead,wewill	be	designing	your	other	pages	using	this	main	page	as	the
template.
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Add	a	Feedback	Form	to	Your	Website	in	Dreamweaver

vGenerate	a	custom	feedback	form	script	 In	 the	next	page,	 enter	 the	 information	 requested	by	 the	 form.	Modify	 the	URLs	 supplied
below	to	contain	your	real	domain.	For	example,	 if	your	domain	is	“suchandsuchaname.com”,	use	that	instead	of	the	“example.com”
given	below.

•Email:	(enter	your	email	address) •URL	of	Feedback	Form:	hfp://www.example.com/feedback.html
•URL	of	“Thank	You”	Page:	hfp://www.example.com/thankyou.html
•URL	of	“Error”	Page:	hfp://www.example.com/error.html

Finally,	read	the	licence	agreement.	If	you	agree	to	the	terms,	indicate	it	in	the	form,	and	click	“Generate	script”	to	continue.
Do	not	close	the	web	page	that	appears.	Leave	it	open	while	you	work	on	the	next	few	steps.

vSaving	the	script
Start	up	Dreamweaver.	Select	“File	|	New”	from	the	menu.	That	is,	click	the	File	menu,	followed	by	the	“New…”	item	on	the	menu	that
appears.	Click	“Blank	Page”	from	the	leftmost	column.	In	the	“Page	Type”	column,	select	the	“PHP”	item.	Click	“Create”.
Click	“View	|	Code”	from	the	menu	to	switch	to	Code	view.	Note:	this	step	is	very	important.	If	you	omit	it,	your	feedback	form	will	not
work.	Select	everything	you	see	in	the	window	with	your	mouse	and	hit	the	DEL	key.	You	should	now	be	left	with	a	blank	window.
Switch	to	your	web	browser,	and	locate	the	section	that	has	the	header	“Feedback	Form	Script”.	Select	everything	in	the	box	below.	If
you	are	using	Windows,	one	easy	way	to	select	everything	is	to	simply	click	your	mouse	somewhere	in	the	box	and	type	Ctrl+A	(hold
down	the	Ctrl	key	and	type	‘a’).	Then	copy	the	text	you	have	selected	to	the	clipboard.	To	do	this,	use	Ctrl+C	in	Windows,	or	use	“Edit	|
Copy”	 from	the	browser’s	menu.	 If	your	browser	does	not	have	an	“Edit”	menu,	 try	clicking	the	right	mouse	bufon	 in	the	box	and
selecting	“Copy”	from	the	menu.
Switch	 back	 to	Dreamweaver,	 and	 select	 “Edit	 |	 Paste”.	 The	 entire	 content	 of	 the	 script	 generated	 by	 the	 Feedback	 Form	Wizard
appears	(in	various	colours).	Do	not	afempt	to	beautify	it,	add	or	change	anything.	Do	not	even	add	a	blank	line.	This	is	not	the	user-
visible	portion	of	your	web	page.	We	will	come	to	that	later.
Note:	if	you	do	not	see	the	output	displayed	in	a	variety	of	colours,	you	have	omifed	the	very
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important	step	mentioned	above.	Close	the	document	without	saving	it	and	restart	this	section	again.
Select	“File	|	Save	As”	and	type	“feedback.php”	into	the	“File	name”	box.	Do	not	use	any	other	name.	Do	not	use	capital	lefers.	Select
“View	|	Design”.	You	should	see	a	blank	page.	Do	NOT	type	anything	here.	Click	“File	|	Close”	to	close	the	file.
vCreating	the	feedback	form	web	page
Select	“File	|	New”,	choose	“Page	from	Template”	and	click	“Create”.	Modify	the	title	field	to	“Contact	Us”.	Modify	the	“Page	Title”
editable	region	to	read	“Contact	Us”	as	well.	Delete	all	the	text	in	the	“Page	Description”	editable	region.
Nowswitchtothebrowser	windowthatcontainsthegeneratedcode	fromthesitewizard.com’s	wizard.	This	time	locate	the	section
in	the	output	generated	by	the	wizard	that	reads	“HTML	Code”.	Click	in	the	box	below	those	words,	select	everything	in	the	box	and
copy	it	to	the	clipboard.
Switch	back	to	Dreamweaver.	Make	sure	your	cursor	is	in	the	“Page	Description”	editable	region.	Select	“View	|	Code”	from	the	menu.
Dreamweaver	will	switch	to	the	HTML	code	view.	Your	text	cursor	should	be	just	after	“<p>”	and	before	“&nbsp;<p>”.	Using	the	arrow
keys	on	your	keyboard,	move	the	cursor	to	the	end	of	that	line	(that	is,	after	the	“<p>&nbsp;<p>”.	Then	select	“Edit	|	Paste”.	The	text
from	thesitewizard’s	feedback	form	wizard	should	be	inserted	at	that	point.
Now	use	“View	|	Design”	to	switch	back	to	the	Design	mode.	You	should	now	be	able	to	see	the	feedback	form	in	your	web	page.
To	widen	the	input	field	of	“Name”,	click	somewhere	in	the	box	next	to	“Name”.	In	the	“Properties”	pane	at	the	bofom	of	the	screen,
change	the	default	“Char	width”	of	“25”	to	a	value	that	befer	suits	your	page.	For	example,	increase	the	number	if	you	want	the	box	to
be	wider	and	decrease	it	if	you	want	it	to	be	narrower.	Repeat	the	process	with	the	“Email	address”	field	so	that	both	the	“Name”	field
and	the	“Email	address”	fields	have	the	same	width	on	the	screen.
Similarly,	you	can	change	the	width	and	height	of	the	“Comments”	box.	Click	the	box	under	the	word	“Comments”.	In	the	“Properties”
pane,	change	the	“Char	width”	to	a	more	appropriate	number	than	“25”	if	you	wish.	To	change	the	default	height	of	the	“Comments”
box,	look	for	the	“Num	lines”	box	in	the	“Properties”	pane	and	change	it	to	the	height	you	want	to	have.	You	can	experiment	with	the
values	until	you	are	satisfied	with	the	appearance	of	the	boxes	on	your	page.
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Note	that	modifying	the	size	of	the	various	boxes	in	the	form	merely	changes	the	appearance	of	the	box	on	the	screen.	These	sizes	do
not	affect	how	much	text	your	visitor	can	type	into	the	field.	Most	browsers	will	simply	scroll	the	text	if	the	box	is	 not	 wide	 or	 tall
enough	for	what	the	visitor	wants	to	type.
If	you	like,	you	can	also	change	the	text	appearing	on	the	bufon.	By	default,	this	text	is	“Send	Feedback”.	To	change	it	click	on	the
bufon.	In	the	“Properties”	pane	at	the	bofom	of	the	Dreamweaver	window,	change	the	text	in	the	“Value”	box	to	some	other	text	if	you
wish.
Click	“File	|	Save	As”	and	type	“feedback.html”	into	the	“File	name”	box.	Note	that	you	should	not	type	any	other	name	here,	since	the
navigation	menus	you	created	for	your	site.

Creating	the	“Thank	You”	and	“Error”	pages
By	now,	you	should	have	no	trouble	creating	new	pages	from	your	template,	having	done	so	a	few	times	already	when	creating	the
other	pages	of	your	site.	Use	the	same	method	that	you	have	been	using	in	the	past	and	create	two	new	pages:	the	“ThankYou”page
and	the	“Error”	page.
The	“Thank	You”	page	is	displayed	by	the	feedback	form	script	after	your	visitor	clicks	the	“Send	Feedback”	bufon.	It	typically	thanks
your	visitor	for	sending	his	comments.	The	main	purpose	of	such	a	page	is	to	provide	feedback	to	the	visitor	that	his	comments	had
been	successfully	submifed.	You	may	write	anything	you	wish	for	this	page.	If	you	don’t	know	what	to	say,	you	may	use	the	following
text:	Thank	you	for	your	comments.	If	your	message	requires	a	reply,	I	typically	reply	within	24	hours	of	the	receipt	of	the	message.
The	“Error”	page	is	shown	whenever	the	visitor	submits	the	form	without	filling	one	of	the	fields.	For	example,	if	he	fails	to	enter	an
email	address	when	the	form	is	submifed,	the	“Error”	page	will	be	displayed	instead	of	the	“ThankYou”page.Yourerror	page	should
inform	the	visitor	that	he	needs	to	complete	all	the	fields	in	the	form,	and	that	he	is	to	click	the	browser’s	“Back”	bufon	to	go	back	to
the	form	to	repair	the	error.	If	you	don’t	know	what	to	say,	you	may	use	the	following	text:	There	were	errors	in	the	form	that	you
submifed.	Please	complete	all	the	requested	information	before	submifing	the	form.	Click	the	‘Back’	bufon	on	your	browser	to	return
to	the	form	to	fix	the	error.
Save	 your	 “ThankYou”page	 with	 a	 filename	 of	 “thankyou.html”	 (without	 the	 quotes)	 and	 your	 “Error”	 page	 with	 a	 name	 of
“error.html”	(without	the	quotes).	These	are	the	names	you	supplied	earlier	to	the	Feedback	Form	Wizard.	The	customized	script	that
the	wizard	created	has	the	names	hardcoded	into	it.	You	should	therefore	not	change	the	names	at	this	point,	or	254



the	script	will	not	work	properly.

Make	Money	From	Your	Website
If	you	 look	at	many	websites,	you	will	probably	notice	 that	 there	are	banner	advertisements	displayed	on	most	pages.	 If	you	are	a
newcomer	 to	 the	 scene,	 you	might	 think	 that	 you	must	either	be	a	 company	or	 that	 your	 site	must	be	 famous	before	 you	can	get
advertisers,	just	as	it	is	the	case	in	hardcopy	publications.
In	reality,	anyone	with	a	website	can	get	advertisers.	While	it	is	true	that	if	your	site	is	well-known,	you	may	get	companies	contacting
you	 to	 offer	 to	 advertise	 on	 your	 site,	 you	 can	get	 advertising	 revenue	even	 if	 you	are	 just	 starting	out	 and	 your	 site	 is	 relatively
unknown.
Thewayto	do	this	is	to	join	as	an	“affiliate”	of	various	companies	or	sites,	either	directly,	or	through	an	affiliate	network.	An	affiliate
network	 is	simply	an	 intermediary	with	whom	you	can	sign	up	to	get	advertisers	(as	opposed	to	dealing	with	 individual	companies
separately).
>>	Payment	Schemes
Before	joining	any	program,	you	should	probably	be	aware	of	the	different	payment	schemes	available.

1.	 Pay	Per	Impression	(CPM)
Here,	you	are	paid	according	to	the	number	of	times	the	advertiser’s	banner	is	displayed	on	your	site.	The	amount	you	earn	is
typically	calculated	based	on	the	number	of	thousand	impressions	of	the	banner	(impressions	=	number	of	times	the	banner	is
displayed),	 often	 abbreviated	CPM	 (cost	per	 thousand,	with	 the	M	being	 the	Latin	numeral	 for	 thousand).	That	 is,	 $5	CPM
means	that	you	get	paid	$5	for	1,000	displays	of	the	banner.	In	general,	the	amount	paid	is	usually	small,	but	it	is	easy	to	earn
since	everytime	a	visitor	loads	the	page,	you	earn.	This	is	known	as	a	“high	conversion	rate”.	Needless	to	say,	this	method	will
allow	you	to	automatically	earn	more	if	your	site	afracts	a	lot	of	visitors.

2.	 Pay	Per	Click	(PPC)
When	you	are	paid	per	click,	you	are	only	paid	when	visitors	click	 the	advertiser’s	banner	on	your	site.	The	amount	paid	 is
usually	 higher	 than	 the	 pay	 per	 impression	 scheme.	Whether	 you	 get	 a	 high	 conversion	 rate	 here	 depends	 on	 the	 banner
(whether	it	afracts	people	to	click	it),	although	in	general,	it	has	a	higher	conversion	rate	than	the	pay	per	sale	method.	A	high
traffic	site	will	probably	enjoy	a	higher	click	rate	than	a	lower	traffic
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site,	although	you	will	probably	get	befer	results	if	your	banners	are	carefully	selected	to	suit	the	target	audience	of	your	site.
3.						Pay	Per	Sale	or	Lead	(sometimes	referred	to	as	Cost	Per	Action,	or	CPA)

While	you	will	probably	get	the	highest	payment	rates	with	this	method,	it	has	the	lowest	conversion	rate	of	the	three	schemes.
You	will	only	earn	if	your	visitors	click	through	the	banner	and	either	purchase	an	item	from	the	advertiser	or	take	some	other
prescribed	action	(eg,	sign	up	for	a	service).	Like	thePay	PerClick	method,	you	get	much	befer	results	 if	you	carefully	select
your	advertisers	to	suit	the	target	audience	of	your	site.

In	general,	to	avoid	wasting	resources	in	issuing	cheques	for	very	small	amounts,	advertisers	will	usually	accrue	the	amount	owing	to
you	until	it	reaches	a	certain	level	(such	as	$25)	before	they	pay	you.
Customise	the	Navigation	Menu	Bar	on	Your	Website	using	Dreamweaver
Most	websites	have	some	sort	of	navigation	menu.
Your	Navigation	Menu
As	it	stands,	the	navigation	menu	in	your	left	column	has	four	bufons	that	currently	do	not	appear	to	actually	do	anything.	Carry	out
the	following	steps	to	make	them	into	working	bufons.
Select	“Link	one”	by	dragging	your	mouse	over	those	words	to	highlight	it.	Type	“Home”	(without	the	quotes),	overwriting	the	existing
words.

Click	to	put	your	text	cursor	in	the	“Link”	field	of	the	Properties	panel,	and	replace	the	hash	(“#”)	mark	that	is	currently	there
with	 the	 web	 address	 of	 your	 home	 page.	 For	 example,	 if	 your	 website	 has	 a	 URL	 of	 “hfp://www.example.com/“,
type“hfp://www.example.com/”(without	the	quotes)	followed	by	the	ENTER	(or	RETURN	key	on	the	Mac).	Alternatively,	you	can
also	use	a	relative	URL
With	this	step,	the	top	bufon	of	your	menu	now	says	“Home”	and	is	a	clickable	link	pointing	to	your	home	page.
Incidentally,	 I	know	that	you	already	made	the	site	 logo	link	to	your	home	page	 in	the	previous	chapter.	However,	 the	home
page	is	also	de	rigueur	the	first	link	of	a	site’s	navigation	menu,	and	users	have	come	to	expect	it	there.	Not	only	will	keeping
to	this	convention	make	your	site	more	user-friendly,	since	the	links	are	where	they	are	“supposed	to	be”,	but	it	will	also	help
novice	users	who	don’t	know	that	the	site	logo	is	actually	clickable.
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(By	the	way,	when	you	hit	the	ENTER	key	after	typing	your	URL,	your	bufon	may	have	an	additional	thin	blank	line	underneath.
This	is	just	a	temporary	visual	glitch.Youdidn’t	do	anything	wrong.	Just	ignore	it.	It	will	go	away	eventually	when	you	replace
the	text	on	the	next	bufon	or	when	you	do	something	else.)

1.	 The	Feedback	(or	Contact)	Form
Apart	from	the	topmost	link,	which	should	always	be	“Home”,	the	other	links	can	be	in	any	order	you	want.	I’ll	simply	suggest	a
sequence	in	this	article,	but	feel	free	to	put	them	in	a	different	order.
Select	“Link	two”	and	replace	the	words	with	“Feedback”	(without	the	quotes).	Note	that	unlike	the	“Home”	link	above	(which
has	 a	 fixed	 convention	 across	 nearly	 every	 site	 on	 the	 internet),	 you	 don’t	 actually	 have	 to	 use	 the	 word	 “Feedback”;	 for
instance,	some	people	prefer	to	say	“Support”,	“Contact	Us”	or	“Contact	Form”.
Modify	the	“Link”	field	for	that	bufon	so	that	it	says	“feedback.html”	(without	the	quotes).	Do	not	use	any	other	name	for	this
link.	Do	not	use	capital	(uppercase)	lefers,	spaces	or	change	it	in	any	way.	If	you	do,	you	will	have	problems	when	you	complete
chapter	8.	Don’t	worry	if	your	bufon	says	“Support”,	but	the	link	says	“feedback.html”.	What	the	bufon	reads	and	what	the	link
says	are	two	separate	things.	One	is	for	the	user	to	read,	and	should	be	in	plain	English	so	that	they	can	understand	it.	The
other	one	is	for	the	browser	to	use,	and	can	be	in	thick	computerese	or	whatever.	The	reason	it	needs	to	say	“feedback.html”
and	not	some	other	thing	is	because	you’ll	create	a	file	called	“feedback.html”	in	chapter	8,	and	if	you	use	a	different	name
here,	your	bufon	will	not	link	to	the	right	file.

2.	 The	About	Us	Page	(Optional)
If	 you	 are	 running	 a	 business,	 you	 probably	 should	 have	 an	 “About	 Us”	 page	 somewhere	 on	 your	 site,	 to	 tell	 your	 visitors
something	about	your	company.	(Look	at	it	as	a	chance	to	promote	your	company.)	The	page	is	optional	for	personal	and	hobby
websites.	For	those	not	planning	to	create	an	“About	Us”	page,	skip	to	the	next	point.
Select	“Link	three”	and	replace	the	text	with	“About	Us”,	“About	Me”,	“About”	or	some	such	thing.	Change	the	link	from	“#”	to
“about.html”	(without	the	quotes).

3.	 The	Site	Map
Replace	“Link	four”	(or	“Link	three”	if	you	have	skipped	the	About	Us	page	above)	with	“Site	Map”	and	its	corresponding	link
“#”	with	“sitemap.html”	(without	the	quotes).
When	you	reach	this	paragraph,	you	will	either	have	an	extra	unused	bufon			(because
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you	didn’t	create	an	About	Us	bufon),	or	you	have	run	out	of	dummy	bufons	to	reuse	(because	you	did).	Whichever	the	 case
may	be,	you	will	undoubtedly	want	to	add	more	bufons	to	your	menu	to	point	to	the	other	important	pages.	Some	of	you	will
also	want	to	know	how	to	delete	unwanted	bufons	that	you	have	added	by	mistake.

How	to	Add	a	New	Buflon	to	the	Navigation	Menu
1.	 Click	somewhere	 in	the	bofommost	bufon	in	your	menu.	This	will	put	the	blinking	text	cursor	somewhere	amidst	the

text.	Position	the	cursor	so	that	it	comes	after	all	the	words	in	that	bufon,	but	still	on	the	same	line.Youcan	do	this	using
the	arrow	keys	on	your	keyboard.	For	example,	if	the	last	bufon	says	“Site	Map”,	move	the	text	cursor	so	that	it	is	just
after	the	“p”	in	“Map”.

2.	 Hit	the	ENTER	key	(or	the	RETURN	key	on	the	Mac).	This	will	create	a	very	thin	anaemic-looking	bufon	underneath,
and	puts	the	text	cursor	there.	In	fact,	at	this	point,	it	won’t	even	look	like	a	bufon	to	you,	but	more	like	a	very	thin	line.

3.	 Type	 the	 words	 you	 want	 the	 bufon	 to	 show.	 For	 example,	 if	 you	 are	 creating	 a	 page	 to	 list	 all	 your	 products,	 type
“Products”	(without	the	quotes).	The	bufon	will	become	taller,	to	accomodate	the	words	you	entered,	but	it	will	still	not
look	like	the	others:	the	text	will	not	be	aligned	properly,	and	the	colour	will	be	wrong.

4.	 Select	the	words	that	you’ve	just	typed.	If	you	find	it	difficult	to	highlight	everything	using	the	mouse,	use	the	keyboard:
ie,	hold	down	the	shift	key	on	your	keyboard	while	using	the	arrow	keys	to	move	the	cursor	over	the	lefers	you	want	to
select.

5.	 Type	the	URL	that	you	want	the	bufon	to	point	to	into	the	“Link”	field	of	the	Properties	panel,	followed	by	the	ENTER
key.	There	will	not	be	any	“#”	for	you	to	overwrite,	so	just	type	your	address	into	the	blank	field.	For	example,	if	you’re
linking	to	the	Products	page,	type	“products.html”	(without	the	quotes).

The	text	appearing	on	your	bufon	should	now	be	centred,	and	have	the	same	colour	scheme	as	the	rest	of	your	menu.
Repeat	the	above	procedure	as	many	times	as	you	need,	till	you	have	all	the	bufons	you	want.

How	to	Delete	a	Buflon	from	the	Navigation	Menu
1.	 Select	all	the	words	appearing	on	the	bufon	that	you	want	to	delete.
2.	 Hit	the	Delete	key	on	your	keyboard.	This	causes	the	bufon	to	collapse	into	a	thin	sliver.
3.	 Move	your	mouse	pointer	so	that	it	is	directly	over	the	remnants	of	the	bufon	and	click
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the	right	mouse	bufon.
4.	Click	the	“Remove	tag	<li>”	item	in	the	menu	that	pops	out.	The	bufon	should	disappear	completely.

Warning:if	you	don’t	see	“Remove	tag	<li>”	in	the	menu,	but	see	something	else,	like	“Remove	tag	<ul>”,	do	not	click	it.	Hit
the	ESC	key	instead	to	get	rid	of	the	menu,	and	try	again.	Clicking	“Remove	tag”	with	wild	abandon,	without	making	sure	that
it’s	really	“Remove	tag	<li>”	and	not	something	else,	is	generally	a	bad	thing.	It	may	result	in	your	accidentally	deleting	the
formafing	from	the	menu	or	even	the	entire	menu	itself.

If	you	make	a	mistake	that	you	don’t	know	how	to	recover	from,	try	using	the	“Edit	|	Undo”	menu	item.	That	is,	click	“Edit”	from	the
menu	bar,	followed	by	“Undo	[whatever]”	from	the	menu	that	appears,	where	“[whatever]”	is	the	operation	that	you	last	performed.
(The	“Undo”	menu	item	says	different	things	depending	on	what	you	did	before	invoking	the	menu,	but	it	will	always	begin	with	the
word	“Undo”.)	On	the	other	hand,	if	you	have	made	so	many	errors	that	even	the	“Undo”	bufon	is	unable	to	repair,	you	may	want	to
abandon	all	the	work	you	did	in	the	current	session	and	reload	your	file	from	your	last	save.	To	do	this,	click	“File	|	Close”	and	when
Dreamweaver	issues	a	dialog	box	saying	“Save	changes	to	index.html?”,	click	“No”.	Then	reopen	the	file	again	by	doubleclicking	the
“index.html”	line	in	the	Files	panel.	Be	warned	that	this	will	cause	you	to	lose	everything	you	have	done	since	your	last	save,	so	only
do	it	as	a	last	resort.	And	don’t	do	it	at	all	if	you	have	saved	your	file	after	you	made	your	mistake,	since	you’ll	only	load	back	the	same
error-filled	page,	this	time	with	no	Undo	facility.
How	to	Customise	the	Colours	of	Your	Navigation	Menu
If	you	have	altered	your	background	colours	in	chapter	4,	and	have	been	waiting	with	bated	breadth	to	match	your	menu	colours	to
the	scheme	found	on	the	rest	of	the	page,	your	moment	has	arrived.
Unlike	the	rest	of	the	page,	however,	the	bufons	on	the	menu	actually	have	different	colours	depending	on	whether	a	mouse	pointer	is
hovering	over	 it.(Youwill	 only	be	able	 to	 see	 the	bufon’s	default	 colour	 in	Dreamweaver;	 to	 view	 the	 colour	when	a	mouse	pointer
isoverit,	you	will	need	to	use	a	web	brower.)	1.	Click	your	mouse	pointer	somewhere	in	any	one	of	your	navigation	menu	bufons	(it
doesn’t	mafer	which).	This	puts	your	text	cursor	in	the	middle	of	the	word	(or	words)	on	one	of	the	bufons.
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2.	 Look	for	the	Rules	section	in	the	CSS	Styles	panel	on	the	right	side	of	Dreamweaver.	Youshould	see	these	2	lines.
The	line	saying	“ul.nav	a,	ul.nav	a:visited	<a>”	contains	the	rules	for	the	default	bufon.	By	“default”,	I	mean	the
bufon	as	it	appears	on	the	page	when	the	mouse	is	not	pointing	at	it.
Another	 line	 saying	 “ul.nav	 a:hover,	 ul.nav…	 <a>”	 holds	 the	 rules	 for	 the	 bufon	 when	 the	 mouse	 pointer	 is
hovering	 over	 it.	 Notice	 that	 the	 line	 is	 almost	 the	 same	 as	 the	 other	 one,	 except	 that	 “a:hover”	 occurs
somewhere	within	it.

Double	clicking	one	or	the	other	of	these	lines	will	bring	up	the	CSS	Rule	Definition	dialog	box	with	the	relevant	rules	that	you
can	modify.	For	example,	if	you	want	to	change	the	default	colours,	double	click	the	first	line	described	earlier.	Do	the	same
with	the	“a:hover”	line	to	customize	the	bufon	colour	when	the	mouse	is	over	it.

3.	 The	CSS	Rule	Definition	dialog	box,	which	you’ll	probably	find	very	familiar	since	you	have	repeatedly	encountered	it	in
the	earlier	chapters,	will	appear.Yes,it	is	the	same	dialog	box	and	it	behaves	exactly	as	it	has	in	the	previous	chapters
with	no	new	unpleasant	surprises.

Click	the	“Background”	line	in	the	list	box	on	the	left	to	bring	up	the	options	pertaining	to	colours.
4.	 Change	the	colour	of	your	bufon	to	your	satisfaction	using	the	colour	picker	for	the	“Background-color”	field.
5.	 Click	the	“OK”	bufon	for	the	CSS	Rule	Definition	dialog	box	when	you’re	done.
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Knowledge	Check	Points

Dreamweaver	Multiple	Choice	Questions	and	Answers
1.	 How	many	Sites	can	you	define	with	one	copy	of	Dreamweaver	installed	on	your	computer?

A. unlimited B. 2
C. 10 D. 999
Ans:	A

2.	 What	do	you	add	to	a	template	in	order	to	control	where	page	content	goes?
A.	 TextFrames	B.	HTML	Controllers

C.	Editable	Regions	D.	Page	Content	ControllersAns:	C

3.	 Which	of	the	following	is	NOT	a	Style?
A.	 Linked	B.	Embedded

C.	Inline	D.	Orthogonal
Ans:	D

4.	 Which	of	the	following	is	NOT	a	Hotspot	tool?
A.	 Orthogonal	Hotspot	Tool	B.	Rectangular	Hotspot	Tool

C.	Oval	Hotspot	Tool	D.	Polygon	Hotspot	ToolAns:	A

5.	 Which	of	the	following	is	not	supported	by	older	browsers?
A.	 CSS	B.	Layers

C.	Frames	D.	All	of	the	aboveAns:	D

6.	 Which	of	the	following	is	the	HTML	tag	to	start	a	Heading	Level	3?	A.	<H3>	B.	</H3>
C.	<#H3>	D.	<H3/>
Ans:	A

7.	 Which	type	of	style	should	you	use	if	you	want	to	use	the	formats	on	multiple	pages?
A.	 Linked	B.	Embedded

C.	Inline	D.	Orthogonal
Ans:	A
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8.	 When	you	create	a	“recipient”	hidden	field	for	a	form,	which	of	the	following	is	theONLYcorrectwayto	type	the	word
“recipient?”:

A.	 Recipient	B.	<recipient></recipient>
C.	recipient	D.	RECIPIENT	Ans:	C

9.	 Which	file	controls	how	your	frames	will	appear?
A.	 Frameset	B.	Master	Document

C.	Template	D.	Timeline	Ans:	A

10.	 What	can’t	layers	do	if	you	want	to	convert	them	to	tables?
A.	 Be	close	B.	Contain	a	Color

C.	Be	larger	than	the	target	table	D.	OverlapAns:	D

11.	 The	trick	to	gefing	a	ball	to	bounce	around	aWebpage	is	to:
A.	 Add	AnimationBounce	layers

B.	 Add	keyframes	to	the	timeline
C.	 Add	Bounce	parameters	to	the	Object	properties

D.	 Dreamweave	rdoes	not	support	animation…	use	Flash	instead	Ans:	B

12.	 By	default,	what’s	the	Fps	shown	on	the	timeline?	A.	15	B.	1
C.	20	D.	huh?
Ans:	A

13.	 When	you	swap	images,	it’s	best	if:
A.	 The	images	are	the	same	“Mime”	type

B.	 The	images	are	the	same	color
C.	 The	images	are	the	same	size

D.	 Youuse	the	“Constrain”	tool	Ans:	C

14.	 Which	of	the	following	is	false?
A.	 The	Site	Map	can	be	saved	as	an	image
B.	 Youcan	FTP	files	using	Dreamweaver
C.	 Youcan	create	forms	in	Dreamweaver
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D.	None	of	the	above	Ans:	D

15.	 Which	of	the	following	is	NOT	a	Page	Property?
A.	 Title	B.	Tracing	Image

C.	Margin	Width	D.	Timeline	Ans:	D

16.	 Dreamweaver	users	work	in	the	Document	Window	using	one	of	how	many	views?
A.	 3	B.	5

C.	2
Ans:	A

17.	 The	general	definition	of	a(n)	is	a	set	of	linked	documents	with	sharedafributes,	such	as	related	topics,	a
similar	design,	or	a	shared	purpose.

A.	 index	B.	website
C.	Internet	D.	Homepage	Ans:	B

18.	 provides	the	largest	text.
A.	 H6	B.	24

C.	H1	D.	Bold
Ans:	C

19.	 Dreamweaver’s	feature	allows	users	to	select	colors	and	make	perfect	colormatches.
A.	 Color	Cube	B.	Palafes

C.	HTML	view	D.	Eye	dropperAns:	D

20.	 The	W	and	H	boxes	in	the	Property	inspector	indicate	the	width	and	height	of	an	image,	in
A.	 inches	B.	pixels

C.	points	D.	millimeters	Ans:	B

21.	 A	subfolder	is	a	folder	inside	another	folder.
A.	 True	B.	False

Ans:	A
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22.	 AWebsite’s	home	page	is	normally	named	home.htm	or	home.html
A.	 True	B.	False

Ans:	B
23.	 view	is	a	hand-coding	environment	for	writing	and	editing	code.

A.	 Design	B.	Split
C.	Code	Ans:	C

24.	 images	are	used	to	add	texture	and	interesting	color	to	aWeb	page.
A.	 Clip	Art	B.	Animated

C.	Background	D.	Cropped	Ans:	C

25.	 In	the	mode,	you	create	tables	by	drawing	them.
A.	 Layout	B.	Expanded

C.	Standard	Ans:	A

26.	 A	is	a	vertical	collection	of	cells	in	a	table.
A.	 Row	B.	Column

C.	TableIDAns:	B

27.	 A	is	the	container/intersection	where	a	row	and	column	meet	in	atable.
A.	 tag	B.	table	ID

C.	link	D.	cell
Ans:	D

28.	 A	can	connect	users	to	a	place	on	the	same	web	page	or	to	place	on	another	site.
A.	 root	folder	B.	typeface

C.	text	editor	D.	hyperlinkAns:	D

29.	 In	order	to	define	a	site,	users	must	create	a	both	a	and	.
A.	 domain	name	IP	address	B.	login	password

C.	site	name	home	page	D.	site	name	root	folderAns:	D
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30.	 Which	of	the	following	is	NOT	a	valid	reason	for	defining	a	local	site	in	Dreamweaver?
A.	 To	enable	Dreamweaver	to	create	relative	links	between	documents

B.	 To	enable	Dreamweaver	to	display	all	your	sites	files	in	the	‘Files	Panel’
C.	 To	provide	details	of	yourWebserver	so	that	you	can	upload	you	site

D.	 To	allow	Dreamweaver	to	conduct	link	checking	between	documents	Ans:	C

31.	 To	view	and	change	current	formafing	for	selected	objects	or	text,	you	would	use:
A.	 Insert	bar	B.	Property	Inspector

C.	File	PanelAns:	B

32.	 Youcan	insert	dates	into	your	web	page	that	will	automatically	be	updated	whenever	you	save	the	page.
A.	 True	B.	False

Ans:	A
33.	 To	insert	a	special	character,	what	category	on	the	Insert	bar	do	you	use?

A.	 Common	B.	HTML
C.	TextAns:	C

34.	 Which	panel	can	be	used	to	manage	and	create	new	sites?
A.	 Files	B.	Application

C.	Tag	InspectorAns:	A

35.	 What	should	the	home	page	of	your	site	be	named?
A.	 home.html	B.	Anything	you	want	to	name	it

C.	index.html	Ans:	C

36.	 Cell	padding	determines	the	number	of	pixels	between	adjacent	cells.
A.	 True	B.	False

Ans:	B
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37.	 Which	graphic	format	can	you	Not	insert	into	your	web	page?
A.	 bmp	B.	gif

C.	png	Ans:	A

38.	 Which	view	must	you	be	in	to	draw	out	a	table	visually.
A.	 Standard	B.	Layout

C.	TableAns:	B

39.	 Formafing	using	CSS	styles	allows	each	individual’s	browser	to	control	thewayyour	page	is	displayed.
A.	 True	B.	False

Ans:	B
40.	 What	is	the	properwayto	manually	type	an	email	link?

A.	 email:myname@austincc.edu	B.	mailto:myname@austincc.edu
C.	mail:myname@austincc.eduAns:	B

41.	 The	latest	version	of	Dreamweaver	is:
A.	 Adobe	Dreamweaver	CS5.5	B.	Adobe	Dreamweaver	CS5

C.	Adobe	Dreamweaver	CS4	D.	Macromedia	Dreamweaver	8Ans:	A

42.	 Dreamweaver	is	sold	by	what	software	company:
A.	 Adobe

B.	 Macromedia
C.	 Microsoft

D.	 No	company,	the	program	simply	appeared	one	day	on	the	web.	Ans:	A

43.	 Youcan	use	Dreamweaver	to	create:
A.	 HTML,	XML,	and	CSS	files

B.	 PHP,	Java,	and	ASP.NET
C.	 The	new	space-time	continuum	format	STCML

D.	 all	of	the	above,	except	the	space-time	continuum	thing…	Ans:	D
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44.	 HTML	tags	are	surrounded	by:
A.	 brackets	<	…	>

B.	 parenthesise	(	…	)
C.	 quote	marks	”	…”

D.	 Fire-breathing	dragons	who	try	to	keep	you	away	from	tags	Ans:	A

45.	 Youcan	save	images	for	theWebin	these	formats:
A.	 JPG,	GIF,	PNG	B.	PSD,	Tiff

C.	Flickr	D.	ftp,	fla,	jsp
Ans:	A

46.	 The	first	page	of	a	web	site	should	most	commonly	be	named:
A.	 home.html

B.	 index.html	or	default.htm	depending	on	the	server
C.	 MySite.html

D.	 Something	cool,	so	the	other	sites	will	not	make	fun	of	it	Ans:	B

47.	 The	</h1>	is	an	opening	tag.
A.	 True

B.	 False
C.	 Do	I	have	to	learn	HTML	tags?

D.	 Close	your	darn	tags!Wereyou	born	in	a	barn?	Ans:	B

48.	 Bonus	question:	What	is	the	refrain	of	the	pop	hit	single	Dreamweaver	by	Gary	Wright
A.	 Tomorrow,	tomorrow,	there’s	always	tomorrow…

B.	 Younever	count	your	money	…
C.	 Yesterday,	all	my	troubles	seemed	so	far	away…

D.	 Dream	weaver,	I	believe	you	can	get	me	through	the	night	Ans:	D

49.	 What	option	in	theTargetpop-up	menu	is	chosen	to	open	a	linked	document	in	a	new	browser	window	while	keeping
the	current	window	available?

A.	 top	B.	self
C.	blank	D.	parent
Ans:	C
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50.	 What	does	the	asterisk	after	the	file	name	in	the	document	title	bar	signify?
A.	 document	is	untitled

B.	 page	is	not	located	within	the	site
C.	 the	extension	to	the	file	name	has	not	been	specified

D.	 unsaved	additions	or	deletions	were	made	to	the	page	Ans:	D

51.	 Using	Dreamweaver,	it	is	possible	to	convert	layers	to	tables	and	tables	to	layers.
A.	 True
B.	 False	Ans:	A

52.	 What	describes	the	correctwayto	create	a	page	layout	that	always	fills	the	browser	window,	no	mafer	what	size
window	the	viewer	has	set?

A.	 Add	a	spacer	image	to	the	table.
B.	 Create	the	table	cell	with	a	percentage	width	in	the	HTML.
C.	 Use	the	Dreamweaver	Autostretch	option	to	set	the	table	width	to	resize	automatically.
D.	 Create	a	fixed	width	table	that	corresponds	with	the	specific	numeric	width	of	the	viewer’s	browser.

Ans:	C
53.	 Selecting	header	in	the	Property	inspector	for	a	given	table’s	cell	makes	that	content	(Choose	two)
A.	 bold	and	centered	in	most	browsers

B.	 justified	in	all	browsers
C.	 a	<th>	element
D.	 bold	and	italicized	in	most	browsers

E.	 left-justified	in	all	browsers	\	Ans:	C

54.	 A	template	can	be	modified	after	documents	have	been	created	based	on	the	template.
A.	 True	B.	False

Ans:	A
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55.	 What	accurately	describes	thewaytemplates	work	in	Dreamweaver?	If	a	template	file	is	opened	you	can	edit
A.	 nothing	in	the	file,	unless	no	pages	have	been	created	from	the	template.

B.	 everything	in	the	file.
C.	 any	editable	region.

D.	 anything	in	the	file,	but	only	in	Code	View.	Ans:	B

56.	 What	happens	when	content	in	<DIV>	tags	is	viewed	with	3.0	versions	of	Netscape?
A.	 No	content	is	displayed	at	all.
B.	 The	content	looks	the	same	as	it	does	in	any	other	browser.
C.	 The	content	is	only	displayed	if	the	visible	afribute	is	set	to	true.
D.	 The	content	appears	in	the	same	location	as	where	the	<DIV>	tags	appear	in	the	code.

Ans:	D
57.	 The	behaviors	that	come	with	Dreamweaver	were	wrifen	to	work	in	all	browsers.

A.	 True	B.	False
Ans:	B

58.	 What	panel	is	used	to	change	the	event	that	triggers	an	image	swap?
A.	 CSS	Panel	B.	Assets	Panel

C.	Frames	Panel	D.	Objects	Panel
E.	Behaviors	PanelAns:	E

59.	 What	is	onewayyou	change	the	color	of	text	in	Dreamweaver	4.0?
A.	 Highlight	the	text	and	then	select:	Edit>Font>Color	from	the	menu
B.	 Highlight	the	text	and	select	a	new	color	with	the	Color	Picker	in	the	Properties	panel
C.	 Youare	unable	to	change	the	text	color	in	Dreamweaver,	it	can	only	be	changed	in	the	HTML

D.	 Highlight	the	text	and	change	the	color	in	the	Objects	panel	Ans:	B

60.	 Bullets	in	unordered	lists	can	only	be	circles.
A.	 True	B.	False

Ans:	B
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Skill	Check	Point

1.	 Write	HTML	Code	for	creating	a	website	of	your	organization.
a)The	website	site	should	contain	five	pages	i.e.	Home,	About	us,	Profile,	Details,	Contact	us.
b)Home	page	should	be	Main	page	(first	page)

2.	 Create	Enquiry	form	and	use	their	validation	form
a)Last	name,	Contact	us,	and	email	is	compulsory	field.
b)Information	should	be	submit.
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Chapter	Seven

ITDC-412
Web	Scripting	-	Java	Script

	
•Java	Script	Review
•Functions	–	user	defined
•String	Object
•Math	Object
•Array	Object
•Events
•Case	Studies

	
271



JAVASCRIPT	REVIEW
JavaScript	is	a	programming	language	used	to	make	web	pages	interactive.	JavaScriptwasdesigned	primarily	for	adding	interactivity	toWebpages	and	creatingWebapplications.	JavaScript	is
used	for	client	side	scripting.	Client-side	JavaScript	programs,	or	scripts,	can	be	embedded	directly	in	HTML	source	of	Web	pages.	JavaScript	is	widely	supported	by	most	of	the	brewers
available	today.

•JavaScripts	inHTMLmust	be	inserted	between	<script>	and	</script>	tags.
•JavaScripts	can	be	put	in	the	<body>	and	in	the	<head>	section	of	an	HTML	page.

JavaScript	is	a	lightweight,	interpreted	programming	language	with	object-oriented	capabilities	that	allows	you	to	build	interactivity	into	otherwise	static	HTML	pages.

Client-side	JavaScript
Client-side	JavaScript	is	the	most	common	form	of	the	language.	The	script	should	be	included	in	HTML	document	for	the	code	to	be	interpreted	by	the	browser.	It	means	that	a	web	page
need	no	longer	be	static	HTML,	but	can	include	programs	that	interact	with	the	user,	control	the	browser,	and	dynamically	create	HTML	content.

The	JavaScript	code	is	executed	when	the	user	submits	the	form,	and	only	if	all	the	entries	are	valid	they	would	be	submifed	to	the	Web	Server.	JavaScript	can	be	used	to	trap	user-initiated
events	such	as	bufon	clicks,	link	navigation,	and	other	actions	that	the	user	explicitly	or	implicitly	initiates.

Advantages	of	JavaScript
•Less	server	interaction:Youcan	validate	user	input	before	sending	the	page	off	to	the	server.	This	saves	server	traffic,	which	means	less	load	on	your	server.
•Immediate	feedback	to	the	visitors:They	don’t	have	to	wait	for	a	page	reload	to	see	if	they	have	forgofen	to	enter	something.
•Increased	interactivity:Youcan	create	interfaces	that	react	when	the	user	hovers	over	them	with	a	mouse	or	activates	them	via	the	keyboard.
•Richer	interfaces:Youcan	use	JavaScript	to	include	such	items	as	drag-and-drop	components	and	sliders	to	give	a	Rich	Interface	to	your	site	visitors.

Limitations	with	JavaScript
•Client-side	JavaScript	does	not	allow	the	reading	or	writing	of	files.	This	has	been	kept	for	security	reason.

	
272



•	JavaScript	cannot	be	used	for	Networking	applications	because	there	is	no	such	support	available.
•	JavaScript	doesn’t	have	any	multithreading	or	multiprocess	capabilities.
JAVASCRIPT	FUNCTIONS
A	 function	 is	a	block	of	code	 that	will	be	executed	when	someone	calls	 it.	Functions	can	be	classified	 in	 two	categories:	Library	 functions	and	User	defined	 functions.	The	difference
between	this	two	functions	is,	Library	functions	are	already	built	 in	and	we	need	not	 to	write	 its	code,	whereas	a	User	defined	function	has	to	be	wrifen	to	get	 it	executed	during	the
output.

User	Defined	Functions
The	user-defined	functions	are	defined	by	a	user	as	per	its	own	requirement.	The	user-defined	functions	are	part	of	the	program.	In	user-defined	functions	the	name	of	function	is	decided
by	user	that	can	be	change	at	any	time,	whereas	in	library	function	name	of	function	can’t	be	changed.

Example:
<!DOCTYPE	html>
<html>
<head>
<script	type=“text/javascript”>	function	myFunction()

{

alert(“Hello	World!”);

}

</script>
</head>
<body>
<bufon	onclick=“myFunction()”>Tryit</bufon>
</body>
</html>
Syntax	of	user-defined	function
A	function	is	wrifen	as	a	code	block	inside	curly	{	}	braces,	proceeded	by	the	function	keyword:

function	function-name()

{
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some	code	to	be	executed

}

The	code	inside	the	function	will	be	executed	when	someone	calls	the	function.	The	function	can	be	called	directly	when	an	event	occurs	(like	when	a	user	clicks	a	bufon),	and	it	can	be
called	from	anywhere	by	JavaScript	code.

JavaScript	is	case	sensitive.	The	function	keyword	must	be	wrifen	in	lowercase	lefers,	and	the	function	must	be	called	with	the	same	capitals	as	used	in	the	function	name.

Calling	a	Function	with	Arguments
When	you	call	a	function,	you	can	pass	along	some	values	to	it,	these	values	are	called	arguments	or	parameters.	These	arguments	can	be	used	inside	the	function.	You	can	send	as	many
arguments	as	you	like,	separated	by	commas	(,)	myFunction(argument1,argument2)

Declare	the	argument,	as	variables,	when	you	declare	the	function:	function	myFunction(var1,var2)

{

some	code

}

The	variables	and	the	arguments	must	be	in	the	expected	order.	The	first	variable	is	given	the	value	of	the	first	passed	argument	etc.

Example:
<bufon		onclick=“msg(‘SCERT’,‘Delhi’)”>Try		it	</bufon>	<script	type=“text/javascript”>	function	msg(name,place)

{

alert(“Welcome	To	”	+	name	+	“		”	+	place);

}

</script>
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<!DOCTYPE	html>	<html>
<body>
<p>Click	the	bufon	to	call	a	function	with	arguments</p>
<bufon	onclick=“msg(‘SCERT’,‘Delhi’)”>Tryit</bufon>
<script	type=“text/javascript”>	function	msg(name,place)

{

alert(“Welcome	To	”	+	name	+	”	”	+	place);

}

</script>
	

</body>
</html>\
The	function	above	will	alert	“Welcome	ToSCERTDelhi”	when	the	bufon	is	clicked.
Functions	with	a	Return	Value
Sometimes	you	want	your	function	to	return	a	value	back	to	where	the	call	was	made.	This	is	possible	by	using	the	return	statement.	When	using	the	return	statement,	the	function	will
stop	executing,	and	return	the	specified	value.

Syntax:
function	myFunction()

{

var	x=5;	return	x;

}

The	function	above	will	return	the	value	5.
The	function-call	will	be	replaced	with	the	return	value:var	myVar=myFunction();	The	variable	myVar	holds	the	value	5,	which	is	what	the

function	myFunction()	returns.You	can	also	use	the	return	value	without	storing	it	as	a	variable:	275



document.getElementById(“demo”).innerHTML=myFunction();
The	innerHTML	of	the	“demo”	element	will	be	5,	which	is	what	the	function	myFunction()	returns.	You	can	make	a	return	value	based	on	arguments	passed	into	the	function:

Example:

Calculate	the	product	of	two	numbers,	and	return	the	result:	function	prod(a,b)

{

return	a*b;

}

document.getElementById(“demo”).innerHTML=prod(4,3);	The	innerHTML	of	the	“demo”	element	will	be:
12

The	return	statement	is	also	used	when	you	simply	want	to	exit	a	function.	The	return	value	is	optional:	function	add(a,b)

{

if	(a>b)

{

return;

}

x=a+b

}

The	function	above	will	exit	the	function	if	a>b,	and	will	not	calculate	the	sum	of	a	and	b.
Scope	of	JavaScript	Variables

Local	Variables
A	variable	declared	within	a	JavaScript	function	becomes	local	and	can	only	be	accessed	from	within	that	function.	You	can	have	local	variables	with	the	same	name	in	different	functions,
because	local	variables	are	only	recognized	by	the	function	in	which	they	are	declared.	Local	variables	are	deleted	as	soon	as	the	function	is	completed.
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Global	Variables
Variables	declared	outside	a	function,	become	global,	and	all	scripts	and	functions	on	the	web	page	can	access	 it.	 If	you	assign	a	value	to	variable	that	has	not	yet	been	declared,	the
variable	will	automatically	be	declared	as	a	global	variable.	This	statement:	carname=“Volvo”;
will	declare	the	variablecarnameas	a	global	variable	,	even	if	it	is	executed	inside	a	function.
The	Lifetime	of	JavaScript	Variables
The	lifetime	JavaScript	variable	starts	when	they	are	declared.	Local	variables	are	deleted	when	the	function	is	completed.	Global	variables	are	deleted	when	you	close	the	page.

JAVASCRIPT	OBJECTS

Everything	in	JavaScript	is	an	object:	a	String,	a	Number,	an	Array,	a	Date.	In	JavaScript,	an	object	is	data,	with	properties	and	methods.

•Propertiesarevaluesassociated	with	an	object.
•	Methodsareactionsthat	can	be	performed	on	objects.	When	you	declare	a	JavaScript	variable	like	this:	var	txt	=	“Hello”;
Youactually	create	a	JavaScript	String	object.	The	String	object	has	a	built-in	property	called	length.	For	the	string	above,	length	has	the	value	5.	The	String	objects	also	have	several	built-
in	methods.

Example:
person=new	Object();	person.firstname=“John”;	person.lastname=“Write”;	person.age=50;
person.eyecolor=“blue”;	This	example	creates	an	object	called	“person”,	and	adds	four	properties	to	it.
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Accessing	Object	Properties
The	syntax	for	accessing	the	property	of	an	object	is:	objectName.propertyName
This	example	uses	the	length	property	of	the	String	object	to	find	the	length	of	a	string:

var	message=“Hello	World!”;	var	x=message.length;

The	value	of	x,	after	execution	of	the	code	above	will	be:	12
Accessing	Object	Methods
The	syntax	for	calling	a	method	of	an	object	is:	objectName.methodName()
This	example	uses	the	toUpperCase()	method	of	the	String	object,	to	convert	a	text	to	uppercase:

var	message=“Hello	world!”;	var	x=message.toUpperCase();

The	value	of	x,	after	execution	of	the	code	above	will	be:HELLO	WORLD!
Creating	JavaScript	Objects
With	JavaScript	you	can	define	and	create	your	own	objects.	There	are	2	different	ways	to	create	a	new	object:

1.	 Define	and	create	a	direct	instance	of	an	object.
2.	 Use	a	function	to	define	an	object,	then	create	new	object	instances.

Creating	a	Direct	Instance
This	example	creates	a	new	instance	of	an	object,	and	adds	four	properties	to	it.
Example:

person=new	Object();
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person.firstname=“John”;	person.lastname=“Write”;	person.age=50;	person.eyecolor=“blue”;
Alternative	syntax	(using	object	literals).	person=
{firstname:“John”,lastname:“Write”,age:50,eyecolor:“blue”};Using	an	Object	Constructor	This	example
uses	a	function	to	construct	the	object

Example:
function	person(firstname,lastname,age,eyecolor)

{

this.firstname=firstname;	this.lastname=lastname;	this.age=age;	this.eyecolor=eyecolor;

}

The	reason	for	all	the	“this”	stuff	is	that	you’re	going	to	have	more	than	one	person	at	a	time	(which	person	you’re	dealing	with	must	be	clear).	That’s	what	“this”	is:	the	instance	of	the
object	at	hand.

Creating	JavaScript	Object	Instances

Once	you	have	a	object	constructor,	you	can	create	new	instances	of	the	object,	like	this:	var	myFather=new	person(“John”,“Write”,50,“blue”);	var	myMother=new

person(“Sally”,“Rally”,48,“green”);

Adding	Properties	to	JavaScript	Objects
You	 can	 add	 new	 properties	 to	 an	 existing	 object	 by	 simply	 giving	 it	 a	 value.	 Assume	 that	 the	 person	Object	 already	 exists	 -	 you	 can	 give	 it	 new	 properties	 named	 firstname,

lastname,	age,	and	eyecolor	as	follows:	person.firstname=“John”;	person.lastname=“Write”;
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person.age=30;	person.eyecolor=“blue”;	x=person.firstname;
The	value	of	x,	after	execution	of	the	code	above	will	be:	John
Adding	Methods	to	JavaScript	Objects
Methods	are	just	functions	afached	to	objects.	Defining	methods	to	an	object	is	done	inside	the	constructor	function:	function	person(firstname,lastname,age,eyecolor)

{

this.firstname=firstname;	this.lastname=lastname;	this.age=age;	this.eyecolor=eyecolor;

this.changeName=changeName;	function	changeName(name)

{

this.lastname=name;

}

}

The	changeName()	function	assigns	the	value	of	name	to	the	person’s	lastname	property.	myMother.changeName(“Write”);	JavaScript	knows	which	person	you	are	talking	about	by
substituting	this	with	myMother.

JAVASCRIPT	NUMBER	OBJECT

The	Number	object	is	an	object	wrapper	for	primitive	numeric	values.	The	Number	object	represents	numerical	date,	either	integers	or	floating-point	numbers.	In	general,	you	do	not	need
to	worry	about	Number	objects	because	the	browser	automatically	converts	number	280



literals	to	instances	of	the	number	class.
Syntax	for	creating	a	number	object:

var	val	=	new	Number(number);
If	the	argument	cannot	be	converted	into	a	number,	it	returns	NaN	(Not-a-Number).
Number	Properties

Property Description
MAX_VALUE The	largest	possible	value	a	number	in	JavaScript	can

have	1.7976931348623157E+308
MIN_VALUE The	smallest	possible	value	a	number	in	JavaScript

can	have	5E-324

NaN Equal	to	a	value	that	is	not	a	number.

NEGATIVE_INFINITY A	value	that	is	less	than	MIN_VALUE.
POSITIVE_INFINITY A	value	that	is	greater	than	MAX_VALUE
prototype A	 static	 property	 of	 the	 Number	 object.	 Use	 the

prototype	 property	 to	 assign	 new	 properties	 and
methods	 to	 the	 Number	 object	 in	 the	 current
document

Number	Methods
The	Number	object	contains	only	the	default	methods	that	are	part	of	every	object’s	definition.

Method Description
constructor() Returns	the	function	that	created	this	object’s	instance.	By

default	this	is	the	Number	object.
toExponential() Forces	a	number	to	display	in	exponential	notation,	even	if	the

number	is	in	the	range	in	which	JavaScript	normally	uses
standard	notation.

toFixed() Formats	a	number	with	a	specific	number	of	digits	to	the	right
of	the	decimal.

toLocaleString() Returns	a	string	value	version	of	the	current	number	in	a
format	that	may	vary	according	to	a	browser’s	locale	sefings.

toPrecision() Defines	how	many	total	digits	(including	digits	to	the	left	and
right	of	the	decimal)	to	display	of	a	number.

toString() Returns	the	string	representation	of	the	number’s	value.
valueOf() Returns	the	number’s	value.
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JAVASCRIPT	STRING	OBJECT

The	String	object	is	used	to	manipulate	a	stored	piece	of	text.	String	objects	are	created	with	new	String().

Syntax
var	txt	=	new	String(“string”);	var	txt	=	“string”;

String	Object	Properties:

Property Description
constructor Returns	the	function	that	created	the	String	object’s	prototype
length Returns	the	length	of	a	string
prototype Allows	you	to	add	properties	and	methods	to	an	object
Example:
<!DOCTYPE	html>
<html>
<head>
<b>	Example	for	String	Properties	</b>
<script	type=“text/javascript”>	function	book(title,	author){
this.title	=	title;	this.author		=	author;

}

</script>
</head>
<body>
<script	type=“text/javascript”>
var	str	=	new	String(	“Hello	World”	);	document.write(“<br>”	+	“str.constructor	is:”
+	str.constructor+	“<br>”);	document.write(“str.length	is:”	+	str.length+	“<br>”);
var	myBook	=	new	book(“Conversations	with	Myself”,“Nelson	Mandela”);	book.prototype.price	=	null;
myBook.price	=	28;	document.write(“Book	title	is	:	”	+	myBook.title	+	“<br>”);
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document.write(“Book	author	is	:	”	+	myBook.author	+	“<br>”);	document.write(“Book	price	is	:	$”	+
myBook.price	+	“<br>”);	</script>
</body>
</html>

String	Object	Methods:

Method Description
charAt() Returns	the	character	at	the	specified	index
charCodeAt() Returns	the	Unicode	of	the	character	at	the	specified	index
concat() Joins	two	or	more	strings,	and	returns	a	copy	of	the	joined

strings
fromCharCode() Converts	Unicode	values	to	characters

indexOf() Returns	the	position	of	the	first	found	occurrence	of	a
specified	value	in	a	string

lastIndexOf() Returns	the	position	of	the	last	found	occurrence	of	a
specified	value	in	a	string

match() Searches	for	a	match	between	a	regular	expression	and	a
string,	and	returns	the	matches

replace() Searches	for	a	match	between	a	substring	(or	regular
expression)	and	a	string,	and	replaces	the	matched	substring
with	a	new	substring

search() Searches	for	a	match	between	a	regular	expression	and	a
string,	and	returns	the	position	of	the	match

slice() Extracts	a	part	of	a	string	and	returns	a	new	string
split() Splits	a	string	into	an	array	of	substrings

substr() Extracts	the	characters	from	a	string,	beginning	at	a
specified	start	position,	and	through	the	specified
number	of	character

substring() Extracts	the	characters	from	a	string,	between	two	specified
indices

toLowerCase() Converts	a	string	to	lowercase	lefers
toUpperCase() Converts	a	string	to	uppercase		lefers
valueOf() Returns	the	primitive	value	of	a	String	object
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Example:
<!DOCTYPE	html>
<html>
<head><b>	Example	for	String	Properties	</b>
</head>
<body>
<script	type=“text/javascript”>	var	str1	=	new	String(	“Hello”	);	var	str2	=	new	String(	“World”	);
document.write(“<br>”	+	“String	1	:	”	+	str1);	document.write(“<br>”	+	“String	2	:	”	+	str2);
document.write(“<br>”	+	“Concatenated	String	1	&	String	2	:	”	+	str1.concat(	str2	));
document.write(“<br>”	+	“String	1	toUpperCase:	”	+	str1.toUpperCase(	));	document.write(“<br>”	+
“String	2	toLowerCase:	”	+	str2.toLowerCase(	));	</script>
</body>
</html>
JAVASCRIPT	MATH	OBJECT
The	Math	object	allows	you	to	perform	mathematical	tasks.	Math	is	not	a	constructor.	All	properties/methods	of	Math	can	be	called	by	using	Math	as	an	object,	without	creating	it.

Syntax:
var	x	=	Math.PI;	//	Returns	PI
var	y	=	Math.sqrt(16);	//	Returns	the	square	root	of	16

Math	Object	Properties:

Property Description
E Returns	Euler’s	number	(approx.	2.718)
LN	2 Returns	the	natural	logarithm	of	2	(approx.	0.693)
LN	10 Returns	the	natural	logarithm	of	10	(approx.	2.302)
LOG	2E Returns	the	base-2	logarithm	of	E	(approx.	1.442)

LOG	10E Returns	the	base-10	logarithm	of	E	(approx.	0.434)

PI Returns	PI	(approx.	3.14)
SQRT	1_2 Returns	the	square	root	of	1/2	(approx.	0.707)
SQRT	2 Returns	the	square	root	of	2	(approx.	1.414)
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Example:
<!DOCTYPE	html>
<html>
<head>
<b>JavaScript	Math	Property	Example	:	</b>
</head>
<body>
<script	type=“text/javascript”>
var	property_value	=	Math.SQRT	1_2	document.write(“<br>”	+	“Property	Value	of	SQRT	1_2	Property	is	:	”	+
property_value);	document.write(“<br>”	+	“Property	Value	of	SQRT	2	Property	is	:	”	+	Math.SQRT	2);
document.write(“<br>”	+	“Property	Value	of	PI	Property	is	:	”	+	Math.PI);	</script>
</body>
</html>
Math	Object	Properties:

Method Description
abs(x) Returns	the	absolute	value	of	x
acos(x) Returns	the	arccosine	of	x,	in	radians
asin(x) Returns	the	arcsine	of	x,	in	radians
atan(x) Returns	the	arctangent	of	x	as	a	numeric	value	between	-PI/2

and	PI/2	radians

atan2(y,x) Returns	the	arctangent	of	the	quotient	of	its	arguments
ceil(x) Returns	x,	rounded	upwards	to	the	nearest	integer
cos(x) Returns	the	cosine	of	x	(x	is	in	radians)
exp(x) Returns	the	value	of	Ex
floor(x) Returns	x,	rounded	downwards	to	the	nearest	integer
log(x) Returns	the	natural	logarithm	(base	E)	of	x
max(x,y,z,…,n) Returns	the	number	with	the	highest	value
min(x,y,z,…,n) Returns	the	number	with	the	lowest	value
pow(x,y) Returns	the	value	of	x	to	the	power	of	y
random() Returns	a	random	number	between	0	and	1
round(x) Rounds	x	to	the	nearest	integer

sin(x) Returns	the	sine	of	x	(x	is	in	radians)

sqrt(x) Returns	the	square	root	of	x

tan(x) Returns	the	tangent	of	an	angle
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Example:
<!DOCTYPE	html>
<html>
<head>
<b>JavaScript	Math	Object	Method	Example	:
</b>
</head>
<body>
<script	type=“text/javascript”>	var	value1	=	Math.sin(30);		var	value2	=	Math.cos(30);	var	value3	=	
Math.tan(30);	var	value4	=	Math.pow(5,2);	var	value5	=	Math.sqrt(25);	document.write(“<br>”	+	“Test
Value	of	sin(30)
:	”	+	value1);
document.write(“<br>”	+	“Test	Value	of	cos(30)	:	”	+	value2	);	document.write(“<br>”	+	“Test	Value	of	tan(30)	:	”
+	value3	);	document.write(“<br>”	+	“Test	Value	of	power(5,2)	:	”	+	value4	);	document.write(“<br>”	+	“Test
Value	of	sqrt(25)	:	”	+	value5	);	</script>
</body>
</html>
JAVASCRIPT	ARRAY	OBJECT
The	Array	object	is	used	to	store	multiple	values	in	a	single	variable.	An	array	is	a	special	variable,	which	can	hold	more	than	one	value	at	a	time.	For	example	if	you	have	a	list	of	car
names,	storing	the	cars	in	single	variables	could	look	like	this:	var	car1=“Toyota”;	var	car2=“Volvo”;	var	car3=“BMW”;

An	array	can	hold	many	values	under	a	single	name,	and	you	can	access	the	values	by	referring	to	an	index	number.

Creating	an	Array
An	array	can	be	created	in	three	ways.	The	following	code	creates	an	Array	object	called	myCars:
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1.	 Regular:
var	myCars=new	Array();	myCars[0]=“Saab”;	myCars[1]=“Volvo”;	myCars[2]=“BMW”;

2.	 Condensed:
var	myCars=new	Array(“Saab”,“Volvo”,“BMW”);

3.	 Literal:
var	myCars=[“Saab”,“Volvo”,“BMW”];

Accessing	an	Array
You	refer	to	an	element	in	an	array	by	referring	to	the	index	number.	This	statement	access	the	value	of	the	first	element	in	myCars:	var	name=myCars[0];
This	statement	modifies	the	first	element	in	myCars:	myCars[0]=“Opel”;

Array	Object	Properties:

Property Description
constructor Returns	the	function	that	created	the	Array	object’s	prototype
length Sets	or	returns	the	number	of	elements	in	an	array
prototype Allows	you	to	add	properties	and	methods	to	an	Array	object
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Example:
<!DOCTYPE	html>
<html>
<head>
<b>JavaScript	Array	constructor	Property	Example</b>
</head>
<body>
<script	type=“text/javascript”>	var	arr	=	new	Array(	10,	20,	30	);
document.write(“arr.constructor	is:”	+	arr.constructor);				document.write(“arr.length	is	:	”	+	arr.length);	</script>
</body>
</html>
Array	Object	Methods

Method Description
concat() Joins	two	or	more	arrays,	and	returns	a	copy	of	the	joined

arrays
indexOf() Search	the	array	for	an	element	and	returns	its	position
join() Joins	all	elements	of	an	array	into	a	string
lastIndexOf() Search	the	array	for	an	element,	starting	at	the	end,	and

returns	its	position
pop() Removes	the	last	element	of	an	array,	and	returns	that

element
push() Adds	new	elements	to	the	end	of	an	array,	and	returns	the

new	length
reverse() Reverses	the	order	of	the	elements	in	an	array
shift() Removes	the	first	element	of	an	array,	and	returns	that

element
slice() Selects	a	part	of	an	array,	and	returns	the	new	array
sort() Sorts	the	elements	of	an	array
splice() Adds/Removes	elements	from	an	array

toString() Converts	an	array	to	a	string,	and	returns	the	result

unshift() Adds	new	elements	to	the	beginning	of	an	array,	and	returns
the	new	length

valueOf() Returns	the	primitive	value	of	an	array
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Example:
<!DOCTYPE	html>
<html>
<head>
<b>JavaScript	Array	Method	Example</b>
</head>
<body>
<script	type=“text/javascript”>
var	arr	=	new	Array(“Orange”,	“Mango”,	“Banana”,	“Apple”,	“Pineapple”);
document.write(“<br>”	+	“Original	array	is	:	“
+	arr);
document.write(“<br>”	+	“Sorted	array	is	:	”	+	arr.sort()	);
document.write(“<br>”	+	“Reversed	array	is	:	“
+	arr.reverse()	);
</script>
</body>
</html>
JAVASCRIPT	DATE	OBJECT
The	Date	object	is	used	to	work	with	dates	and	times.	Date	objects	are	created	with	new	Date().	There	are	four	ways	of	instantiating	a	date:	var	d	=	new	Date();
var	d	=	new	Date(milliseconds);	var	d	=	new	Date(dateString);
var	d	=	new	Date(year,	month,	day,	hours,	minutes,	seconds,	milliseconds);
Date	Object	Properties

Property Description
constructor Returns	the	function	that	created	the	Date	object’s	prototype
prototype Allows	you	to	add	properties	and	methods	to	an	object
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Date	Object	Methods

Method Description
getDate() Returns	the	day	of	the	month	(from	1-31)
getDay() Returns	the	day	of	the	week	(from	0-6)
getFullYear() Returns	the	year	(four	digits)
getHours() Returns	the	hour	(from	0-23)
getMilliseconds() Returns	the	milliseconds	(from	0-999)
getMinutes() Returns	the	minutes	(from	0-59)
getMonth() Returns	the	month	(from	0-11)
getSeconds() Returns	the	seconds	(from	0-59)
getTime() Returns	the	number	of	milliseconds	since	midnight	Jan	1,

1970

getTimezoneOffset() Returns	the	time	difference	between	UTC	time	and	local
time,	in	minutes

getUTCDate() Returns	the	day	of	the	month,	according	to	universal	time
(from	1-31)

getUTCDay() Returns	the	day	of	the	week,	according	to	universal	time
(from	0-6)

getUTCFullYear() Returns	the	year,	according	to	universal	time	(four	digits)

getUTCHours() Returns	the	hour,	according	to	universal	time	(from	0-23)

getUTCMilliseconds() Returns	the	milliseconds,	according	to	universal	time
(from	0-999)

getUTCMinutes() Returns	the	minutes,	according	to	universal	time	(from	0-
59)

getUTCMonth() Returns	the	month,	according	to	universal	time	(from	0-
11)

getUTCSeconds() Returns	the	seconds,	according	to	universal	time	(from	0-
59)

getYear() Deprecated.	Use	the	getFullYear()	method	instead
parse() Parses	a	date	string	and	returns	the	number	of

milliseconds	since	midnight	of	January	1,	1970

setDate() Sets	the	day	of	the	month	of	a	date	object

setFullYear() Sets	the	year	(four	digits)	of	a	date	object
setHours() Sets	the	hour	of	a	date	object
setMilliseconds() Sets	the	milliseconds	of	a	date	object
setMinutes() Set	the	minutes	of	a	date	object
setMonth() Sets	the	month	of	a	date	object
setSeconds() Sets	the	seconds	of	a	date	object
setTime() Sets	a	date	and	time	by	adding	or	subtracting	a

specified	number	of	milliseconds	to/from	midnight
January	1,	1970
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setUTCDate() Sets	the	day	of	the	month	of	a	date	object,	according	to
universal	time

setUTCFullYear() Sets	the	year	of	a	date	object,	according	to	universal	time
(four	digits)

setUTCHours() Sets	the	hour	of	a	date	object,	according	to	universal	time

setUTCMilliseconds() Sets	the	milliseconds	of	a	date	object,	according	to
universal	time

setUTCMinutes() Set	the	minutes	of	a	date	object,	according	to	universal
time

setUTCMonth() Sets	the	month	of	a	date	object,	according	to	universal
time

setUTCSeconds() Set	the	seconds	of	a	date	object,	according	to	universal
time

setYear() Deprecated.	Use	the	setFullYear()	method	instead
toDateString() Converts	the	date	portion	of	a	Date	object	into	a	readable

string
toGMTString() Deprecated.	Use	the	toUTCString()	method	instead
toISOString() Returns	the	date	as	a	string,	using	the	ISO	standard
toJSON() Returns	the	date	as	a	string,	formated	as	a	JSON	date
toLocaleDateString() Returns	the	date	portion	of	a	Date	object	as	a	string,

using	locale	conventions

toLocaleTimeString() Returns	the	time	portion	of	a	Date	object	as	a	string,
using	locale	conventions



toLocaleString() Converts	a	Date	object	to	a	string,	using	locale
conventions

toString() Converts	a	Date	object	to	a	string

toTimeString() Converts	the	time	portion	of	a	Date	object	to	a	string

toUTCString() Converts	a	Date	object	to	a	string,	according	to	universal
time

UTC() Returns	the	number	of	milliseconds	in	a	date	string	since
midnight	of	January	1,	1970,	according	to	universal	time

valueOf() Returns	the	primitive	value	of	a	Date	object
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Example:
<!DOCTYPE	html>
<html>
<head>
<b>JavaScript	Date	Method	Example</b>
</head>
<body>
<script	type=“text/javascript”>	var	dt	=	new	Date();
document.write(“<br>”	+	“Date	and	Time	:	”	+	dt	);
document.write(“<br>”	+	“Today’s	date	and	time	:	”	+	dt.getDate()	);	document.write(“<br>”	+	“Today’s	month	:	”	+
dt.getMonth()	);	document.write(“<br>”	+	“Today’s	year	:	”	+	dt.getYear()	);
document.write(“<br>”	+	“Today’s	time	zone	:	”	+	dt.getTimezoneOffset()	);
</script>
</body>
</html>
JAVASCRIPT	BOOLEAN	OBJECT
The	Boolean	object	is	used	to	convert	a	non-Boolean	value	to	a	Boolean	value	(true	or	false).
Boolean	Object	Properties

Property Description
constructor Returns	the	function	that	created	the	Boolean	object’s

prototype
prototype Allows	you	to	add	properties	and	methods	to	a	Boolean	object
Boolean	Object	Methods

Method Description
toString() Converts	a	Boolean	value	to	a	string,	and	returns	the	result
valueOf() Returns	the	primitive	value	of	a	Boolean	object
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Example:
<!DOCTYPE	html>
<html>
<head>
<b>JavaScript	toString()	Method	Example</b>
</head>
<body>
<script	type=“text/javascript”>	var	flag	=	new	Boolean(false);
document.write(	“<br>”	+	“flag.toString	is	:	”	+	flag.toString()	);
document.write(	“<br>”	+	“flag.valueOf	is	:	”	+	flag.valueOf()	);
</script>
</body>
</html>
JAVASCRIPT	REGEXP	OBJECT
A	regular	expression	is	an	object	that	describes	a	pafern	of	characters.	Regular	expressions	are	used	to	perform	pafern-matching	and	search-and-replace	functions	on	text.

Syntax
var	paf=new	RegExp(pafern,modifiers);var	paf=/pafern/modifiers;

pafern	specifies	the	pafern	of	an			expression
modifiers	specify	if	a	search	should	be	global,	case-sensitive,	etc.
Modifiers
Modifiers	are	used	to	perform	case-insensitive	and	global	searches:

Modifier Description
i Perform	case-insensitive	matching

g Perform	a	global	match	(find	all	matches	rather	than	stopping
after	the	first	match)

m Perform	multiline	matching
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Brackets
Brackets	are	used	to	find	a	range	of	characters:

Expression Description
[abc] Find	any	character	between	the	brackets
[^abc] Find	any	character	not	between	the	brackets
[0-9] Find	any	digit	from	0	to	9
[A-Z] Find	any	character	from	uppercase	A	to	uppercase	Z
[a-z] Find	any	character	from	lowercase	a	to	lowercase	z
[A-z] Find	any	character	from	uppercase	A	to	lowercase	z
[adgk] Find	any	character	in	the	given	set
[^adgk] Find	any	character	outside	the	given	set

(red|blue|green) Find	any	of	the	alternatives	specified
Metacharacters
Metacharacters	are	characters	with	a	special	meaning:

Metacharacter Description
. Find	a	single	character,	except	newline	or	line	terminator
\w Find	a	word	character
\W Find	a	non-word	character
\d Find	a	digit
\D Find	a	non-digit	character
\s Find	a	whitespace	character
\S Find	a	non-whitespace	character

\b Find	a	match	at	the	beginning/end	of	a	word

\B Find	a	match	not	at	the	beginning/end	of	a	word

\0 Find	a	NUL	character
\n Find	a	new	line	character
\f Find	a	form	feed	character
\r Find	a	carriage	return	character
\t Find	a	tab	character
\v Find	a	vertical	tab	character
\xxx Find	the	character	specified	by	an	octal	number	xxx
\xdd Find	the	character	specified	by	a	hexadecimal	number	dd
\uxxxx Find	the	Unicode	character	specified	by	a	hexadecimal

number	xxxx
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Quantifiers

Quantifier Description
n+ Matches	any	string	that	contains	at	least	one	n
n* Matches	any	string	that	contains	zero	or	more	occurrences	of

n
n? Matches	any	string	that	contains	zero	or	one	occurrences	of	n
n{X} Matches	any	string	that	contains	a	sequence	of	X	n’s
n{X,Y} Matches	any	string	that	contains	a	sequence	of	X	to	Y	n’s
n{X,} Matches	any	string	that	contains	a	sequence	of	at	least	X	n’s
n$ Matches	any	string	with	n	at	the	end	of	it
^n Matches	any	string	with	n	at	the	beginning	of	it

?=n Matches	any	string	that	is	followed	by	a	specific	string	n

?!n Matches	any	string	that	is	not	followed	by	a	specific	string	n
RegExp	Object	Properties

Property Description
global Specifies	if	the	“g”	modifier	is	set
ignoreCase Specifies	if	the	“i”	modifier	is	set
lastIndex The	index	at	which	to	start	the	next	match
multiline Specifies	if	the	“m”	modifier	is	set
source The	text	of	the	RegExp		pafern
RegExp	Object	Methods

Method Description
compile() Compiles	a	regular	expression
exec() Tests	for	a	match	in	a	string.	Returns	the	first	match
test() Tests	for	a	match	in	a	string.	Returns	true	or	false

	
295



Example:
<!DOCTYPE	html>
<html>
<head>
<b>JavaScript	RefExp()	Method	Example</b>
</head>
<body>
<script	type=“text/javascript”>	var	str=“Hello	world!”;
//look	for	“Hello”
var	paf1=	new	RegExp(“Hello”,“g”);var	result=paf1.exec(str);
document.write(“<br>”	+	“<br>”	+	“Original	String:	”	+	str);
document.write(“<br>”	+	“Search	pafern:	”	+	paf1);
document.write(“<br>”	+	“Returned	value:	”	+	result);
//look	for	“World”
var	paf2=	new	RegExp(“world”,“g”);	var	result=paf2.test(str);document.write(“<br>”	+	“<br>”	+	“Searchpafern:
”	+	paf2);	document.write(“<br>”	+	“Returned	value:	”	+	result);
</script>
</body>
</html>
JavaScript	Global
The	JavaScript	global	properties	and	functions	can	be	used	with	all	the	built-in	JavaScript	objects.

JavaScript	Global	Properties

Property Description
Infinity A	numeric	value	that	represents	positive/negative	infinity

NaN “Not-a-Number”	value

undefined Indicates	that	a	variable	has	not	been	assigned	a	value
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JavaScript	Global	Functions

Method Description
Function Description
decodeURI() Decodes	a	URI
decodeURIComponent() Decodes	a	URI	component
encodeURI() Encodes	a	URI
encodeURIComponent() Encodes	a	URI	component
escape() Encodes	a	string
eval() Evaluates	a	string	and	executes	it	as	if	it	was	script

code
isFinite() Determines	whether	a	value	is	a	finite,	legal	number

isNaN() Determines	whether	a	value	is	an	illegal	number

Number() Converts	an	object’s	value	to	a	number

parseFloat() Parses	a	string	and	returns	a	floating	point	number

parseInt() Parses	a	string	and	returns	an	integer
String() Converts	an	object’s	value	to	a	string
unescape() Decodes	an	encoded	string
Example:
<!DOCTYPE	html>
<html>
<head>
<b>JavaScript	Global	Functions	Example</b>
</head>
<body>
<script	type=“text/javascript”>
var	test1=	new	Boolean(true);	var	test2=	new	Boolean(false);	var	test3=	new	Date();
var	test4=	new	String(“111”);		var	test5=	new	String(“111	222”);	document.write(“<br>”	+
Number(test1)+	“<br>”);
document.write(Number(test2)+	 “<br>”);	 document.write(Number(test3)+	 “<br>”);
document.write(Number(test4)+	“<br>”);	document.write(Number(test5)+	“<br>”);
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document.write(“isFinite(111)	:	”	+	isFinite(111)	+	“<br>”);	document.write(“isFinite(-9.23)	:	”	+	isFinite(-	9.23)+
“<br>”);	document.write(“isFinite(0)	:	”	+	isFinite(0)+	“<br>”);
document.write(“isFinite(Hello)	:	”	+	isFinite(“Hello”)+	“<br>”);	document.write(“isFinite(2012/01/01)	:	”	+
isFinite(“2012/01/01”)+	“<br>”);	document.write(“isNaN(111)	:	”	+	isNaN(111)+	“<br>”);
document.write(“isNaN(-9.23)	:	”	+	isNaN(-	9.23)+	“<br>”);
document.write(“isNaN(0)	:	”	+	isNaN(0)+	“<br>”);
document.write(“isNaN(Hello)	:	”	+	isNaN(“Hello”)+	“<br>”);	document.write(“isNaN(2012/01/01)	:	”	+
isNaN(“2012/01/01”)+	“<br>”);	</script>
</body>
</html>
JAVASCRIPT	EVENTS
A	JavaScript	can	be	executed	when	an	event	occurs,	like	when	a	user	clicks	on	an	HTML	element.	HTML	events	can	be	occurs:
•When	a	user	clicks	the
mouse

•When	a	web	page	has
loaded

•When	an	image	has	been
loaded

•When	the	mouse	moves	over	an
element

•When	an	input	field	is
changed

•When	anHTMLform	is
submifed

•When	a	user	strokes
a	key

To	execute	code	when	a	user	clicks	on	an	element,	add	JavaScript	code	to	an	HTML	event	afribute:

onclick=JavaScript
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Example:
<!DOCTYPE	html>
<html>
<head>
<script	type=“text/javascript”>	function	sayHello()	{
alert(“Hello	World”)

}

</script>
</head>
<body>
<input	type=“bufon”	onclick=“sayHello()”	value=“Say	Hello”	/>
</body>
</html>
HTML	DOM	Events
HTMLDOMevents	allow	JavaScript	to	register	different	event	handlers	on	elements	in	anHTML	document.	Events	are	normally	used	in	combination	with	functions,	and	the	function
will	not	be	executed	before	the	event	occurs	such	as	when	a	user	clicks	a	bufon.
Mouse	Events

Property Description
onclick The	event	occurs	when	the	user	clicks	on	an	element
ondblclick The	event	occurs	when	the	user	doubleclicks	on	an	element
onmouseup The	event	occurs	when	a	user	releases	a	mouse	bufon	over	an

element
onmousedown The	event	occurs	when	a	user	presses	a	mouse	bufon	over	an

element
onmouseover The	event	occurs	when	the	pointer	is	moved	onto	an	element
onmouseout The	event	occurs	when	a	user	moves	the	mouse	pointer	out	of

an	element
onmousemove The	event	occurs	when	the	pointer	is	moving	while	it	is	over

an	element
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Example:

<!DOCTYPE	html>
<html>
<head>
<script	type=“text/javascript”>
function	click1()

{

alert(“Hello	Sir,	You	have	clicked
the
bufon”)

}

function	click2()

{

alert(“Hello	Sir,	You	have	double
clicked	the
bufon”)

}

</script>
</head>
<body>
<input		type=“bufon”	
onclick=“click1()”
value=“Click”	/>
<input		type=“bufon”	
ondblclick=“click2()”
value=“Double	click”	/>
</body>
</html>

	
Keyboard	Events

Aflribute Description
onkeydown The	event	occurs	when	the	user	is	pressing	a	key
onkeyup The	event	occurs	when	the	user	releases	a	key
onkeypress The	event	occurs	when	the	user	presses	a	key
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Example:
<!DOCTYPE	html>
<html>
<head>
<script	type=“text/javascript”>	function	function1()

{

alert(“You	pressed	a	key	inside	the	input	field”);

}

</script>
</head>
<body>
<p>Press	a	key	in	the	input	field.</p>
<input	type=“text”	onkeypress=“function1()”>
</body>
</html>
Frame/Object	Events

Aflribute Description
onload The	event	occurs	when	a	document,	frameset,	or	<object>

has	been	loaded
onunload The	event	occurs	once	a	page	has	unloaded	(for	<body>	and

<frameset>)
onresize The	event	occurs	when	a	document	view	is	resized
onscroll The	event	occurs	when	a	document	view	is	scrolled

onabort The	event	occurs	when	an	image	is	stopped	from	loading
before	completely	loaded	(for	<object>)

onerror The	event	occurs	when	an	image	does	not	load	properly	(for				
<object>,	<body>	and	<frameset>)
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Example:
<!DOCTYPE	html>
<html>
<head>
<h1>	Welcome	to	SCERT	Delhi</h1>
<script	type=“text/javascript”>	function	msg()

{

alert(“Page	loaded	successfully”);

}

</script>
</head>
<body	onload=“msg()”>
</body>
</html>
Form	Events

Aflribute Description
onsubmit The	event	occurs	when	a	form	is	submifed
onreset The	event	occurs	when	a	form	is	reset
onchange The	event	occurs	when	the	content	of	a	form	element,	the

selection,	or	the	checked	state	have	changed	(for	<input>,
<select>,	and	<textarea>)

onselect The		event		occurs		when		a		user	selects	some	text		(for		
<input>	and	<textarea>)

onfocus The		event		occurs		when		an		element		gets		focus		(for		
<label>,	<input>,	<select>,	textarea>,	and	<bufon>)

onblur The	event	occurs	when	a	form	element	loses	focus
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Example:
<!DOCTYPE	html>
<html>
<head>
<script	type=“text/javascript”>	function	msg1()

{

alert(‘Thank	you	‘	+	myform.data.value	+’!’)

}

</script>
</head>
<body>
<b>Type	your	name	and	press	the	bufon</b<br>
<form	name=“myform”	onSubmit=msg1()>
<input	type=“text”	name=“data”>
<input	type=“submit”	name	=“submit”	value=“Submit	this	form”>
</form>
</body>
</html>
EVENTS	CASE	STUDIES
1)	Change	the	color	of	a	block	when	a	user	holds	down	the	mouse	bufon.

<!DOCTYPE	html>
<html>
<head>

<script	type=“text/javascript”>
function	mDown(x)

{

x.style.backgroundColor=”#7CFC
00”;
x.innerHTML=”<b>MOUSE
DOWN</b>”

}

function	mUp(x)

{

x.style.backgroundColor=”#FF
0000”;
x.innerHTML=”<b>MOUSE
UP</b>”

}

</script>
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</head>	<body>
<div	onmousedown=“mDown(this)”	onmouseup=“mUp(this)”	style=“background-color:#FFFF	00;
width:120px;height:20px;padding:40px;”>	<b>Click	Me</b></div>
</body>
</html>

2)Display	an	error	message	when	an	image	does	not	load	properly.
<!DOCTYPE	html>
<html>
<head>
<script	type=“text/javascript”>	function	imgError()

{

alert(‘The	image	could	not	be	loaded.’);

}

</script>
</head>
<body>
<h1>	Welcome	to	SCERT	</h1>
<img	src=“image.gif”	onerror=“imgError()”>
</body>
</html>

3)Change	the	background-color	of	an	input	field	when	it	gets	focus.

<!DOCTYPE	html>
<html>
<head>

<script	type=“text/javascript”>
function	function1(x)

{

x.style.background=“red”;

}

function	function2(x)

{

x.style.background=“green”;

}

function	function3(x)

{
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x.style.background=“yellow”;

}

function	function4(x)

{

x.style.background=“blue”;

}

</script>



</head>
<body>

<p>Enter	your	Name:	<input
type=“text”
onfocus=“function1(this)”>	</p>
<p>Enter	your	Address:	<input
type=“text”
onfocus=“function2(this)”>	</p>
<p>Enter	your	City:	<input
type=“text”
onfocus=“function3(this)”>	</p>
<p>Enter	your	Phone	No.:
<input	type=“text”
onfocus=“function4(this)”>	<p>
<p>When	the	input	field	gets
focus,	it	changes
the	background-color.</p>

</body>
</html>

	

4)Change	the	size	of	an	image	when	the	cursor	moves	over	it.

<!DOCTYPE	html>
<html>
<head>

<script	type=“text/javascript”>
function	mover(x)

{

x.style.height=“396px”;
x.style.width=“396px”;

}

function	mout(x)

{

x.style.height=“132px”;
x.style.width=“132px”;

}

</script>

</head>
<body>

<img
onmouseover=“mover(this)”
onmouseout=“mout(this)”
border=“0”
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src=“smiley.gif”	alt=“Smiley”	width=“132”	height=“132”>	</body>
</html>
5)	Display	the	message	to	state	browser	has	enabled	cookies	or	not.

<!DOCTYPE	html>
<html>
<body	onload=“chkcookies()”>

<script	type=“text/javascript”>
function	chkcookies()

{

if
(navigator.cookieEnabled==true)

{

alert(“Cookies	are	enabled”)

}

else

{

alert(“Cookies	are	not
enabled”)

}

}

</script>

</body>
</html>
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Exercise
Knowledge	Check	Point

1.	 JavaScript	is	used	for	………………………	side	scripting.

a) Client b) Server
c) Local d) Global

2.	 A	JavaScript	can	be	executed	when	………………………..	occurs,

a) Function b) Event
c) Command d) Call

3.	 A	…………………..	is	a	block	of	code	that	will	be	executed	when	someone	calls	it.

a) Function b) Event
c) Command d) Call

4.	 A	variable	declared	within	a	JavaScript	function	becomes	………………………	and	can	only	be	accessed	from	within	that	function.

a) Local b) Global
c) Free d) Universal

	
5.	 Variablesdeclared	outside	a	function,	become	……………………….	and	all	scripts	and	functions	on	the	web	page	can	access	it.

a) Local b) Global
c) Free d) Universal

	
6.	 In	JavaScript,	an	……………………..	is	data,	with	properties	and	methods.

a) Function b) Event
c) Command d) Object

7.	 The	………………………	object	represents	numerical	date,	either	integers	or	floating-point	numbers.

a) Number b) String
c) Math d) Array

	
8.	 The	……………………	object	is	used	to	manipulate	a	stored	piece	of	text.

a) Number b) String
c) Math d) Array
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9.	 The	……………………	object	allows	you	to	perform	mathematical	tasks.

a) Number b) String
c) Math d) Array
10.	 The	……………………	object	is	used	to	store	multiple	values	in	a	single	variable.

a) Number b) String
c) Math d) Array
11.	 The	………………………	object	is	used	to	work	with	dates	and	times.

a) Number b) Date
c) Math d) Array
12.	 The	…………………	object	is	used	to	convert	a	non-Boolean	value	to	a	Boolean	value.

a) Boolean b) Date
c) Math d) Array
13.	 HTML	…………………	events	allow	JavaScript	to	register	different	event	handlers	on	elements	in	an	HTML	document.

a) Window b) Keyboard
c) DOM d) Mouse

	
14.	 The	……………………	event	occurs	when	the	user	clicks	on	an	element.

a) onclick b) onmouseover
c) onmouseup d) onkeypress
15.	 The	…………………	event	occurs	when	a	user	releases	a	mouse	bufon	over	an	element.

a) onclick b) onmouseover
c) onmouseup d) onkeypress
16.	 The	………………………	event	occurs	when	the	pointer	is	moved	onto	an	element.

a) onclick b) onmouseover
c) onmouseup d) onkeypress
17.	 The	……………………………	event	occurs	when	the	user	presses	a	key.

a) onclick b) onmouseover
c) onmouseup d) onkeypress
18.	 The	……………………	event	occurs	when	a	document,	frameset,	or	object	has	been	loaded

a) indexOf() b) onsubmit
c) onload d) onkeypress
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19.	 The	……………………….	event	occurs	when	a	form	is	submifed.

a) indexOf() b) onsubmit
c) onload d) onkeypress
20.	 The	method	……………………	search	the	array	for	an	element	and	returns	its	position.

a) indexOf() b) concat()
c) pop() d) push()

Hands	on	Activities

1.	 Define	a	function	max()	that	takes	two	numbers	as	arguments	and	returns	the	largest	of	them.	Use	the	if-then-else	construct	available	in	Javascript.

2.	 Define	a	function	maxOfThree()	that	takes	three	numbers	as	arguments	and	returns	the	largest	of	them.

3.	 Write	a	function	that	takes	a	character	(i.e.	a	string	of	length	1)	and	returns	true	if	it	is	a	vowel,	false	otherwise.

4.	 Defineafunction	sum()andafunction	multiply()that	sums	andmultiplies(respectively)	all	the	numbers	in	an	array	of	numbers.	For	example,	sum([1,2,3,4])	should	return
10,	and	multiply([1,2,3,4])	should	return	24.

5.	 Define	a	function	reverse()	that	computes	the	reversal	of	a	string.	For	example,	reverse(“jag	testar”)should	return	the	string	“ratset	gaj”.

6.	 Write	a	function	findLongestWord()	that	takes	an	array	of	words	and	returns	the	length	of	the	longest	one.

7.	 Write	a	function	filterLongWords()	that	takes	an	array	of	words	and	an	integer	i	and	returns	the	array	of	words	that	are	longer	than	i.

8.	 Create	a	page	with	JavaScript	to	generate	Alert	Box	if	user	tries	to	change	text	in	text	input	field.

9.	 Create	a	page	with	JavaScript	to	show	the	date	and	time	when	the	page	loads.
10.	 Create	a	page	with	JavaScript	to	create	a	navigational	bar	with	 images.	When	the	mouse	is	over	the	 image,	an	alternate	version	of	the	 image	should	appear.	When	the

mouse	moves	off	the	image,	the	original	image	should	reappear.
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Skill	Check	Point

Write	the	JavaScript	code	for	creating	a	Registration	Form	with	following	client	side	validations:
a)The	Login	name,	Email	address,	Password,	Confirm	password	cannot	left	empty.
b)The	Email	address	needs	to	be	scanned	for	the	presence	of	an	‘@’	and	‘.’	Symbol.
c)The	Password	and	Confirm	password	has	to	be	same.
d)The	length	of	password	should	not	be	less	than	8	characters

References:
1.	 Ivan	Bayross,WebEnabled	Commercial	Application	Development	UsingHTML,DHTML,javascript,	Perl	CGI,	BPB	Publication,	New	Delhi	(2005)
2.	 JavaScript	Tutorial	-	W3Schools,	www.w3schools.com/js/
3.	 JavaScript	Tutorial,	www.tutorialspoint.com/javascript/
4.	 JavaScript	Tutorial,	www.echoecho.com
5.	 Learn	JavaScript	Programming,	www.codecademy.com/tracks/javascript
6.	 JavaScript	Tutorial,	hfp://html.net/tutorials/javascript/
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Skills	required	for	Web	Designing:
Webdesign	 is	 a	broad	area	 covering	many	different	 skill	 sets	 and	disciplines	 that	 are	used	 in	 the	production	and	maintenance	of	websites.	The	different	 areas	of	web	design	 include
interface	design,	web	graphic	design,	authoring,	user	experience	design	and	search	engine	optimization.	To	be	a	successful	web	designer	you	must	have	personal	skills,	self	 learning,
technical,	writing	and	editorial	skills,	you	must	be	well	versed	with	graphic	design	theory.

The	following	personal	technical	and	additional	skills	are	needed	to	be	a	goodWebdesigner.
1.	 Personal	Skills:
•Logical	thinking•Creativity•Communication	skills•Wrifen	skills•Organization	skills•Punctuality•Design	Sense•Self	learning

2.	 Technical	Skills:
The	following	list	of	technical	skills	is	a	list	of	the	skills	you	need	to	be	a	good	Web	designer.

•HTML,	XHTML
•CSS
•JavaScript	and	Ajax •PHP,	ASP,	Java,	Perl	or	C++
•Database	–	MySQL,	MSSQL
•Flash •SEO	Techniques •Dreamweaver•Windows	Movie	Maker

3.	 Additional	Skills
•Web	Server	Administration•Database	concepts•Project	Management•Creativity	&	Graphics	Design
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•Business	Sense
•Graphic	Design	Theory•Know	Typography	well•Must	be	aware	of	UI	(	User	Interface	)	design	paferns.

1.	 HTML:For	Beginners	HTML	(HyperTextMark-up	Language)	is	the	starting	point	for	web	design.	It	is	the	basic	and	fundamental	skill	that	is	used	to	create	web	pages.	HTML
uses	tags	to	open	and	close	a	passage	of	text.

2.	 CSS:	Cascading	Style	Sheets	(CSS)	is	another	fundamental	skill	in	web	design	to	convert	HTML	codes	into	formafed	web	pages.	It	has	to	do	with	the	appearance	and	format
of	each	web	page	with	respect	to	color,	text,	fonts,	borders,	etc.

3.	 JavaScript:	JavaScript	is	the	script	language	which	is	associated	with	HTML	and	used	in	web	design.	This	language	improves	the	interactivity	of	a	Web	page	with	the	addition
of	dynamic	content.	The	JS	is	embedded	in	HTML	code.

4.	 SEO:A	web	designer	must	ensure	that	the	site	is	search	engine	friendly.Youmust	understand	the	basics	of	search	engine	optimization	and	integration	of	their	design	features
so	as	to	help	the	website	in	gaining	more	visibility	on	the	Internet.

5.	 JQUERY:	This	is	latest	website	design	craze,	with	the	ability	to	interact	with	the	server	on	the	fly.	For	a	while	now,	we	have	seen	on	larger	corporate	sites,	the	introduction	of
what	appear	to	mainly	be	usability	improvements,	and	slick	CSS	transitions	and	effects.

6.	 PHP:	Regarded	as	 the	 Internet’s	number	one	choice	 for	server-side	 languages,	 its	open	source	benefits	come	right	out	on	 top	again.	PHP	 is	used	widely	 throughout	 the
internet	from	simple	functions	for	using	dynamic	dates,	and	including	template	files	right	through	to	complete	object	oriented	application	development.

7.	 FLASH:	Animation	on	the	web	is	as	popular	as	ever	with	more	focus	on	3D	tools	interactivity	and	compatibility.	Having	the	skills	to	be	able	to	create	nice	animations	can
certainly	give	your	work	the	wow	factor	that	will	sell	your	work	to	your	clients.	Animation	and	video	are	one	of	the	best	ways	to	get	the	afention	of	your	users.

8.	 SERVERADMINISTRATION:	There	are	certainly	many	areas	of	web	design	that	are	not	glamorous,	but	equally	as	 important	 if	you	are	to	maintain	a	high	level	of	service.
Administering	Domains,	Hosting,	Emails,	servers,	backups	etc	is	essential	for	smooth	website	running.
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9.	 PROJECT	MANAGEMENT:	When	running	or	working	 for	a	web	company,	although	not	necessarily	 related	 to	website	design,	but	more	good	business	practice	 in	general,
being	able	to	manage	the	project	to	the	constraints	of	time,	budget	and	resources,	could	be	the	difference	between	a	successful	project	with	on	going	support,	maintenance
and	future	developments	and	a	disappointed	client	that	looks	elsewhere	for	future	WebsiteDesign

10.	 MYSQL:	Open	source	technologies	on	the	web	have	so	far	dominated	when	it	comes	to	all	round	uptakes.	Web	designers	of	all	levels	can	use	MySQL	technology	freely	within
the	Website	Design.	With	the	bulk	of	web	applications	using	MySQL	along	with	PHP,	it’s	no	surprise	that	having	this	skill	set	can	certainly	be	valuable	in	this	day	and	age.

Additional	skills	explained:
1.	 Sketching/Drawing:	This	is	the	basic	skill	that	the	graphic	designers	should	possess	to	get	their	ideas	on	paper.	The	designer	can	also	learn	a	variety	of	software	to	improve
its	ability	to	delineate.

2.	 Typography:	Typography	is	the	art	of	type	design	and	requires	a	good	understanding	of	font	families,	with	the	use	of	line-height,	kerning	and	tracking.	A	graphic	designer
should	know	the	difference	between	the	families	and	styles	and	how	best	to	use.

3.	 Print	Design	&	Layout:	An	understanding	of	Print	Layout	and	design	is	a	prerequisite	for	a	graphic	designer.	The	use	of	design	programs	such	as	Adobe	In	Design	and	Quark
is	necessary.	The	designer	must	have	a	detailed	knowledge	of	the	printing	process	to	understand	the	use	of	the	color	space.

4.	 Photography:	This	photography	is	a	skill	that	can	enhance	the	designer’s	ability	to	impress	his	clients.	Using	a	digital	camera,	the	designer	could	illuminate	the	subject.	This
is	an	add-on	skill.

Skills	Required	For	Multimedia	Professional:
Multimedia	is	media	and	content	that	uses	a	combination	of	different	content	forms	and	to	develop	such	media,	content	a	multimedia	professional	must	be	well	versed	with	multimedia
software,	tools,	techniques,	services	and	media	devices.

Following	is	the	list	of	a	successful	multimedia	professional	skill	set	and	technical	qualities:
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1.	 Personal	Skills:
•Active
Listening

•Critical
Thinking

•Judgment
and
Decision
Making

•Time
Management

•Speaking•Writing	-
Communicating

•Reading
Comprehension

•Active
Learning

•Monitoring•Instructing•Service
Orientation

•Social
Perceptiveness

•Systems
Evaluation

•Management
of	Material

2.	 Technical	Skills:
•Adobe	Acrobat •Photoshop •Page	Maker/Quark•Corel	Draw•Flash/Shockwave•Web	Development	Tools	for	FrontPage•HTML-XML-HTXML
•Video	Edit	Magic•3D	Max	Studio•Dreamviewer •Illustrator •Paint •Windows	Movie	Maker

3.	 Additional	Skill	set
•Troubleshooting•Operation	and	Control•Complex	Problem	Solving•Equipment	Maintenance
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•Systems	Analysis
•Quality	Control	Analysis•Management	of	Personnel	Resources•Coordination
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Annexure1
	

ITDC-410
Movie	Editing	Tools(with	Premier	Pro)

	
•Familiarisation	of	interface	components
•Importing	pictures
•Importing	Audio	andVideo	Files
•Splifling	and	Joining	Movie	Clips
•AddingTitlesand	publishing
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Introduction
Adobe	Premiere	is	a	video	Editing	software	package	suitable	for	both	amateur	enthusiasts	and	professionals.	It	can	be	purchased	and	used	alone,	or	alongside	other	applications	such	as
Adobe	Photoshop,	After	Effects,	etc.

Premiere	is	a	powerful	editing	tool,	capable	of	producing	broadcast-quality	and	high-definition	video.	It	is	a	very	popular	package	amongst	video	enthusiasts	and	professionals,	although
other	packages	are	usually	preferred	for	the	very	top	level	of	television	production.

Familiarization	of	Interface	Components	Premiere	Pro	Workspace:	Overview

The	screenshot	below	shows	the	default	workspace.	This	workspace	can	be	customized	in	many	ways	—	you	can	rearrange	the	panels	and	use	specialist	panels	for	different	tasks	(audio
Mixer,	titles,	etc).	For	now	we	will	stick	to	the	default	workspace.
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The	default	panels
1.	 The	Tools	Panel	is	where	you	can	select	various	editing	tools	to	use	in	the	timeline.
2.	 The	Project	Panel	is	where	you	store	all	the	elements	which	make	up	your	edited	video	(Video	Clips,	audio	clips,	graphics,	titles,	etc).

3.	 The	Source	Monitor	is	where	you	can	preview	clips,	make	simple	adjustments	and	add	them	to	the	timeline.

4.	 The	Program	Monitor	shows	the	edited	video	from	the	timeline.
5.	 The	Media	Browser	allows	you	to	browse,	preview	and	import	clips	from	your	hard	Drives	and	network.

6.	 The	Timeline	Panel	is	where	you	arrange	the	elements	of	your	video	in	the	desired	order.
7.	 The	Audio	Meters	display	the	volume	level	from	the	timeline.

Exporting	Video	from	Adobe	Premiere	Pro
This	section	shows	how	to	export	Video	clips	using	Adobe	Premiere	Pro.Youcan	export	in	a	variety	of	formats	and	it’s	important	to	choose	the	right	one	for	the	job.

Export	options	can	be	found	in	the	menu	underFile	>	Export.
Important:	Before	exporting,	make	sure	you	have	the	correct	panel	and	source	selected	in	the	 workspace.	 For	 example,	 select	 the	 timeline	 panel	 to	 export	 the	 timeline,	 or	 select	 the
preview	monitor	to	export	a	clip	shown	there.	If	the	export	option	is	grayed	out,	you	don’t	have	a	clip	or	timeline	selected.

AVI
To	export	as	an	AVI	file,	chooseFile	>	Export	>	Movie.
This	creates	a	large	file	but	is	the	best	quality.	Use	this	option	for	mastering	purposes	or	if	you	want	to	be	able	to	edit	the	video	later.	For	maximum	quality,	export	as	an	uncompressed
AVI.
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Working	with	project	:
Step	by	step	instructions	to	start	a	new	project	:-

1.	 Start	adobe	premier
2.	 Click	new	project	icon
3.	 Chose	preset
4.	 Name	the	project
5.	 Click	on	browser	and	locate	a	directory	to	save	the	project
6.	 Click	ok	bufon

After	that	left	panel	where	storage	and	clips	middle	project	window	and	bofom	timeline	and	right	side	tools	shows	there

Tools
Premiers	give	a	number	of	tools	that	help	you	to	work	faster	and	easy
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Adobe	Premiere	Tools	Panel	(Toolbox)
The	toolbox	contains	common	tools	used	for	editing	clips	in	the	timeline.	Click	on	any	of	the	bufons	(or	use	the	keyboard	shortcuts)	to	select	each	tool.	The	default	tool	is	the	selection
tool.

When	you	select	a	tool	the	mouse	pointer	will	usually	change	to	a	new	icon	to	represent	the	tool	when	held	over	the	timeline	panel.	In	some	cases	you	can	change	the	behaviour	of	a	tool
by	holding	down	a	modifier	key	such	as	the	Shih	key.

The	tools	are	described	below	with	links	to	more	information.
Buflon	Keyboard	DescriptionShortcut

V	Selection	tool
The	default	tool,	used	to	select	clips	in	the	timeline.

M	TrackSelect	tool
Select	all	clips	on	a	track	from	a	given	point,	or	select	multiple	tracks.

B	Ripple	Edit	tool
Adjust	an	edit	point	and	move	other	clips	in	the	timeline	to	compensate.

N	Rolling	Edit	tool
Adjust	an	edit	point	between	two	clips	without	affecting	the	rest	of	the	timeline.

X	Rate	Stretch	tool
Change	the	duration	of	a	clip	while	simultaneously	changing	the	speed	to	compensate.

C	Razor	tool
Cut	a	clip	(or	multiple	clips)	into	two	clips.

Y	Slip	tool
Move	a	clip’s	in	and	out	points	by	the	same	amount	simultaneously,	so	the	rest	of	the	timeline	is	not	affected.

U	Slide	tool
Move	a	clip	back	and	forth	in	the	timeline,	while	simultaneously	adjusting	adjacent	clips	to	compensate.
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P	Pen	tool
Create	control	(anchor)	points.

H	Hand	tool
Drag	the	timeline	view	left	and	right.

Z	Zoom	tool
Click	in	the	timeline	to	magnify	the	view,	or	drag	and	select	a	rectangular	area	to	zoom	into.

Importing	Audio	and	Video	Files	Insert	the	sound	file	in	any	clip
1.	 Click	Select	and	Import	the	file	to	the	Project	Assets	panel.	Ensure	that	you	do	not	click	the	drop	down	menu.	Switch	to	Adobe	Premiere	Elements	and	notice	that	the	file	has
been	added	to	the	Project	Assets	panel.

2.	 Use	the	file	as	you	would	any	other	sound	files	in	Adobe	Premiere	Elements.
To	import	additional	files	from	Smart	Sound,	click	Use	Smart	Sound	from	the	Music	panel,	and	re-run	this	procedure.

1.	 Click	Add	media	to	import	the	video	clip	you	want	to	enhance.	Ignore	if	the	video	clip	is	already	present	on	the	timeline.
2.	 Select	the	option	to	import	media.
3.	 Select	Guided	>	Adjusting	Title	to	your	movie.
4.	 Click	Titles	&	Text	on	the	action	bar.
5.	 Select	a	template	and	drag-and-drop	it	to	the	timeline.	There	are	several	templates	available	with	predefined	text.	Select	from	the	drop-down	list	to	explore	other	templates.

Select	Title
1.	 To	add	custom	text,	select	the	default	text	and	type	in	your	desired	text.	Doubleclick	to	select	the	text	if	the	text	is	not	selected.
2.	 Doubleclick	the	text	panel	to	open	it.	You	can	adjust	the	font,	style,	size,	and	color	in	the	Adjustments	panel.
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3.	 There	are	various	predefined	styles	you	can	select	from.	Click	the	Style	tab	in	the	Adjustments	bar.

Choose	and	Add	Styles
Click	the	desired	style	to	apply	it	to	the	text.

4.	 You	can	animate	your	text.	To	add	an	animation,	click	the	desired	animation	and	select	Apply.

Import	a	title	file
You	can	import	a	title	into	a	project	that	was	exported	from	another	Premiere	Elements	project.

1.	 In	the	Expert	view,	click	Project	Assets	to	open	the	Project	Assets	panel.
2.	 Right-click/Ctrlclick	on	the	Project	Assets	panel	and	select	Get	Media	From	>	Files	And	Folders.

Align	objects
1.	 If	necessary,	doubleclick	the	title	in	the	Expert	view	timeline	to	open	it	in	the	Monitor	panel.
2.	 In	the	Monitor	panel,	Shift-click	two	or	more	objects	or	drag	a	marquee	over	them.
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3.	 Do	one	of	the	following:
-Right-click/ctrlclick	any	of	the	objects	selected,	and	choose	Align	Objects.	Or-Choose	Text	>	Align	Objects.

4.	 Select	the	type	of	alignment	you	want.
Distribute	objects

1.	 If	necessary,	doubleclick	the	title	in	the	Expert	view	timeline	to	open	it	in	the	Monitor	panel.

2.	 In	the	Monitor	panel,	Shift-click	three	or	more	objects	or	drag	a	marquee	over	them.
3.	 Do	one	of	the	following:

-Right-click/ctrlclick	any	of	the	objects	selected,	and	choose	Distribute	Objects.	Or-ChooseText>	Distribute	Objects.
Transform	objects
You	have	full	flexibility	in	adjusting	an	object’s	position,	rotation,	scale,	and	opacity—afributes	collectively	referred	to	as	transform	properties.	To	transform	an	object,	you	can	drag	in	the
Monitor	panel	or	choose	a	command	from	the	Text	menu.

Create	a	rolling	or	crawling	title
Although	static	 titles,	graphics,	and	 images	may	suffice	 for	 some	projects,	others	 require	 titles	 that	move.	Using	 roll	 and	crawl	options,	 you	can	 instantly	create	professional-looking
moving	titles.
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The	length	of	the	title	in	the	Quick	view	timeline	determines	the	speed	of	the	movement.	The	more	you	increase	the	title	clip	length,	the	slower	the	movement.

Rolling	titlesmove	characters	vertically	across	the	screen.
Crawling	titlesmove	characters	horizontally	across	the	screen.
Ke`yframeslet	you	move	characters	across	a	custom	path	that	you	create	by	sefing	different	position	keyframes	at	several	points	in	time.

Note:You	cannot	add	a	roll	or	crawl,	or	apply	keyframes	to	a	title	that	uses	an	animation	preset.Applying	an	animation	preset	will	overwrite	all	roll,	crawl,	and	keyframe	seflings.

Use	Roll/Crawl	options	to	change	a	rolling	title	to	a	crawling	title	or	vice	versa,	specify	the	direction	of	a	crawl,	and	set	the	timing	of	movement.

A	rolling	title	is	commonly	used	for	production	credits.
Create	a	rolling	or	crawling	title

1.	 Do	one	of	the	following:
To	create	a	rolling	title,	choose	Text	>	Roll/Crawl	Options	>	Roll.	To	create	a	crawling	title,	choose	Text	>	Roll/Crawl	Options	>	Crawl.

2.	 Create	the	text	and	graphic	objects	for	the	title.	Use	the	Monitor	panel’s	scroll	bar	to	view	offscreen	areas	of	the	title.	When	the	title	is	added	to	the	Quick	view	timeline	or
the	Expert	view	timeline,	the	hidden	offscreen	areas	roll	or	crawl	into	view.

3.	 Select	the	Roll/Crawl	Options	in	the	Roll/Crawl	Options	dialog	box.
4.	 Specify	options	as	desired,	and	then	click	OK.

Note:	You	can	specify	a	direction	for	crawling	titles	only.	Rolling	titles	always	move	from	the	boflom	tothe	top	of	the	screen.

Adjust	an	object’s	opacity
1.	 If	necessary,	doubleclick	the	title	in	the	Expert	view	timeline	to	open	it	in	the	Monitor	panel.
2.	 In	the	Monitor	panel,	select	an	object.
3.	 Do	one	of	the	following:

Right-click/ctrlclick	the	object	and	choose	Transform	>	Opacity.	Choose	Text	>	Transform	>	Opacity.
4.	 Type	a	new	Opacity	value,	and	click	OK.
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Note:	The	Opacity	property	sefling	adjusts	the	opacity	of	objects	within	a	title.	You	can	set	the	overallopacity	of	the	entire	title	in	the	Expert	view	timeline	as	you	would	any	video	clip,	using
effects.

Move	objects
1.	 If	necessary,	doubleclick	the	title	in	the	Expert	view	timeline	to	open	it	in	the	Monitor	panel.
2.	 In	the	Monitor	panel,	select	one	or	more	objects.
3.	 Do	one	of	the	following:

Drag	the	selected	object	or	objects	to	a	new	position.	Choose	Text	>	Transform	>	Position.	Type	new	x	and	y	position	values,	and	then	clickOK.Right-click/ctrlclick	the	selected	object	or
objects,	and	choose	Transform	>	Position.	Type	new	x	and	y	position	values,	and	then	Click	OK.
note:	The	x	and	y	position	values	correspond	to	a	coordinate	system	in	which	the	upper-leß	corner	of	thetitle	is	0,	0.	When	you	enter	values	for	x	andy,Premiere	Elements	places	the	center
of	the	selected	object’s	bounding	box	at	that	point.
BringToFrontBrings	the	object	to	the	top	of	the	stacking	order.Bring	Forward	Switches	the	object	with	the	object	directly	in	front	of	it.Send	To	Back	Moves	the
object	to	the	bofom	of	the	stacking	order.
Send	BackwardSwitches	the	object	with	the	object	directly	behind	it.
note:	If	your	text	or	shape	elements	are	densely	stacked,	it	may	be	difficult	to	select	an	element	within	thestack.	You	can	use	the	Text	>	Select	or	right-click/ctrlclick	>	Select	command	to
navigate	easily	through	the	stacked	elements	to	reach	the	target	element.
Expert	view	timeline
For	more	advanced	editing,	use	the	Expert	view	timeline.	The	Expert	view	timeline	graphically	represents	your	movie	project	as	video	and	audio	clips	arranged	in	vertically	stacked	tracks.
When	you	capture	video	from	a	digital	video	device,	the	clips	appear	sequentially	as	they	occur.

Expert	view	timeline
The	Expert	view	timeline	uses	a	time	ruler	to	display	the	components	of	your	movie	and	their	relationship	to	each	other	over	time.Youcan	trim	and	add	scenes,	indicate	important	frames
with	markers,	add	transitions,	and	control	how	clips	are	blended	or	superimposed.	Compared	to	the	Quick	view,	the	Expert	view	timeline	has	more	tracks.
Organizer:	Opens	Elements	Organizer	to	let	you	organize	and	manage	your	media	files
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Instant	Movie:	Automatically	guides	you	through	the	movie	creation	process.	It	lets	you	quickly	select	movie	templates	and	edit	clips.	Instant	Movie	also	lets	you	add	theme-based	effects,
titles,	transitions,	and	audio	to	your	movie.	You	can	change	sefings	as	desired.
Tools:Provides	options	that	let	you	add	cool	effects	to	your	video.	For	example,	use	Time	Remapping	and	Smart	Mix	to	add	sophisticated	motion	effects	to	your	video.	You	can	choose	Smart
Trim	to	let	Premiere	Elements	automatically	edit	your	footage	for	a	crisper	video.

	
Transitions:	Provides	transitions	you	can	use	between	your	movie	clips.	The	Transition	contextual	control	appears	automatically	when	you	apply	a	transition	for	the	first	time.	Use	it	to
modify	the	transition	properties.	To	open	the	Transition	contextual	control	later,	doubleclick	the	transition.	The	Expert	view	provides	more	transition	effects	compared	to	the	Quick	view.
Titles	and	Text:	Contains	pre-formafed	title	templates	you	can	use	in	your	movie.	The	Title	contextual	control	appears	automatically	when	you	apply	a	title	to	your	movie	for	the	first	time.
Use	it	to	modify	the	title	properties.	To	open	the	Title	contextual	control	later,	doubleclick	the	title.	The	Expert	view	provides	more	title	templates	compared	to	the	Quick	view.
Effects:	Shows	special	effects	and	presets	you	can	apply	to	clips	in	your	movie.	To	edit	a	special	effect	after	applying	it,	click	Applied	Effects	to	modify	the	properties	in	the	Applied	Effects
panel.	Compared	to	the	Quick	view,	the	Expert	view	provides	more	effects	that	are	organized	under	various	categories.
Audio:	Lets	you	add	theme	music	to	your	movie.Youcan	select	multiple	music	clips	from	here,	and	they	are	played	in	the	order	selected.	Click	Use	Smart	Sound	to	choose	third-party	music
plugins	for	your	movie.
Graphics:	Lets	you	add	graphic	images,	such	as	clip	art	and	callouts	(thought	bubbles	or	speech	balloons)	to	specific	portions	in	your	clips.
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Adjust	panel
The	Adjust	panel	lets	you	adjust	the	inherent	properties	of	your	clip,	for	example	color	and	lighting.	You	can	also	use	the	Smart	Fix	tool	to	enhance	the	quality	of	your	video	footage.
Adjust	panel
To	display	the	Adjust	panel,	select	the	clip	and	then	click	Adjust	on	the	right.	If	you	add	a	title	to	your	clip,	use	the	Adjust	panel	to	alter	its	properties,	if	required.

Applied	Effects	panel

The	Applied	Effects	panel	lets	you	view	the	properties	of	effects	already	applied	to	your	clip.	The	panel	provides	various	options	that	enable	you	to	modify	the	applied	effects.
Applied	Effects	panel
To	display	the	Applied	Effects	panel,	select	the	clip	to	which	effects	are	applied,	and	click	Applied	Effects	on	the	right.
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Importing	media	through	Embedded	Elements	Organizer
Youcan	import	media	(photos,	videos,	and	audio)	in	Elements	Organizer	to	the	Adobe	Premiere	Elements	Editor	workspace.Youcan	import	media	present	 in	a	catalog	toPREworkspace.
However,	 the	media	 that	has	been	organized	 into	albums	 in	Elements	Organizer	appears	as	 local	albums	 in	 the	Embedded	Elements	Organizer.	The	Embedded	Elements	Organizer	or
Embedded	EO	enables	you	to	add	media	to	the	timeline	directly.	You	can	access	the	Embedded	EO	option	from	the	Add	Media	drop-down	list.
Note:The	creation	and	deletion	of	albums	is	not	possible	in	Embedded	EO.

Accessing	media	through	Embedded	EO
You	can	now	access	the	albums	created	in	Elements	Organizer	from	PRE	Editor	worskpace	itself.	There	is	an	Embedded	Elements	Organizer	option	present	under	Add	Media	that	enables
access	to	EO	albums.	To	import	media	through	Elements	Organizer,	follow	these	steps:
1Click	Add	Media	>	Elements	Organizer.
2Click	Local	Albums.	The	albums	created	in	Elements	Organizer	are	displayed	under	Local	Albums.	Click	on	an	Album	to	display	the	media	present	under	that	album	in	EmbeddedEO.Youcan
click	again	on	the	album	to	deselect	it,	this	refreshes	the	media	visible	in	Embedded	EO	and	displays	all	the	media	available	in	the	Elements	Organizer	catalog.
Click	on	the	Show	Still	Image	icon	if	nothing	is	displayed	in	Embedded	EO.

1.	 Doubleclick	on	a	video	or	audio	file	to	preview	it	in	the	Source	Monitor.
2.	 Click	on	a	file	to	select	it.	Click	Add	Files	to	add	it	to	the	timeline.

You	can	select	multiple	files	and	add	them	to	the	timeline.	Also,	you	can	drag	and	drop	media	from	the	Embedded	EO	to	specific	points	in	the	video	on	the	timeline.
3.	 Click	Done	once	you	are	through	adding	the	files	to	exit	Embedded	EO.
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Working	with	files	in	the	Embedded	EO

You	can	perform	various	tasks	on	your	files	in	the	Embedded	EO	panel.	Click	Add	Media	>	Elements	Organizer	to	access	this	panel.	You	can	perform	the	following	tasks	in	this	panel:
A.	 Back	buflon	Click	Back	to	return	to	the	Add	Media	options.
B.	 Local	Albums	Click	Local	Albums	to	view	the	media	in	the	Elements	Organizer	catalog.	Click	an	album	to	view	the	media	present	in	that	album.
C.	 Previous	and	Next	buflonClick	the	previous	or	next	bufon	to	move	through	the	displayed	media.

Note:	You	can	view	up	to	1000	files	in	Embedded	EO.Embedded	EO	panel	buflons
A.	 Search	content	Click	this	icon	to	open	a	text	box.	Enter	the	search	criteria	and	press	Enter	to	search	for	a	specific	media	file.	This	is	not	a	live	search	so	must	press	Enter
after	entering	your	search	criteria.

B.	 Show	Video	Click	this	icon	to	view	video	files	only.
C.	 Show	Audio	Click	this	icon	to	view	audio	files	only.
D.	 Show	Still	Image	Click	this	icon	to	view	photos	only.
E.	 Select	order

Click	this	to	sort	the	files	by	date	or	the	batches	in	which	they	were	imported.	You	can	sort	the	photos	in	the	following	ways:	Newest/Oldest	first:	Sorts	the	files	by	creation	date.	Default
order	of	display	in	Embedded	EO	is	newest	first.	Import	batch:	Sorts	the	files	according	to	the	batches	in	which	they	were	imported.	The	rendition	vidoes	are	not	visible	when	files	are
sorted	by	the	Import	batch	option.
Projects	Review	project	presets	and	seflings	Start	a	new	project	Open	a	project
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Projects
Premiere	Elements	creates	a	project	file	for	every	new	project	that	you	want	to	publish	or	save	to	work	on	it	later.	You	can	also	create	a	project	before	importing	media.
The	project	file	references	the	media	that	you	add	to	a	project	including	videos,	images,	titles,	and	themes.
Project	files	are	small	in	size.	They	include	title	files	and	references	to	the	source	files	that	you	capture	or	import.	Because	the	project	files	store	references,	avoid	moving,	renaming,	or
deleting	the	source	files	so	that	Premiere	Elements	can	locate	them.
Review	project	presets	and	seflings
When	you	create	a	project,	you	can	review	the	default	preset	and	sefings	by	clicking	the	Change	Sefings	bufon	in	the	New	Project	dialog.	Adobe	Premiere	Elements	automatically	adjusts
your	project	sefings	based	on	the	type	of	media	you	import.

1.	 In	Premiere	Elements,	select	File	>	New	Project.
2.	 Click	Change	Sefings.

Start	a	new	project
1.	 Do	one	of	the	following:

From	the	Welcome	screen,	click	Video	Editor	and	select	New	Project.	If	Premiere	Elements	is	open,	choose	File	>	New	Project.
2.	 (Optional)	To	change	the	project	sefings,	click	Change	Sefings,	select	a	different	preset,	and	click	OK.

Note:Aßer	you	change	your	project	seflings,	you	cannot	modify	them	later.
If	you	do	not	change	the	project	sefings,	Adobe	Premiere	Elements	uses	the	sefings	of	your	previous	project.	Alternatively,	it	creates	an	NTS/PAL	AVCHD	full	HD	project	based	on
your	region	sefings.
You	can	import	a	clip	whose	sefings	do	not	match	the	sefings	of	an	empty	project.	Adobe	Premiere	Elements	overwrites	the	project	sefings	with	the	sefings	of	your	clip	when	you
drop	it	on	to	the	Expert	view	timeline.

By	default,	the	folder	where	you	save	your	project	also	stores	rendered	previews,	conformed	audio	files,	and	captured	audio	and	video.	These	files	are	large,	so	save	them	to	your	largest,
fastest	hard	drive.	To	store	the	files	separately	from	projects,	choose	Edit	>	Preferences	>	Scratch	Disks.
Open	a	project	You	can	open	only	one	project	at	a	time.	To	ensure	that	Premiere	Elements	can	open	an	existing	project,	ensure	that	both	the	project	file	(.PRE)	and	the	source	files	are
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accessible	on	your	computer.	Do	one	of	the	following:	In	the	Welcome	screen,	click	Video	Editor	and	then
click	Existing	Project.	Choose	the	project	name.	(If	the	project	isn’t	listed,	choose	Open,	select	the
project	file,	and	click	Open.)	If	Premiere	Elements	is	open,	choose	File	>	Open	Project	or	Open	Recent
Project;	then	select	the	project	file,	and	click	Open.
In	Windows®,	doubleclick	the	project	file.
note:	Premiere	Elements	can	open	projects	you	create	in	earlier	versions.	However,	previousversions	cannot	open	projects	you	create	in	later	versions.	If	you	have	multiple	versions
of	Premiere	Elements	installed,	open	a	project	from	within	the	soßware.	Alternatively,	right-click/ctrlclick	the	file	and	choose	the	application.
Saving	and	backing	up	projects

Save	a	project	Back	up	a	project	with	Auto	Save	Open	an	Auto	Save	project	Save	a	project
Saving	a	project	saves	your	editing	decisions,	references	to	source	files,	and	the	most	recent	arrangement	of	panels.	Protect	your	work	by	saving	often.

To	save	the	currently	open	project,	choose	File	>	Save.
To	save	a	copy	of	a	project,	choose	File	>	Save	As,	specify	a	location	and	filename,	and	click	Save.
To	save	a	copy	of	a	project	and	continue	working	in	the	original	project,	choose	File	>	Save	A	Copy.	Specify	a	location	and	filename,	and	click	Save.
Tip:Tospecify	where	Premiere	Elements	stores	project-related	files,	such	as	captured	video	andaudio,	and	previews,	set	up	a	scratch	disk.

Back	up	a	project	with	Auto	Save
To	revisit	editing	decisions	or	recover	from	a	crash,	enable	the	Auto	Save	option.	This	option	automatically	saves	backup	project	files	to	the	Adobe	Premiere	Elements	Auto-Save	folder	at	a
specified	time	interval.	For	example,	you	can	set	Premiere	Elements	to	save	a	backup	copy	every	15	minutes.
Automatic	saving	serves	as	an	alternative	to	the	Undo	command,	depending	on	the	project	changes	between	each	save.	Because	project	files	are	smaller	compared	to	source	video	files,
archiving	multiple	versions	of	a	project	consumes	less	disk	space.
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1.	 Choose	Edit	>	Preferences	>	Auto	Save.
2.	 Do	one	of	the	following,	and	then	click	OK:

Select	Automatically	Save	Projects,	and	enter	the	duration	in	minutes	after	which	Adobe	Premiere	Elements	saves	the	project.
Type	a	number	for	the	Maximum	Project	Versions	to	specify	how	many	versions	of	each	project	file	you	want	to	save.	For	example,	if	you	type	5,	Premiere	Elements	saves	five	versions
of	each	project	you	open.
note:	Each	time	you	open	a	project,	save	it	at	least	once	before	the	Auto	Save	option	takes	effect.

Open	an	Auto	Save	project
1.				Do	either	of	the	following:

Start	Adobe	Premiere	Elements.	In	the	Welcome	screen,	click	Video	Editor	and	then	click	Existing	Project.
In	Adobe	Premiere	Elements,	choose	File	>	Open	Project.
In	the	project	folder,	open	the	file	in	the	Adobe	Premiere	ElementsAuto-Savefolder.	(If	no	files	are	available,	theAutoSave	preference	is	possibly	turned	off.)	2.
Note:When	you	start	Premiere	Elements	aßer	a	crash,	a	message	prompts	whether	you	want	toopen	the	last	saved	version	of	your	project.

Project	sefings	and	presets
About	project	seflings	and	presets	Dynamic	sequence	preset	Create	or	change	project	presets	Check	your	project’s	seflings
About	project	seflings	and	presets
Project	 sefings	 determine	 the	 properties	 of	 your	 video	 and	 audio	 project	 assets.	 For	 example,	 they	 determine	 their	 format(DV,HDV,AVCHD),source	 (hard	 disk	 or	 Flash	 memory
camcorder),	and	aspect	ratio	(standard	or	widescreen	video).	Project	sefing	also	specify	the	frame	rate,	audio	sample	rate,	upper	or	lower	field	first,	and	bit	depth	for	your	project.
When	you	start	a	new	project,	Premiere	Elements	applies	a	project	preset	to	it.	A	project	preset	is	a	collection	of	preconfigured	project	sefings.Youcan	use	the	default	project	preset	for	the
television	standard	for	the	Premiere	Elements	version	installed	on	your	computer.
NTSC	(National	Television	Standards	Commifee)	is	the	television	standard	for	the	Americas,	the	Caribbean,	Japan,	South	Korea,	and	Taiwan.
PAL	(Phase	Alternating	Line)	is	the	standard	format	for	Europe,	Russia,	Africa,	Middle	East,	India,	Australia,	New	Zealand,	South	Pacific,	China,	and	other	parts	of	Asia.
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Because	you	can’t	change	the	project	preset	after	starting	a	project,	verify	the	format	of	your	source	footage	before	selecting	a	project	preset.
If	you	specify	lower	quality	seflings	for	output	(such	as	streaming	web	video),	do	not	change	yourproject	seflings.	Change	your	export	seflings	instead.

Dynamic	sequence	preset
When	you	add	a	movie	clip	to	the	Expert	view	timeline,	Adobe	Premiere	Elements	automatically	changes	your	project	sefings	in	the	background	to	match	the	clip	properties.	They	include
dimension,	fps,	pixel	aspect	ratio,	and	field	order.



Create	or	change	project	presets
Adobe	Premiere	Elements	includes	default	project	presets	for	media	from	common	sources,	includingDVcamcorders,	cameras,DVDdiscs,	and	mobile	phones.Youcannot	create	a	custom	project	presets	or
change	a	project	preset	after	selecting	a	preset	and	starting	a	project.
To	change	the	project	preset	when	starting	a	new	project,	click	the	Change	Sefings	bufon	in	the	New	Project	dialog.	Select	the	preset	that	matches	your	footage.
If	you	add	a	movie	clip	whose	preset	does	not	match	the	project’s	preset	to	the	Expert	view	timeline,	a	message	appears.	Click	Yes	to	let	Adobe	Premiere	Elements	change	the	project’s	sefings	to	use	the
closest	available	preset.	For	more	information,	see	Dynamic	Sequence	Preset.
Select	a	project	preset
By	default,	 Premiere	Elements	uses	 an	AVCHD	preset	 for	 the	 television	 standard	 you	 specify	when	 you	 install	 the	 program.	 Select	 a	 new	preset	 to	 create	 projects	 in	 a	 different	 format,	 television
standard,	or	frame	aspect	ratio.
The	preset	you	select	becomes	the	default,	which	is	used	for	all	new	projects,	until	you	select	another	preset.	If	you	choose	a	preset	temporarily,	change	it	when	you’ve	finished	using	it.

1.	 Start	Premiere	Elements.
2.	 In	the	Welcome	screen,	click	Video	Editor,	and	then	click	New	Project.	(Or,	choose	File	>	New	>	Project.)
3.	 In	the	New	Project	dialog	box,	click	Change	Sefings.

Select	the	preset	that	matches	the	format	and	standard	of	the	footage	you	want	to	edit.	For	example,	to	edit	most	HDV	footage	from	1080i	camcorders,	choose	HDV	1080i	30	orHDV
4.	 Click	OK.
5.	 Provide	a	name	and	location	for	your	project,	and	click	OK.
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Change	the	seflings	of	an	open	project
After	you	create	a	project,	you	can	only	make	minor	display-related	changes	to	the	project	sefings.
Note:You	cannot	change	the	Editing	mode	and	the	format	of	Preview	files	aßeryou	create	a	project.

1.	 Choose	Edit	>	Project	Sefings	>	General.
2.	 In	the	Project	Sefings	dialog	box,	specify	project	sefings	for	General,	Capture,	and	Video	Rendering.
3.	 Click	OK

Check	your	project’s	seflings
Project	presets	include	project	sefings	under	three	categories:	General,	Capture,	and	Video	Rendering.	After	you	start	a	project,	you	can’t	change	most	of	the	sefings,	such	as	frame	rate,	size,	and	aspect
ratio.	However,	you	can	review	the	sefings	to	ensure	that	the	media	you	want	to	add	to	the	project	is	compatible.
Open	the	project	in	Premiere	Elements,	and	choose	Edit	>	Project	Sefings	>[category].
Note:Third-party	products,	such	as	PCs,	capture	cards,	and	hardware	bundles	sometimes	includecustom	presets.	See	the	third-party	documentation	for	details.
NTSC	vs	PAL	presets
NTSCpresets	conform	to	theNTSCstandard,	where	each	video	frame	includes	525	horizontal	lines	displayed	at	29.97	frames	per	second.	The	StandardNTSC	preset	applies	to	footage	that	has	a	4:3
aspect	ratio.	The	Widescreen	NTSC	preset	applies	to	footage	that	has	a	16:9	aspect	ratio.
PAL	presets	conform	to	the	PAL	standard,	where	each	video	frame	includes	625	lines	displayed	at	25	frames	per	second.
General	seflings
General	sefings	(Edit	>	Project	Sefings	>	General)	control	the	fundamental	characteristics	of	a	project.	They	include	the	editing	mode	used	to	process	video,	frame	size,	aspect	ratios,	count	time	(Display
Format),	and	playback	sefings	(Time	base).	These	sefings	match	the	most	common	source	media	in	your	project.	For	example,	if	most	of	your	footage	is	DV,	use	the	DVPlayback	editing	mode.	The	quality
of	your	video	can	deteriorate	if	you	change	these	sefings	arbitrarily.
General	sefings	include	the	following	options.
Editing	Mode	Identifies	the	television	standard	and	format	for	the	project.	You	cannot	change	the	Timebase,	Frame	Size,	Pixel	Aspect	Ratio,	Fields,	and	Sample	Rate	preview	sefings.	The	335



editing	mode	determines	these	sefings.
note:	The	Editing	Mode	sefling	represents	the	specifications	of	the	source	media,	not	the	final	outputseflings.	Specify	output	seflings	when	you	export	a	project.
Timebase	Specifies	the	time	divisions	used	to	calculate	the	time	position	of	each	edit	(PAL:	25,NTSC:	29.97).
Playback	SeflingsThis	bufon	is	available	if	you	use	a	DV	preset,	a	DV	editing	mode,	or	install	a	plug-in	that	provides	additional	playback	functions.	For	a	DV	editing	mode,	this	option	indicates	where	you
want	your	previews	to	play.	For	information	on	the	playback	sefings	for	third-party	plugins,	see	the	developer	documentation.
Frame	Size	Specifies	the	frame	pixels	for	your	project	playback.	In	most	cases,	the	frame	size	for	your	project	matches	the	frame	size	of	your	source	media.	You	can’t	change	the	frame	size	to	compensate
for	slow	playback.	However,	you	can	adjust	the	playback	sefings:	Right-click/ctrlclick	the	monitor	and	choose	Playback	Sefings.	Adjust	the	frame	size	of	the	output	by	changing	the	Export	sefings.
Pixel	Aspect	RatioSets	the	aspect	ratio	for	pixels.	The	video	format(PALorNTSC)determines	this	ratio.	If	you	use	a	pixel	aspect	ratio	that	is	different	from	your	video,	the	video	can	appear	distorted
when	you	render	it	and	play.
FieldsSpecifies	 the	 field	dominance,	or	 the	order	 in	which	the	two	 interlaced	 fields	of	each	 frame	are	drawn.	Premiere	Elements	captures	DV	footage	with	 fields,	even	 if	 the	 footage	wasrecorded	as
progressive	scan.
Display	Format	(video)Specifies	the	way	time	appears	throughout	the	project.	The	time	display	options	correspond	to	standards	for	editing	video	and	motion-picture	film.	For	DV	NTSC	video,	choose	30-
fps	Drop-Frame	Timecode.	For	DV	PAL	video,	choose	25-fps	Timecode.
Title	Safe	Area	Specifies	the	frame	edge	area	to	mark	as	a	safe	zone	for	titles,	so	that	titles	aren’t	cut	off	byTVsthat	zoom	the	picture.	A	rectangle	with	crosshairs	marks	the	title-safe	zone	when	you	click
the	Safe	Zones	bufon	in	the	monitor.	Titles	require	a	wider	safe	zone	than	action.
Action	Safe	AreaSpecifies	the	frame	edge	area	to	mark	as	a	safe	zone	for	action	so	that	TVsthat	zoom	the	picture	do	not	exclude	the	action.	A	rectangle	marks	the	action-safe	zone	when	you	click	the
Safe	Zones	bufon	in	the	monitor.
Sample	RateIdentifies	the	audio	sample	rate	for	the	project	preset.	In	general,	higher	rates	provide	befer	audio	quality	in	projects,	but	they	require	more	disk	space	and	processing.	Record	audio	at	a
high-quality	sample	rate,	and	capture	audio	at	the	rate	at	which	it	was	336



recorded.
Display	Format	 (audio)Specifies	 whether	 audio	 time	 display	 is	measured	 by	 using	 audio	 samples	 or	milliseconds.	 By	 default,	 time	 is	 displayed	 in	 audio	 samples.	 However,	 you	 can	 display	 time	 in
milliseconds	for	sample-level	precision	when	you	are	editing	audio.
Capture	seflings
Capture	sefings	(Edit	>	Project	Sefings	>	Capture)	control	how	video	and	audio	are	transferred	directly	from	a	deck	or	DV	camcorder.	(Other	Project	Sefings	panels	do	not	affect	capturing.)
Video	Rendering	seflings
Video	Rendering	sefings	control	the	picture	quality,	compression	sefings,	and	color	depth	that	Premiere	Elements	uses	when	you	play	video	from	the	Expert	view	timeline.
To	 access	 Video	 Rendering	 sefings,	 choose	 Edit	 >	 Project	 Sefings	 >	 Video	 Render.	 These	 sefings	 include	 the	 following	 options:	Maximum	Bit	 DepthAllows	 Premiere	 Elements	 to	 use	 up	 to	 32-bit
processing,	even	if	the	project	uses	a	lower	bit	depth.	Selecting	this	option	increases	precision	but	decreases	performance.
File	FormatSpecifies	the	format	of	the	preview	video.CompressorIdentifies	the	codec	(compressor/decompressor)	that	Premiere	Elements	applies	to	generate	movie	previews.	The	project	preset	defines
the	codec.	You	cannot	change	it	because	it	must	conform	to	the	DV	standard.
note:	If	you	don’t	apply	effects	to	your	clip	or	change	its	frame/time	characteristics,	Adobe	PremiereElements	uses	the	clip’s	original	codec	for	playback.	If	your	changes	necessitate	frame	recalculation,
Adobe	Premiere	Elements	applies	the	codec	identified	here.
Optimize	StillsSelect	this	option	to	use	still	images	efficiently	in	projects.	For	example,	you	can	use	an	image	that	has	a	duration	of	2	seconds	in	a	30-fps	project.	Premiere	Elements	creates	a	2-second
frame	instead	of	60	frames,	each	with	a	duration	of	1/30	second.	Deselect	this	option	if	projects	encounter	playback	problems	when	displaying	still	images.
Project	Assets	panel	overview	Rename	a	source	file	in	a	project	Find	an	item	in	a	project	Locate	missing	files	for	a	project	Delete	a	clip
Project	Assets	panel	overview
The	Project	Assets	panel	lets	you	preview	source	material	for	your	projects.	Select	the	Expert	view	and	then	click	Project	Assets.
You	can	view	the	contents	of	a	project	using	the	list	view	or	the	grid	view.	Use	the	panel
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options	menu	to	switch	between	the	views.
The	grid	view	displays	a	snapshot	of	the	video	you	imported	into	the	project.	The	Project	Assets	panel	indicates	files	that	you	use	in	the	Expert	view	timeline	with	a	green	icon.	Use	the	Search	box	to
search	for	files	within	the	panel.
Display	and	arrange	media	items
In	the	Project	Assets	panel,	you	can	display	items	in	the	List	view.	The	List	view	lets	you	view	more	items	simultaneously,	search,	and	sort	items	by	properties	such	as	media	type	and	duration.
To	sort	items	in	List	view,	click	the	column	heading	by	which	you	want	to	sort	the	items.	(For	example,	click	Media	Type	to	sort	items	by	type.)	If	folders	are	expanded,	items	sort	from	the	top	level	and
down	the	Project	Assets	panel	hierarchy.	To	reverse	the	sort	order,	click	the	column	heading	again.
To	see	more	of	the	column	headings	in	List	view,	drag	the	right	side	of	the	Project	Assets	panel	to	the	right.	Alternatively,	drag	the	scroll	bar	at	the	bofom	of	the	panel	to	the	right.
Organize	clips	in	folders
The	Project	Assets	panel	can	include	folders	into	which	you	can	organize	project	contents	in	the	same	way	as	folders	in	Windows	Explorer.	Folders	can	contain	media	files	or	subfolders.	Consider	using
folders	to	organize	media	types,	such	asDVcaptures,	Adobe	Photoshop	Elements	still	images,	and	audio	files.

In	the	Project	Assets	panel,	do	any	of	the	following:
Note:To	access	the	Project	Assets	panel,	select	Project	Assets	in	the	Expert	view.

To	add	a	folder,	click	the	New	Folder	icon	at	the	bofom	of	the	Project	Assets	panel.	In	the	list	view,	if	you	click	New	Folder	multiple	times	in	a	row,	each	new	folder	is	nested	inside	the	previous	new
folder.
To	move	an	item	into	a	folder,	drag	the	item	to	the	Folder	icon.	You	can	move	folders	into	other	folders	to	nest	them.
To	display	the	contents	of	a	folder,	doubleclick	the	folder.	Alternatively,	in	List	view,	click	the	triangle	beside	the	Folder	icon	to	expand	the	folder.
To	navigate	to	parent	folders,	click	the	appropriate	icon.Youcan	click	and	hold	this	bufon	to	see	a	list	of	all	the	folders	above	the	one	currently	listed.Youcan	also	jump	to	a	folder	by	highlighting	it	and
releasing	the	mouse	bufon.
Rename	a	source	file	in	a	project
To	rename	a	clip,	select	it,	choose	Clip	>	Rename,	type	the	new	name,	and	press	Enter.	(The
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change	affects	only	references	used	 in	 the	Project;	 the	name	of	 the	original	source	 file	 in	 the	Project	workspace	and	Windows	remains	 the	same.)	To	rename	an	original	source	 file,	close	 Premiere
Elements,	and	rename	the	file	in	Windows.	The	next	time	you	open	the	project,	Premiere	Elements	asks	you	to	locate	the	file.

Tip:	You	can	also	rename	a	selected	clip	by	clicking	its	name	once	to	select	the	text,	typing	the	newname,	and	pressing	Enter.
Find	an	item	in	a	project
Right-click	an	item	in	the	Expert	view	timeline,	and	select	Reveal	In	Project.
To	find	an	item	on	the	hard	drive,	right-click	the	clip,	choose	Properties,	and	note	the	path	at	the	top	of	the	Properties	panel.
Locate	missing	files	for	a	project
Premiere	Elements	doesn’t	 store	original	 source	 files	 in	a	project—it	 references	 the	name	and	 location	of	 each	 source	 file	when	you	 import	 it.	 If	 you	 later	move,	 rename,	or	delete	a	 source	 file	 in
Windows,	the	Where	Is	The	File	dialog	box	opens	when	you	next	open	the	project.
In	addition	to	source	files,	a	project	also	referencespreview	files.	Preview	files	allow	you	to	preview	effects	in	real	time	without	having	to	render	them—a	process	that	can	take	hours.	Preview	files	can	be
recreated	if	necessary.
Note:	Aßer	you	create	the	final	movie,	you	can	delete	source	files	if	you	do	not	plan	to	reuse	them.	If	youplan	to	re-edit	the	movie	in	the	future,	archive	the	project	with	 the	Project	Archiver	before
deleting	source	files.
In	the	Where	Is	The	File	dialog	box,	choose	one	of	the	following	options:
Display	Only	Exact	Name	Matches	Displays	only	the	files	that	match	the	name	of	the	missing	file	when	the	project	was	last	closed.	If	you	know	that	the	name	of	a	file	has	changed,	deselect	this	option.
SelectReplaces	the	missing	file	with	the	original	or	replacement	file.
FindStarts	the	Windows	XP	Search	feature.
Skip	PreviewsIgnores	missing	preview	files	so	you	aren’t	asked	to	find	them.
Skip	Replaces	the	missing	file	with	an	offline	file.	The	offline	file	acts	as	a	placeholder	for	related	clips	in	the	Project	Assets	panel	and	the	Expert	view	timeline.
Skip	AllReplaces	all	missing	clips	with	offline	files	without	asking	you	for	confirmation.
Delete	a	clip
Because	Premiere	Elements	doesn’t	store	media	files	in	the	project,	deleting	a	clip	from	a	project	removes	all	instances	from	a	movie.	However,	Premiere	Elements	does	not	delete	the	339



clip’s	source	file	from	the	Windows	desktop.	To	conserve	disk	space,	delete	the	source	file.	To	delete	a	media	file	from	the	Project	workspace,	do	one	of	the	following	:	Select	the	file	in	the	panel
and	click	the	Delete	icon.	Right-click/ctrlclick	it	in	the	Expert	view	timeline,	and	choose	Delete.Youcan	also	delete	by	selecting	the	file	and	pressing	the	Delete	key.	The	file	is	deleted	from	the
Elements	Organizer,	but	it	is	not	deleted	from	your	hard	disk.
Tip:	To	identify	unused	items	in	a	project,	see	the	Video	Usage	and	Audio	Usage	columns	in	List	view.	Todisplay	these	columns,	scroll	to	the	right.	A	green	check	mark	(list	view)	and	a	green	dot	(grid
view)	indicates	that	the	asset	is	being	used	in	the	project.
Viewing	clip	properties
See	an	overview	of	basic	clip	propertiesViewcomprehensive	file	information	Customize	List	view	propertiesViewdetails	about	effect	properties	See	an	overview	of	basic	clip	properties
To	view	the	basic	properties	of	a	clip,	right-click/ctrlclick	the	clip	in	the	Project	Assets	panel,	choose	Properties.
View	comprehensive	file	information
Premiere	Elements	 includes	tools	 that	you	can	use	to	evaluate	a	 file	 in	any	supported	format	stored	 inside	or	outside	a	project.	For	example,	you	can	determine	whether	a	clip	you	exported	has	an
appropriate	 data	 rate	 for	 Internet	 distribution.	 Video	 file	 properties	 can	 include	 file	 size,	 number	 of	 video	 and	 audio	 tracks,	 duration,	 average	 frame	 rate,	 audio	 sample	 rate,	 video	 data	 rate,	 and
compression	sefings.	In	addition,	they	include	information	about	dropped	frames	in	captured	clips.
Use	the	Get	Properties	feature	to	check	for	dropped	frames	in	a	clip	you	captured.	Use	the	Data	Rate	Analysis	graphs	to	evaluate	how	well	the	output	data	rate	matches	the	requirements	of	your	delivery
medium.	The	graphs	depict	the	render	keyframe	rate,	the	difference	between	compression	keyframes	and	differenced	frames	(frames	that	exist	between	keyframes).	They	also	depict	the	data	rate	levels
at	each	frame.
Do	one	of	the	following:

If	the	clip	is	in	the	Expert	view	timeline,	select	it	and	choose	File	>	Get	Properties	For	>	Selection.
If	the	clip	is	not	in	the	project,	choose	File	>	Get	Properties	For	>	File.	Locate	the	clip	you	want	to	analyze	and	then	click	Open.

Customize	List	view	properties
You	can	customize	the	List	view	to	display	only	the	information	you	want	to	see.	You	can	also
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rename	columns,	add	columns	of	your	own,	rearrange	columns,	and	change	the	width	of	columns.
Specify	which	properties	appear	in	List	view
The	Name	property	appears	by	default,	and	displays	the	clip	name	on	disk.Youcannot	remove	the	Name	property	using	the	Edit	Columns	dialog	box.	You	can	change	the	name	the	clip	uses	inside	the
project.
Open	 the	 Project	 Assets	 panel.	 Right-click/ctrlclick	 in	 the	Media	 view,	 and	 choose	 Edit	 Columns.	 Ensure	 that	 you	 click	 an	 area	 outside	 the	 rows	 containing	 the	 assets.	 Select	 any	 of	 the	 following
properties	you	want	to	appear	in	Media	view,	and	click	OK	:	Used	Displays	a	check	mark	if	the	clip	is	used	in	the	project.

Media	TypeMedia,	such	as	Movie	or	Still	Image.
Frame	RateThe	frame	rate	of	the	clip,	such	as	29.97	fps.
Media	Duration	Length	of	the	captured	media	on	disk,	expressed	in	the	Display	Format	specified	in	the	General	section	of	the	Project	Sefings	dialog	box.
note:	In	Premiere	Elements,	all	durations	in	a	panel	include	the	frames	that	the	In	point	and	Outpoint	 specify.	For	example,	 sefling	 the	 In	point	and	Out	point	 to	 the	 same	 frame	 results	 in	a
duration	of	one	frame.
Video	DurationThe	duration	of	the	clip	the	Video	In	point	and	Out	point	define.	Incorporating	any	adjustments	applied	in	Premiere	Elements,	such	as	changing	the	clip	speed.
Audio	DurationThe	duration	of	the	clip	theAudioIn	point	and	Out	point	define.	Incorporating	any	adjustments	applied	in	Premiere	Elements,	such	as	changing	the	clip	speed.
Video	Info	The	frame	size	and	aspect	ratio	of	the	clip,	and	whether	an	alpha	channel	is	present.
Audio	InfoThe	audio	specifications	of	the	clip.
Video	UsageThe	number	of	times	the	video	component	of	a	clip	is	used	in	the	movie.Audio	UsageThe	number	of	times	the	audio	component	of	a	clip	is	used	in	the	movie.StatusSpecifies	whether	a
clip	is	online	or	offline.	If	a	clip	is	offline,	this	option	also	indicates	why.
ClientField	for	adding	a	client’s	name	or	other	details.

Adjust	columns	in	List	view
Use	the	List	view	to	quickly	evaluate,	locate,	or	organize	clips	based	on	specific	properties.
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1.	 Open	the	Project	Assets	panel.
2.	 Do	any	of	the	following:

To	change	the	width	of	a	column,	position	the	pointer	over	a	dividing	line	between	column	headings	until	the	Column	Resize	icon	appears.	Then,	drag	horizontally.
To	create	a	column,	right-click/ctrlclick	and	choose	Edit	Columns,	click	Add	and	select	a	column	name	(after	which	the	new	column	appears).	Type	a	name	and	choose	a	type	for	the	new	column,
and	clickOK.Textcolumns	can	contain	any	text	you	enter.	Boolean	columns	provide	a	check	box.
To	display	a	column,	right-click/ctrlclick	and	choose	Edit	Columns,	and	then	click	the	box	next	to	the	column	name	you	want	to	display.
To	sort	columns	in	ascending	or	descending	order,	click	their	heading.
To	rearrange	columns,	right-click/ctrlclick	and	choose	Edit	Columns,	select	a	column	name,	and	click	Move	Up,	or	Move	Down.
note:	Premiere	Elements	locks	some	column	aflributes.	You	can’t	locate	or	change	these	aflributesin	the	Edit	Columns	dialog	box.

For	example,	you	can	change	the	names	of	columns	you	added,	but	not	the	names	of	columns	built	in	Premiere	Elements.
View	details	about	effect	properties

1.	 Select	a	clip	in	the	Quick	view	timeline	or	the	Expert	view	timeline.
2.	 Click	the	Applied	Effects	bufon	and	view	the	properties	in	the	Applied	Effects	panel.

Undo	changes	incrementally
If	you	change	your	mind	about	an	edit	or	effect,	Premiere	Elements	provides	several	ways	to	undo	your	work.Youcan	undo	only	those	actions	that	alter	video	content;	for	example,	you	can	undo	an	edit,
but	you	cannot	undo	scrolling	a	panel.

To	undo	or	redo	the	most	recent	change,	choose	Edit	>	Undo.	(You	can	sequentially	undo	a	series	of	recent	changes.)	To	undo	a	change,	and	all	successive	changes	that	occurred	since	you	last
opened	a	project,	delete	it	from	the	History	panel.
To	stop	a	change	that	Premiere	Elements	is	processing	(for	example,	when	you	see	a	progress	bar),	press	Esc.
To	undo	all	changes	made	since	you	last	saved	the	project,	choose	File	>	Revert.
To	undo	changes	made	before	you	last	saved	a	project,	try	opening	a	previous	version	in	the	Adobe
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Premiere	Auto-Save	folder.	Then	choose	File	>	Save	As	to	store	the	project	outside	the	AdobePremiere	Auto-Save	folder.	The	number	of	changes	you	can	undo	depends	on	the	Auto	Save-preference
seflings.

Undo	any	previous	change
The	History	panel	records	the	changes	you	make	to	a	project.	Each	time	you	add	a	clip,	insert	a	marker,	or	apply	an	effect,	the	History	panel	adds	that	action	to	its	list.	The	tool	or	command	you	used
appears	in	the	panel	along	with	an	identifying	icon.	You	can	use	the	panel	to	quickly	undo	several	changes.	When	you	select	a	change	in	the	panel,	the	project	returns	to	the	state	of	the	project	at	the
time	of	that	change.	The	more	recent	changes	turn	gray	and	disappear	when	you	make	your	next	change.
The	History	panel	records	changes	only	for	the	current	session.	Closing	a	project	or	choosing	the	Revert	command	clears	the	History	panel.	While	the	panel	lists	most	changes,	it	does	not	list	individual
changes	within	some	panels,	nor	does	it	list	program-wide	changes,	such	as	Preferences	sefings.

To	display	the	History	panel,	choose	Window	>	History.	To	select	a	change	in	the	History	panel,	click	it.
To	delete	a	selected	change,	click	and	then	click	OK.
To	move	around	in	the	History	panel,	drag	the	slider	or	the	scroll	bar	in	the	panel.	Or,	choose	Step	Forward	or	Step	Backward	from	the	History	panel	menu.
To	clear	all	changes	from	the	History	panel,	choose	Clear	History	from	the	History	panel	menu,	and	then	click	OK.
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Create	an	Instant	Movie	from	the	workspace
1.	 From	the	Quick	view	timeline	or	the	Expert	view	timeline,	select	the	clips	that	you	want	to	include	in	your	movie.
2.	 From	the	Action	bar,	click	Instant	Movie.
3.	 Choose	a	theme	for	your	movie	or	download	a	template.	To	download	and	online	template	for	your	instant	movie:

a.	 Right-click/Ctrlclick	the	movie	theme	template.
b.	 Click	Download	Now	to	download	selected	template.	Click	Download	All	to	download	all	the	templates.
c.	 (Optional)	Click	the	Download	In	Background	bufon	to	let	the	content	download	in	the	background	while	you	continue	to	work	in	Adobe	Premiere	Elements.

4.	 Specify	the	properties	for	the	movie,	as	desired:
To	preview	a	movie	theme,	move	the	mouse	cursor	over	the	theme’s	thumbnail	to	see	a	description,	and	click	the	Play	bufon	to	watch	a	preview.	Click	Next.

	
Opening	and	Closing	Titles:	Opening	and	closing	titles	can	be	multiple	lines.	However,	for	best	results,	keep	the	opening	title	to	one	line.InstantMovie:	Specifies	whether	you	want	to	perform	an	auto
edit,	which	automatically	trims	the	clips	and	adds	them	to	the	project	based	on	their	Smart	Tags.	And	whether	to	analyze	clips	and	apply	Smart	Tags	to	them.
Apply	To:	Specifies	whether	to	apply	the	theme	to	the	entire	project	or	to	the	selected	clips	in
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the	Quick	view	timeline/Expert	view	timeline.Music:	Specifies	whether	to	use	the	theme	music,	your	own	music	(click	Browse	to	locate	and	open	it),	or	no	music.Youcan	select	multiple	music	clips,	and
they	are	played	in	the	order	selected.	Drag	the	slider	between	Music/Sound	FX	and	My	Clips	to	set	the	amount	of	soundtrack	and	audio	effects	used	versus	the	sound	from	your	clips.	InstantMovie	syncs
with	the	beats	of	the	music,	so	changing	the	song	can	significantly	change	the	results.	In	addition,	changing	the	song	changes	the	duration	of	the	movie	to	match	the	duration	of	the	new	song.
Speed	And	Intensity:	Enables	you	to	control	the	speed	of	cuts	and	amount	of	effect.	Click	the	triangle	beside	the	Speed	And	Intensity	option	and	use	the	slider	to	adjust	the	speed	of	cuts	and	amount	of
effect.Duration:	Specifies	the	length	of	the	finished	movie.	Match	Music	creates	a	movie	to	the	length	of	the	theme	music.	This	parameter	lets	you	specify	the	exact	length	of	time	by	dragging	hours,
minutes,	and	seconds.	Use	All	Clips	ensures	all	the	selected	clips	are	used	and	bases	the	length	of	time	on	their	duration.
Note:	If	you	specify	a	duration	that	is	longer	than	the	theme	music,	the	music	will	loop.	If	the	duration	is	shorter	than	the	length	of	the	theme	music,	the	music	ends	with	the	last	clip.
Sequence:	Specifies	whether	clips	are	arranged	according	to	the	Time/Date	stamp	or	according	to	the	theme’s	editing	rules.	Theme	Content:	Specifies	which	aspects	of	the	theme	are	included	in	the
final	 movie.	 Select	 or	 deselect	 any	 of	 the	 options.	 If	 some	 of	 your	 clips	 have	 effects	 already	 applied,	 you	 can	 choose	 to	 keep	 the	 applied	 effects,	 or	 remove	 them	 and	 apply	 the	 theme’s	 effects
instead.Render	Preview:	If	this	option	is	enabled,	the	instant	movie	is	rendered	after	it	is	created	and	placed	on	the	timeline.	Rendering	improves	the	frame	rate	of	the	movie	for	playback.
Edit	an	Instant	Movie
When	you	create	an	Instant	Movie,	Adobe	Premiere	Elements	combines	all	the	clips	into	a	single	clip.	You	can	break	apart	this	combined	clip	if	you	want	to	edit	or	replace	the	individual	clips.	Use	the
Replace	Clip	command	to	quickly	replace	one	clip	with	another	without	having	to	trim	and	edit	the	new	clip	to	fit.	Alternatively,	change	the	effects	or	overlays	applied	to	the	clip.
Because	Instant	Movie	is	created	using	beat	detect	on	the	added	music	clip,	changing	the	Audio	Adding	media	into	Adobe	Premiere	Elements

Add	media	from	Embedded	Elements	Organizer	Import	from	Adobe	Revel	Add	files	from	Files	and	Folders	Import	photos	from	your	digital	camera,	phones,	or	removable	drive	Import	from
Flip,AVCHD,cameras,	phones,	or	removable	drives	Capture	video	fromDV/HDV	camcorders,	webcams,	and	WDM	devices
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Youcan	 add	 media	 to	 Premiere	 Elements	 using	 one	 of	 these	 methods:capturingfrom	 live	 or	 recorded	 sourcesimportingfiles	 from	 other	 types	 of	 storageaddingfrom	 the	 Project	 Assets
panelrecordingnarrations	from	a	microphone	When	you	add	media	files	to	Premiere
Elements,	they	are	added	to	the	Quick	view	timeline	and	the	Expert	view	timeline.	In	addition,	they	are	added	to	the	Project	Assets	panel	in	the	Expert	view.	A	thumbnail,	called	a	clip,	represents	each
file	in	the	Project	Assets	panel.	Clips,	whether	they	contain	audio,	video,	or	images,	are	the	building	blocks	of	your	movies.
To	add	new	media	into	Premiere	Elements,	click	Add	Media.	Use	any	of	the	following	options	in	the	Add	Media	panel	to	add	media	files:	Add	Media	panel
Elements	Organizer	Select	this	option	to	add	media	from	the	albums	in	Elements	Organizer.	From	the	Elements	Organizer	application,	drag	video	and	images	to	the	Quick	view/Expert	view	timeline	or
the	Project	Assets	panel.
Adobe	Revel	Select	this	option	to	add	media	from	Adobe	Revel.	From	the	Adobe	Revel	online	albums,	drag	video	and	images	to	the	Quick	view/Expert	view	timeline	or	the	Project	Assets	panel.
Files	And	Folders	Import	videos,	photos,	and	audio	files	from	your	personal	computer’s	hard	drive.
Digital	Still	Camera,	Phones,	or	Removable	DriveImport	photos	 from	a	camera,	mobile	phone,	or	 through	USB.	This	option	opens	 the	Adobe	Premiere	Elements	 -	Media	Downloader	window.	 It	also
imports	media	from	devices	that	store	video	files	in	Flash
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memory,	or	on	a	disk
Flip,AVCHD,Cameras,	Phones	or	Removable	DriveAdd	media	from	devices	that	store	video	files	in	Flash	memory	or	on	a	disk.	Such	devices	include	Flip	and	other	compact	video	cameras,	AVCHD,	DVD,
DSLR	and	other	cameras,	and	mobile	phones.
Webcam	Or	WDM	DeviceCapture	video	from	a	webcam	or	WDM-compatible	capture	device.	This	option	opens	the	Capture	window.
DVD	Camcorder	or	PC	DVD	Drive	Import	video	from	your	DVD	based	AVCHD	camers	or	your	computer’sDVDdrive.Youcan	import	media	files	inAVCHDformat	from	aDVDCamcorder.	This	option	opens
the	Adobe	Premiere	Elements	-	Video	Importer	window.
Note:DVD	drive	is	not	detected	in	Mac	OS.
HDV	CamcorderCapture	video	from	an	HDV	camcorder	through	FireWire	(IEEE	1394).	This	option	opens	the	Capture	window.
DV	CamcorderCapture	video	from	a	DV	camcorder	through	FireWire	(IEEE	1394)	or	USB.	This	option	opens	the	Capture	window.
Add	media	from	Embedded	Elements	Organizer

1Click	Add	Media,	and	select	Elements	Organizer.	The	Embedded	Elements	Organizer	option	launches.
2In	the	Embedded	EO	workspace,	locate	the	album	containing	your	media.
3Drag	one	or	more	media	files	to	the	Quick	view	timeline	or	Expert	view	timeline	in	Adobe	Premiere	Elements.

Import	from	Adobe	Revel
You	can	import	media	(photos	and	videos)	uploaded	to	libraries	in	Adobe	Revel	to	Adobe	Premiere	Elements	Editor	workspace.	Media	uploaded	to	Adobe	Revel	are	available	in	the	Mobile	album	section
of	Embedded	EO	and	Adobe	Revel	menu	options.	The	Adobe	Revel	option	is	present	under	Add	Media.	To	import	media	from	Adobe	Revel	to	PRE	workspace,	follow	these	steps:

1Click	Add	Media	>	Adobe	Revel.
2Click	Mobile	Albums.	The	libraries	created	in	Adobe	Revel	are	displayed	under	Mobile	Albums.	Click	on	an	Album	to	display	the	media	present	under	that	album	in	the	Adobe	Revel	dialogbox.Youcan	click
again	on	the	album	to	deselect	it,	this	refreshes	the	media	visible	in	Adobe	Revel	and	displays	all	the	media	available	in	the	Adobe	Revel	library.
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3Click	on	a	file	to	select	it.	Click	Add	Files	to	add	it	to	the	timeline.
4Click	Done	after	importing	the	files	from	Adobe	Revel.

You	can	select	multiple	files	and	add	them	to	the	timeline.	Also,	you	can	drag	and	drop	media	to	specific	points	in	the	video	on	the	timeline.
Add	file	from	folder	:
Click	Add	Media,	and	then	click	Files	And	Folders.	Locate	and	select	the	files	that	you	want,	and	click	Open.	To	add	an	entire	folder,	select	it	and	click	Import	Folder.	Drag	files	or	folders	from	Windows
Explorer	to	the	Project	Assets	panel.	Drag	files	from	Windows	Explorer	directly	to	the	Quick	view	or	Expert	view	timeline.
Note:	You	can	also	use	the	Elements	Organizer	to	access	files	that	are	stored	on	your	hard	drive.	Filesthat	you	added	to	the	Elements	Organizer	 from	 either	Premiere	Elements	 or	Adobe	Photoshop
Elements	are	displayed.
Import	photos	from	your	digital	camera,	phones,	or	removable	drive

1.	 Connect	the	digital	camera,	or	mobile	phone	to	your	computer.
Note:Install	any	drivers	your	device	requires.	Consult	the	manual.

	
2.	 In	Adobe	Premiere	Elements,	select	Add	Media	>Digital	Still	Camera,	Phones	Or	Removable	Drives,	and	then	click	Advanced	Dialog.

Adobe	Premiere	Elements-Photo	Downloader	(Advanced	Dialog	view)
1.	 Choose	the	drive	or	device	from	the	Get	Photos	From	pop-up	menu.	Thumbnails	of	all	importable	files	appear	in	the	dialog	box.
2.	 To	specify	a	location	for	the	saved	files,	do	one	of	the	following:

To	save	files	to	the	default	Adobe	folder,	leave	the	location	as	it	appears	in	the	dialog	box.
To	specify	a	different	location,	click	Browse	(Windows)/Choose	(Mac	OS)	and	choose	a	folder.	Alternatively,	click	Make	New	Folder	(Windows)/New	Folder	(Mac	OS)	to	create	a	folder	and	name	it.
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To	create	one	or	more	subfolders	for	grouping	files	by	criteria,	click	the	triangle	next	to	the	Create	Subfolder	field.	Choose	one	of	the	options	from	the	pop-up	menu	for	naming	the	subfolder.
To	rename	the	files	in	the	folder	consistently,	click	the	triangle	next	to	the	Rename	Files	field.	Choose	an	option	from	the	pop-up	menu	for	naming	the	files.	The	filename	defaults	to	the	folder	name	you
enter.	When	the	files	are	added	to	the	folder	and	the	Project	Assets	panel,	the	filenames	are	in	increments	of	0001.

1Select	files	to	add	to	the	Project	Assets	panel.	A	check	mark	below	the	file’s	thumbnail	indicates	that	the	file	is	selected.	By	default,	all	files	are	selected.	Click	an	option	to	remove	the	check	mark
and	exclude	a	file.	You	can	also	select	or	deselect	all	files	by	using	the	Check	All	bufon	or	the	Uncheck	All	bufon.
2If	you	are	using	metadata,	you	can	select	Preserve	Current	Filename	In	XMP.
3Click	the	triangle	next	to	Apply	Metadata,	select	a	template,	and	fill	in	the	Creator	and	Copyright	fields.
4Click	Get	Media.Youcan	click	Cancel	in	the	Progress	dialog	box	at	any	time	to	stop	the	process.

Note:	If	you	don’t	intend	to	use	all	the	files	you	add,	you	can	delete	them	from	the	Project	Assets	panel.Deleting	files	from	the	panel	doesn’t	delete	them	from	your	hard	drive.
Import	from	Flip,	AVCHD,	cameras,	phones,	or	removable	drives
Many	types	of	devices	other	than	DV	camcorders,	HDV	camcorders,	webcams,	and	WDM	devices	record	and	store	video.
Using	the	video	importer,	you	can	import	video	clips	from	tapeless	camcorders,	FLIP	and	AVCDHD	camera,	removable	memory	devices,	and	mobile	devices.
You	can	also	import	files	from	removable	media,	such	as	DVDs,	memory	cards,	and	multimedia	cards.	These	files	are	copied	to	the	hard	drive	location	you	specify.	The	files	are	also	added	to	the	Project
Assets	panel.
You	can	add	clips	directly	to	the	Quick	view/Expert	view	timeline	without	first	creating	a	project.	When	you	add	a	clip	to	either	timeline,	Adobe	Premiere	Elements	automatically	changes	your	project
sefings	to	match	the	clip	properties.
However,	if	you	add	a	clip	to	an	existing	project	whose	preset	does	not	match	the	clip’s	preset,	a	message	appears.	ClickYesto	let	Adobe	Premiere	Elements	change	the	project’s	sefings	to	use	the	closest
available	preset.
Note:	Image	files	cannot	be	imported	using	this	option.	To	import	images,	use	the	Photos	From	Cameras
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Or	Devices	option	in	the	Add	Media	panel.
1.	Do	one	of	the	following:

Place	the	DVD	into	your	computer’s	DVD	drive.	Connect	your	card	reader	such	as	SD	card	or	memory	stick	to	your	computer.	Connect	the	digital	camera,	mobile	phone,	or	other	device	to	your
computer	using	the	USB	2.0	port.
USB	2.0	portNote:Install	any	drivers	your	device	requires.	Consult	the	manual.

1.	 Click	Add	Media.
2.	 Click	the	device	from	which	you	want	to	import:	Videos	From	Flip	Or	Camera

DVDCamera	Or	Computer	Drive		The	Video	Importer	dialog	box	appears.
note:	Video	Importer	cannot	import	media	from	external	hard	drives.	If	you	want	to	import	media	froman	external	hard	drive,	use	the	Files	And	Folders	option	in	the	Add	Media	panel.

4.	 In	the	Source	Menu,	select	the	device	from	which	you	want	to	download	movie	clips.	The	contents	of	the	device	or	disk	are	displayed	in	the	panel	below	the	Source	menu.	The	number	of
files,	and	the	size	of	the	content	is	displayed	at	the	bofom	of	the	panel

containing	the	content.

5.	 Do	one	of	the	following:
To	importallthe	content	displayed	in	the	panel,	click	Check	All.	To	import	a	few	clips,	click	deselect	All,	and	select	only	those	clips	that	you	want	to	import.
Note:	To	preview	the	contents	of	a	clip,	click	the	clip.	Click	the	Play	buflon	in	the	Preview	panel.

6.	 To	specify	a	location	for	the	saved	files,	do	one	of	the	following:
To	 save	 files	 to	 the	 default	 Adobe	 folder,	 leave	 the	 location	 as	 it	 appears	 in	 the	 dialog	 box.	 To	 specify	 a	 different	 location,	 click	 Browse	 (Windows)/Choose	 (Mac	 OS)	 and	 choose	 a	 folder.
Alternatively,	click	Make	New	Folder	(Windows)/New	Folder	(Mac	OS)	to	create	and	name	a	new	folder.

7.	 Select	a	naming	convention	for	the	downloaded	files	using	the	Presets	menu.
FilenameRetains	the	filenames	the	camcorder	assigns.
Folder	Name	-	NumberIf	your	folder	name	isWeddingPics,	the	clips	are	assigned	the	names	Wedding	Pics-001,	Wedding	Pics-002,	and	so	on.
Date	-	filename	Adds	a	timestamp	to	the	filename	the	camcorder	assigns.	The	timestamp	is	the	current	date	and	time	-	the	date	and	time	on	which	the	movies	were	transferred	to
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your	computer.
note:Torename	files,	delete	them	from	the	Project	Assets	panel	in	the	Expert	view,	and	reimportthem.
Custom	Name	-	NumberEnter	a	custom	name	in	the	Name	field.	For	example,	if	you	enter	My	Holiday	in	the	field,	the	clips	are	named	My	Holiday-001,	My	Holiday-002,	and	so	on.
1(Optional)	If	you	want	to	delete	the	selected	files	in	the	camera	after	import,	select	the	option	After	Copying	Delete	Originals.
2(Optional)	If	you	do	not	want	the	imported	clips	added	to	the	Quick	view/Expert	view	timeline	after	import,	deselect	Add	To	Timeline.	The	imported	clips	are	added	only	to	the	Project	panel.
3(Optional)	If	you	want	to	create	an	InstantMovie	using	the	selected	clips,	select	Create	InstantMovie.
4Click	Get	Media.Youcan	click	Cancel	in	the	Progress	dialog	box	at	any	time	to	stop	the	process.

Note:	 If	 you	don’t	 intend	 to	use	 all	 the	 files	 you	 add,	 you	 can	delete	 them	 from	 the	Project	Assets	panel.Deleting	 files	 from	 the	panel	doesn’t	delete	 them	 from	 your	hard	drive.	This	practice	 is
recommended	for	large	VOB	files.
Capture	video	from	DV/HDV	camcorders,	webcams,	and	WDM	devices
Devices,	such	asDVcamcorders,HDVcamcorders,	webcams,	andWDMdevices	capture	live	video.	Using	the	Capture	window,	you	capture	live	video	from	these	devices	and	copy	the	video	clips	to	the	hard
drive	location	you	specify.	You	can	add	these	clips	to	Adobe	Premiere	Elements	by	dragging	them	from	Windows	Explorer	to	the	Quick	view/Expert	view	timeline.You	can	also	drag	the	clips	to	the	Project
Assets	panel	in	the	Expert	view.	Alternatively,	use	the	File	And	Folders	option	in	the	Add	Media	panel	to	add	the	clips	to	the	Quick	view/Expert	view	timeline.
1.	Do	one	of	the	following:

Turn	on	the	webcam	to	capture	live	footage	Connect	the	DV	camcorder,	HDV	camcorder,	or	the	WDM	device	to	your	computer	using	the	FireWire	(IEEE	1394)	port.FireWire	portNote:Install	any
drivers	your	device	requires.	Consult	the	manual.

1.	 Click	Add	Media.
2.	 From	the	Add	Media	panel,	select	the	option	for	the	device	using	which	you	want	to	capture	video:
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DVCamcorderHDVCamcorderWebcamOrWDM
The	Capture	window	appears.

4.	In	the	Capturing	Source	menu,	select	the	device	from	which	you	want	to	capture	video	clips.	The	video	that	the	device	captures	is	displayed	in	the	panel	below	the	Capturing	Source	menu.
Note:You	can	extract	frames	using	stop	motion	or	full	motion	from	the	integrated	camera’swebcam	feed.

1.	 Click	the	Capture	bufon.
2.	 Specify	a	name	for	the	captured	video.
3.	 To	specify	a	location	for	the	video,	do	one	of	the	following:

To	 save	 files	 to	 the	 default	 Adobe	 folder,	 leave	 the	 location	 as	 it	 appears	 in	 the	 dialog	 box.	 To	 specify	 a	 different	 location,	 click	 Browse	 (Windows)/Choose	 (Mac	 OS)	 and	 choose	 a	 folder.
Alternatively,	click	Make	New	Folder	(Windows)/New	Folder	(Mac	OS)	to	create	and	name	a	new	folder.

1.	 Click	Add	Media	and	select	Files	And	Folders.
2.	 Browse	to	the	location	where	you	saved	the	video	files	and	add	them	to	the	Quick	view/Expert	view	timeline.

Note:	Youcan	also	use	Windows	Explorer	to	locate	the	saved	video	files	and	drag	them	to	AdobePremiere	Elements.
Add	numbered	image	files	as	a	single	clip

1Make	sure	that	each	still-image	filename	has	the	correct	filename	extension.	All	filenames	in	the	sequence	must	contain	an	equal	number	of	digits	before	the	extension	for	example,	file000.bmp,
and	file001.bmp.
2Do	one	of	the	following:
Click	Add	Media	and	choose	Files	And	Folders.	Choose	File	>	Add	Media	from	>	Files	And	Folders.

3.	 Locate	and	select	the	first	image	in	the	sequence.	From	the	Files	Of	Type	menu,	select	Numbered	Stills,	and	click	Open.	Premiere	Elements	interprets	all	of	the	numbered	files	as	a	single
sequence.
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note:	For	information	on	changing	the	duration	of	images,	see	“Set	duration	for	imported	images”in	Help.
5.1				audio	import
Drag	clips	to	the	Monitor	window
Adobe	Premiere	Elements	facilitates	importing	and	playing	clips	with	5.1	audio	in	the	same	format	as	the	project	preset.Youcan	create	movies	combiningAVCHDvideo	and	stereo	audio	and	5.1	audio	and
stereo	audio.	You	can	move	clips	from	track	to	track	in	the	Expert	view	timeline	regardless	of	whether	the	audio	is	5.1	or	stereo.	If	you	import	5.1	audio	file	to	the	stereo	channel,	it	is	converted	to	5.1
and	the	otherwayround.	To	create	a	5.1	channel	track,	drag	a	5.1	onto	the	empty	area	on	the	Expert	view	timeline	of	a	stereo	project.	Alternatively,	drag	a	channel	audio	video	clip	or	a	5.1	channel	audio
only	clip.	A	5.1	channel	track	in	a	stereo	project	is	created.	To	create	a	stereo	track	in	a	5.1	channel	project,	drag-and-drop	a	stereo	clip	into	the	empty	area	on	Expert	view	timeline.	A	stereo	track	in	a
5.1	channel	project	is	created.
1.	Do	one	of	the	following:

From	the	Welcome	screen,	click	New	Project.
If	Adobe	Premiere	Elements	is	open,	choose	File	>	New	Project.

1.	 Click	Change	Sefings	to	change	the	preset	used.	Select	FullHD1080i	30	5.1	channel	from	the	AVCHD	folder,	and	click	OK.
2.	 In	the	New	Project	dialog	box,	specify	a	name	and	location	for	the	project,	and	click	OK.In	the	Expert	view	timeline,	you	can	see	5.1	beside	the	Audio	tracks.	You	can	now	include	clips	to

your	project.	However,	the	audio	is	mapped	to	a	channel	type	depending	on	how
you	insert	the	media	file.

Drag	clips	to	the	Monitor	window
When	you	drag	clips	onto	the	Monitor	window,	the	audio	is	mapped	to	the	channel	type	of	Audio	1	track.
However,	when	you	drag	onto	the	Monitor	window,	you	are	presented	with	the	following	additional	options.	The	audio	mappings	change	depending	on	the	option	you	select.
Insert	Aher	This	Scene	Audio	is	mapped	to	the	Audio	one	track,	and	the	clip	is	inserted	in	the	Video	1/Audio	1	track.	The	clip	is	inserted	at	the	end	of	the	existing	clip.
Split	And	InsertAudiois	mapped	to	theAudio1	track,	and	the	clip	is	inserted	in	the	Video1/Audio1	track.	The	current	clip	is	split	at	the	point	where	theCTIis	pointing.	The	clip	is	inserted.
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Place	On	Top	If	there	is	an	empty	track	above	Video	1/Audio	1,	the	selected	clip	is	inserted	on	that	track,	and	mapped	to	the	corresponding	track’s	channel	type.	If	there	is	no	empty	track,	a	new	track	is
created	matching	the	channel	type	of	the	selected	clip.	Adobe	Premiere	Elements	places	the	video	on	the	CTI,	in	a	track	above	the	existing	video.	The	new	video	file	overlaps	the	existing	video	clip.
Picture	In	Picture	If	there	is	an	empty	track	above	Video	1/Audio	1,	the	selected	clip	is	inserted	on	that	track,	and	mapped	to	the	corresponding	track’s	channel	type.	If	there	is	no	empty	track,	a	new
track	is	created	matching	the	channel	type	of	the	selected	clip.	Adobe	Premiere	Elements	places	the	existing	and	the	inserted	videos	simultaneously.	The	user	can	see	both	the	videos.
Place	On	Top,	And	Apply	Videomerge	If	there	is	an	empty	track	above	Video	1/Audio	1,	the	selected	clip	is	inserted	on	that	track	and	mapped	to	the	corresponding	track’s	channel	type.	If	there	is	no
empty	track,	a	new	track	is	created	matching	the	channel	type	of	the	selected	clip.	Adobe	Premiere	Elements	places	the	video	on	the	CTI,	in	a	track	above	the	existing	video	and	applies	Videomerge
effect	on	the	new	video.	The	underlying	and	the	top	videos	can	be	seen.
Replace	Clip	The	clip	is	replaced	and	the	mapping	matches	the	channel	type	of	the	replaced	clip’s	track.
Note:	When	you	drop	an	audio-only	clip	into	the	Monitor	window,	it	is	placed	on	the	Soundtrack	trackand	mapped	to	stereo.
Creating	specialty	clips
Add	color	bars	and	a	1-kHz	tone	Create	and	add	a	black	video	clip	Create	a	colored	mafle	for	a	background	Change	the	tone	level	of	clips
You	generate	Specialty	clips	by	using	panel	options	in	the	Project	Assets	panel.	They	reside	in	the	Project	Assets	panel	along	with	your	added	clips.
You	can	create	universal	counting	leaders,	color	bars,	a	1-kHz	tone,	black	video,	and	colored	backgrounds	for	your	project.	Use	Specialty	clips	for	calibration	of	your	video	or	simply	as	footage.
Create	and	add	a	black	video	clip
You	add	black	video	clips	to	separate	multiple	movies	or	to	create	pauses	in	a	movie.	You	can	also	use	a	black	video	clip	for	a	title.

1.	 Click	Project	Assets.
2.	 In	the	Project	Assets	panel,	click	New	Item	from	the	panel	options	and	choose	Black	Video.
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Create	a	colored	mafle	for	a	background
You	can	create	a	clip	consisting	of	a	full-frame	mafe	of	solid	color,	which	you	can	use	as	a	solid	background	for	titles	or	animated	clips.
Brightly	colored	mafles	can	serve	as	temporary	backgrounds	to	help	you	see	transparency	more	clearlywhile	you	adjust	a	key	effect.

1.	 Click	Project	Assets.
2.	 In	the	Project	Assets	panel,	click	New	Item	from	the	panel	options	and	choose	Color	Mafe.
3.	 Choose	a	color	in	the	Adobe	Color	Picker	dialog	box,	and	click	OK.	A	color	mafe	clip	is	placed	into	both	the	Project	Assets	panel	and	the	Expert	view	timeline.

Change	the	tone	level	of	clips
1.	Select	a	clip	using	one	of	the	following	methods:

To	set	the	level	for	all	new	clip	instances,	click	New	Item	from	the	panel	options	in	the	Project	Assets	panel.	Then,	select	the	Bars	And	Tone	option.
To	set	the	level	for	only	one	clip	instance,	select	the	clip	in	the	Expert	view	timeline.

1.	 Choose	Clip	>	Audio	Options	>	Audio	Gain.

2.	 In	the	Clip	Gain	dialog	box,	do	one	of	the	following,	and	click	OK:Drag	the	value	control	left	to	decrease,	or	right	to	increase,	volume.
Highlight	the	value	control	and	type	a	number	to	increase	or	decrease	volume.	Positive	numbers	increase	it.	Negative	numbers	decrease	it.
The	Normalize	option	adjusts	the	peak	amplitude	in	the	selected	clips	to	the	user-specified	value.	For	example,	this	option	adjusts	the	gain	of	a	clip	with	a	peak	amplitude	of	-6	dB	to	+6	dB.
Ensure	that	Normalize	All	Peaks	To	is	set	to	0.0	dB.
Guidelines	for	adding	files

Guidelines	for	adding	video	files	Guidelines	for	adding	audio	files	Guidelines	to	add	image	files	Guidelines	for	adding	an	animation	or	still-image	sequence
Guidelines	for	adding	video	files
You	can	add	various	video	file	formats	to	your	project.	Imported	video	and	sequence	files	can	have	frame	sizes	up	to	4096	x	4096	pixels.
Before	you	add	video	files	that	you	did	not	capture	yourself,	make	sure	you	can	view	the	videooutside		Premiere		Elements.		Usually,		doubleclickingavideofileopensa	playback	355



application,	such	as	Windows	MediaPlayerand	QuickTime	player.	(Be	sure	to	use	the	most	up-to-date	version	of	Windows	Media	Player.)	If	you	can	play	back	your	file	in	the	player	application,	you	can
usually	use	that	file	in	Premiere	Elements.
note:	To	play	back	VOB	(Video	Object)	files,	use	the	DVD	player	that	came	with	your	DVD	burner.
When	adding	video	files,	consider	the	following:
MPEG	file	compatibility
An	MPEG	file	can	be	imported	or	played	in	Premiere	Elements	if	it	meets	the	following	criteria:
The	file	must	be	in	a	format	that	Premiere	Elements	supports.
The	 compressor	 used	 to	 create	 the	 file	 must	 be	 compatible	 with	 the	 Premiere	 Elements	 decompressor.	 The	 compatibility	 requirements	 for	 playing	 compressed	 files	 are	 less	 stringent	 than	 the
requirements	for	editing	them.	MPEG	files	that	play	in	Windows	Media	Player	and	QuickTime	can	be	imported	or	played	in	Premiere	Elements	if	they	meet	the	compatibility	requirements.
note:	The	first	time	you	import	an	MPEG-2	file,	Premiere	Elements	automatically	activates	thecomponents	if	you	are	connected	to	the	Internet.	If	you	are	not	connected	to	the	Internet,	you	are	prompted
to	activate	the	MPEG-2	component.	The	instructions	appear	in	the	Activating	Component	dialog	box.
Type	1	AVI	file	render	requirements
Render	these	files	before	you	can	preview	them	from	your	DV	camcorder.	To	render	a	Type	1AVI	clip,	add	 it	 to	 the	Quick	view/Expert	view	timeline.	Build	a	preview	file	of	 that	section	of	 the	Quick
view/Expert	view	timeline	by	pressing	Enter.	If	the	clip	must	be	rendered,	a	red	line	appears	above	the	clip	in	the	Quick	view/Expert	view	timeline.
DVD	file	protection
If	the	DVD	is	a	motion-picture	disc	that	uses	copy	protection,	you	cannot	add	the	files.
Guidelines	for	adding	audio	files
When	you	add	audio	files	to	a	project,	they	are	conformed	to	the	audio	sample	rate	specified	in	the	Project	Sefings	dialog	box.	During	that	process,	you’ll	see	a	progress	bar	in	the	lower-right	corner	of
the	application	window.Youcan	play	back	conformed	audio	instantly	at	high	quality	because	it’s	consistent	with	all	other	audio	in	the	project.
By	default,	conformed	audio	is	stored	at	the	location
C:\Users\<username>.<domain>\AppData\Roaming\Adobe\Common.	You	can	change	the	default	location	of	the	media	cache	by	choosing	one	of	the	following	options:	356



(Windows)	Edit	>	Preferences	>	Scratch	Disks.
(Mac	OS)	Adobe	Premiere	Elements	12	>	Preferences	>	Scratch	Disks.
Note:Aßer	you	conform	an	audio	clip,	 you	don’t	have	 to	confirm	 it	again	unless	 you	delete	 thecorresponding	 file	 in	 the	Media	Cache	 folder.	 If	 you	delete	conformed	audio	 files,	Premiere	Elements
regenerates	them	when	you	open	related	projects.
When	adding	audio	files,	consider	the	following:
Stereo	and	mono	files	You	can	add	many	of	the	stereo	audio	files	that	you	can	open	in	another	audio	player,	such	as	Windows	Media	Player,	to	your	project.	To	create	a	stereo	version	of	a	mono	file,	the
mono	channel	is	copied	to	both	the	left	and	right	channel	in	the	new	stereo	track.	In	this	case,	both	channels	contain	the	same	information.
5.1	surround	sound	files	Importing	clips	containing	5.1	audio	adds	a	5.1-channel	audio	track	to	your	project.
mp3	and	WMA	filesFormats	such	as	mp3	andWMAare	compressed	using	a	method	that	reduces	some	of	the	original	audio	quality.	To	play	back	compressed	audio,	Premiere	Elements	(like	most	video
editing	applications)	must	decompress	and	possibly	alter	the	file’s	sample	rate.	Compressing	can	degrade	the	audio	quality.
CD	files	If	you	want	to	add	audio	from	a	CD,	copy,	or	rip,	the	audio	tracks	to	your	hard	drive	using	another	application.	Windows	Media	Player,	included	with	Windows	XP,	can	perform	this	task.Youcan
also	use	AdobeAuditionto	rip	theCDat	various	quality	sefings	and	perform	complex	audio-processing	functions	on	the	file.	If	you	plan	to	air	or	distribute	your	movie,	ensure	that	you	own	the	copyright,	or
have	licensed	the	copyright	to	your	CD	audio.
Internet	files	You	can	download	music	from	the	Internet	for	your	projects.	WMA	(Windows	Media	Audio)	and	AAC	(QuickTime)	files	can	have	pre-encoded	sefings	that	don’t	allow	you	to	play	them	in
Premiere	Elements.
Importing	Pictures	Guidelines	to	add	image	files
By	default,	Premiere	Elements	scales	images	to	fit	the	project	frame	size.	You	can	override	this	behavior	and	instead	add	your	files	at	the	size	at	which	they	were	created.	You	can	also	set	the	default
duration	for	all	images	that	you	add	by	changing	the	value	in	General	Preferences.
You	can	add	still	images	with	frame	sizes	up	to	4096	x	4096	pixels.	Create	files	with	frame	size	equal	to	or	more	than	the	frame	size	of	your	video.	Choosing	the	appropriate	frame	size
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ensures	that	you	don’t	enlarge	the	image	in	Premiere	Elements.	When	you	scale	up	an	image,	it	often	becomes	pixelated.	Create	it	at	a	larger	frame	size	than	the	project.	For	example,	if	you	plan	to	scale
an	image	200%,	create	the	image	at	double	the	project	frame	size	before	you	add	it.
You	can	also	add	animations,	which	are	saved	as	a	sequence	of	numbered	still-image	files.
When	adding	still-image	files,	consider	the	following:
Photoshop	Elements	filesPremiere	Elements	works	well	with	images	and	video	templates	you	create	in	Photoshop	Elements.
JPEG	files	If	you	are	having	trouble	importing	JPEG	files	to	Premiere	Elements,	open	them	in	Photoshop	Elements	and	resave	them.	Then	try	to	import	them	again.
TIFF	imagesYou	can	add	files	from	Photoshop	3.0	or	 later.	However,	Premiere	Elements	doesn’t	support	16-bit	TIFF	images	created	in	Photoshop	or	other	applications.	Empty	(transparent)	areas	of
nonflafened	Photoshop	files	appear	transparent	in	Premiere	Elements	because	the	transparency	is	stored	as	an	alpha	channel.
RGB	modeWhen	you	are	editing	or	creating	your	still	images,	make	sure	that	you	do	all	of	your	work	in	RGB	mode.	For	more	information,	consult	your	product’s	user	guide	about	color	management.
RGB	mode	produces	colors	that	are	suitable	for	video.
Guidelines	for	adding	an	animation	or	still-image	sequence
The	frames	in	an	animation	are	drawn	as	graphics	and,	therefore,	are	not	scenes	of	live	action,	as	in	conventional	digital	video.	Premiere	Elements	can	also	add	a	sequence	of	numbered	still-image	files
and	automatically	combine	them	into	a	single	clip;	each	numbered	file	represents	one	frame.	Some	applications,	such	as	Adobe	After	Effects®,	can	generate	a	numbered	sequence	of	still	images.	Images
in	a	still-image	sequence	cannot	include	layers.	Flafen	images	that	are	part	of	a	sequence.	For	information	on	layers	and	flafening,	see	the	documentation	for	the	application	that	created	the	file.
Note:Changing	the	default	duration	of	still	images	in	the	Preferences	dialog	box	does	not	affect	theduration	of	still	images	that	are	part	of	a	sequence.
When	creating	three-dimensional	images	or	animations	for	use	in	Premiere	Elements,	use	the	following	guidelines	whenever	possible:	Use	broadcast-safe	colors.	Most	applications	that	create	animations
(such	as	Adobe	After	Effects)	allow	you	to	check	for	broadcast-safe	colors.	See	your	application’s	documentation	for	more	information.
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Use	the	pixel	aspect	ratio	and	frame	size	specified	in	the	project	sefings	in	Premiere	Elements.	Use	the	appropriate	field	sefings	to	match	your	project.
You	can	use	an	Adobe	application	(such	as	Photoshop)	to	generate	the	sequence.	Select	Embed	Project	Link	to	open	the	sequence	in	the	application	thatwasused	to	create	it.	For	example,	select	aPSDfile
in	the	Project	Assets	panel	in	Premiere	Elements.	Then,	choose	Edit	>	Edit	Original	to	open	the	file	in	Photoshop	with	the	original	layers	intact.
Set	duration	for	imported	still	images
Change	the	default	duration	for	still	images	Set	a	unique	duration	for	a	still	image
When	you	add	a	still	image,	you	can	assign	a	specific	duration	to	it.	The	duration	specifies	how	much	time	the	image	occupies	in	the	Quick	view/Expert	view	timeline.	You	can	set	a	default	duration	for	all
still	images	that	you	add,	and	you	can	change	their	duration	in	the	Quick	view/Expert	view	timeline.
The	frame	rate	of	your	project	determines	the	amount	of	time	that	a	certain	number	of	frames	occupies.	If	you	specify	30	frames	for	a	29.97	frame-per-second	(fps)	NTSC	project,	each	still	image	has	a
duration	of	about	one	second.	ForPAL,if	you	specify	25	frames	for	a	25-fps	project,	each	still	image	in	the	Quick	view/Expert	view	timeline	has	a	duration	of	one	second.
Change	the	default	duration	for	still	images

1.	 Do	one	of	the	following:
On	Windows,	select	Edit	>	Preferences	>	General.	On	Mac	OS,	select	Adobe	Premiere	Elements	12	>	Preferences	>	General.
Right-click/ctrlclick	in	the	Project	Assets	panel	and	choose	Still	Image	Duration.

2.	 For	Still	Image	Default	Duration,	specify	the	number	of	frames	you	want	as	a	default	duration.
Note:Changing	the	default	duration	of	still	images	does	not	affect	the	duration	of	still	imagesalready	in	the	Quick	view/Expert	view	timeline	or	Project	Assets	panel.	To	apply	the	new	default	length
to	all	still	images	in	your	project,	delete	them	from	the	Project	Assets	panel	and	reimport	them	into	your	project.

Set	a	unique	duration	for	a	still	image
1.	Do	one	of	the	following:

In	the	Expert	view,	position	the	Selection	tool	over	either	end	of	the	image,	and	drag.	Select	the	clip	and	choose	Clip	>	Time	Stretch.	Enter	a	new	duration	and	click	OK.
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Working	with	scratch	disks
•About	scratch	disks	•	Types	of	scratch	disks	•	Set	up	a	scratch	disk	•	Maximizing	scratch	disk	performance
About	scratch	disks
When	you	edit	a	project,	Premiere	Elements	uses	disk	space	to	store	scratch	files	for	your	project.	These	include	captured	video	and	audio,	conformed	audio,	and	preview	files.	Adobe	Premiere	Elements
uses	conformed	audio	files	and	preview	files	to	optimize	performance,	allowing	real-time	editing,	high	processing	quality,	and	efficient	output.	All	scratch	disk	files	are	preserved	across	work	sessions.	If
you	delete	conformed	audio	files,	Premiere	Elementsautomatically	recreates	them.If	youdelete	preview	files,	theyare	not	berecreatedautomatically.
By	default,	scratch	files	are	stored	where	you	save	the	project.	The	scratch	disk	space	required	increases	as	your	movie	becomes	longer	or	more	complex.	If	your	system	has	access	to	multiple	disks,
choose	Edit	>	Preferences	>	Scratch	Disks	/	Adobe	Premiere	Elements	12	>	Preferences	>	Scratch	Disks.	Specify	the	disks	Premiere	Elements	uses	for	these	files.	For	best	results,	set	up	your	scratch
disks	at	the	very	beginning	of	a	project,	before	capturing	or	editing.
Types	of	scratch	disks
While	performance	can	be	enhanced	by	sefing	each	scratch	disk	 type	 to	a	different	disk,	you	can	also	specify	 folders	on	 the	same	disk.	Select	Edit	>	Preferences	>	Scratch	Disks	 /	Adobe	Premiere
Elements	12	>	Preferences	>	Scratch	Disks	to	set	the	following	scratch	disk	options.
Captured	VideoFolder	or	disk	for	video	files	and	stop-motion	still	image	files	that	you	capture	using	the	Capture	panel.
Captured	AudioFolder	or	disk	for	audio	files	that	you	capture	using	the	Capture	panel.Video	PreviewsFolder	or	disk	for	video	preview	files.	These	files	are	created	when	you	choose	Timeline	>	Render
Work	Area,	export	to	a	movie	file,	or	export	to	a	DV	device.	If	the	previewed	area	includes	effects,	the	effects	are	rendered	at	full	quality	in	the	preview	file.
Audio	PreviewsFolder	or	disk	for	audio	preview	files.	These	files	are	created	when	you	choose	Timeline	>	Render	Work	Area	command.	They	are	also	created	when	you	choose	Clip	>AudioOptions	>
Render	And	Replace,	export	to	a	movie	file	orDVdevice.	If	the	previewed	area	includes	effects,	the	effects	are	rendered	at	full	quality	in	the	preview	file.
Media	CacheFolder	or	disk	for	audio	peak	files,	audio	conform	files,	video	index	files,		and	360



other	files	Premiere	Elements	creates	to	improve	performance	when	reading	media	files.DVD	Encoding	Folder	or	disk	for	encoded	video	and	audio	files	that	are	generated	when	you	create	a	DVD.
Note:Premiere	Elements	places	preview	files,	encoded	files,	media	cache	files,	and	other	types	withinsubfolders	of	the	folders	you	specify	for	these	types.	Each	subfolder	is	named	for	the	type	of	scratch
files	it	contains.
Set	up	a	scratch	disk
You	set	up	scratch	disks	in	the	Scratch	Disks	panel	of	the	Preferences	dialog	box.	To	verify	the	amount	of	free	disk	space	on	the	selected	volume,	see	the	box	to	the	right	of	the	path.	If	the	path	is	too
long	to	read,	place	the	pointer	over	the	path,	and	the	full	path	appears	in	a	tool	tip.

1.	 Choose	Edit	>	Preferences	>	Scratch	Disks	/	Adobe	Premiere	Elements	12	>	Preferences	>	Scratch	Disks.
2.	 For	each	scratch	disk	type,	specify	a	disk	location	for	Premiere	Elements	to	store	the	corresponding	files.	Choose	one	of	these	options	from	the	pop-up	menu:

My	DocumentsStores	scratch	files	in	the	My	Documents	folder.
Same	As	ProjectStores	scratch	files	in	the	same	folder	where	the	project	is	stored.CustomIndicates	that	the	current	path	isn’t	in	the	pop-up	menu.	The	current	path	isn’t	changed	until	you	click
Browse	to	specify	any	available	disk	location.

Maximizing	scratch	disk	performance
If	your	computer	has	only	one	hard	disk,	consider	leaving	all	scratch	disk	options	at	their	default	sefings.
If	it	has	more	than	one,	choose	large,	secondary	hard	drives	for	scratch	disks	and	not	the	main	load	drive.	In	Premiere	Elements,	you	can	place	each	type	of	scratch	file	onto	its	own	disk.	For	example,
you	copy	video	to	one	disk	and	audio	to	another.
Defragment	scratch	disks	regularly	by	using	the	Disk	Defragmenter	tool	in	Windows	or	a	third-party	utility.	To	use	the	Disk	Defragmenter	tool,	choose	Start	>	All	Programs	>	Accessories	>	System	Tools
>	Disk	Defragmenter.	For	more	instructions,	see	the	documentation	provided	with	Windows	or	the	third-party	utility.
Specify	your	fastest	hard	disks	for	capturing	media	and	storing	scratch	files.	You	can	use	a	slower	disk	for	audio	preview	files	and	the	project	file.
Specify	only	disks	afached	to	your	computer.	The	throughput	from	a	hard	disk	on	a	network
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is	too	slow.	Avoid	using	removable	media	as	scratch	disks	because	Premiere	Elements	always	requires	access	to	scratch	disk	files.	Scratch	disk	files	are	preserved	for	each	project,	even	when	you	close
the	project.	Premiere	Elements	reuses	these	files	when	you	reopen	the	project	associated	with	them.	If	scratch	disk	files	are	stored	on	removable	media	and	the	media	is	removed	from	the	drive,	the
scratch	disk	is	not	available	to	Premiere	Elements.

You	 can	 divide	 a	 single	 disk	 into	 partitions	 and	 set	 up	 each	 partition	 as	 a	 virtual	 scratch	 disk.	However,	 partitioning	 doesn’t	 improve	 performance	 because	 the	 single	 drive	mechanism	 is	 a
bofleneck.	For	best	results,	set	up	scratch	disk	volumes	on	actual	separate	drives.
Working	with	offline	files

About	offline	files	Edit	an	offline	file	Replace	an	offline	file	with	a	file	on	your	computer	About	offline	files
An	offline	file	is	a	placeholder	for	a	source	file	that	Premiere	Elements	cannot	currently	find	on	your	hard	drive.	Offline	files	remember	information	about	the	missing	source	files	they	represent.	If	an
offline	file	appears	in	the	Quick	view/Expert	view	timeline,	a	“Media	Offline”	message	appears	in	the	monitor	and	in	the	Quick	view/Expert	view	timeline.
Edit	an	offline	file

1In	the	Expert	view,	click	Project	Assets.
2In	the	Project	Assets	panel,	doubleclick	the	offline	file.	Where	Is	The	File	[name	of	the	file]	dialog	box	appears.	Locate	the	source	file,	select	the	file,	and	click	Select.
3Right-click/Ctrlclick	the	file	and	select	Edit	Original	to	edit	the	file.

Replace	an	offline	file	with	a	file	on	your	computer
1In	the	Expert	view,	click	Project	Assets.
2In	the	Project	Assets	panel,	select	one	or	more	offline	files.
3Choose	Edit	>	Locate	Media.
4Locate	and	select	the	actual	source	file,	and	click	Select.
Note:	If	you	selected	more	than	one	offline	file,	the	Aflach	Which	Media	dialog	box	appears	in	turnfor	each	file	you	selected.	Pay	aflention	to	the	offline	filename	in	the	title	bar	of	the	dialog	box	so
that	you	relink	the	correct	source	file	to	each	offline	file.

Working	with	aspect	ratios	and	field	options
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• Understanding	aspect	ratios
•Capturing	or	adding	various	aspect	ratios
•View	a	project’s	aspect	ratio
•Adjust	pixel	aspect	ratio	for	a	still	image	or	source	clip
•Use	square-pixel	files	in	a	D1	or	DV	project
•Set	field	options	for	imported	interlaced	video

Understanding	aspect	ratios
The	aspect	ratio	specifies	the	ratio	of	width	to	height.	Video	frames	have	an	aspect	ratio	(frame	aspect	ratio)	as	do	the	pixels	that	make	up	the	frame	(pixel	aspect	ratio).	Some	video	camcorders	can
record	various	frame	aspect	ratios,	and	the	NTSC	and	PAL	video	standards	use	different	pixel	aspect	ratios.	If	an	image	of	a	circle	appears	oval-shaped,	there	can	be	a	mismatch	between	the	aspect
ratios	of	the	image	and	your	project.
Premiere	Elements	automatically	afempts	to	detect	and	compensate	for	the	pixel	aspect	ratio	of	source	clips	so	that	distortion	doesn’t	occur.	If	a	clip	appears	distorted	in	Premiere	Elements,	you	can
manually	change	its	pixel	aspect	ratio.	It’s	important	to	reconcile	pixel	aspect	ratios	before	reconciling	frame	aspect	ratios.	Misinterpretation	of	a	source	clip’s	aspect	ratio	causes	incorrect	frame	aspect
ratio.
Frame	aspect	ratio
Frame	aspect	ratiodescribes	the	ratio	of	width	to	height	 in	the	dimensions	of	an	 image.	For	example,DVNTSChas	a	 frame	aspect	ratio	of	4:3	 (or	4.0	width	by	3.0	height).	For	comparison,	a	 typical
widescreen	frame	has	a	frame	aspect	ratio	of	16:9;	many	camcorders	that	have	a	widescreen	mode	can	record	using	this	aspect	ratio.	Many	films	are	shot	using	even	wider	aspect	ratios.
A	4:3	frame	aspect	ratio	(left),	and	a	wider	16:9	frame	aspect	ratio	(right)

	
When	you	add	clips	into	a	project	with	a	different	frame	aspect	ratio,	decide	how	to	reconcile	the	different	values.Youcan	show	a	widescreen	movie	with	a	16:9	frame	aspect	ratio	on	a	standardTVwith	a
4:3	frame	aspect	ratio	in	two	ways.	Use	the	Leferboxing	technique	to	fit	the	entire	width	of	the	16:9	frame	into	a	black	4:3	frame.	Black	bands	appear	above	and	below	the	widescreen	frame.
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Alternatively,	use	the	Pan	and	scan	technique	to	fill	the	4:3	frame	with	only	a	selected	area	of	the	16:9	frame.	Although	this	technique	eliminates	the	black	bars,	it	also	eliminates	part	of	the	action.
Premiere	Elements	automatically	leferboxes	any	16:9	footage	that	you	add	into	a	4:3	aspect	ratio	project.
Pixel	aspect	ratio
Pixel	aspect	ratio	describes	the	ratio	of	width	to	height	 in	a	single	pixel	of	a	 frame.	Pixel	aspect	ratios	vary	because	different	video	systems	make	different	assumptions	about	the	number	of	pixels
required	to	fill	a	frame.	For	example,	many	computer	video	standards	define	a	frame	that	has	a	4:3	aspect	ratio	as	640	x	480	pixels.	Pixels	that	are	square,	which	have	an	aspect	ratio	themselves	of	1:1,
perfectly	fill	the	horizontal	and	vertical	space	the	frame	defines.	However,	video	standards	such	asDVNTSC(standard	forDVcamcorders	in	the	U.S.)	define	a	4:3	aspect	ratio	frame	as	720	x	480	pixels.
Consequently,	to	fit	all	of	these	pixels	in	the	frame,	the	pixels	must	be	narrower	than	the	square	pixels.	These	narrow	pixels	are	called	rectangular	pixels,	and	they	have	an	aspect	ratio	of	0.9:1,	or	0.9	as
they	are	commonly	called.	DV	pixels	are	vertically	oriented	in	systems	producingNTSCvideo	and	horizontally	oriented	in	systems	producing	PAL	video.	Premiere	Elements	displays	a	clip’s	pixel	aspect
ratio	next	to	the	clip’s	image	thumbnail	in	the	Project	Assets	panel.

	
If	you	display	rectangular	pixels	on	a	square-pixel	monitor,	images	appear	distorted,	for	example,	circles	distort	into	ovals.	However,	when	displayed	on	a	broadcast	monitor,	the	images	appear	correctly
proportioned	because	broadcast	monitors	use	rectangular	pixels.Premiere	Elements	exports	clipsof	variouspixel	aspect	ratios	without	distortion.It	automatically	adjusts	the	pixel	aspect	ratio	of	your
project	to	the	pixel	aspect	ratio	of	the	clips.Youcan	encounter	a	distorted	clip	if	Premiere	Elements	interprets	pixel	aspect	ratio	incorrectly.	Correct	the	distortion	by	manually	by	specifying	the	source
clip’s	pixel	aspect	ratio.
Pixel	and	frame	aspect	ratios
A.Square	pixels	and	4:3	frame	aspect	ratioB.Nonsquare	pixels	and	4:3	frame	aspect	ratioC.

Nonsquare	pixels	displayed	uncorrected	on	a	square-pixel	monitor
	

364



Capturing	or	adding	various	aspect	ratios
Premiere	Elements	afempts	to	automatically	compensate	for	pixel	aspect	ratios	and	preserve	the	frame	size	of	added	images.	Images	that	you	add	are	treated	in	the	following	ways:	Add	video	with	D1
resolution	720	x	486	orDVresolution	720	x	480.	Premiere	Elements	automatically	sets	the	video’s	pixel	aspect	ratio	to	D1/DV	NTSC	(0.9).	For	a	footage	with	D1	orDVresolution	720	x	576,	Premiere
Elements	sets	its	pixel	aspect	ratio	toD1/DVPAL(1.067).	However,	it	helps	to	see	the	Project	Assets	panel	or	the	Interpret	Footage	dialog	box	to	ensure	that	all	files	are	interpreted	correctly.
Premiere	 Elements	 automatically	 assigns	 pixel	 aspect	 ratios	 to	 files	 by	 using	 the	 Interpretation	 Rules.txt	 file	 in	 the	 Premiere	 Elements/Plug-in	 folder.	 If	 a	 specific	 type	 of	 image	 is	 consistently
misinterpreted	(distorted),	modify	 the	entries	 in	the	Interpretation	Rules.txt	 file.	 If	you	want	to	override	the	pixel	aspect	ratio	 interpretation	for	 files	already	 in	a	project,	use	the	Interpret	Footage
command.
To	change	the	size	of	a	clip	in	Premiere	Elements,	select	the	clip	and	change	the	Scale	property	of	the	Motion	effect.	The	Motion	effect	is	available	in	the	Properties	view	with	the	clip	selected	in	the
Expert	view	timeline.
View	a	project’s	aspect	ratio
The	preset	you	choose	when	you	start	a	project	sets	the	pixel	aspect	ratio	for	the	project.	Youcan’t	change	the	aspect	ratio	after	it	is	initially	set.
Choose	Edit	>	Project	Sefings	>	General.
Adjust	pixel	aspect	ratio	for	a	still	image	or	source	clip
To	combine	diverse	footage	within	a	project	and	generate	an	output	without	distorting	source	images,	ensure	that	all	files	are	interpreted	correctly.
Note:	When	you	set	the	pixel	aspect	ratio	of	a	file,	use	its	original	ratio,	not	the	ratio	of	the	project	andfinal	output.

1.	 In	the	Expert	view,	click	Project	Assets.
2.	 Select	the	still	image	or	source	clip.
3.	 Choose	File	>	Interpret	Footage.
4.	 In	the	Pixel	Aspect	Ratio	section,	select	Use	Pixel	Aspect	Ratio	From	File	to	use	the	original	ratio	of	the	file.	Alternatively,	choose	one	of	the	following	from	the	Conform	To	menu:
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Square	Pixels	Uses	a	1.0	pixel	aspect	ratio.	Use	this	sefing	if	your	source	clip	has	a	640	x	480	or	648	x	486	frame	size.	You	can	also	use	this	sefing	if	the	file	was	exported	from	an	application	that
supports	only	square	pixels.
D1/DV	NTSC	Uses	a	0.9	pixel	aspect	ratio.	Use	this	sefing	if	your	source	clip	has	a	720	x	480	or	720	x	486	frame	size.	This	sefing	lets	you	maintain	a	4:3	frame	aspect	ratio	for	the	clip.	Use	this
sefing	for	clips	exported	from	an	application	that	works	with	nonsquare	pixels,	such	as	a	3D	animation	application.
note:	For	more	information	about	D1,	see	the	Glossary	in	Premiere	Elements	Help.
D1/DV	NTSC	WidescreenUses	a	1.2	pixel	aspect	ratio.	Use	this	sefing	if	your	source	clip	has	a	720	x	480	or	720	x	486	frame	size.	This	sefing	lets	you	maintain	a	16:9	frame	aspect	ratio.
D1/DV	PAL	Uses	a	1.0666	pixel	aspect	ratio.	Use	this	sefing	if	your	source	clip	has	a	720	x	576	frame	size	and	you	want	it	to	maintain	a	4:3	frame	aspect	ratio.
D1/DVPALWidescreenUses	a	1.4222	pixel	aspect	ratio.	Use	this	sefing	if	your	source	clip	has	a	720	x	576	frame	size	and	you	want	it	to	maintain	a	16:9	frame	aspect	ratio.
Anamorphic	2:1Uses	a	2.0	pixel	aspect	ratio.	Use	this	sefing	if	your	source	clip	was	amorphically	transferred	from	a	film	frame	with	a	2:1	aspect	ratio.
HD	Anamorphic	1080Uses	a	1.333	pixel	aspect	ratio.

Use	square-pixel	files	in	a	D1	or	DV	project
Youcan	use	square-pixel	footage	in	aDVproject	and	generate	output	that	does	not	appear	distorted.	Premiere	Elements	either	“upsamples”	(increases)	or	“downsamples”	(decreases)	the	resolution	of	a
file	that	does	not	match	the	project	frame	size.	Downsampling	results	in	a	higher-quality	image.	Create	files	that	are	larger	than	the	project’s	frame	size	so	that	Premiere	Elements	need	not	upsample
and	enlarge	them.

Prepare	the	file	by	using	one	of	the	following	methods,	and	then	capture	or	add	the	file	to	Premiere	Elements:	If	your	final	output	is	DV	(NTSC),	create	and	save	it	at	a	720	x	540	frame	size.
Saving	at	this	frame	size	prevents	upsampling	or	640	x	480	to	prevent	field	distortion	on	a	field-rendered	file.
If	your	final	output	is	DV	(PAL),	create	and	save	it	at	a	768	x	576	frame	size.	Saving	at	this	frame	size	prevents	upsampling	and	field	distortion	on	a	field-rendered	file.
If	your	final	output	is	D1	(NTSC),	create	and	save	it	at	a	720	x	540	frame	size.
The	frame	size	of	a	square-pixel	image	can	match	the	frame	size	of	your	project	(for
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example	720	x	480).	However,	if	they	have	different	pixel	aspect	ratios,	redesign	the	image	using	a	different	frame	size	(such	as	720	x	540).	Redesigning	is	necessary	when	the	application	you	use
to	prepare	the	file	doesn’t	support	nonsquare	pixels.

Set	field	options	for	imported	interlaced	video
In	most	video,	each	frame	consists	of	two	fields.	One	field	contains	the	odd-numbered	lines	in	the	frame,	and	the	other	contains	the	even-numbered	lines.	The	fields	areinterlaced,	or	combined,	to	create
the	complete	image.	Adobe	Photoshop	Elements	includes	a	reverse	field	order	preset	for	video	imported	from	a	hard	disk	or	Flash	memory	camcorder	that	uses	upper	fields	first.	You	can	capture	source
footage	with	upper	fields	first.	For	this	footage,	ensure	that	your	project	uses	either	the	Standard	or	Widescreen	preset	from	the	Flash	Memory	Camcorders	presets	folder.
Ordinarily,	interlacing	isn’t	apparent	to	a	viewer.	However,	each	field	captures	the	subject	at	a	different	time.	Due	to	the	time	difference,	playing	a	clip	in	slow-motion	or	creating	a	freeze	frame	makes
the	two	fields	discernible.Youobserve	the	same	behavior	when	you	export	a	 frame	as	a	still	 image.	To	avoid	this	situation,	you	candeinterlacethe	 image.	Deinterlacing	eliminates	one	field	and	either
duplicates	or	interpolates	the	lines	of	the	remaining	field.
Reversing	thefield	dominance,the	order	in	which	the	fields	are	recorded	and	displayed,	can	cause	playback	problems.	When	the	field	dominance	is	reversed,	motion	appears	jerky	because	the	fields	no
longer	appear	in	chronological	order.	Fields	are	reversed	when	the	original	videotape’s	field	dominance	is	the	opposite	of	the	field	dominance	of	the	video-capture	card	used	to	capture	the	clip.	Fields
are	 also	 reversed	when	 the	 field	 dominance	 of	 the	 original	 videotape	 and	 the	 video-editing	 software	 are	 opposite	 to	 each	 other.	Reversing	 can	 also	happen	when	 you	 set	 an	 interlaced	 clip	 to	 play
backward.
To	avoid	these	complications,	you	can	deinterlace	the	image.	Deinterlacing	eliminates	one	field	and	either	duplicates	or	interpolates	the	lines	of	the	remaining	field.Youcan	also	set	field	options	for	an
interlaced	clip	so	that	the	clip’s	picture	and	motion	quality	are	preserved	in	certain	situations.	These	include	changing	the	clip	speed,	exporting	a	filmstrip,	playing	a	clip	backward,	or	freezing	a	video
frame.

1Select	a	clip	in	the	Expert	view	timeline,	and	choose	Clip	>	Video	Options	>	Field	Options.
2Select	Reverse	Field	Dominance	to	change	the	order	in	which	the	clip’s	fields	appear.	This	option	is	useful	when	the	field	dominance	of	the	clip	doesn’t	match	your	equipment	or	when	you	play	a
clip	backward.
3For	Processing	Options,	select	one	of	the	following	choices,	and	click	OK.
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NoneDoes	not	process	the	clip’s	fields.
Interlace	Consecutive	FramesConverts	pairsofconsecutive	progressive-scan(noninterlaced)	frames	into	interlaced	fields.	This	option	is	useful	for	converting	60	fps	progressive-scan	animations
into	30-fps	interlaced	video	because	many	animation	applications	don’t	create	interlaced	frames.
Always	DeinterlaceConverts	interlaced	fields	into	whole	progressive-scan	frames.	Premiere	Elements	deinterlaces	by	discarding	one	field	and	interpolating	a	new	field	based	on	the	lines	of	the
remaining	field.	It	keeps	the	field	specified	in	the	Field	Sefings	option	in	the	Project	Sefings.	If	you	specified	No	Fields,	Premiere	Elements	keeps	the	upper	field	unless	you	selected	Reverse	Field
Dominance,	in	which	case	it	keeps	the	lower	field.	This	option	is	useful	when	freezing	a	frame	in	the	clip.
Flicker	Removal	Prevents	thin	horizontal	details	in	an	image	from	flickering	by	slightly	blurring	the	two	fields	together.	An	object	as	thin	as	one	scan	line	flickers	because	it	can	appear	only	in
every	other	field.

Supported	devices	Supported	file	types	for	import
Verify	whether	Adobe	Premiere	Elements	supports	the	file	format	and	the	device	from	which	you	import	the	file.
Supported	file	types	for	import
In	 addition	 to	 capturing	 footage,	 you	 can	 import	 image,	 video,	 and	 audio	 files.Youcan	 add	 files	 from	 folders	 on	 your	 computer,	 accessory	 hard	 drives,	 and	 mobile	 phones.Youcan	 also	 add	 files
fromDVDs,Blu-ray	discs,CDs,digital	cameras,	other	devices,	or	the	Internet.	Adobe	Premiere	Elements	12.0	supports	DV,	HDV,	WDM,	and	AVCHD	formafed	video.
Files	that	you	add	to	a	project	are	visible	in	the	Project	Assets	panel	in	the	Expert	view.	Adobe	Premiere	Elements	automatically	adds	them	to	Elements	Organizer.
note:	Some	file	formats	require	activation	of	components	before	you	can	add	them	to	a	project.
Supported	video	formats
Adobe	Flash®(.swf)AVIMovie	(.avi)AVCHD(.m2ts,	.mts,	.m2t)DV	Stream	(.dv)MPEGMovie	(.mpeg,	.vob,	.mod,	.ac3,	.mpe,	.mpg,	.mpd,	.m2v,	.mpa,	.mp2,	.m2a,	.mpv,	.m2p,	.m2t,	.m1v,	.mp4,	.m4v,	.m4a,
.aac,	3gp,	.avc,	.264)	QuickTime	Movie	(.mov,	.3gp,	.3g2,	.mp4,	.m4a,
.m4v)	TOD	(.tod)	Windows	Media	(.wmv,	.asf)	-	Windows	only
note:	To	import	video	from	mobile	phones	(.3gp	and	.mp4),	you	must	have	the	most	recent	version	ofQuickTime	installed	on	your	computer.
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Supported	image	formats
Adobe	Photoshop®	(.psd)	Adobe	Premiere	Elements	title	(.prtl)	Bitmap	(.bmp,	.dib,	.rle)	CompuServe	GIF®	(.gif)	JPEG®	(.jpg,	.jpe,	.jpeg,	.gif)	Pixar	Picture	(.pxr)	Portable	Network	Graphic	(.png)	RAW
(.raw,	.raf,	.crw,	.cr2,	.mrw,	.nef,	.orf,	.dng)
Supported	audio	formats
AdvancedAudioCoding	(.aac)	Dolby®AC-3(.ac3)	Macintosh®AudioAIFF(.aif,	.aiff)			M	P3®Audio(.mp3)M	P	E	G	®	Audio(.mpeg,.mpg,	.mpa,	.mpe,	.m2a)	QuickTime(.mov,.m4a)	Windows	Media	(.wma)	-
Windows	only	Windows	WAVE	(.wav)	note:	Dolby	AC-3	is	imported	as	a	standalone.ac3	file	or	as	part	of	an	encoded	audio	file	in	a	.vob	(DVD)or	.mod	(JVC®	Everio)	file,	but	exported	as	Dolby	Digital
Stereo	only.
Activate	a	component	for	import
Some	 file	 formats	 such	 as	MPEG-2,	MPEG	4(SP),	 and	AMR	 require	 component	 activation	 before	 you	 can	 add	 them	 to	 a	 project.	 If	 you	 are	 connected	 to	 the	 Internet,	 component	 activation	 occurs
automatically.	If	you	are	not	connected	to	the	Internet,	the	Activating	Component	dialog	box	appears.

1.	 When	the	Activating	Component	dialog	box	appears,	connect	to	the	Internet.
2.	 In	the	Activating	Component	dialog	box,	click	Copy	to	copy	the	serial	number.
3.	 Click	the	URL	to	go	to	the	activation	website.
4.	 Paste	the	serial	number	into	the	ID	box	on	the	website.
5.	 Copy	the	key,	paste	it	in	the	Activating	Component	dialog	box,	and	then	click	OK.

The	website	displays	a	key	for	unlocking.
Sharing	files	between	Adobe	Premiere	Elements	and	Adobe	Photoshop	Elements
Youcan	access	all	images	in	a	Photoshop	Elements	catalog	directly	from	the	Elements	Organizer	workspace	of	Premiere	Elements.	You	can	also	add,	edit,	and	manage	your	images,	and	then	drag	them	to
the	Quick	view/Expert	view	timeline	of	Adobe	Premiere	Elements	for	use	in	your	project.
Adobe	Photoshop	Elements	and	Premiere	Elements	are	designed	to	work	together,	whether	you	purchase	the	products	separately	or	bundled	in	one	package.	These	programs	seamlessly	combine	digital
photography	and	video	editing,	lefing	you	create	exciting	video	projects.	The	two	programs	support	many	of	the	same	file	types,	which	makes	the	transfer	of	most	files	between	them	easy	and	efficient.
For	example,	you	can	catalogPSDfiles	in	Photoshop	Elements	and	then	add	them	to	the	Quick	view/Expert	view	timeline	directly	from	the	369



Elements	Organizer	in	Premiere	Elements.
note:	The	Photoshop	Elements	Organizer	shows	clips	of	audioAVIfiles	with	broken	video	thumbnailicons.	However,	they	play	correctly.	The	Photoshop	Elements	Editor	can	import	individual	video	frames
from	ASF,	AVI,	MPEG,	and	Windows	Media	files.	(Choose	File	>	Import	>	Frame	From	Video.)	Here	are	a	few	ways	you	can	share	files	between	Photoshop	Elements	and	Premiere	Elements:	Organize	your
photos,	video	clips,	and	audio	clips	in	either	Premiere	Elements	or	Photoshop	Elements.	Find	the	assets	using	Elements	Organizer	in	either	application	and	add	them	to	a	project.
Capture	video	in	Premiere	Elements	and	open	it	from	the	Elements	Organizer	and	create	and	edit	still	images	from	the	video.
(Windows	only)	Create	a	slideshow	 in	Photoshop	Elements	6.0	or	 later	with	captions,	 transitions,	effects,	music,	narration,	graphics,	and	titles.	 Import	 the	slideshow	 into	Premiere	Elements	 to	edit
further	or	burn	toDVD.Alternatively,	import	individual	photos	into	Premiere	Elements	and	create	the	slideshow	there.
note:	The	SendToAdobe	Premiere	Elements	command	in	Photoshop	Elements	works	only	when	youuse	Photoshop	Elements	6.0	or	later	with	Adobe	Premiere	Elements	4.0	orlater.
Customize	menu	templates	in	Photoshop	Elements,	and	then	use	them	in	your	Premiere	Elements	project.	(Menu	templates	are	PSD	files	stored	in	the	Premiere	Elements	application	folder.)	Create	a
Photoshop	Elements	file	with	your	video	project’s	sefings,	enhance	it	in	Photoshop	Elements,	and	then	use	it	in	Premiere	Elements.
Create	and	add	a	black	video	clip
You	add	black	video	clips	to	separate	multiple	movies	or	to	create	pauses	in	a	movie.	You	can	also	use	a	black	video	clip	for	a	title.

1.	 Click	Project	Assets.
2.	 In	the	Project	Assets	panel,	click	New	Item	from	the	panel	options	and	choose	Black	Video.

Create	a	colored	mafle	for	a	background
You	can	create	a	clip	consisting	of	a	full-frame	mafe	of	solid	color,	which	you	can	use	as	a	solid	background	for	titles	or	animated	clips.
Brightly	colored	mafles	can	serve	as	temporary	backgrounds	to	help	you	see	transparency	more	clearlywhile	you	adjust	a	key	effect.
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1.	 Click	Project	Assets.
2.	 In	the	Project	Assets	panel,	click	New	Item	from	the	panel	options	and	choose	Color	Mafe.
3.	 Choose	a	color	in	the	Adobe	Color	Picker	dialog	box,	and	click	OK.	A	color	mafe	clip	is	placed	into	both	the	Project	Assets	panel	and	the	Expert	view	timeline.

Change	the	tone	level	of	clips
1.	 Select	a	clip	using	one	of	the	following	methods:

To	set	the	level	for	all	new	clip	instances,	click	New	Item	from	the	panel	options	in	the	Project	Assets	panel.	Then,	select	the	Bars	And	Tone	option.	To	set	the	level	for	only	one	clip	instance,	select
the	clip	in	the	Expert	view	timeline.

2.	 Choose	Clip	>	Audio	Options	>	Audio	Gain.
3.	 In	the	Clip	Gain	dialog	box,	do	one	of	the	following,	and	click	OK:	Drag	the	value	control	left	to	decrease,	or	right	to	increase,	volume.	Highlight	the	value	control	and	type	a	number	to

increase	or	decrease	volume.	Positive	numbers	increase	it.	Negative	numbers	decrease
Move	through	the	Expert	view	timeline
When	 placing	 and	 arranging	 clips	 in	 the	 Expert	 view	 timeline,	move	 the	 current-time	 indicator	 to	 the	 appropriate	 location.	 In	 the	 time	 ruler,	 the	 current-time	 indicator	 corresponds	 to	 the	 frame
displayed	in	the	Monitor	panel.
A	vertical	line	extends	from	this	current-time	indicator	through	all	the	tracks.	Zooming	in	and	out	of	the	Expert	view	timeline	can	help	you	identify	the	exact	location	for	placing	a	clip	or	performing	an
edit.
In	the	Expert	view	timeline,	do	any	of	the	following:	Drag	the	current-time	indicator.
Click	the	time	ruler	where	you	want	to	position	the	current-time	indicator.
Press	Shift	while	dragging	the	current-time	indicator	to	snap	it	to	the	edge	of	the	closest	clip	or	marker.
Drag	the	time	display	(below	the	Monitor	panel)	to	the	desired	time	value.
Click	the	time	display	(at	the	bofom	of	the	Monitor	panel),	type	a	valid	time,	and	then	press	Enter.	(You	need	not	type	leading	zeros,	colons,	or	semicolons.	However,	Adobe	Premiere	Elements	interprets
numbers	under	100	as	frames.)	You	can	use	the	Home	or	End	keys	on	the	keyboard	to	skip	between	the	beginning	and	end	of	the	movie.
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The	 Page	Up	 and	 Page	Down	 keys	move	 the	 current-time	 indicator	 to	 the	 previous	 and	 next	 clipsrespectively.	The	Right	 or	Leß	Arrow	keys	move	 the	 current-time	 indicator	 forward	 or	back	by	 a
frame.Pressing	Shiß+Right	Arrow	or	Shiß+Leß	Arrow	moves	the	current-time	indicator	forward	or	back	byfive	frames	each	time.
Add	clips	to	the	Expert	view	timeline
When	you	insert	a	clip	into	the	Expert	view	timeline,	adjacent	clips	onall	tracksshift	to	accommodate	the	new	clip.	By	shifting	all	clips	together,	the	audio	and	video	of	the	existing	clips	remain	in	sync.
Sometimes,	you	don’t	want	all	clips	to	shift	with	each	insertion.	For	example,	when	you	add	background	music	that	superimposes	the	entire	movie,	you	don’t	want	clips	to	shift.
To	shift	specific	clips	togather,	press	the	Alt	key	as	you	insert.	Ata	time,	you	can	shift	specific	clips	simultaneously	on	a	maximum	of	two	tracks.	These	include	the	track	receiving	the	insertion	and	the
track	containing	the	linked	audio	or	video	(if	any).	The	affected	tracks	shift	together,	remaining	aligned.	The	clips	on	other	tracks	are	unaffected.
Insert	a	clip,	shih	clips	in	the	Expert	view	timeline
Do	one	of	the	following:
Drag	the	clip	from	the	Project	Assets	panel	to	the	desired	location	in	the	Expert	view	timeline.	When	the	pointer	changes	to	the	Insert	icon,	release	the	mouse.
Move	the	current-time	indicator	to	the	desired	location	in	the	Expert	view	timeline.	Then	select	the	clip	in	the	Project	Assets	panel	and	choose	Clip	>	Insert.
Insert	a	clip,	shih	clips	on	only	the	target	and	linked	tracks
Alt-drag	the	clip	from	the	Project	Assets	panel	to	the	desired	location	in	the	Expert	view	timeline.	When	the	pointer	changes	to	the	Insert	icon,	release	the	mouse.
If	you	drag	a	clip	into	the	blank	space	above	the	topmost	video	track	(for	video)	or	below	the	lowest	audio	track	(for	audio),	Adobe	Premiere	Elements	creates	a	new	track	for	the	clip.	If	the	clip	contains
both	audio	and	video,	it	creates	both	a	new	video	and	new	audio	track.
Overlay	a	clip	in	the	Expert	view	timeline
The	easiest	way	to	replace	a	portion	of	a	video	is	to	overlay	it	with	other	footage.	When	you	overlay	a	clip,	the	clip	you	add	replaces	any	existing	frames	starting	at	the	location	you	designate.
If	the	new	clip	is	40	frames	long,	it	overlays	40	frames	of	the	existing	clip.	The	frames	following	the	overlay,	if	any,	remain	at	the	same	location	in	the	track.	Overlays	do	not	change	the	length	372



of	the	movie	unless	the	overlay	extends	beyond	the	end	of	the	movie.	Do	one	of	the	following:	Ctrl-drag/Cmd-drag	the	clip	from	the	Project	Assets	panel	to	the	first	frame
you	want	to	overlay.	When	the	pointer	changes	to	the	Overlay	icon,	release	the	mouse.
Move	the	current-time	indicator	to	the	first	frame	you	want	to	overlay,	select	the	clip	in	the	Project	Assets	panel,	and	then	choose	Clip	>	Overlay.
Place	one	clip	above	another	in	the	Expert	view	timeline
Youcan	place	one	clip	above	another	without	replacing	a	section	of	the	lower	clip	as	is	done	with	an	overlay.Youcan	use	clips	stacked	in	this	way,	for	example,	with	various	keying	effects.

1.	 In	the	Expert	view	timeline,	drag	the	current-time	indicator	to	a	location	above	a	video	clip	where	you	want	to	overlay	another	clip.
2.	 Shift-drag	a	clip	from	the	Project	Assets	panel,	and	drop	it	on	to	the	Monitor	panel.
3.	 Choose	Place	On	Top.

Adobe	Premiere	Elements	drops	the	second	clip	into	the	first	available	video	track	at	the	location	of	the	current-time	indicator.
Replace	a	clip	in	the	Expert	View	timeline
To	replace	a	clip	in	the	middle	of	the	Expert	view	timeline,	without	altering	the	length	or	changing	the	effects	or	overlays,	use	the	Replace	Clip	command.	This	option	is	useful	when	editing	expanded
instant	movies.

1.	 From	the	Project	Assets	panel,	select	the	clip	you	want	to	use.
2.	 In	the	Expert	view	timeline,	right-click/ctrlclick	the	clip	you	want	to	replace	and	choose	Replace	Clip	From	Project	Assets.

If	the	incoming	clip	is	longer	in	duration,	it	is	trimmed	from	the	end	to	match	the	existing	duration	of	the	outgoing	clip.
If	the	incoming	clip	is	shorter	in	duration,	a	warning	message	appears	giving	you	the	choice	to	cancel	the	replace	action	or	use	black	frames	to	fill	the	excess	duration.
Select,	move,	align,	and	delete	clips	in	the	Expert	view	timeline
After	you’ve	added	a	clip	to	your	movie,	you	may	need	to	rearrange	clips,	copy	and	paste	scenes,	and	delete	other	clips.	Several	techniques	let	you	select	individual	clips,	a	range	of	clips,	or	only	the	audio
or	video	portion	of	a	linked	clip.
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Select	clips	in	the	Expert	view	timeline
Using	the	mouse	cursor,	do	any	of	the	following:
To	select	a	single	clip,	click	the	clip	in	the	Expert	view	timeline.	If	the	clip	is	linked	or	grouped,	clicking	one	clip	selects	the	other	linked	or	grouped	clips.	To	select	only	the	audio	or	video	portion	of
linked	clips,	Alt-click	the	desired	clip.	To	select	a	single	clip	within	a	group,	Alt-click	the	desired	clip.	To	select	multiple	clips,	Shift-click	each	clip	you	want	 to	select.	 (Shift-click	a	selected	clip	 to
deselect	it.)	To	select	sequential	clips,	drag	a	rectangle	(marquee	selection)	that	includes	the	clips	you	want	to	select.	To	add	a	range	of	clips	to	the	current	selection,	Shift-drag	a	marquee	around	the
clips.
Selecting	a	range	of	clips	by	dragging	a	marquee

Move	a	clip	in	the	Expert	view	timeline

You	can	easily	rearrange	clips	in	the	Expert	view	timeline	by	dragging.	By	using	the	same	techniques	you	use	to	add	a	clip,	you	can	choose	to	insert	or	overlay	clips	when	you	move	them.
To	move	a	clip	and	insert	it	so	all	tracks	shift	after	insertion,	drag	the	clip	to	the	desired	location.	When	the	pointer	changes	to	the	Insert	icon,	release	the	mouse	bufon.	To	move	a	clip	and	overlay
another	clip	in	the	movie,	drag	the	clip	to	the	first	frame	you	want	to	overlay,	and	then	press	Ctrl/Cmd.	When	the	pointer	changes	to	the	Overlay	icon,	release	the	mouse	bufon.
To	move	only	one	clip	of	a	linked	pair,	Alt-select	the	clip	you	want	to	move.	Drag	it	to	the	desired	location.	If	you	want	to	shift	clips	only	on	the	target	tracks,	release	the	mouse	bufon	when	the	pointer
changes	to	the	Insert	icon.	If	you	want	to	overlay	another	clip,	press	the	Ctrl	key,	and	when	the	pointer	changes	to	the	Overlay	icon,	release	the	mouse.
Align	clips	by	using	the	Snap	option
The	Snap	option,	which	is	enabled	by	default,	makes	it	easier	to	align	clips	with	each	other	or	with	particular	points	in	time.	You	can	move	a	clip	with	the	Snap	option	selected.	The	clip	374



automatically	aligns	with	the	edge	of	another	clip,	a	marker,	the	start	and	end	of	the	time	ruler,	or	the	current-time	indicator.
Snapping	also	helps	ensure	that	you	don’t	inadvertently	perform	an	insert	or	overlay	edit	when	dragging.	As	you	drag	clips,	a	pop-up	window	displays	the	distance,	in	frames,	that	you	have	moved	them.
A	negative	number	indicates	you’ve	moved	them	toward	the	beginning	of	the	movie.
Choose	Timeline	>	Snap.	A	check	mark	indicates	that	the	option	is	enabled.
Delete	a	clip	in	the	Quick	view	timeline	or	Expert	view	timeline
Deleting	a	clip	from	a	movie	doesn’t	delete	it	from	the	project.	The	clip	is	still	available	in	the	Project	Assets	panel.

1.	 In	the	Quick	view	timeline	or	Expert	view	timeline,	select	one	or	more	clips.	(Alt-click	to	select	only	the	audio	or	video	portion	of	a	clip.)
2.	 Do	one	of	the	following:

To	delete	clips	and	leave	a	gap	of	the	same	duration,	calledclearing,choose	Edit	>	Delete.
To	delete	a	clip	and	close	the	resulting	gap,	called	aripple	deletion,	choose	Edit	>	Delete	And	Close	Gap,	or	press	the	Delete	or	Backspace	key.
Note:When	a	clip	is	deleted	from	the	Quick	view	timeline,	a	transition	that	follows	the	clip	is	alsodeleted.	When	a	clip	is	deleted	from	the	Expert	view	timeline,	the	preceding	and	following	transitions	are
deleted.
Delete	empty	space	between	clips	in	the	Expert	view	timeline
You	can	quickly	delete	 empty	 space	between	clips	 in	 the	Expert	 view	 timeline	by	using	 the	Delete	And	Close	Gap	command.	Alternatively,	 press	 the	Delete	or	Backspace	key.	Both	 techniques	 shift
adjacent	clips	over	to	fill	the	gap.
In	the	Expert	view	timeline,	do	one	of	the	following:
Right-click	the	empty	space,	and	choose	Delete	And	Close	Gap.
Select	the	space	you	want	to	delete,	and	press	the	Delete	or	Backspace	key.
note:	If	the	gap	is	small	and	difficult	to	select,	move	the	current-time	indicator	to	the	gap	and	click	theZoom	In	buflon.
Create	a	duplicate	clip	in	the	Expert	view	timeline
Each	time	you	drag	a	source	clip	from	the	Project	Assets	panel	to	the	Expert	view	timeline,	you	create	aclip	instance.	This	instance	shares	the	source	clip’s	default	In	and	Out	points.	If	you	delete	the
source	clip	in	the	Project	Assets	panel,	all	instances	of	the	clip	in	the	Expert	view	375



timeline	are	deleted.
To	create	clip	instances	with	different	default	In	and	Out	points,	duplicate	the	source	clip	in	the	Project	Assets	panel.	If	you	delete	a	duplicate	clip	in	the	Project	Assets	panel,	all	instances	of	it	in	the
Expert	view	timeline	are	deleted.
Link	video	and	audio	clips
Most	video	includes	a	soundtrack.	In	the	Project	Assets	panel,	clips	that	contain	both	video	and	audio	appear	as	a	single	item.	When	you	add	the	clip	to	a	movie	in	the	Expert	view	timeline,	the	video	and
audio	appear	on	separate	tracks	with	the	video	directly	above	the	audio.
The	video	and	audio	remain	linked.	When	you	drag	the	video	portion	in	the	Expert	view	timeline,	the	linked	audio	moves	with	it,	and	vice	versa.	For	this	reason,	audio/video	pairs	are	calledlinked	clips.	In
the	Expert	view	timeline,	the	names	of	linked	clips	are	underlined	and	identified	with	a	[V]	for	video	or	[A]	for	audio.
Linked	clips	share	same	name	with	either	[V]	or	[A]	appended	and	are	underlined.
All	editing	tasks	(such	as	moving,	trimming,	or	changing	the	clip	speed)	act	on	both	parts	of	a	linked	clip.Youcan	temporarily	override	the	link	by	pressing	the	Alt	key	when	you	initiate	editing	tasks.	You
can	also	place	the	video	or	audio	portion	separately.

Link	and	unlink	video	and	audio	clips

You	can	link	a	video	clip	and	an	audio	clip	so	that	they	act	as	a	unit.	When	you	select,	trim,	split,	delete,	move,	or	change	the	speed	of	one,	you	affect	the	other	clip	as	well.	You	can	temporarily	override
the	link	as	needed.	In	the	Expert	view	timeline,	the	names	of	linked	clips	are	underlined	and	identified	with	a	[V]	for	video	or	[A]	for	audio.
To	link	video	and	audio	clips,	Shift-click	a	video	and	audio	clip	to	select	them	both,	and	then	choose	Clip	>	Link	Audio	And	Video.
To	unlink	 video	and	audio	 clips,	 select	 a	 linked	clip	 and	choose	Clip	>	UnlinkAudioAnd	Video.	 (Though	 the	 audio	 and	 video	 are	unlinked,	 they	 are	both	 still	 selected.	Reselect	 either	 clip	 to	use	 it
separately.)	376



To	select	linked	clips	individually,	Alt-click	the	desired	clip.	After	selecting	it,	you	can	move	or	trim	the	clip	independently	of	its	linked	clip.
To	quickly	delete	an	audio	or	video	clip	without	unlinking	it,	right-click/ctrlclick	the	clip	and	chooseeither	Delete	Audio	or	Delete	Video	from	the	menu.
Delete	only	the	audio	or	video	portion	of	a	linked	clip

In	the	Expert	view	timeline,	do	one	of	the	following:
Right-click/Ctrlclick	the	linked	clip	and	choose	Delete	Audio	or	Delete	Video.

Alt-click	the	audio	or	video	portion	to	select	it	alone,	and	press	the	Delete	or	Backspace	key.	Select	a	linked	click	and	choose	Clip	>	Unlink	Audio	And	Video.	Reselect	either	clip	and	choose	Edit	>	Clear	or
Edit	>	Delete	And	Close	Gap.
The	clips	shift	over	to	fill	the	gap	left	by	the	deleted	clip.
Enable	and	disable	clips
Occasionally,	you	might	want	to	disable	a	clip	while	you	try	a	different	editing	idea	or	to	shorten	the	processing	time.	Disabling	a	clip	hides	it	when	you	view	the	movie	in	the	Monitor	panel	or	when	you
export	the	movie.	You	can	still	move	or	change	a	disabled	clip.

Select	one	or	more	clips	in	the	Quick	view	timeline	or	the	Expert	view	timeline,	and	choose	Clip	>	Enable.
The	check	mark	next	to	the	command	disappears	when	you	disable	a	clip,	and	the	clip	appears	dimmed	in	the	Quick	view	timeline	and	the	Expert	view	timeline.

Hand	on	Activities
Star	Trek	Transporter	Effect	Step	1:	The	Files	and	Project	The	first	task	is	to	gather	the	required	files	and	create	the
project.

(1)The	Transport	Scene
The	first	and	most	important	video	clip	begins	with	an	empty	scene.	The	subject	walks	into	shot	and	assumes	their	“materialized”	position,	then	begins	acting	as	if	they	had	just	beamed	in.	If	you	want	to
make	your	own	transporter	effect	you	will	obviously	need	to	provide	this	shot	yourself.
Note:The	shot	must	be	steady	—	use	a	tripod.
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(2)The	Transporter	Sparkles
The	second	video	clip	provides	the	sparkling	effect.	This	is	a	five-second	clip	of	full-screen	flickering	sparkles	on	a	black	background.	You	can	make	your	own	sparkles	or	download	the	clip	used	in	this
tutorial	(below).

	
(3)The	Audio	File

We	will	also	add	a	transporter	sound	effect	which	is	the	same	duration	as	the	sparkle	video	clip.
2							Tutorial	:	Ghost	Effect
Creating	a	ghost	effect	for	video	is	quite	simple,	as	long	as	you	have	an	editing	package	capable	of	using	layers	and	sefing	layer	opacity.
First	of	all,	set	the	camera	up	on	a	tripod	and	frame	the	shot.	Shoot	the	scene	empty	(without	the	ghost),	then	shoot	the	scene	again	with	the	ghost	actor.	It’s	very	important	that	both	versions	(takes)	of
the	shot	are	framed	identically,	so	don’t	move	the	camera	at	all.	The	background	also	needs	to	be	still.
Import	both	takes	of	the	shot	into	your	editing	program	(Adobe	Premiere	in	this	case).	Place	the	empty	shot	on	the	first	video	track	and	the	ghost	shot	on	the	next	track.
Set	the	opacity	of	the	ghost	shot	to	around	30%,	or	whatever	sefing	achieves	the	best	result.
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Knowledge	Check	Points
Q1)		how	do	you	show	keyframing	on	a	video	track.
Ans:	You	can	see	keyframes	by	twirling	down	the	triangle	and	opening	a	view	track.	There	lives	a	keyframe	popup	where	you	can	show	keyframes,	show	Opacity	keyframes	or	hide	keyframes.

	
Opacity	has	its	own	menu	option	because	I	can	only	assume	it’s	the	most	often	accessed	parameter	for	things	like	fading	up	on	a	clip.	Of	note	is	the	fact	that	with	Show	Keyframes	selected	you	can	then
choose	what	type	of	keyframes	to	show	on	a	PER	CLIP	basis	with	the	clip	keyframe	menu:
There	you	can	even	choose	keyframes	for	things	like	filter	effects	as	well	as	the	usual	Motion,	Opacity	and	Time	Remapping
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Q	2)		How	to	Import	file	?
Answer	:	Then	open	up	Adobe	Premier.	You	then	need	to	click	‘file’,	‘import’

	
Now	make	sure	you	click	on	the	first	image	in	the	sequence,	(normally	named	000000	).	Then	check	the	‘image	sequence’	box.	It	will	then	bring	in	the	whole	sequence.

	
380



	
The	sequence	will	now	be	ready	for	editing.	And	Click	open
Q	3)		How	to	fade	music	in	and	out	for	montage	with	adobe	premiere	pro	?
Ans	:	move	the	timeline	cursor	to	where	you	want	the	audio	to	start	to	fade	out

2)on	the	upper	middle	window	in	premiere,	make	sure	you	are	on	the	Effect	Controls	tab3)expand	Volume	(this	should	be	on	the	left	column	it	actually	says	fx	Volume)
3)you	will	notice	Bypass	and	Level	now…	expand	Level 4)click	on	0.0	dB	this	should	set	a	key	frame	at	the	current	point	on	the	timeline..	leave	it	at

that
5)move	the	timeline	curser	to	a	good
spot	where	you’d	like	the	volume	to
be	LOW

6)adjust	the	0.0	dB	by	holding	down	the	left-click	and
dragging	down.	if	it	goes	into	the	negative	dBs,	the	volume
is	decreasing

7)find	a	spot	for	where	you	want	the	volume	to	start	to	increase	back	to	normal	again	by
dragging	the	timeline	cursor	once	again	.	then	adjust	the	dB	as	needed..	this	will	again
create	a	key	frame

	
381



Q	4)		How	to	upload	a	video	from	adobe	premiere	pro	?
Ans	:Go	to	YouTube.
Click	upload	click				browse.	go	into	computer
there’s	probably	something	along	the	lines	of	‘CD’	or	‘disk’	there	click	it
choose	the	file	you	want	to	upload	done.
Q	5)		Can	a	FCP	project	be	brought	into	CS6?
Premiere	Pro	CS	six	supports	FCP	XML	so	projects	can	be	both	imported	and	exported	from	Premiere	Pro	to	Final	Cut	Pro.	Export	your	entire	project	from	Final	Cut	Pro	as	an	XML	and	then	import	that
XML	into	Premiere	Pro.	You	may	have	to	reconnect	some	media	and	it	might	not	be	a	one	hundred	percent	translation	but	it’s	actually	quite	easy	process.
Q	6	)		How	to	bring	one	timeline	from	one	project	to	another?
Ans	:	The	simplest	method	is	you	have	a	project	open	that	you	want	to	move	a	select	sequence	from	is	to	just	select	the	sequence	andCOPY.Then	open	the	next	project	andPASTE.	That	will	paste	that
new	sequence	into	the	edit.	Note	that	all	the	media	that	is	in	that	new	timeline	will	get	new	items	created	in	the	project	as	well.
A	more	interesting	method	is	to	do	a	File>Import	and	choose	a	Premiere	Pro	project	that	contains	a	sequence	you	want	to	import.	You’ll	get	an	option	import	an	entire	project	or	a	selected	sequence:
Choose	Import	Selected	Sequences	and	you	can	choose	exactly	what	edits	to	import:
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That’s	one	of	the	joys	of	Dynamic	Linking	amongst	the	Creative	Suite	applications,	great	interchange.
Q	7)		How	can	you	move	a	clip	to	a	different	layer	with	keyboard	shortcuts?
Ans	:	You’re	looking	for	the	option	up	arrow,	down	arrow	shortcut	that	Final	Cut	Pro	uses	to	move	clips	up	and	down	into	higher	and	lower	video	tracks	or	audio	tracks.	Premiere	Pro	CS	6	does	not	have
the	shortcut	or	a	similar	keyboard	shortcut.	It’s	too	bad	as	this	is	one	of	those	lifle	features	that	Final	Cut	Pro	has	that	works	very	well	and	is	very	useful.	Please	Adobe	add	such	a	shortcut	or	something
similar.
Q8)		How	can	you	remove	audio	from	video	clip	quickly	in	the	timeline?
Ans:	The	audio	can	begin	before	the	video	or	extend	it	after	the	video	into	the	next	clip	(or	vice	versa).	Trimming	linked	audio	and	video	separately	is	called	a	split	edit.	Usually,	when	you	create	a	split
edit	in	one	clip,	you	must	create	one	in	the	adjacent	clip	so	they	don’t	overlap	each	other.
You	can	create	two	kinds	of	split	edits:

•A	J-cut,	or	audio	lead,	in	which	audio	starts	before	linked	video,	or	video	continues	after
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the	audio.
•An	L-cut,	or	video	lead,	in	which	video	starts	before	linked	audio,	or	audio	continues	after	the	video.

1.	 In	the	Expert	view	timeline,	select	the	clip.
2.	 If	the	clip	is	adjacent	to	another,	Alt-drag	the	audio	portion	down	to	a	separate	track	so	there	is	empty	space	next	to	it.
3.	 (Optional)	Move	the	current-time	indicator	to	the	video	frame	you	want	to	trim,	and	make	sure	Snap	is	enabled	with	a	check	mark.	(If	it	isn’t,	choose	Timeline	>	Snap.)
4.	 Position	the	pointer	over	the	edge	of	the	video	clip	you	want	to	trim,	and	do	one	of	the	following:

If	trimming	the	beginning	of	the	clip,	when	the	Trim-In	icon	appears,	press	Alt	and	drag	the	edge	to	the	desired	frame.	(You	can	release	the	Alt	key	after	you	begin	dragging.)	Notice
that	the	video	stays	aligned	with	the	previous	clip.
If	trimming	the	end	of	the	clip,	when	the	Trim-Out	icon	appears,	press	Alt	and	drag	the	edge	to	the	desired	frame.(Youcan	release	the	Alt	key	after	you	begin	dragging.)	Notice	that
subsequent	clips	in	the	track	shift	left.

Q9.			How	can	I	add	new	video	tracks?
Ans	:	You	have	a	video	and	you	want	to	replace	the	soundtrack	with	one	of	your	creations	or	another	track?
Make	use	of	Windows	Movie	Maker	(it	comes	with	Windows	-	if	this	was	not	the	case	you	can	download	it	here:	Windows	Movie	Maker).
We	will	proceed	in	four	steps:

•Import	Video•Remove	the	sound	of	the	video•Create	/	Add	a	new	audio	track•Save	Video
Import	Video
Firstly,	run	Windows	Movie	Maker.
Generally,	it	is	found	in	Start	Menu	All	Programs	Accessories,	but	it	depends	on	your	version	of	Windows.

•Start	by	importing	the	video.	To	do	this,	click	on	“Import	Media”	(or	directly	on	the	“Video”	tab).
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•Now	the	video	is	present	in	the	imported	media.
•Drag	in	the	track	“Video.”

Remove	the	sound	of	the	video
•Open	the	“Video”	to	show	the	audio	track.
•Now	right	click	on	the	audio	track	of	the	video	and	select	“Mute”.

Create	/	Add	a	new	audio	track
To	record	your	voice	if	you	want	to	insert	it	in	the	video,	you	can	use:

•The	recorder	software	of	Windows	(usually	it	is	in	Start	Menu	All	Programs	Accessories).
•Or	an	audio	editing	software	like	Audacity.
•Save	the	file	as	an	mp3	or	WMA,	for	Windows	Movie	Maker	compatibility.
•Just	as	you	opened	the	video,	Open	the	new	audio	track.
•Once	the	files	are	imported,	it	will	drag	in	the	new	audio	track	and	not	the	one	of	the	video.
•Just	click	on	“Publish	to	This	Computer	“

Q	10.	How	can	I	copy	and	paste	clips	to	the	same	tracks?
Ans	:	Copy	and	paste	keyframes	in	a	Timeline	panel
When	you	paste	keyframes	into	a	Timeline	panel,	the	earliest	keyframe	appears	at	the	current	time	and	the	other	keyframes	follow	in	relative	order.	The	keyframes	remain	selected	after	pasting,	so	you
can	fine-tune	their	location.
You	can	paste	keyframes	only	to	a	clip	or	track	that	displays	the	same	property	as	the	copied	keyframes.	Also,	Premiere	Pro	can	paste	keyframes	at	the	current-time	indicator	on	only	one	clip	or	track	at	a
time.	Because	the	current-time	indicator	can	span	multiple	video	and	audio	tracks,	Premiere	Pro	uses	criteria	in	the	following	order	to	determine	where	to	paste	the	keyframes:

•If	the	current-time	indicator	is	positioned	within	a	selected	clip,	keyframes	are	pasted	in	that	clip.
•If	audio	keyframes	are	cut	or	copied,	Premiere	Pro	pastes	in	the	first	track	where	it	finds	a	corresponding	effect	property,	looking	first	at	a	sequence’s	audio	tracks,	then	its	submix	tracks,	and	then	the
master	track.
•If	none	of	the	above	conditions	produces	a	target	video	or	audio	track	that	matches	both	the	effects	property	and	the	scope	(clip	or	track)	of	the	cut	or	copied	keyframes,	the	Paste
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command	is	unavailable.	For	example,	if	you	copy	audio	track	keyframes	but	the	targeted	audio	track	displays	clip	keyframes,	the	keyframes	can’t	be	pasted.
1.	 In	a	Timeline	panel,	choose	from	a	clip	or	track’s	effect	menu	to	display	the	property	containing	the	keyframes	you	want	to	copy.
2.	 Select	one	or	more	keyframes.
3.	 Choose	Edit	>	Copy.
4.	 In	the	timeline	for	the	sequence	containing	the	destination	clip	or	track,	do	one	of	the	following:

Select	the	clip	where	you	want	to	paste	the	keyframes.
Target	the	video	or	audio	track	where	you	want	the	copied	keyframes	to	appear.

5.	 Make	sure	that	the	clip	or	track	displays	the	same	property	as	the	keyframes	you	copied;	otherwise,	the	Paste	command	is	unavailable.	If	the	property	is	not	available	on	the	clip	or	track’s
effect	properties	menu,	you	must	apply	the	same	effect	that	was	applied	to	the	clip	or	track	from	which	the	keyframes	were	copied.

6.	 Move	the	current-time	indicator	to	the	point	in	time	where	you	want	the	keyframes	to	appear.
7.	 Choose	Edit	>	Paste.

===============

Skill	Check	Point
•How	to	import	Video	in	Premier.
•How	to	separate	sound	from	video	file.
•How	to	make	movie.
•How	to	make	Video	CD	in	Adobe	Premier-pro.

===============

386



Annexure	2
	

Annexure	2New	Applications
New	applications	through	internet	and	phones:

1.	 3G
International	Mobile	Telecommunications-2000	(IMT—2000),	befer	known	as3Gor3rd	Generation,	is	a	generation	of	standards	for	mobile	phones	and	mobile	telecommunications	services	fulfilling
specifications	by	the	International	Telecommunication	Union.	Application	services	include	wide-area	wireless	voice	telephone,	mobile	Internet	access,	video	calls	and	mobile	TV,	all	 in	a	mobile
environment.
In	2008,	India	entered	into	the	3G	arena	with	the	launch	of	3G	enabled	Mobile	and	Data	services	by	Bharat	Sanchar	Nigam	Ltd.	(BSNL)	in	Bihar	(Patna).	BSNL	is	the	first	Mobile	operator	in
India	to	launch	3G	services.	Later,	MTNL	launched	3G	in	Mumbai	&	Delhi.
3G	enables	downloading	of	different	types	of	files	such	as	audio,	video,	etc.	at	a	very	high	speed.	The	bandwidth	and	location	information	available	to	3G	devices	gives	rise	to	applications	not
previously	available	to	mobile	phone	users.	Some	of	the	applications	are:	Mobile	TV	–	a	provider	redirects	a	TV	channel	directly	to	the	subscriber’s	phone	where	it	can	be	watched.
Video	on	demand–	a	provider	sends	a	movie	to	the	subscriber’s	phone.
Video	conferencing–	subscribers	can	see	as	well	as	talk	to	each	other.
Tele-medicine–	a	medical	provider	monitors	or	provides	advice	to	the	potentially	isolated	subscriber.
Location-based	services	–	a	provider	sends	localized	weather	or	traffic	conditions	to	the	phone,	or	the	phone	allows	the	subscriber	to	find	nearby	businesses	or	friends.

2.	 Wi-Fia	trademark	of	the	Wi-Fi	Alliance	that	refers	to	a	range	of	connectivity
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technologies	including	wireless	local	area	network	(WLAN)	and	a	range	of	technologies	that	support	PAN,	LAN	and	even	Wide	Area	Network	(WAN)	connections.
Wi-Fi	devices	are	installed	in	many	personal	computers,	video	game	consoles,	MP	3	players,	smart	phones,	printers,	and	other	peripherals,	and	newer	laptop	computers.
Wi-Fi	enabled	device	such	as	a	personal	computer,	video	game	console,	smart	phone	or	digital	audio	player	can	connect	to	the	Internet	when	within	range	of	a	wireless	network	connected	to	the
Internet.	The	coverage	of	one	or	more	(interconnected)	access	points	—	called	hotspots	—	can	comprise	an	area	as	small	as	a	few	rooms	or	as	large	as	many	square	miles.	Coverage	in	the	larger
area	may	depend	on	a	group	of	access	points	with	overlapping	coverage.
Wi-Fi	also	allows	communications	directly	from	one	computer	to	another	without	the	involvement	of	an	access	point.	This	is	called	thead-hocmode	of	Wi-Fi	transmission.
The	most	common	wireless	encryption-standard,	Wired	Equivalent	Privacy	(WEP),	has	been	shown	to	be	easily	breakable	even	when	correctly	configured.

3.	 Wikipedia
hfp://www.wikipedia.org/
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Wikipedia	is	a	multilingual,	web-based,	free	content	encyclopedia	project.	Wikipedia	is	wrifen	collaboratively	by	volunteers	from	all	around	the	world.	With	rare	exceptions,	its	articles	can	be	edited	by
anyone	with	access	to	the	Internet	Wikipedia	is	a	registered	trademark	of	the	non-profit	Wikimedia	Foundation.	The	name	Wikipedia	is	a	Combination	of	the	words	wiki	(a	type	of	collaborative	website)
and	encyclopedia.	Since	its	creation	in	2001,	Wikipedia	has	grown	rapidly	into	one	of	the	largest	reference	Web	sites	on	the	Internet.
In	every	article,	 links	will	guide	you	to	associated	articles,	often	with	additional	 information.Youare	welcome	to	be	bold	and	edit	articles	yourself,	contributing	knowledge	further	information,	cross-
references,	or	citations	as	you	see	fit	in	a	collaborative	way,	so	long	as	they	do	so	within	Wikipedia	editing	policies.
One	need	not	fear	accidentally	damaging	Wikipedia	when	adding	or	improving	information,	as	other	editors	is	always	around	to	advise	or	correct	obvious	errors.
Because	Wikipedia	 is	an	ongoing	work	to	which	 in	principle	anybody	can	contribute,	 it	differs	 from	a	paper-based	reference	source,	as	Wikipedia	can	be	constantly	updated,	with	articles	on	topical
events	being	created	or	updated	within	minutes	or	hours	or	days	of	their	occurrence.
4.						Blogs:
A	blog	(a	contraction	of	the	term	“web	log”)	is	a	type	of	website,	usually	maintained	by	an	individual	with	regular	entries	of	commentary,	descriptions	of	events,	or	other	material	such	as	graphics	or
video.	Entries	are	commonly	displayed	in	reverse-chronological	order.from	the	most	recent	‘post’	(or	entry)	at	the	top	of	the	main	page	to	the	older	entries	towards	the	boflom.
Blogs	are	usually	(but	not	always)	wrifen	by	one	person	and	are	updated	prefy	regularly.	Blogs	are	often	(but	not	always)	wrifen	on	a	particular	topic	–	there	are	blogs	on	virtually	any	topic	you	can	think
of.	From	photography,	to	spirituality,	to	recipes,	to	personal	diaries	to	hobbies	–	blogging	has	as	many	applications	and	varieties	as	you	can	imagine.	Whole	blog	communities	have	sprung	up	around
some	of	these	topics	pufing	people	into	contact	with	each	other	in	relationships	where	they	can	learn,	share	ideas,	make	friends	with	and	even	do	business	with	people	with	similar	interests	from	around
the	world.
Example	of	a	blogging	website:
hfp://www.21classes.com/
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5.	 Free	Call	and	SMS	sites

a.	 Skypehflp://about.skype.com/
Skype	is	software	that	enables	the	world’s	conversations.	Millions	of	individuals	and	businesses	use	Skype	to	make	free	video	and	voice	calls,	send	instant	messages	and	share	files	with	other
Skype	users.	Everyday,	people	also	use	Skype	to	make	low-cost	calls	to	landlines	and	mobiles.
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a.	Wayto	SMS
hfp://site2.way2sms.com/content/index.html?
First	web	to	mobile	Free	SMS	site	Send,	Free	Chat,	Free	SMS	Free	Group	SMS	to	India:	to	any	mobile	to	any	network.
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6.	 Social	Networking	Websites:

A	social	networking	and	discussion	service	focuses	on	building	and	reflecting	of	social	networks	or	social	relations	among	people,	e.g.,	who	share	interests	and/or	activities.	Following	are	some	of	the
most	frequently	used	social	networking	sites.
Examples:

1.	 Linkedin
hfp://www.linkedin.com/
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2.	 Facebook
hfp://www.facebook.com/

	
3.	 Orkut

hfps://www.orkut.com
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4.	Hi5
hfp://www.hi5.com/friend/displayHomePage.do
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Annexure	3
	

Annexure	3
Career/	Further	Studies	Options

Further	Education

Students	can	pursue	courses	in	the	areas	of	multimedia,	graphics,	animation,	VFX,	web	designing	at	universities	and	other	institutions	for	enhancing	their	knowledge	and	skills.
The	students	with	vocational	stream	in	12th	can	pursue	courses	at	ITIs(Industrial	Training	Institutes)	The	students	with	vocational	stream	in	12th	can	pursue	diploma	in	computer	science	and	engg	and
also	in	IT	at	Polytechnics.

Process	of	admission	of	vocational	stream	students	into	Polytechnics	:

Vocational	 students	 seeking	 admission	 in	 Polytechnic	 have	 to	 appear	 for	 CET	 conducted	 by	 BTE,Delhi	 and	 upon	 qualification	 selection	 will	 join	 the	 three	 year	 diploma	 programme	 in	 second
year(i.e.heshe	will	get	admission	into	2nd	year	of	the	three	year	course	at	Polytechnics	directly)	In	case	students	want	to	pursue	Degree	 in	engineering	after	completing	Diploma	in	their	respective
stream	from	Polytechnic,	then	he	is	required	to	appear	again	in	CET	conducted	by	the	university	offering	Degree	programme	in	engineering	(for	exampleGGSIPUin	Delhi)	for	a	regular	course.	Upon
qualification	selection	heshe	will	directly	be	admifed	into	2nd	year	of	the	four	year	Degree	course	in	Engineering.
OR

Alternatively	he/she	can	pursue	degree	part	time	from	DCE	and	Jamia	in	the	evening	and	become	graduate	engineer.
OR

Else	the	student	has	the	option	of	pursuing	AMIE	from	the	Institution	of	engineers	,	Delhi	in
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particular	stream	from	the	respective	branch.	AMIE	is	treated	as	equivalent	to	B.Tech.	degree.AMIE	is	to	be	done	through	correspondence.
Once	a	student	becomes	graduate	engineer	through	any	of	the	above	modes	and	wants	to	study	further	,	he/she	can	pursue	higher	education	such	as	post	graduation,	etc.	as	per	the	university	norms,
eligibility	conditions,	norms	of	equivalence	of	the	courses,	admission	process,etc.	with	any	of	the	Indian	or	foreign	universities.	He	can	pursue	education	upto	Phd	in	their	field.	They	can	pursue	career
in	industry	as	well	as	in	academics.
Students	may	surf	the	internet,	refer	advertisements	and	notifications	for	admission	to	courses/programmes	in	training	and	educational	institutions.
Skills	needed	 for	quality	 in	 trained	and	 skilled	manpower	 :IT	 requires	 precision	 in	 decision	making,	 logical	 thinking	 and	 reasoning,	 some	numerical	 abilities.	Besides	 the	 students	must	 havegood
communication	in	English	(wrifen	and	spoken),	presentation	andITskills	and	sound	knowledge	of	their	domain.
Career	Opportunities

After	passing	Class	XII	in	IT	vocational	stream	opportunities	would	be	available	in	following	work	areas:-
Data	entry	operation,	computer	operation,	word	processing,	etc.

With	further	up	gradation	of	required	IT	skills	and	personal	skills,etc.	students	can	also	seek	job	opportunities	in	web	designing,	web	site	creation,	digital	designing,	multimedia	and	graphics	and	other
related	work.
Some	of	the	companies	which	hire	those	students	are	TCS,	Tech	Mahindra,	HCL,	IBM,	CSC,etc.
Opportunities	available	to	students	after	passing	Cl	XII	are	also	given	at	the	following	web	site	as	well	as	many	other	educational	web	sites	:	hfp://edudel.nic.in/welcome_folder/after12th.htm

Students	can	consult	YUVAHelpline	for	career	guidance.	Toll	Free	YUVA	phone	line	is	1800-11-6888,	10580.
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Annexure	4
	

Annexure	4Important	Links
The	page	displays	list	of	some	of	the	relevant	links	to	educational	and	government	sites.

1.	 Education	Department,	GNCT,	Delhi	:	hflp://www.edudel.nic.in/

2.	 SCERT	:	hflp://www.edudel.nic.in/SCERT	OR	www.scertdelhi.nic.in

3.	 Central	Board	of	Secondary	Education	(CBSE):	hflp://www.cbse.nic.in/

4.	 Central	Institute	of	Educational	Technology	(CIET):	hflp://www.ciet.nic.in/

5.	 Centre	for	Cultural	Resources	and	Training	(CCRT):	hflp://ccrtindia.gov.in/

6.	 Indira	Gandhi	National	Open	University	(IGNOU):	hflp://www.ignou.ac.in/

7.	 Jamia	Millia	Islamia:	hflp://jmi.ac.in/

8.	 National	Council	of	Educational	Research	andTraining:hflp://www.ncert.nic.in
9.	 University	of	Delhi:	hflp://www.du.ac.inSubject	wise	Links	for	students:

Math:hflp://mathforum.org/dr.math/hflp://www.aplusmath.com/
This	web	site	was	developed	to	help	students	improve	their	maths	skills	interactively

hflp://www.aaastudy.com

AAA	Math	features	a	comprehensive	set	of	interactive	arithmetic	lessons.	Unlimited	practice	is	available	on	each	topic	which	allows	thorough	mastery	of	the	concepts.
Science:hflp://www.execulink.com/~ekimmel/
This	is	a	website	for	high	school	science	students.	You’ll	find	a	variety	of	interactive	quizzes,
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games	and	puzzles	to	practice	what	you’re	learning.	There	are	also	some	specific	student	resources	for	each	course
hflp://cnx.org/content/col10264/latest/

Each	module	develops	a	centralconceptinChemistryfrom	experimental	observations	and	inductive	reasoning.	This	approach	complements	an	interactive
hflp://www.fun-science-fair-projects.com/

This	e-book	is	a	compilation	of	47	unique	science	projects	covering	ten	different	subject	areas.	All	of	the	projects	are	easy-to-do	and	educational.
hflp://www.glenbrook.k12.il.us/gbssci/Phys/Class/BBoard.html

The	Physics	Classroom	is	an	online	interactive	tutorial	of	basic	physics	concepts.	The	lessons	use	an	easy-to-understand	language	to	present	common	physics
Social	Science:hflp://www.wou.edu/las/socsci/anthro/harappa.htmhflp://bla.stisd.net/resources/AncientCivilizations/default.htm	Hindi:hflp://www.webduniya.com
Useful	Links	for	Teachers	and	Students	:hflp://www.ictmanual.net/
It	 provides	 Online	 Training	 Manual	 forICTIntegration	 in	 School	 Education	 for	 teachers,	 teacher	 educators,ICTcoordinators,	 trainers	 and	 any	 one	 else	 concerned	 about	 integratingICT	 (web2	 in
particular)	in	improving	the	educational	practices.	It	is	compliant	with	the	“ICTCompetency	Standards	for	Teachers”	(ICT-CST)	developed	by	UNESCO.
hflp://www.geogebra.org/cms/

Free	mathematics	software	for	learning	and	teaching,	GeoGebra	is	an	interactive	geometry,	algebra,	and	calculus	application,	intended	for	teachers	and	students.	Constructions	can	be	made	with	points,
vectors,	segments,	lines,	polygons,	conic	sections,	inequalities,	implicit	polynomials	and	functions.	All	of	them	can	be	changed	dynamically	afterwards.	Elements	can	be	entered	and	modified	directly	on
screen,	or	through	the	Input	Bar.	GeoGebra	has	the	ability	to	use	variables	for	numbers,	vectors	and	points,	find	derivatives	and	integrals	of	functions.
hflp://star.mit.edu/index.html

It	provides	software	tools	for	academics,	researchers,	teachers	and	students	which	facilitate
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learning	of	various	concepts.	For	example	StarBiochem	is	a	molecular	3-D	viewer	that	allows	students	to	learn	key	concepts	in	structural	biology	in	an	interactive	manner.	This	software	allows	for	the
visualization	 and	 manipulation	 of	 any	 of	 the	 structures	 present	 in	 the	 Protein	 Data	 Bank;	 StarGeneticsis	 a	 genetic	 cross	 simulator.	 Using	 StarGenetics	 students	 can	 performing	 virtual	 mating
experiments	between	genetically	different	organisms	across	a	range	of	traits.
Several	useful	tools	and	material	are	available	on	the	web	which	can	be	used	to	aid	and	enhance	learning.	The	teachers	and	the	students	can	search	for	them	using	the	search	engines	and	the	techniques
described	above.

	
Bibliography:hfp://en.wikipedia.org/wiki/Operating_system	hfp://en.wikipedia.org/wiki/Task_bar	hfp://home.earthlink.net/~cassidyny/spreadsheet.htm
hfp://library.thinkquest.org/5862/partsof.htm.	hfp://science.csustan.edu/tutorial/Excel/index.htm
hfp://webmediaworkshop.com/Classes/cs100/mod.ss/unit.1/lesson.1/navigatess.htmlhfp://wordprocessing.about.com/od/wordprocessingsoftware/a/tabletips.htmhfp://www.adobe.com/devnet/dreamweaver.html
hfp://www.atlantiswordprocessor.com/en/help/html/selecting_text.htm	hfp://www.baycongroup.com/excel2003/excel03.htm
hfp://www.computerhope.com/issues/ch000791.htm	hfp://www.contextures.com/xlSort01.html	hfp://www.dreamweavertutorial.co.uk/
hfp://www.edu.pe.ca/journeyon/pro_d_pages/file_management/FileManagementinWindows.htm	hfp://www.elearningplace.co.uk/6852/taster/tastertypescomp.php?sess_key
hfp://www.esu.edu/win_tutorial/dt_2.html	hfp://www.geocities.com/Athens/Delphi/6470/word.htm
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hfp://www.gobe.com/gp/help/Overview/GSDocWindows.htmhfp://www.internet4classrooms.com/on-line_ie.htm	hfp://www.internefutorials.net/internet.html
hfp://www.jegsworks.com/Lessons/words/basics/step-spelling.htm	hfp://www.learndreamweavertutorials.com/	hfp://www.ncsu.edu/it/edu/winword_trng/word/editing.html
hfp://www.nos.org/htm/ms-word3.htm	hfp://www.thesitewizard.com/#	hfp://www.tutorialspoint.com/lisfutorials/dreamweaver/1
hfp://www.webopedia.com/TERM/k/keyboard.htmlhfps://www.adobe.com/	hfp://www.tutorialized.com/tutorials/Premiere/1	hfp://www.microsoft.com/en-in/server-
cloud/products/sqlserver/hfp://www.w3schools.com/sql/	hfp://www.sqlservercentral.com/hfp://windows.microsoft.com/en-us/windows/homewww.bsesdelhi.com.
hfp://www.passportindia.gov.in/AppOnlineProject/welcomeLink	www.movies.ticketplease.com
hfp://www.makemytrip.com/	hfps://www.irctc.co.in/eticketing/loginHome.jsf	hfp://www.flipkart.com/
hfp://moodle.com/

hfp://code.tutsplus.com/tutorials/the-essentials-of-writing-high-quality-javascript—net-15145
hfp://www.webestools.com/

hfps://docs.google.com/file/d/0BzsgtY7KuQUXdzgyLURVZ	3BuS3c/edit?pli=1
hfp://sumtotalz.com/TotalAppsWorks/Javascript/JS_BasicCalc.htmlhfp://www.javascriptsource.com/miscellaneous/basic-javascript-quiz.html

400
Adobe	Dream	Weaver	CS	3

Help	file	of	Windows	Movie	Maker

Ivan	Bayross,	Web	Enabled	Commercial	Application	Development	Using	H	T	M	L	,	DHTML,javascript,	Perl	CGI,	BPB	Publication,	New	Delhi	(2005)	JavaScript	Tutorial	-	W3Schools,
www.w3schools.com/js/JavaScript	Tutorial,	hfp://html.net/tutorials/javascript/	JavaScript	Tutorial,	www.echoecho.com
JavaScript	Tutorial,www.tutorialspoint.com/javascript/LearnJavaScriptProgramming,www.codecademy.com/tracks/javascript	Open	source	software	and	free	online	tutorials
Premier	Pro

Software	and	their	Help	files	used	in	the	manualSQL 	Server	Windows	Movies	Maker

Tutorials	on	Dreamweaver,	Premier	Pro,	Java	Script,	SQL, 	SQL 	Server,	Movie	Maker,	onlinereservation	system,	e-governance,	online	shopping	and	bill	payments.

Other	relevant	web	sites
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